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Introduction to Resource Management
Resource Management contains the following workflows/sections:

 Using the Repository Search - This section describes the way in which you 
can search the repository. For a detailed explanation, see Using the 
Repository Search on page 13.

 Metadata Management - This section describes working with the MD 
Editor and searching external resources. For a detailed explanation, see 
Metadata Management on page 147.

 Inventory - This section describes inventory management activities. For a 
detailed explanation, see Inventory on page 273.

 Managing Profiles for Record Import – This section describes creating, 
editing, viewing, copying, deleting, and using import profiles, plus how to 
start new imports. For a detailed explanation, see Managing Profiles for 
Record Imports on page 511.

 Configuration - This section describes the resource management 
configuration activities. For a detailed explanation, see Configuring 
Resource Management on page 611.
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Using the Repository Search

The Alma repository includes bibliographic records, authority records, and 
inventory records (holdings and items for physical material and portfolios for 
electronic resources). The repository consists of the Institution Zone (IZ) and the 
Community Zone (CZ) and, for collaborative network environments, the 
Network Zone (NZ). (Refer to Working with the Repository Search and MD 
Editor in a Collaborative Network on page 4 in the Alma Collaborative Networks 
(Consortia) Guide for more information regarding the NZ Repository Search 
facility.)

Information in the IZ is managed by the institution. Information in the CZ is 
managed by Ex Libris and synchronized with each IZ on a weekly schedule. 
Institutions are allowed to review any changes/updates that might be made in 
the IZ and take certain actions such as unlinking their IZ version from a CZ 
resource in order to create and maintain local overrides during regular 
synchronizations. (Refer to Working with the Community Zone Updates Task 
List on page 503 for more information about managing CZ updates made to the 
IZ.)

The Alma CZ incorporates global authority files from the Library of Congress 
(LC), the United States National Library of Medicine (NLM), and the German 
National Library (GND). The CZ also includes the Central KnowledgeBase 
(CKB). The CZ repository content enables validation of records (preferred/
nonpreferred terms) and collection development (ordering physical and 
electronic resources). For additional information, refer to Working with 
Authority Records on page 184 and Using the Repository Search Results List 
on page 35. 

This section includes: 

 Repository Search Workflow on page 14

 Searching in the Repository on page 15

 Managing Search Queries and Sets on page 81

 Viewing Export Processes on page 109

 Search Indexes on page 115
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VIDEO:
For more information about the Community Zone, see the Alma 
Community Zone Intro and Task List video (14:10 mins).

For searches outside the Alma repository, see Searching External Resources on 
page 264.

Repository Search Workflow
The following is an illustration of the repository search workflow that illustrates 
the way in which you can search the repository.

Figure 1: Repository Search Workflow

The following is a detailed description of the steps within this workflow (with 
the numbers corresponding to the numbers in the diagram):

1 You can perform a repository search using one of the following options:

a Saved Query – After performing any repository search you have the 
option of saving the search query for future use (see Saving Queries on 

http://www.youtube.com/watch?v=biKoHRSc5DI&hd=1
http://www.youtube.com/watch?v=biKoHRSc5DI&hd=1
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page 32). Choosing this option enables you to use one of your 
previously saved queries (see Using Saved Queries on page 34), or you 
can use a query created by another user (see Managing Search Queries 
and Sets on page 81).

b Persistent Search Box – This option allows you to search the repository 
in the Keywords search index, similar to the simple search (see Using 
the Simple Search on page 19), as well as searching for users, vendors, 
and other items. It is available at all times on any page in Alma (see 
Using the Persistent Search Box on page 16).

c Simple Search – This option enables you to perform a simple search in 
the repository  using three basic search criteria (see Using the Simple 
Search on page 19).

d Advanced Search – This option enables you to perform an advanced 
search containing multiple search criteria and conditions (see Using the 
Advanced Search on page 20).

2 The results of any repository search (using any of the options listed in step 
1) are displayed in the results list page where you can: 

a Save the Query – After performing a repository search you have the 
option of saving the search query for future use (see Saving Queries on 
page 32).

b Use the Search Results – Depending on the search criteria, the search 
results that are displayed offer many different options from viewing the 
bibliographic record to creating a PO line for the item (see Using the 
Repository Search Results List on page 35). 

Searching in the Repository

PERMISSIONS:
Any user can search the repository.

The main access points to the Alma repository search are:

 The persistent search box located at the top of every page (see Using the 
Persistent Search Box on page 16)

 The Repository Search option under Resource Management > Search and 
Sets in the Alma main menu (see Using the Alma Repository Search on 
page 18)
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VIDEO:
See the Navigating And Searching In Alma training WebEx sessions on using 
the search function within Alma. Note that you must be logged on to the 
Ex Libris Learning Center to access this session.

Using the Persistent Search Box
The Persistent Search box provides a simple search interface for searching the 
repository and other areas of Alma. Searching the repository with the Persistent 
Search box is the same as performing a simple search in the Keywords search 
index. For a list of the keyword indexes searched when using the persistent 
search box, see Keyword Search Indexes on page 136. Not selecting any option 
from the drop-down list is the same as selecting All titles. 

To use the Persistent Search box:

1 At the top of any page, select the required presearch criteria from the 
Persistent Search drop-down list.

The following is an example of the Persistent Search box and the presearch 
criteria available.

Figure 1: 

Figure 2: Persistent Search Drop-Down List of Options

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1013
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2 Enter the search term or value in the Persistent Search box and click Find 
.

The following table describes the search page in which the results are 
displayed, and the user types for which the presearch option itself is 
displayed.

Table 1. Persistent Search Box – Presearch Criteria

Presearch 
Criteria

Results Displayed In Displayed For User 
Types

All titles Repository Search page All

Physical items Repository Search page All

Electronic portfolios Repository Search page All

Funds Funds and Ledgers page Fund Manager, Ledger 
Manager, Purchasing 
Manager, Purchasing 
Operator, Selector

Collection Repository Search page All

Electronic collection Repository Search page All

Digital files Repository Search page All

Order lines Search for PO Line page (see 
Searching for PO Lines in the 
Alma Acquisitions Guide for a 
description of the search 
results)

Invoice Manager, Invoice 
Operator, Invoice Operator 
Extended, Purchasing 
Manager, Purchasing 
Operator, Selector, Trial 
Manager, Trial Operator

Invoices Find Invoices page (see 
Searching for Invoices in the 
Alma Acquisitions Guide for a 
description of the search 
results)

Invoice Manager, Invoice 
Operator, Invoice Operator 
Extended, Purchasing 
Manager, Purchasing 
Operator, Selector

Requests Resource Request Monitoring 
page (see Monitoring 
Requests and Work Orders in 
the Alma Fulfillment Guide)

Receiving Operator, 
Receiving Operator 
Limited, Circulation Desk 
Manager, Circulation Desk 
Operator, Fulfillment 
Services Manager, 
Fulfillment Services 
Operator, Requests 
Operator, Work Order 
Operator
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Using the Alma Repository Search
The Alma repository search enables you to search the repository for physical 
items, electronic portfolios, electronic collections, collections, digital files, or 
authorities. The repository search offers you the following methods of 
searching:

 Simple Search – Enables you to search the repository using Find, Where, and 
Contains filters (see Using the Simple Search on page 19)

 Advanced Search – Enables you to build search criteria and include 
additional search conditions that allow you to refine your search (see Using 
the Advanced Search on page 20)

NOTE:
For information regarding search indexes, see Search Indexes on 
page 115.

VIDEO:
See the Navigating And Searching In Alma training WebEx sessions on using 
the search function within Alma. Note that you must be logged on to the 
Ex Libris Learning Center to access this session.

You can also save search queries and reuse them at any time (see Working with 
Queries on page 32).

To access the Alma Repository Search, select Resource Management > Search 
and Sets > Repository Search.

Vendors Search Vendors page (see 
Navigating and Filtering the 
List of Vendors in the Alma 
Acquisitions Guide)

Vendor Manager

Users Find and Manage Users page 
(see Managing Users in the 
Alma Administration Guide)

User Administrator, User 
Manager, General System 
Administrator

Authorities Repository Search page All

Table 1. Persistent Search Box – Presearch Criteria

Presearch 
Criteria

Results Displayed In Displayed For User 
Types

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1013
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Figure 3: Repository Search Page

Using the Simple Search
The Repository Search page has a Simple Search interface as well as links to the 
Advanced Search (see Using the Advanced Search on page 20) and Saved 
Queries (see Saving Queries on page 32). The Simple Search comprises the 
following elements:

 Find – Enables you to choose from the following types of resources to be 
searched:

 All Titles – Returns all bibliographic records in the repository

 Physical Titles – Returns bibliographic records that have physical 
holdings in the repository

 Electronic Titles – Returns bibliographic records for all electronic titles 
in the repository

 Digital Titles – Returns bibliographic records for all digital titles in the 
repository

 Digital Files – Returns item information for all digital files in the 
repository

 Physical Items – Returns item- and holdings-level information for all 
physical resources in the repository

 Electronic Portfolio – Returns all electronic portfolios in the repository

 Collection – Returns all collections in the repository

 Electronic Collection – Returns all electronic collections in the repository

 Authorities – Returns authority records

 Where – Enables you to choose the index or field on which to perform the 
search. The indexes that display vary depending on the resource type that 
you selected with the Find option. 

Local search indexes that display in the Where drop-down list can be 
configured in Resource Management > Resource Configuration > 
Configuration Menu > Search Configuration > Search Indexes. Refer to 
Configuring Search Indexes on page 615 for additional information.
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NOTE:
The Keywords search index is a general index that contains values from 
many fields but not from all the fields. For a list of the keyword indexes 
searched when using the persistent search box, see Keyword Search 
Indexes on page 136. 

 Contains – Use this option to enter your search content.

NOTES:
Regarding search content:

 Articles - You may either include or omit articles (such as the, a, an) in 
your search content. Materials have been indexed with and without the 
articles to enable consistent search results. 

 Special characters can be entered in the same manner as other characters. 
(For example, if a title contains the ! special character, you can search for a 
title containing the keyword !)

 The ? wildcard character is supported for any single character. The * 
wildcard character is supported for any string following the entry of 
three non-special characters.

 ISBN - Records in the Alma database have been converted from the 
ISBN-10 to the ISBN-13 format. This enables consistent search results 
when you need to match records on content entered for an ISBN search.

After you enter your search elements and click Go, the items that match your 
search query display on the Repository Search page.

On the Repository Search page, you can:

 Click Save Query if you want to save the search criteria details (see Saving 
Queries on page 32).

 Use the results of the search as described in Using the Repository Search 
Results List on page 35.

 Perform an advanced search by clicking the Advanced search link (see 
Using the Advanced Search on page 20).

Using the Advanced Search
The Advanced Search option supports a more powerful, refined search, 
including multiple fields and search fields of other resource types. For example, 
when searching physical titles, you can search for a bibliographic title in a 
particular holdings location.

This is done by choosing the Advanced Search option and adding conditions to 
the search input.
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To use the Advanced Search:

1 On the Repository Search page, click the Advanced Search link. The 
Advanced Search page opens.

Figure 4: Advanced Search Page

2 Select an option from the Find drop-down list and click Add Conditions. 
The Advanced Search – Add Conditions dialog box opens.

NOTE:
The options available in the Advanced Search – Add Conditions dialog 
box vary based on your selection from the Find drop-down list on the 
Advanced Search page.
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Figure 2: 

Figure 5: Advanced Search – Add Conditions Dialog Box (when Physical Titles is Selected 
from the Find Option)

Most of the options presented in the Advanced Search – Add Conditions dialog 
box are self-explanatory. Refer to the following table for additional information 
regarding the Advanced Search – Add Conditions options.

Table 2. Additional Information for Advanced Search – Add Conditions Options

Option Description
Originating system ID The record ID created in the system from which the 

item was imported.

Originating system The name of the system from which the item was 
imported into Alma.

Tag sync external catalog Indicates whether the MMS record must be 
synchronized with an external catalog such as OCLC 
WorldCat.

Item PID The internal-, system-generated ID for the item.

Provenance code A code, defined by the institution indicating the origin 
of the material.
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In addition to these fields (or conditions) based on the type of search, Alma 
supports RDA fields and subfields for systems that use RDA. An example of the 
fields are shown in the image below.

Figure 3: 

Figure 6: Add Conditions with RDA Fields

The following RDA fields are supported by Alma.

Current location Selecting this index retrieves only items currently in the 
searched location.

Temporary library The actual physical location of the item.

Temporary physical 
location

Selecting this index retrieves all items identified in the 
system’s temporary location field regardless of whether 
the item is currently in the temporary location (that is, 
even when Item is in temporary 
location=No).

Other Classification 
Number 

A classification number from a scheme not covered by 
one of the other number fields.

Table 2. Additional Information for Advanced Search – Add Conditions Options

Option Description
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NOTE:
Bibliographic, authority, and holdings types appear under subheadings in 
the table below. Repeatable fields are marked by "(R)" in the description. 
Non-repeatable fields are marked by "(NR).”

Table 3. RDA Fields Supported in Alma

Field Description
Bibliographic

028 Publisher Number (R)

264 Production, Publication, Distribution, Manufacture, 
and Copyright Notice (R)

336 Content Type (R)

337 Media Type (R)

338 Carrier Type (R)

340 Physical Medium (R)

344 Sound Characteristics (R)

345 Projection Characteristics of Moving Image (R)

346 Video Characteristics (R)

347 Digital File Characteristics (R)

377 Associated Language (R)

380 Form of Work (R)

381 Other Distinguishing Characteristics of Work or 
Expression (R)

382 Medium of Performance (R)

383 Numeric Designation of Musical Work (R)

384 Key (NR)

Authority

046 Special Coded Dates (R) 

336 Content type (R)

368 Other Attributes of Person or Corporate Body (R)

370 Associated Place (R)

371 Address (R)
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3 Build the Advanced Search conditions to match your search requirements.

372 Field of Activity (R)

373 Associated Group (R)

374 Occupation (R)

375 Gender (R)

376 Family Information (R)

378 Fuller Form of Personal Name (NR)

377 Associated Language (R)

380 Form of Work (R)

381 Other Distinguishing Characteristics of Work or 
Expression (R)

382 Medium of Performance (R)

383 Numeric Designation of Musical Work (R)

384 Key (NR)

Holdings

337 Media Type (R)

338 Carrier Type (R)

Table 3. RDA Fields Supported in Alma

Field Description
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a From the Advanced Search dialog box, select one or more conditions for 
your search and click Add Conditions. The Advanced Search page 
refreshes and opens showing the selected search fields.

Figure 7: Advanced Search Page with Search Fields

b Select the condition logic for your search:

 Contains Keywords

 Contains Phrase

 Starts With

 Equals

 Not Equals

 >

 <

 >=

 <=

 In

 Not In
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 Before

 After

 Is Empty – For example, you can use this condition to find all 
physical items that do not have barcodes.

The condition logic options vary depending on the Add Condition 
selected. See Table 4 for a sample list.

c Enter your Add Condition content criteria (free-form text or a value 
selected from a search or drop-down list).

NOTES:
 Special characters can be entered in the same manner as other characters. 

(For example, if a title contains the ! special character, you can search for a 
title containing the keyword !)

 The ? wildcard character is supported for any single character. The * 
wildcard character is supported for any string following the entry of 
three non-special characters.

d Optionally:

 Repeat step 3a through step 3c to further narrow your search

 Remove a specific condition, as needed, using the remove condition 
icon (the broom) 

 Use Clear Conditions to remove all the conditions

4 Click Go. The items that match your search criteria display on the 
Repository Search page.

Figure 8: Repository Search Page – with Results
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NOTE:
The search criteria used are listed in the Current Search line at the top of 
the page.

5 On the Repository Search page, you can:

 Click Save Query if you want to save the search criteria details (see 
Saving Queries on page 32).

 Use the results of the search as described in Using the Repository 
Search Results List on page 35

 Change the search criteria by clicking the Change Query link and 
redefining your search criteria (Figure 7).

 Go back to a simple search by clicking the Simple Search link (see 
Using the Simple Search on page 19).

 Choose from the list of saved queries by clicking the Saved Queries link 
(see Using Saved Queries on page 34).

Finding Holdings Without Items Using Advanced Search
Using the Has items advanced search condition, you can locate holdings 
without items.

To find holdings without items using the Has items condition:

1 From the Alma main menu > Resource Management > Search and Sets, click 
Repository Search.

2 Click Advanced search.

3 Confirm that your Find option is set to Physical Titles and click Add 
Conditions.

4 Select the Has items condition, and click Add Conditions.
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Figure 9: Has Items Advanced Search Condition (Physical Titles/Holdings Column)

5 Specify No for the Has items (equals) condition.

Figure 10: Has Items Yes/No Option (Holdings)

6 Click Go.

The search results display.
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Finding Physical Titles/Items Without Barcodes Using Advanced 
Search

Alma provides the capability to conduct an advanced search of physical titles/
items without barcodes or other information. This is possible with the Is Empty 
advanced search option (see the table below for a sample list of conditions with 
the Is Empty option). From your search results, you can create sets to analyze 
and manage/update your Alma database.

Table 4. Is Empty Sample List

All Titles  
(No Present)

Holdings  
(Not Present)

Physical Items  
(Not Present)

LC call number Permanent call number type Inventory number

Dewey decimal class 
number

Permanent physical location Public note

UDC Library Fulfillment note

Other classification 
number

Call number suffix Internal note 1

Additional publication 
year

Summary holdings Internal note 2

Language Holdings note Internal note 3

LC control number Item sequence number

ISBN PO line

ISSN Alternative call number

ISSN link Alternative call number type

Other standard ID Creation date

Government document 
number

Current library

National bibliography 
number

Currently location

Publisher number Due back from temp location 
date

Standard number Expected receiving date

Other system number Inventory date

Notes Is Magnetic

Local notes Item policy
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To find physical titles without barcodes:

1 From the Alma main menu > Resource Management > Search and Sets, click 
Repository Search.

2 Click Advanced search.

3 Confirm that your Find option is set to Physical Titles and click Add 
Conditions.

4 From the Physical Items column, select Barcode and click Add Conditions.

The barcode additional condition displays with the Is Empty option 
available from the drop-down list.

Description Last shelf report date

MMS SIP ID Material type

Physical description Modification date

Country of publication On shelf date

Genre form On shelf seq

Publisher location Pages

Material type Pieces

Medium type Process type

Originating system ID

Originating system

Tag suppressed

Tag sync external 
catalog

Tag brief

Local field 900

Relator

Table 4. Is Empty Sample List

All Titles  
(No Present)

Holdings  
(Not Present)

Physical Items  
(Not Present)
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Figure 11: Is Empty Advanced Search Condition

5 Click Go.

The search results display all the physical items without barcodes.

Working with Queries
You can save queries that you have created for later use. Refer to:

 Saving Queries on page 32

 Using Saved Queries on page 34

Saving Queries
Saving queries enables you to save sets of search criteria that can be reused.

You can save any search query whether it was created using the Persistent 
Search box (see Using the Persistent Search Box on page 16), the Simple Search 
(see Using the Simple Search on page 19) or the Advanced Search (see Using 
the Advanced Search on page 20). 
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To save a query:

1 Click Save Query that displays on the Repository Search page after each 
search. 

The Set Details page opens.

Figure 12: Set Details Page

2 Enter the set details in the respective fields. (The Set Name is a mandatory 
field and must be unique. Other fields are optional).

By default, the set is designated as Private (Yes), only available to you from 
the My Sets tab on the Manage Sets page (Figure 13). If you select No, the set 
becomes a public set and is available to all other users from the Public Sets 
tab on the Manage Sets page (Figure 13).

By default, the Status is set to Active. Optionally, select Inactive.
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3 Click Save. The Manage Sets page opens displaying the newly saved set on 
the list of saved sets. For more information on Managing Sets see Managing 
Search Queries and Sets on page 81.

Figure 13: Manage Sets Page

Using Saved Queries
Saved queries can be accessed using the Saved Queries link on the Repository 
Search page or from the Manage Sets menu link.

For information on how to use a saved query from the Manage Sets page see 
Managing Search Queries and Sets on page 81
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To access and use saved queries from the Repository Search page:

1 On the Repository Search page, click the Saved Queries link. The Select Set 
page opens.

Figure 14: Select Set Page

2 Select the set you want to use and click Select Set. The search is performed 
according to the settings in the saved query, and the Repository Search page 
opens showing the results of the search.

Figure 15: Repository Search Page with Results

See Using the Repository Search Results List on page 35 for details 
regarding how to use the search results.

Using the Repository Search Results List
The Repository Search results list provides a numbered list of matching results 
displayed according to the type of resource chosen for your search. By default, 
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search results are displayed according to an internal ranking mechanism that is 
based on Apache Solr. The basic scoring/ranking model explanation is located at 
http://www.solrtutorial.com/solr-search-relevancy.html. Documents 
are scored/ranked in the following manner: 

 Term Frequency - The frequency with which a term appears in a document. 
Given a search query, the higher the term frequency, the higher the 
document score.

 Inverse Document Frequency - The rarer a term is across all documents in 
the index, the higher its contribution to the score. 

 Coordination Factor - The more query terms found in a document, the 
higher its score.

 Field Length - The more words a field contains, the lower its score. This 
factor penalizes documents with longer field values.

In addition, primary and secondary sorts may be selected from the drop-down 
lists at the top of the search results. Both drop-down lists offer the following 
options (where Asc=ascending and Desc=descending): 

 Rank

 Title – Asc

 Title – Desc

 Creator – Asc

 Creator – Desc

 Publication Date – Asc

 Publication Date – Desc

VIDEO:
For information about terminology used on the Repository Search Results 
list, see the “Managed by Department” Changed to “In Process” video (2:58 
mins).

Facets
Search results may be filtered using the facets displayed in the left pane of the 
search results. The number of facets are determined by the type of material 
searched and the search results. Refer to the table below for a list of facets 
provided. 

http://www.youtube.com/watch?v=4UoW0gau2wc&hd=1
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Table 5. Search Result Facets

Search Type Facets Provided
All titles Inventory

Material type

Language

Publication year

Physical titles Material type

Language

Publication year

Electronic titles Material type

Language

Digital titles Language

Publication year

Entity type

Preservation type

Digital files Entity type

File MIME type

File size bytes

File extension

Physical items Item material type

Library

Process type

Electronic portfolio Type

Interface

Electronic collection type

Service

Electronic material type

Availability

Collection Library

Electronic collection Type



Alma Resource Management

January 201538

Chapter 2: Using the Repository Search

Ex Libris Confidential

The facets display a count in parentheses next to the facet label. 
Figure 4: 

Figure 16: Facet Count in Parentheses

The facet numbers in parentheses are directly related to the total count provided 
with your search results. In the illustration below, the total count is 10. In the 
previous illustration (from the same search results), the facet counts add up to 
10 for each facet type.

Figure 5: 

Figure 17: Total Count in Search Results

Interface

Electronic collection type

Availability

Authorities Heading Usage

Vocabulary

Table 5. Search Result Facets

Search Type Facets Provided
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Sometimes the total count is labeled approximately. This may happen when the 
number of results is large. In order to provide reasonable response time with 
search results, Alma is designed to provide an approximate count when the 
results are large. 

Figure 6: 

Figure 18: Approximate Total Count

NOTE:
Since the facet count is related to the total count, when the total count is 
labeled approximately, the facet counts are also approximate.

To select a facet, click the link for the facet you prefer to narrow the search 
results. You may select more than one facet when multiple facets are available 
(see illustration below). You can also deselect facets that you previously selected 
by closing the facet (clicking the “X”) in the Search limited to row. 

Figure 7: 

Figure 19: Multiple Facets
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Institution, Community, and Network Tabs
If you conduct your search in the Institution tab, which includes your 
institution’s locally held resources, records that are linked to the Community 
Zone have an  icon next to them. If you click this icon, results of the search 
query display in the Community tab.

Similarly, if you conduct your search in the Community tab, which includes 
records in the Community Zone, records for which local inventory also exists 
have an  icon next to them. If you click this icon, results of the search query 
display in the Institution tab.

Where Alma is implemented for collaborative network environments, the 
Repository Search page displays a Network tab that provides access to the data 
stored in the Network Zone (NZ). For more information regarding the Network 
tab, refer to Working with the Repository Search and MD Editor in a 
Collaborative Network on page 4 in the Alma Collaborative Networks (Consortia) 
Guide.) 

Repository Search Results Actions
Refer to the table below for a description of the actions that you can take while 
using the Repository Search results.

NOTE:
The links that display depend upon the roles of the user. Not all links 
display for all users.

The details of your search results can be saved for future use by clicking Save 
Query. Refer to Working with Queries on page 32 and Managing Search 
Queries and Sets on page 81 for more information.

Table 6. Search Results List Actions

Search Type Action Description
All Titles 
(Institution tab)

Add to 
Reading List

Add the item to an existing course reading list (refer to 
Managing Reading Lists in the Alma Fulfillment Guide).

View Digital 
Resource

Opens the Digital IE Resource Editor on the General 
Information tab in view mode.

Edit Digital 
Resource

Opens the Digital IE Resource Editor on the General 
Information tab in edit mode.



Chapter 2: Using the Repository Search

41January 2015

Alma Resource Management

Ex Libris Confidential

Other actions Since the results for an All Titles search include physical, 
electronic, and digital titles, the links beneath each record 
vary according to the record type. Refer to the following 
titles-related sections of this table for the descriptions of 
the remaining All Titles search results actions:

 Physical Titles

 Electronic Titles (Institution tab)

 Digital Titles

All Titles 
(Community 
tab)

Order Opens the PO Line Owner and Type page to initiate a 
purchase request (refer to Creating Purchase Order (PO) 
Lines in the Alma Acquisitions Guide).

Portfolio List Opens the Portfolios List page. For more information refer 
to Using the Portfolios List on page 73.

Physical Titles Holdings Opens the MARC Record Simple View (single record) or 
the List of Holdings page (multiple records). For more 
information, refer to Using the List of Holdings on 
page 76.

Items Opens one of the following pages:

 Physical Item Editor (single item)

For more information, refer to Updating Item-Level 
Information on page 465.

 List of Items (multiple items)

For more information, refer to Using the List of Items 
on page 77.

Table 6. Search Results List Actions

Search Type Action Description
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Physical Titles 
(continued) 

Edit Opens the MD Editor (refer to Opening the Metadata 
Editor on page 147) enabling you to modify the 
bibliographic record. 

NOTE:
Search results for a locked record display the Edit 
action and the locked notation for the record is 
displayed in the MD Editor view of the record (see 
example below).   
 
This notation indicates that there is an open draft 
for the record and that someone other than you is 
working on it. As a result, this record cannot be 
edited until the operator that has it locked does a 
Release or Save and Release in the MD Editor or 
the setting for the  
working_copy_lock_timeout parameter has 
expired. The default setting for 
working_copy_lock_timeout is one hour. 
Refer to Configuring Other Settings on page 695 
and Table 84 for configuration information.

Figure 8: 

Figure 20: Locked by Notation

Order Opens the PO Line Owner and Type page to initiate a 
purchase request (refer to Creating Purchase Order (PO) 
Lines in the Alma Acquisitions Guide).

Request Displays the Create Request page (refer to Creating a 
Request in the Alma Fulfillment Guide).

From the Create Request page, you can select a Physical 
titles request such as Move temporarily or Patron 
digitization request from the Request Type drop-down 
list.

Table 6. Search Results List Actions

Search Type Action Description
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Release 
Assignment

Allows staff users with the Catalog Manager role to 
release the bibliographic record if it is assigned to another 
staff user. If you want to remove all bibliographic record 
assignments for a particular staff user, refer to MD Editor 
Menu and Toolbar Options on page 155.

Publishing 
Information

Opens the Publishing Information page that provides the 
following information:

 PID

 Last publication date

 Last publication value

 RTA link

 Job history (if available)

VIDEO:
Learn about debugging publishing 
information in the Debugging Publishing 
Information video (1:52 mins).

More Info Opens the More Info dialog box that displays the 
following information:

 Title

 Related Records - number of related records (or No 
Related Records)

 Orders - number of orders (or No Orders)

 Requests/Work Orders - number of requests/work 
orders (or No Requests/Work Orders). This value does 
not include expired booking requests, and indicates 
only the number of requests/work orders linked to the 
title; it does not indicate anything about the request’s 
place in the queue.

 Courses - number of linked courses (No Course)

Click the links that are displayed in this dialog box to 
access additional details.

VIDEO:
For information on displaying the courses 
associated with a title, see the View Courses 
Linked to a Title video (2:43 mins).

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
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Electronic Titles 
(Institution tab)

Electronic 
Collection List

Displays the portfolio list associated with the title 
(bibliographic record). For more information regarding 
the actions displayed in the portfolio list, refer to Using 
the Portfolios List on page 73.

View It Opens the Alma Resolver Electronic Services page.

For more information regarding the Alma Resolver 
Electronic Services page, refer to Using the Alma 
Resolver Electronic Services Page on page 418.

To enable direct linking to electronic services via Alma 
Resolver Electronic Services, refer to Configuring Direct 
Linking in the Alma Fulfillment Guide.

Order Initiates a purchase request (refer to Creating Purchase 
Order (PO) Lines in the Alma Acquisitions Guide).

When you place orders for electronic resources (from 
bibliographic-/title-level search results) that contain 
multiple URLs (856 $u fields), Alma creates a portfolio for 
each URL (see the example below for Commentaries on the 
Constitution of the United States).

Document 
Delivery

Displays the Create Request page (refer to Creating a 
Request in the Alma Fulfillment Guide).

Publishing 
Information

Opens the Publishing Information page that provides the 
following information:

 PID

 Last publication date

 Last publication value

 RTA link

 Job history (if available)

VIDEO:
Learn about debugging publishing 
information in the Debugging Publishing 
Information video (1:52 mins).

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
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More Info Opens the More Info dialog box that displays the 
following information:

 Title

 Related Records - number of related records (or No 
Related Records)

 Orders - number of orders (or No Orders)

 Requests/Work Orders - number of requests/work 
orders (or No Requests/Work Orders). This value does 
not include expired booking requests, and indicates 
only the number of requests/work orders linked to the 
title; it does not indicate anything about the request’s 
place in the queue. 

 Licenses - number of licenses (or No Licenses)

Refer to Associating a License at the Portfolio Level 
on page 384 and Managing Licenses and 
Amendments in the Alma Acquisitions Guide for related 
information.

 Courses - number of linked courses (No Course)

Click the links that are displayed in this dialog box to 
access additional details.

VIDEO:
For information on displaying the courses 
associated with a title, see the View Courses 
Linked to a Title video (2:43 mins).

Electronic Titles 
(Community 
tab)

Electronic 
Collection List

Opens the Portfolios List page. For more information refer 
to Using the Portfolios List on page 73.

Order Opens the PO Line Owner and Type page to initiate a 
purchase request (refer to Creating Purchase Order (PO) 
Lines in the Alma Acquisitions Guide).

Digital Titles View It Opens the Alma Resolver Electronic Services page from 
which you can view the digital object (if you have 
permission/access to the object).

For more information regarding the Alma Resolver 
Electronic Services page, refer to Using the Alma 
Resolver Electronic Services Page on page 418.

View Opens the Digital IE Resource Editor on the General 
Information tab in view mode.

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
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Digital Titles 
(continued) 

Edit Opens the Digital IE Resource Editor on the General 
Information tab in edit mode.

Export Exports the selected digital title. 

A note displays at the top of the Repository Search page 
(above the Search Criteria options) providing the location 
of the exported digital title.

Order Initiates a purchase request (refer to Creating Purchase 
Order (PO) Lines in the Alma Acquisitions Guide)

Publishing 
Information

Opens the Publishing Information page that provides the 
following information:

 PID

 Last publication date

 Last publication value

 RTA link

 Job history (if available)

VIDEO:
Learn about debugging publishing 
information in the Debugging Publishing 
Information video (1:52 mins).

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
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Digital Titles 
(continued) 

More Info Opens the More Info dialog box that displays the 
following information:

 Title

 Related Records - number of related records (or No 
Related Records)

 Orders - number of orders (or No Orders)

 Requests/Work Orders - number of requests/work 
orders (or No Requests/Work Orders). This value does 
not include expired booking requests, and indicates 
only the number of requests/work orders linked to the 
title; it does not indicate anything about the request’s 
place in the queue.

For more information on the request queue/priority, 
refer to Request Priority in the Alma Fulfillment Guide.

 Courses - number of linked courses (No Course)

Click the links that are displayed in this dialog box to 
access additional details. 

VIDEO:
For information on displaying the courses 
associated with a title, see the View Courses 
Linked to a Title video (2:43 mins). 

Digital Files View It Opens the Alma Resolver Electronic Services page from 
which you can view the digital object (if you have 
permission/access to the object).

For more information regarding the Alma Resolver 
Electronic Services page, refer to Using the Alma 
Resolver Electronic Services Page on page 418.

View Opens the Digital File Resource Editor page in view 
mode.

Edit Opens the Digital File Resource Editor page in edit mode.

Physical Items Edit Displays the Physical Item Editor page for modifying the 
record (refer to Updating Item-Level Information on 
page 465).

Holdings Opens the List of Holdings page. For more information, 
refer to Using the List of Holdings on page 76.

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
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Physical Items 
(continued) 

Items Opens one of the following pages:

 Physical Item Editor (single item)

For more information, refer to Updating Item-Level 
Information on page 465.

 List of Items (multiple items)

For more information, refer to Using the List of Items 
on page 77.

Request Initiates a fulfillment request (refer to Creating a Request 
in the Alma Fulfillment Guide).

Work Order Opens the Create Request page for entering a work order, 
such as to request binding or process a withdrawal. 

Table 6. Search Results List Actions

Search Type Action Description
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Physical Items 
(continued) 

More Info Opens the More Info dialog box that displays the 
following information:

 Title

 Related Records - number of related records (or No 
Related Records)

 Orders - number of orders (or No Orders)

 Requests/Work Orders - number of requests/work 
orders (or No Requests/Work Orders). This value does 
not include expired booking requests, and indicates 
only the number of requests/work orders linked to the 
item; it does not indicate anything about the request’s 
place in the queue.

When clicking this value, both requests bound to the 
item as well as requests that the item can fulfill are 
displayed.

 Number of Loans

 Last Loan Date

 Number of In-House Uses

 Last In-House Use Date

 Courses - number of linked courses (No Course)

Click the links that are displayed in this dialog box to 
access additional details.

VIDEO:
For information on displaying the courses 
associated with a title, see the View Courses 
Linked to a Title video (2:43 mins).

Electronic 
Portfolio 
(Institution tab)

Edit Opens the Electronic Portfolio Editor page for editing the 
portfolio record. For more information, refer to 
Modifying a Portfolio Using the Electronic Portfolio 
Editor on page 349.

View Opens the Electronic Portfolio Editor page in view mode 
to view the portfolio record.

Activate / 
Deactivate

Activates or deactivates an electronic portfolio. The 
resource’s icon changes when the activation status 
changes. For example, when a portfolio is activated, the 
icon appears in color ( ). When the portfolio is 

deactivated, the icon appears gray ( ). 

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1


Alma Resource Management

January 201550

Chapter 2: Using the Repository Search

Ex Libris Confidential

Order Initiates a purchase request (refer to Creating Purchase 
Order (PO) Lines in the Alma Acquisitions Guide).

Link to 
Community

Initiates the process to link a local portfolio to a 
Community Zone (CZ) portfolio. This option is available 
only if a local portfolio was created as a standalone 
portfolio and not as part of an electronic collection.

You may, for example, use this option when you have 
created a local portfolio during the acquisition process 
and later want to link the portfolio to an electronic 
collection in the CZ. 

When you click Link to Community, the Link Standalone 
Portfolio to Community Zone Collection wizard opens, in 
which you 1) select a matching CZ portfolio, 2) select a 
local electronic collection with which to associate the 
standalone portfolio, and 3) select to use the descriptive 
metadata from the CZ bibliographic record or retain the 
IZ descriptive metadata. 

NOTE:
If you choose to retain the IZ descriptive metadata, 
the portfolio’s descriptive metadata will not be 
synchronized with updates from the CZ.

After the local portfolio is linked to a CZ portfolio, the 
Link to Community search results action no longer 
appears and the icon changes from the IZ icon to the CZ 
icon (see below).

For related information, refer to Linking a Local 
Electronic Collection to the Community Zone on 
page 320 and Linking a Local Portfolio to the CZ When 
the Portfolio is Part of a CZ-Linked Service/Electronic 
Collection on page 377.

Create 
E-Activation 
Task

Creates an electronic activation task and displays a 
confirmation message when successful.

Test Access Tests the access to an electronic portfolio and displays the 
results on the Alma Resolver Electronic Services page.

For more information regarding the Alma Resolver 
Electronic Services page, refer to Using the Alma 
Resolver Electronic Services Page on page 418.

Delete Deletes a local portfolio.

Table 6. Search Results List Actions

Search Type Action Description
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Send to 
Ex Libris

Opens the Send to Ex Libris page, enabling you to send a 
portfolio update request to Ex Libris. The contact 
information provided on the Send to Ex Libris page is 
defined by a General System Administrator in 
Administration > General Configuration > 
Configuration Menu > CRM Contacts.

VIDEO:
For information on using this option in the 
Institution tab, see the “Send to Ex Libris” for 
Local Collections video (3:03 mins).

More Info Opens the More Info dialog box that displays the 
following information:

 Title

 Related Records - number of related records (or No 
Related Records)

 Orders - number of orders (or No Orders)

 Licenses - number of licenses

Refer to Associating a License at the Portfolio Level 
on page 384 and Managing Licenses and 
Amendments in the Alma Acquisitions Guide for related 
information.

 Courses - number of linked courses (No Course)

 Usage (last 12 months) - amount of usage for this 
portfolio across all collections (not displayed if the 
data is not collected in UStat)

Click the links that are displayed in this dialog box to 
access additional details. 

VIDEO:
For information on displaying the courses 
associated with a title, see the View Courses 
Linked to a Title video (2:43 mins).

Electronic 
Portfolio 
(Community 
tab)

Activate Initiates the process to add and activate portfolios from 
the CZ for a library.

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=yAgR1ZlDPV0&hd=1
http://www.youtube.com/watch?v=yAgR1ZlDPV0&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
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Order Opens the PO Line Owner and Type page to initiate a 
purchase request (refer to Creating Purchase Order (PO) 
Lines in the Alma Acquisitions Guide).

Send to 
Ex Libris

Opens the Send to Ex Libris page, enabling you to send a 
portfolio update request to Ex Libris. The contact 
information provided on the Send to Ex Libris page is 
defined by a General System Administrator in 
Administration > General Configuration > 
Configuration Menu > CRM Contacts.

Collection Edit Opens the MD Editor for editing the collection.

Edit Collection 
Resource

Opens the Collections Resource Editor page where you 
can view summary information for the collection, look up 
reports and services related to this collection, view titles 
in the collection, and add subcollections to the collection.

View 
Collection 
Resource

View all related services and components of the collection 
without the ability to change or add data.

Electronic 
Collection 
(Institution tab)

Edit Opens the Electronic Collection Editor, enabling you to 
edit the collection record.

Delete Displays a Delete Confirmation dialog box for deleting an 
electronic collection (along with deleting associated 
electronic collection services, portfolios, and e-activation 
tasks, and unlinking PO lines) and provides a drop-down 
list of options (delete, suppress, or do nothing) for 
handling childless bibliographic records when deleting 
the electronic collection.

View Opens the Electronic Collection Editor page in view mode 
to view the collection record.

Portfolio List 
(number)

Opens the Portfolios List page. The (number) represents 
the number of portfolios to be displayed on the Portfolios 
List page. For more information, refer to Using the 
Portfolios List on page 73.

Order Opens the PO Line Owner and Type page to initiate a 
purchase request (refer to Creating Purchase Order (PO) 
Lines in the Alma Acquisitions Guide). 

Table 6. Search Results List Actions

Search Type Action Description
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Electronic 
Collection 
(Institution tab) 
(continued)

Link to 
Community

Initiates the process to link a local electronic collection to 
an electronic collection in the Community Zone (CZ). 
Linking local electronic collections to the CZ provides the 
benefit of CZ updates to the electronic collections that you 
link to the CZ. Refer to Linking a Local Electronic 
Collection to the Community Zone on page 320 for more 
information.

Create 
E-Activation 
Task

Creates an electronic activation task and displays a 
confirmation message when successful.

Publishing 
Information

Opens the Publishing Information page that provides the 
following information:

 PID

 Last publication date

 Last publication value

 RTA link

 Job history (if available)

VIDEO:
Learn about debugging publishing 
information in the Debugging Publishing 
Information video (1:52 mins).

Edit Service Opens the Electronic Service Editor, enabling you to edit 
the electronic service record.

Send to 
Ex Libris

Opens the Send to Ex Libris page, enabling you to send a 
collection update request to Ex Libris. The contact 
information provided on the Send to Ex Libris page is 
defined by a General System Administrator in 
Administration > General Configuration > 
Configuration Menu > CRM Contacts.

NOTE:
You can request that new resources to be added to 
the KB and view existing requests from other 
customers and promote them via Salesforce. For 
more information, see the How can I search for KB 
items and vote for them? section of the Salesforce 
CRM Customer Portal Documentation guide.

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
http://www.youtube.com/watch?v=GWcheoHUvZg&hd=1
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Electronic 
Collection 
(Institution tab) 
(continued)

More Info Opens the More Info dialog box that displays the 
following information:

 Title

 Related Records - number of related records (or No 
Related Records)

 Orders - number of orders (or No Orders)

 Licenses - number of licenses

Refer to Associating a License at the Portfolio Level 
on page 384 and Managing Licenses and 
Amendments in the Alma Acquisitions Guide for related 
information.

 Courses - number of linked courses (No Course)

Click the links that are displayed in this dialog box to 
access additional details. 

VIDEO:
For information on displaying the courses 
associated with a title, see the View Courses 
Linked to a Title video (2:43 mins).

Electronic 
Collection 
(Community 
tab)

Portfolio List 
(number)

Opens the Portfolios List page. The (number) represents 
the number of portfolios to be displayed on the Portfolios 
List page.

Activate Opens the Activation Wizard (refer to Using the 
Activation Wizard on page 406), enabling you to activate 
the resource.

Order Opens the PO Line Owner and Type page to initiate a 
purchase request (refer to Creating Purchase Order (PO) 
Lines in the Alma Acquisitions Guide). 

Send to 
Ex Libris

Opens the Send to Ex Libris page, enabling you to send a 
collection update request to Ex Libris. The contact 
information provided on the Send to Ex Libris page is 
defined by a General System Administrator in 
Administration > General Configuration > 
Configuration Menu > CRM Contacts.

Table 6. Search Results List Actions

Search Type Action Description

http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
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What Displays in the Repository Search Results (Examples)
Since the Repository Search facility in Alma provides the flexibility to conduct a 
variety of searches, the search results include information related to physical, 
electronic, and digital resources. As a result, the content of the search results 
vary and are specific to the type of search you are conducting. For example, the 
titles (all, physical, electronic, and digital) search results display bibliographic 
information; and the inventory (such as items, portfolios, and files) search 
results display details from imported data or data that you have entered using 
the Physical Item Editor (refer to Updating Item-Level Information on 
page 465) or the Electronic Portfolio Editor (refer to Modifying a Portfolio 
Using the Electronic Portfolio Editor on page 349). In general, the Repository 
Search results display:

Authorities

(Institution tab)

Search 
Bibliographic 
Records 
Matching This 
Value

Lists the local authority information that is maintained in 
the IZ. 

Edit Enables you to edit local authority information.

Authorities

(Community 
tab)

Search 
Bibliographic 
Records 
Matching This 
Value

Lists the available LC authority information from the 
authority information that is loaded in the Alma CZ.

Table 6. Search Results List Actions

Search Type Action Description
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 Title

 Material type
Figure 9: 

Figure 21: Bibliographic Material Type in Search Results

Refer to Bibliographic Material Types Identified in Search Results on 
page 65 for more information regarding bibliographic material types. Refer 
to Search Indexes on page 115 for a list of the MARC tags associated with all 
the displayed fields.

 Subject

 Library

 Location

 Copy

 Barcode

 Item policy

 Identifying numbers

 Alma record number (the last number in 035a, the Other System 
Number)

 ISSN, ISBN

 Call number

 Dates
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 Availability

This component of the search results provides a link for accessing additional 
record details.

Figure 10: 

Figure 22: Availability in the Search Results

 Availability of related records

The Availability of Related Records displays in the search results when a 
bibliographic record is found that has no items, but contains a 773 field with 
linking information to another bibliographic record with items. 

Figure 23: Availability of Related Records

 Service
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 Icons

For example, if a record is linked to the Community Zone, it displays the    
icon next to it; or if a record has been suppressed from external discovery, 
the Suppressed icon  displays next to the record.

If you are working in a collaborative network environment, there are 
additional icons and indicators displayed in the Network and Institution 
tabs. 

The illustrations below highlight the following search result examples:

 All titles

 Physical titles

 Electronic titles

 Digital titles

 Digital files

 Physical items

 Electronic portfolio

 Collection

 Electronic collection (Institution tab)

 Electronic collection (Community tab)

 Authorities (Community tab)
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All titles search results (Institution tab):
Figure 11: 

Figure 24: Repository Search Page with the Results of All Titles Search
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Physical titles search results (Institution tab):

Figure 25: Repository Search Results for a Physical Titles Search

Electronic titles search results (Institution tab):

Figure 26: Repository Search Page with Results of an Electronic Titles Search
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Digital titles search results (Institution tab):

Figure 27: Repository Search Page with Results of a Digital Titles Search

Digital files search results (Institution tab):

Figure 28: Digital Files Search Results List
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Physical items search results (Institution tab):

Figure 29: Repository Search Page with Results of a Physical Items Search

Electronic portfolio search results (Institution tab):

Figure 30: Electronic Portfolio Search Results
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Collection search results (Institution tab):
Figure 12: 

Figure 31: Collection Results (partial)

Electronic collection search results (Institution tab):

Figure 32: Electronic Collection Search Results – Institution Tab
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Electronic collection search results (Community tab):

Figure 33: Electronic Collection Search Results – Community Tab

Authorities search results (Community tab):

Figure 34: Repository Search Page with Results of an Authorities Search (Community Tab)
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Bibliographic Material Types Identified in Search Results
The following bibliographic material types are identified in Alma’s search 
results:

 Books

 Journals

 Computer files

 Maps

 Music

 Visual materials

 Mixed materials

Refer to the illustration Figure 21 for material type.

Bibliographic material types are identified using the MARC 21 format for 
bibliographic data (described in Table 7) and an Alma mapping table (Table 9).



Alma Resource Management

January 201566

Chapter 2: Using the Repository Search

Ex Libris Confidential

These material types are identified from the bibliographic fields highlighted in 
Table 8. 

Table 7. Scope of the Bibliographic Format

Scope of the Bibliographic Format  
(MARC 21 - www.loc.gov/marc/bibliographic)
MARC 21 Format for Bibliographic Data is designed to be a carrier for bibliographic 
information about printed and manuscript textual materials, computer files, maps, 
music, journals, visual materials, and mixed materials. Bibliographic data commonly 
includes titles, names, subjects, notes, publication data, and information about the 
physical description of an item. The bibliographic format contains data elements for 
the following types of material: 

 Books (BK) - used for printed, electronic, manuscript, and microform textual 
material that is monographic in nature. 

 Journals (CR) - used for printed, electronic, manuscript, and microform textual 
material that is issued in parts with a recurring pattern of publication (e.g., 
periodicals, newspapers, yearbooks). (NOTE: Prior to 2002, Journals (CR) were 
referred to as Serials (SE)). 

 Computer files (CF) - used for computer software, numeric data, computer-
oriented multimedia, online systems or services. Other classes of electronic 
resources are coded for their most significant aspect. Material may be 
monographic or serial in nature. 

 Maps (MP) - used for all types of printed, electronic, manuscript, and microform 
cartographic materials, including atlases, sheet maps, and globes. Material may be 
monographic or serial in nature. 

 Music (MU) - used for printed, electronic, manuscript, and microform music, as 
well as musical sound recordings, and non-musical sound recordings. Material 
may be monographic or serial in nature. 

 Visual materials (VM) - used for projected media, non-projected media, two-
dimensional graphics, three-dimensional artifacts or naturally occurring objects, 
and kits. Material may be monographic or serial in nature. 

 Mixed materials (MX) - used primarily for archival and manuscript collections of 
a mixture of forms of material. Material may be monographic or serial in nature. 
(NOTE: Prior to 1994, Mixed materials (MX) were referred to as Archival and 
manuscript material (AM)). 
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In the mapping table below (Table 9) that is used to determine the bibliographic 
material type code, source1 corresponds to leader position 6 and source2 
corresponds to leader position 7.

Table 8. Fields that Identify the Bibliographic Material Type

LDR 
POSN 6

LDR 
POSN 7

007 
POSN 00

Alma 
Bibliographic 
Material

Alma Material 
Type Term

a a c d m BK Book

t BK Book

a b i (s) CR Continuing Resource

c d l j MU Music

e f MP Map

g k r o VM Visual Material

m CF Computer File

p MX Mixed material

a s SE Journal

<Default> BK Book

Table 9. Alma Mapping Table for Bibliographic Material Type

        <ref:targetColumn description="Material Type Code" style="" readOnly="true" number="2" 
name="CODE"/>

      <ref:mappingTable displayTableName="Marc21 Bibliographic Material Type" 
tableName="Marc21BibMaterialType">

            <ref:table customerBehavior="HIDE" spPolicy="MERGED" tableLevel="ALL" 
subSystem="DATA_MODEL" enabled="true" description="Marc21 Bibliographic Material Type"/>

            <ref:columns>

                <ref:source1Column description="LDR position 6" style="" readOnly="true" number="0" 
name="POS6"/>

                <ref:source2Column description="LDR position 7" style="" readOnly="true" number="1" 
name="POS7"/>

        <ref:targetColumn description="Material Type Code" style="" readOnly="true" number="2" 
name="CODE"/>

      </ref:columns>

      <ref:mappings>

        <ref:mapping targetCode="BK" source1="a" source2="a"/>
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Working with Jointly Managed E-Resources (Search/Search Results)
Alma Repository Search provides the flexibility to view results determined by 
the Available For assignment of resources. Depending on your environment’s 
configuration (multicampus or collaborative network), you can view resources 
in your search results that belong exclusively or jointly to Available For groups 
whose members can be campuses, libraries, or institutions. With this capability, 
Alma provides a clearer view of the electronic resources’ availability per 
campus/institution allowing you to easily visualize the similarities and 
differences between electronic resources’ availability. 

NOTE:
For more information regarding Available For, refer to Configuring 
Inventory Available For Management Groups for Multicampus 

        <ref:mapping targetCode="BK" source1="a" source2="c"/>

        <ref:mapping targetCode="BK" source1="a" source2="d"/>

        <ref:mapping targetCode="BK" source1="a" source2="m"/>

        <ref:mapping targetCode="BK" source1="t" source2=" "/>

        <ref:mapping targetCode="CR" source1="a" source2="b"/>

        <ref:mapping targetCode="CR" source1="a" source2="i"/>

        <ref:mapping targetCode="CR" source1="a" source2="s"/>

        <ref:mapping targetCode="MU" source1="c"/>

        <ref:mapping targetCode="MU" source1="d"/>

        <ref:mapping targetCode="MU" source1="i"/>

        <ref:mapping targetCode="MU" source1="j"/>

        <ref:mapping targetCode="MP" source1="e"/>

        <ref:mapping targetCode="MP" source1="f"/>

        <ref:mapping targetCode="VM" source1="g"/>

        <ref:mapping targetCode="VM" source1="k"/>

        <ref:mapping targetCode="VM" source1="o"/>

        <ref:mapping targetCode="VM" source1="r"/>

        <ref:mapping targetCode="CF" source1="m"/>

        <ref:mapping targetCode="MX" source1="p"/>

      </ref:mappings>

    </ref:mappingTable>

Table 9. Alma Mapping Table for Bibliographic Material Type
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Environments on page 730 or Configuring Inventory Available For 
Management Groups for Collaborative Environments on page 48.

Alma provides the following search/search results facilities for jointly managed 
resources using their Available For assignment:

 Available For group details provided for each record in the repository 
search results for portfolios and electronic collections (refer to Available For 
Search Results on page 69)

 Search attributes in the Advanced Search for Available For groups (refer to 
Available For Search Attributes on page 70)

 Available For facets (refer to Available For Facets on page 72)

Available For Search Results
The details provided in portfolio and electronic collection search results include 
Available For group/member/institution details. When you do a portfolio search 
and group settings are configured at the portfolio level, an Available For label/
row displays in the search results followed by a list of the groups that the 
portfolio is available for. When you point to the Available For row, a tooltip 
opens that identifies the members of the group(s) listed in the Available For 
row. 

Figure 13: 

Figure 35: Available For Group Details in Search Results

Refer to the illustration below for the portfolio-level group settings for Procedia 
in vaccinology. 
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Figure 14: 

Figure 36: Portfolio-Level Group Settings Example

When you do an electronic collection search and group settings are configured 
at the collection level, an Available For label/row displays in the search results 
followed by a list of the groups that the collection is available for. When you 
point to the Available For row, a tooltip opens that identifies the members of the 
group(s) listed in the Available For row. 

Figure 15: 

Figure 37: Electronic Collection Available For Search Result Details

Available For Search Attributes
When doing an advanced search for an electronic collection or portfolios, the 
following search attributes are available:

 Electronic collections (refer to the first illustration below)

 Collection available for group

 Collection available only for group
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 Portfolios (refer to the second illustration below)

 Available for group

 Available only for group
Figure 16: 

Figure 38: Electronic Collection Advanced Search Attributes for Available For Groups

Figure 17: 

Figure 39: Portfolio Advanced Search Attributes for Available For Groups

When you select one of the Available For group options, the drop-down list of 
search options provided displays a list of Available For groups.
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Figure 18: 

Figure 40: Available For Group Options (Drop-Down List)

Available For Facets
The search result facets have been enhanced for Available For to include group/
member-level information in a tooltip when you point to the Available For 
campus. This enables you to determine which groups are associated with the 
campus. 



Chapter 2: Using the Repository Search

73January 2015

Alma Resource Management

Ex Libris Confidential

Figure 19: 

Figure 41: Tooltip for Available For Facets to Identify Groups/Members 

Using the Portfolios List
The Portfolios List page displays the portfolios that are associated with an 
electronic collection. This list displays after clicking any of the following links:

 Electronic Collection List – Displays in the results for electronic title/
collection searches.

 Portfolio List (number) – Displays in the results for electronic collection 
searches.

 Number of portfolios – Displays on the Additional Information tab in the 
Electronic Collection Editor.
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Figure 20: 

Figure 42: Portfolios List Page

On this page, you can perform the following actions (with the appropriate role/
permissions):

 Edit – Opens the Electronic Portfolio Editor page to edit the portfolio record. 
For more information, see Modifying a Portfolio Using the Electronic 
Portfolio Editor on page 349.

 Activate/Deactivate – Activates/deactivates an electronic portfolio

 View – Opens the Electronic Portfolio Editor page to view the portfolio 
record

 Document Delivery – Opens the Create Request page.

 Order – Opens the PO Line Owner and Type page to initiate a purchase 
request (see Creating Purchase Order (PO) Lines in the Alma Acquisitions 
Guide). This includes the ability to order a portfolio from an e-collection that 
is already locally activated.

 Create E-Activation Task – Creates an electronic activation task and displays 
a confirmation message when successful

Figure 21: 

Figure 43: E-Activation Task Successfully Created

 Test access – Tests the access to an electronic portfolio and displays the 
results on the Alma Resolver Electronic Services page.

 Send to Ex Libris – Opens the Send To Ex Libris page in order for you to 
submit a request.
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 More info – Opens the More info dialog box.

 Delete – Opens a Delete Confirmation dialog box for the portfolio and 
provides the option to delete childless bibliographic records during the 
deletion.

In addition, you can run the following tools:

 Extended Export – Select Tools > Extended Export to export all portfolios in 
the collection to an Excel file. If the collection contains more than 5000 
portfolios, portfolios for each type of service are stored in separate files and 
the job is run in the background. You can use the Monitor Job page 
(Administration > Manage Jobs > Monitor Jobs) to monitor the job’s 
progress and view the Excel files. Collections with fewer portfolios are also 
saved to an Excel file, but the job is run in the foreground and portfolios for 
each type of service are stored in separate tabs in the Excel file.

NOTE:
The portfolio loader supports the matching of CZ portfolios based on the 
CZ portfolio ID and not just the ISSN or ISBN.

The localized field in the Excel file indicates that a CZ portfolio has been 
localized for your institution.

Figure 22: 

Figure 44: Sample Extended Excel Export

VIDEO:
For more information about the Extended Export tool, see the Export Tasks 
From CZ Updates Task List video (3:43 mins).

 Excel (current view) – Select Tools > Excel (current view) to export the list of 
portfolios to an Excel file. Note that the report contains only information 
that displays in the Portfolio List.

http://youtu.be/Iv5Q1ElBVDQ
http://youtu.be/Iv5Q1ElBVDQ
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Figure 23: 

Figure 45: Sample Excel (Current View) Report

Using the List of Holdings
The List of Holdings page lists the holdings (with the MMS ID link) for the 
selected resource. This list displays after clicking any of the following links:

 Holdings – displays in the results for physical title and item searches.

 View all holdings – displays in the Physical Item Editor.

Figure 46: Holdings List Page

The List of Holdings page provides a filter option to display only holdings with 
available items and includes an Actions button that enables you to:

 Edit – Opens the MD Editor page allowing you to edit the holdings record. 
For more information, see Navigating the MD Editor Page on page 149.

 View – Displays the holdings record on the MARC Record Simple View 
page.

 Relink – Opens the MD Editor in split view allowing you to relink the 
holdings record to a bibliographic record. To relink the holdings record, 
enter your search criteria for the bibliographic record and then click Relink 
below the bibliographic record’s information in the search results. This also 
updates the bibliographic record to which the associated PO line is linked.
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Figure 47: Relink Holdings Record in MD Editor

For more information on using the MD Editor, see Navigating the MD 
Editor Page on page 149.

 View items – Opens the List of Items page allowing you to view the items 
that are associated with the holdings record (see Using the List of Items on 
page 77).

 Associate a PO line – Enables you to associate a PO line with a holdings 
record. Select a PO line from the dialog box and click Update. The 
associated PO line is displayed in the PO Line column.

If you want to delete empty holdings records, select the holdings records in the 
list of holdings and click Delete Holdings. The system will not let you remove 
holdings records that contain items. 

Using the List of Items
The List of Items page lists the items for the selected resource and displays after 
clicking one of the following links:

 Items – displays in the results for physical item searches.
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 View all items – displays in the Physical Item Editor.

Figure 48: List of Items Page

The View All Holdings link enables you to view the holdings for the record. For 
more information, see Using the List of Holdings on page 76.

The List of Items page provides a barcode link (Barcode column) to the Physical 
Item Editor page, allows you to filter the list of items by status, and enables you 
to sort according to the sort routines that were configured (see Configuring 
Physical Item Sort Routines on page 734).

The Move Items button enables you to move the selected items to a different 
holdings record.

The following two buttons are available if the items’ associated bibliographic 
record has only one holdings record:

 Add Item – Open the Physical Item Editor and add an additional item.

 Bind Items – Select the check box of at least two items to bind the selected 
items together into one. For details, see Binding Items below.

The Actions button at the end of each row enables you to:

 View – Opens the Physical Item Editor page in read-only mode. 

 Duplicate – Opens the Physical Item Editor page, allowing you to add a 
duplicate copy to the holdings. For more information, see Updating Item-
Level Information on page 465.
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 Move item (request) – Opens the Create Request page, allowing you to 
submit a permanent or temporary move item request. For more information, 
see Creating a Request in the Alma Fulfillment Guide.

 Edit – Opens the Physical Item Editor page, allowing you to update item-
level information. For more information, see Updating Item-Level 
Information on page 465.

 Withdraw (if you have the required permissions) – Opens the Confirmation 
Message dialog box, asking you to confirm the deletion of an item. Click OK 
to remove the item. For more information on withdrawals, see Withdrawing 
an Item on page 472.

Figure 49: Confirmation Message Dialog Box

 Toggle missing status – Toggles the item status between Item in place and 
Item not in place; the Process Type also toggles to Missing when the status 
is Item not in place.

 Work order – Opens the Create Work Order page, allowing you to create a 
work order process for the item. For details on work order requests, see 
Creating a Work Order Request in the Alma Fulfillment Guide.

Binding Items
You can select two or more items on the List of Items page to combine them into 
a single item. Items can be bound only if they are in place, are not in the 
acquisition process, and have not been bound previously.
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To bind items together:

1 On the List of Items page, select the check boxes for two or more items and 
click Bind Items. The Bind Items – Items List page opens.

Figure 50: Bind Items - Items List Page

2 Click Next. The Bind Items – Generate Work Order page opens.

Figure 51: Bind Items - Generate Work Order Page

3 Optionally, select a work order type and work order department from the 
relevant fields, and add notes in the Note field. Choose from the following 
options:

 Click Create and Edit to create the newly bound item and open the 
Physical Item Editor page, where you can edit the item’s details (see 
Updating Item-Level Information on page 465).

 Click Create to create the newly bound item. The item is displayed as a 
single item on the List of Items page.

Figure 52: List of Items Page - Bound Item
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Managing Search Queries and Sets

PERMISSIONS:
To manage search queries and sets, you must have one of the following 
roles:

 Cataloger

 Catalog Manager

 Catalog Administrator

 Electronic/Digital Inventory Operator

 Repository Manager

 Requests Operator

Sets may be used for saving queries, publishing metadata, moving a group of 
records to the editor and for running processes. For information on running 
processes for defined sets, see Running Jobs on Defined Sets in the Alma 
Administration Guide.

By default, the Manage Sets page (refer to the figure below), opens on the My 
Sets tab. The My Sets tab comprises the search queries that you have saved (both 
private and public). There are also tabs for:

 Public Sets – Saved queries that are not marked private

 All Sets – All saved public queries (created by you and other users) and your 
saved queries.

NOTE:
The All Sets tab is available only to users with the role of Repository 
Manager and includes all the sets that are defined in the system. This role 
is also required in order to edit public sets.

To manage sets:

Select Search and Sets > Manage Sets from the Resource Management menu. 
The Manage Sets page opens.
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Figure 53: Manage Sets Page

The Manage Sets page has the columns described in the following table.

Table 10. Manage Sets Page Columns

Column Name Description
Active

Indicates if the set is Active  or Inactive . Click 
on the check mark to make the set Active or Inactive.

Name Identifies the unique name of the set.

Type Indicates if the set is:

 Logical – This is the same as a saved query (see 
Saving Queries on page 32), the population of 
which is determined by the results of the particular 
search associated with the set (see Adding Logical 
Sets on page 89).

 Itemized – This comprises the individual records in 
the repository, selected by the search operator and 
associated with the set (see Adding Itemized Sets 
on page 84).

Created By (only available 
on the Public Sets and All 
Sets tabs)

Identifies the name of the user who created the set.
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Each line on the Manage Sets page has an Actions button that enables you to 
perform the tasks described in the table below. 

Content Type Identifies the content of the set as selected in the Find 
drop-down list (see Using the Alma Repository Search 
on page 18 or Adding and Modifying Sets on page 84).

Creation Date Specifies the date and time the set was created.

Table 11. Actions Button Options

Actions Options Description
Edit Opens the Set Details page that enables you to modify 

the set parameters (see Editing Itemized Sets on 
page 91).

Catalog Set Moves the contents of the set to the Metadata Editor for 
easier cataloging workflow. For more information 
regarding the Metadata Editor, see Opening the 
Metadata Editor on page 147.

Members (itemized sets 
only)

Displays the members (results) of the previous saved 
set (see Viewing Members (Itemized Sets Only) on 
page 97).

Results (logical sets only) Runs the saved search query and displays the results 
(see Viewing Results (Logical Sets Only) on page 100).

Duplicate Makes a copy of a set. Locate the set you want to 
duplicate and select Actions > Duplicate. The set is 
duplicated and added to the Manage Sets page with the 
words Copy of added as a prefix to the set name. After 
duplicating a set you can edit it as described in Editing 
Itemized Sets on page 91 and Editing Logical Sets on 
page 94.

Itemize Converts a logical set to a itemized set. Locate the 
logical set that you want to convert to an itemized set, 
and select Actions > Itemize. Click Confirm in the 
Confirmation Message dialog box (see Converting 
Logical Sets to Itemized Sets on page 96).

Combine Sets Creates a new set based on the members of two existing 
sets (see Combining Sets on page 103). 

Create Title Set Creates a new set of titles based on an existing itemized 
set. 

Table 10. Manage Sets Page Columns

Column Name Description
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Adding and Modifying Sets
When you save a query, it is automatically saved as a logical set and displays in 
the My Sets tab on the Manage Sets page.

You can also add (create) sets directly from the Manage Sets page. The types of 
sets are:

 Itemized – Comprises the individual records in the repository, selected by 
the search operator and associated with the set (see Adding Itemized Sets 
on page 84)

 Logical – Same as a saved query, the population of which is determined by 
the results of the particular search associated with the set.

Therefore, the population of the logical set is determined dynamically, 
reflecting the records currently in the repository. For example, if records 
have been added to (or deleted from) the repository since the logical set was 
created, these records are included in (or removed from) the logical set 
population the next time you run the logical set search query (see Adding 
Logical Sets on page 89).

This section describes how to add itemized sets (see Adding Itemized Sets on 
page 84), and logical sets (see Adding Logical Sets on page 89). It then describes 
how to perform the Actions button tasks. 

Adding Itemized Sets
An itemized set comprises individual records in the repository selected by the 
search operator and associated with the itemized set.

Delete Deletes a set. Locate the set that you want to delete and 
select Actions > Delete. Click Confirm in the 
Confirmation Message dialog box. 

NOTE:
You can delete only logical and itemized sets 
that you own (created by you). However, if you 
have the role of Repository Manager, you can 
delete any set.

Table 11. Actions Button Options

Actions Options Description
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To add an itemized set:

1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 54: Manage Sets Page

2 Click Add Set > Itemized. The Set Details page opens.
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Figure 55: Set Details Page for Itemized Sets

3 Enter the set details in the respective fields. (The Set Name is a mandatory 
field and must be unique. Other fields are optional).

NOTE:
The set name cannot contain special characters (for example: &, #, $, %).

4 From the Set Content Type drop-down list, select the content type for the 
set. The options that are available are a subset of those available in the Find 
drop-down list when performing a simple or advance search. For a 
description of the available options see Using the Simple Search on 
page 19.
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5 If you want to add records to the set by file upload, click Browse , browse 
to the required file, and click Upload and Validate File Content. 

The imported file must have the correct header at the top of the column for 
the data to be read. All other information in the Excel is disregarded. The 
following are the acceptable headers:

The following file formats are accepted:

 Text files:

 .txt

 .csv

 Excel: 

 .xls

 .xlsx

NOTES:
 The import file can contain a maximum of 5000 lines and be a maximum 

size of 10 MB.

 Validation is performed only for PO lines and physical items. If you 
perform an import with invalid data, each invalid cell is ignored.

 If you import a file and then change the content type, you must re-import 
the file.

6 By default, the set is designated as a Private (Yes) set. This means that the set 
is only available to you. If you select No, the set becomes a public set and is 
available to all other users.

7 By default, the Status is set to Active. Optionally, select Inactive.

8 Click Add Contents to Set. The Repository Search page opens.

Table 12. 

Content Type Header
All Titles, Authorities MMS ID

Physical titles, Electronic titles, 
Digital titles, Electronic collections, 
Digital files, Collections

PID

Physical items Barcode and PID (PID, Item PID, or Item ID)

Electronic portfolios PID (PID or Portfolio ID)

PO lines PO line reference
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Figure 24: 

Figure 56: Repository Search Page

9 If you are not adding records to the set by file upload, search for the content 
you want added to the set using the simple search (see Using the Simple 
Search on page 19) or using the advanced search (see Using the Advanced 
Search on page 20). The Repository Search page refreshes to show the 
results of the search.

Figure 25: 

Figure 57: Repository Search Results for Itemized Sets

10 Select the items you want included in the set and click Add Selected. The 
selected records are added to the set. 

You can continue searching, selecting, and adding records. When you are 
done, continue with the next step.
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11 Click Done. The Manage Sets page opens with the new set added to the list 
of sets.

Adding Logical Sets
A logical set is the same as a saved query, and the population of the logical set is 
determined by the results of the particular search associated with the set. 
Therefore, the population of the logical set is determined dynamically reflecting 
the records currently in the repository. For example, if records have been added 
to (or deleted from) the repository since the logical set was created, these 
records are included in (or removed from) the logical set population the next 
time you run the logical set search query. 

You create a logical set in basically the same way as you save a query (see 
Saving Queries on page 32). The difference, however, is that when you create a 
logical set you define the set details first (as you do for an itemized set, see 
Adding Itemized Sets on page 84). 

To add a logical set:

1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 58: Manage Sets Page

2 Click Add Set > Logical. The Set Details page opens.
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Figure 59: Set Details Page for Logical Sets

3 Enter the set details in the respective fields. (The Set Name is a mandatory 
field and must be unique. Other fields are optional).

NOTE:
The set name cannot contain special characters (for example: &, #, $, %).

4 From the Set Content Type drop-down list, select the content type for the 
set. The options available are the same as those available in the Find drop-
down list when performing a simple or advance search. For a description of 
the available options, see Using the Simple Search on page 19.

5 By default, the set is designated as a Private (Yes) set. This means that the set 
is only available to you. If you select No, the set becomes a public set and is 
available to all other users.

6 By default, the Status is set to Active. Optionally, select Inactive.

7 Click Next. The Repository Search page opens.

Figure 60: Repository Search Page
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8 Search for the content you want added to the set using the simple search 
(see Using the Simple Search on page 19) or using the advanced search (see 
Using the Advanced Search on page 20). The Repository Search page 
refreshes to show the results of the search.

Figure 61: Repository Search Results for Logical Sets

9 Click Save. The logical set is saved.

Editing Itemized Sets
An itemized set comprises individual records in the repository selected by the 
search operator and associated with the itemized set. 

Editing an itemized set enables you to not only edit the set details, but also edit 
the items that comprise the set.
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To edit an itemized set:

1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 62: Manage Sets Page

2 Scroll to the itemized set you want to edit and select Actions > Edit. The Set 
Details page opens.

Figure 63: Set Details Page Itemized Set to Edit
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3 Modify the set details as required. The Set Name is a mandatory field and 
must be unique. Other fields are optional. (See Adding Itemized Sets on 
page 84 for a description of the fields.)

NOTE:
The set name cannot contain special characters (for example: &, #, $, %).

4 If you do not want to change the items in the set, click Save. The Manage 
Sets page opens indicating that the set has been successfully saved.

5 If you want to add items to the itemized set, click Add Contents to Set. The 
Repository Search Page opens.

Figure 64: Repository Search Page

6 Search for the content you want added to the set using the simple search 
(see Using the Simple Search on page 19) or using the advanced search (see 
Using the Advanced Search on page 20). The Repository Search page 
refreshes to show the results of the search.



Alma Resource Management

January 201594

Chapter 2: Using the Repository Search

Ex Libris Confidential

Figure 65: Repository Search Results for Itemized Sets

7 Select the items you want included in the set (or click Select All) and click 
Add Selected. The selected records are added to the set. 

You can continue searching, selecting, and adding records. When you are 
done, continue with the next step.

8 Click Done. The Manage Sets page opens indicating that the set has been 
successfully saved.

NOTE:
You can also delete items from the itemized set as described in Viewing 
Members (Itemized Sets Only) on page 97.

Editing Logical Sets
The population of a logical set is determined dynamically, reflecting the records 
currently in the repository. As a result, when you use this function to edit a 
logical set, you only edit the set details. For details on how to change the set 
contents see Viewing Results (Logical Sets Only) on page 100.
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To edit a logical set:

1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 66: Manage Sets Page

2 Scroll to the logical set you want to edit and select Actions > Edit. The Set 
Details page opens.

Figure 67: Set Details Page Logical Set to Edit
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3 Modify the set details as required. The Set Name is a mandatory field and 
must be unique. Other fields are optional. (see Adding Logical Sets on 
page 89 for a description of the fields.)

4 Click Save. The Manage Sets page opens indicating that the set has been 
successfully saved.

Converting Logical Sets to Itemized Sets
You can convert a logical set to an itemized set. This creates a fixed itemized set 
based of the criteria of an existing logical set.

To convert a logical set to an itemized set:

1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 68: Manage Sets Page

2 Scroll to the logical set that you want to convert to an itemized set and select 
Actions > Itemize. The Set Details page opens with the set name filled in:
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Figure 69: Set Details Page Convert Logical Set to Itemized Set

3 Modify the set details as required. See Adding Itemized Sets on page 84 for 
a description of the fields.

4 Click Submit. A confirmation message opens.

5 Click Confirm. The Manage Sets page opens indicating that the set has been 
successfully saved.

Viewing Members (Itemized Sets Only)
The Members option enables you to view, add, or remove members (selected 
items from the results of a repository search) in an itemized set.
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To view members of an itemized set:

1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 70: Manage Sets Page

2 Scroll to the itemized set whose members you want to view and select 
Actions > Members. The Repository Search page opens.

Figure 71: Repository Search Members
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3 To remove a member from the set, click the Remove link. The member is 
removed from the list of members of the set.

NOTE:
This action only removes the member from the list of members of the set. 
It does not delete the member from the set. The member is only deleted 
from the set when you click Done (step 6). Therefore, if you want to 
recover a removed member before you click Done, click Back to go back 
to the Manage Sets page and start over.

4 To remove multiple members from the set, select the members you want to 
remove and click Remove Selected. The selected members are removed 
from the list of members of the set.

NOTE:
This action only removes the members from the list of members of the set. 
It does not delete the members from the set. The members are only deleted 
from the set when you click Done (step 6). Therefore, if you want to 
recover removed members before you click Done, click Back to go back to 
the Manage Sets page and start over.

5 To add members to the set, click Add Members. The Repository Search page 
opens.

Figure 72: Repository Search Page

a Search for the content you want added to the set using the simple search 
(see Using the Simple Search on page 19) or using the advanced search 
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(see Using the Advanced Search on page 20). The Repository Search 
page refreshes to show the results of the search.

Figure 73: Repository Search Results for Itemized Sets

b Select the items you want added to the set, click Add Selected, and click 
Done. The Manage Sets page opens indicating that the set has been 
successfully saved.

6 Click Done. The members are finally removed from the set and the Manage 
Sets page opens.

Viewing Results (Logical Sets Only)
The Results option enables you to view the results of a logical set. The 
population of a logical set is determined dynamically, reflecting the records 
currently in the repository. Therefore, the results of a logical set always reflect 
the current state of items in the repository even though the set may have been 
created in the past.
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To view results of a logical set:

1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 74: Manage Sets Page

2 Scroll to the logical set whose results you want to view and select Actions > 
Results. The Repository Search Results page opens.

Figure 75: Repository Search Results of Logical Set

3 Click Change Query to modify the search criteria according to the way the 
initial set was created (see Using the Simple Search on page 19 or Using the 
Advanced Search on page 20). The following is an example of the Advanced 
Search page after clicking Change Query.
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Figure 76: Change Advanced Search Page

4 Modify the search criteria and click Go. The Repository Search page opens 
showing the results of the new search as shown in the following example.

Figure 77: Example of Results of New Search

5 To save the set and overwrite the existing set, click Save. The Manage Sets 
page opens indicating that the set has been successfully saved. 

6 To save the set as a new query, click Save Query. The Set Details page opens.
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Figure 78: Set Details Page for Logical Set

a Enter the set details in the respective fields. The Set Name is a 
mandatory field and must be unique. Other fields are optional.

The Set Content Type takes on the same value as the original set.

b By default, the set is designated as a Private (Yes) set. This means that 
the set is only available to you. If you select No, the set becomes a public 
set and is available to all other users.

c By default, the Status is set to Active. Optionally, select Inactive.

d Click Save. The Manage Sets page opens indicating that the set has been 
successfully saved.

Combining Sets
You can create a new set based on the members of two existing sets. The 
combined set is an itemized set.

VIDEO:
For more information on Combining Sets, see the Combine Two Sets of Items 
video (3:42 mins).

http://www.youtube.com/watch?v=eE87g5a_kQw&hd=1
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1 Select Search and Sets > Manage Sets from the Resource Management 
menu. The Manage Sets page opens.

Figure 79: Manage Sets Page

2 Scroll to the set whose members you want to combine with another set and 
select Actions > Combine Sets. The Set Details page opens with the 
Combine Sets section:
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Figure 80: Set Details

3 Select an Operation from the Operation drop-down list:

 And – Include only the members in common between the two sets in the 
new combined set.

 Not – Include only the members that are in the first set and not in the 
second set in the new combined set.

 Or – Include all of the members in both of the sets in the new combined 
set.

4 Click  from the With field to display the Set Details page.

5 Select the set that you want to combine with the first set you selected.

6 Click Submit. The following message is displayed indicating the number of 
members in each set you selected to combine, the operation you selected, 
and the number of members in the combined set:
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Figure 81: Confirmation Message

NOTE:
The confirmation message contains a range of members, since some 
members between the two sets may be identical and are therefore only 
included once in the combined set.

7 Click Confirm.

A job is run to combine the sets. The following message is displayed:

 

After the job finishes, the new set is added to the list of sets. (You must refresh 
the list to see the new set):
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Figure 82: Combined Set

Creating Title Sets
You can create title sets from itemized sets of physical items, electronic 
portfolios, or digital files. The new set contains the titles of the items in the 
original set. 

NOTE:
If you want to create title sets from a logical set, you must first convert the 
set from a logical to an itemized set type.
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To create title sets:

1 From the Manage Sets page (Resource Management > Search and Sets > 
Manage Sets), select Actions > Create title set for an itemized set of physical 
items, electronic portfolios, or digital files.

Figure 83: Create Title Set

The Set Details page opens with information concerning the new title set-such as 
the date and time that the set was created-added to the set name. 

Figure 84: Set Details Page

2 Fill in the Description and Note fields (optional) and click Submit. A 
confirmation message such as the following is displayed.
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Figure 85: Confirmation Message

3 Click Confirm. The job runs and creates the title set. When the job is 
finished, the new set is displayed in the list of sets.

Figure 86: New Titles Set

Viewing Export Processes

PERMISSIONS:
Any user can view processes.
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The Exported Processes page enables you to view details of all the export 
processes that you have created and marked as Private, as well as the export 
processes created by you or other users that are marked as Institution. Export 
processes marked as Private are only available to you. Whereas, export 
processes marked as Institution are available to any user.

NOTE:
You can only view export processes in the current version of Alma.

To view export processes:

1 Select Search and Sets > Manage Exports from the Resource Management 
menu. The Exported Processes page opens.

Figure 87: Exported Process Page

The Exported Processes page lists export processes created in the following 
tabs:

 Private – Export processes created by you that are for your use only. 
Other users cannot see or use these export processes.

 Institution – Export processes created by any user that can be seen and 
used by any user.

2 To view details of an exported file, click View Files. The Exported Files page 
opens.
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Figure 88: Exported Files Page

The Exported Files page, lists details of the exported file and includes an 
Actions button that enables you to:

 Delete – Deletes the exported file (see Deleting Exported Files on 
page 111)

 Download – Downloads the exported file (see Downloading Exported 
Files on page 112)

Deleting Exported Files
When you delete an exported file from a process, you only delete the file from 
the process. The process itself remains.

To delete an exported file:

1 Select Search and Sets > Manage Exports from the Resource Management 
menu. The Exported Processes page opens.

Figure 89: Exported Process Page

2 Locate the export process whose export file you want to delete, and click 
View Files. The Exported Files page opens.
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Figure 90: Exported Files Page

3 Select Actions > Delete. The following confirmation message dialog box 
opens.

Figure 91: Delete Exported File Confirmation Message Dialog Box

4 Click Confirm. The exported file is deleted from the process.

Downloading Exported Files
You can download an exported file to your local computer. 
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To download an exported file:

1 Select Search and Sets > Manage Exports from the Resource Management 
menu. The Exported Processes page opens.

Figure 92: Exported Process Page

2 Locate the export process whose export file you want to download, and 
click View Files. The Exported Files page opens.

Figure 93: Exported Files Page

3 Select Actions > Download, or click the File Name link. The Opening File 
dialog box opens.
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Figure 94: Opening File Dialog Box

4 Select the required options and click OK. The exported XML file is 
downloaded and opens. 

Figure 95: Exported XML File
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NOTE:
The above figure is a sample of the first lines of the exported XML file. The 
full XML file may be several pages long.

Search Indexes
This section describes the MARC bibliographic tags and the search indexes to 
which they are mapped.

All Titles
The following table displays the MARC bibliographic tags and the search 
indexes to which they are mapped that are available when performing an All 
Titles search.

NOTE:
You can create additional search indexes (for example, for local fields). For 
detailed information, see Configuring Search Indexes on page 615.

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
Based on LDR 6-7 Material Type

001 (MMS ID) MMS ID

004 Source Record ID

007 Physical Description 

008 06 Date Type Status

008 07-10 Additional Publication Year

008 11-14 Additional Publication Year

008 15-17 Country of Publication

008 35-37 Language

010 a,z LC Control Number

010 a,b,z Standard Number

015 a,z,2 National Bibliography Number

015 a,z Standard Number

016 a,z Standard Number
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019 a,z Other System Number

020 a,z ISBN

020 a,z Standard Number

022 a,l,m,y,z Standard Number

022 a,y,z ISSN

022 l m ISSN Link

024 a,z Standard Number

024 a,z (if indicator 2 = 2) Other Standard ID

024_8 Other Standard ID

027 a,z Standard Number

028 a Publisher Number

028 a Standard Number

030 a,z Standard Number

031 d,t Title

033 Event Date

035 a,z Other System Number

037 a Standard Number

041 a,b,d,e,f,g,j Language

043 a,b,c Geographic Area Code 

044 a,c Country of Publication

050 a LC Call Number

055 a (if indicator 2 = 0-5) LC Call Number

074 a,z Government Document Number

080 a Universal Decimal Class Number

082 a Dewey Decimal Class Number

084 a Other Classification Number 

086 a,z Government Document Number

088 a,z Standard Number

09x Local Call Numbers

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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090 a LC Call Number

092 a Dewey Decimal Class Number

096 a,z Government Document Number

100 a-d,g,j,q,u Name

100 a-d,j,q,u Creator

100 e,4 Relator

110 a-e,g,n,u Name

110 a-e,n,u Creator

111 a,c,d,e,g,n,q,u Name

111 a,c-e,n,q,u Creator

130 a,d,f,g,k-p,r-t Uniform Title

130 a,d,g,k,l,m-p,r-t Title

210 a Title

214 a Title

222 a,b Serial Title

222 a,b Title

240 a,d,f,g,k-p,r,s Title

240 a,d,f,g,k-p,r,s Uniform Title

242 a,b,n,p Title

243 a,d,f,g,k,l-p,r,s Title

243 a,d,f,g,k-p,r,s Uniform Title

245 a,b,k,n,p Title

245 c Names

245 h Medium Type

246 a,b,n,p Title

247 a,b,n,p Title

250 a,b Edition

260 a,e Publisher Location

260 b,f Publisher

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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260 c Publication Year

260 g Additional Publication Year

261 a,b,e Publisher

261 f Publisher Location

262 a Publisher Location

262 b Publisher

264 a Publisher Location

264 b Publisher

264 c Additional Publication Year

336 a Content Type Term

336 b Content Type Code

337 a Media Type Term

337 b Media Type Code

338 a Carrier Type Term

338 b Carrier Type Code

400 a-d,g Name

400 a-d,g,k,p,n,t,v,x Series

400 a,k,n,p,t Title

410 a-d,g Name

410 a-d,g,k,p,n,t,v,x Series

410 a,k,n,p,t Title

411 a,c,d,e,q,k,n,p,t,v,x Series

411 a,c-e,g,q Name

411 k,n,p,t Title

440 a,n,p Title

440 a,n,p,v,x Series

490 a Title

490 a,v,x Series

490 x Standard Number

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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500 a,3,5,6,8 Public Note

501 a Notes

502 a-d,g,o Notes

502 c Publisher

504 a Notes

505 a,g,r,t Description

505 r Name

505 t Title

508 a Name

508 a Notes

510 a,c Notes

511 a Name

511 a Notes

518 strip numeric subfields Notes

520 a,b Description

521 a Notes

522 a Notes

526 a Notes

530 a Additional Physical Form Available 
Note 

533 a-f,n Notes

533 b Publisher Location

533 c Publisher

533 f Series

534 a-c,e-f,k-p,t Notes

534 f Series

534 o,x,z Standard Number

536 a-h Notes

538 a Notes

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index



Alma Resource Management

January 2015120

Chapter 2: Using the Repository Search

Ex Libris Confidential

541 a,c,d,e Notes

542 g,l,n Copyright Note

545 a,b Notes

550 a Name

550 a Notes

561 a Notes

561 a Ownership and Custodial History

562 a,b,c,d,e Notes

563 a Notes

586 a Notes

59x Local Notes

600 a-d,f,g,j-v,x-z Subjects (LC)

600 a-d,f,g,j-v,x-z Subjects

600 a-d,g,j,q,u Name

600 v Genre Form

610 a-e,g,u Name

610 a-g,j-v,x-z Subjects

610 a-g,j,l-v,x-z (if indicator 2 = 0) Subjects (LC)

610 v Genre Form

611 a,c-e,g,n,q,u Name

611 a,c-g,j-l,n,p,q,s-v,x-z (if indicator 2 = 
0)

Subjects (LC)

611 a,c-g,j-l,n,p,q,s-v,x-z Subjects

611 v Genre Form

630 a,d,e-g,k-p,r-t Title

630 a,d,e-g,k-p,r-t Uniform Title

630 a,d,e-g,k-p,r-t,v,x-z (if indicator 2 = 0) Subjects (LC)

630 a,d,e-g,k-p,r-t,v,x-z Subjects

630 v Genre Form

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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648 a,v,x-z Subjects

648 v Genre Form

650 a-e,v,x-z (if indicator 2 = 0) Subjects (LC)

650 a-e,v,x-z (if indicator 2 = 2) Medical Subjects

650 a-e,v,x-z Subjects

650 v Genre Form

651 a,e,v,x-z (if indicator 2 = 0) Subjects (LC)

651 a,e,v,x-z Subjects

651 v Genre Form

653 a Subjects

653 a (if indicator 2 = 6) Genre Form

653 a if 2nd indicator =1-5 Name

654 a-c,e,v,x-z (if indicator 2 = 0) Subjects (LC)

654 a-c,e,v,x-z Subjects

654 v Genre Form

655 a,b,v,c Genre Form

655 a-c,v,x-z (if indicator 2 = 0) Subjects (LC)

655 a-c,v,x-z (if indicator 2 = 2) Medical Subjects

655 a-c,v,x-z Subjects

655 c Genre Form

69x Local Subjects

690 a-e,v,x-z (if indicator 2 = 0) Subjects (LC)

690 a-e,v,x-z Subjects

690 v Genre Form

691 a,e,v,x-z Subjects (LC), Subjects

691 v Genre Form

696 a-d,f,g,j-v,x-z (if indicator 2 = 0) Subjects (LC)

696 a-g,j-v,x-z Name

696 a-d,f,g,j-v,x-z Subjects

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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696 v Genre Form

697 a-g,j-v,x-z (if indicator 2 = 0) Subjects (LC)

697 a-g,j-v,x-z Name

697 a-g,j-v,x-z Subjects

697 v Genre Form

698 a,c-g,j-l,n,p,q,s-v,x-z (if indicator 2 = 
0)

Subjects (LC)

698 a,c-g,j-l,n,p,q,s-v,x-z Name

698 a,c-g,j-l,n,p,q,s-v,x-z Subjects

698 v Genre Form

699 a,d,e-g,k-p,r-t Uniform Title

699 a,d,e-g,k-p,r-t,v,x-z (if indicator 2 = 0) Subjects (LC)

699 a,d,e-g,k-p,r-t,v,x-z Name

699 a,d,e-g,k-p,r-t,v,x-z Subjects

699 v Genre Form

700 a-e,j,q,u Creator

700 a-e,j,q,u Name

700 f,k,l-p,r-t Title

700 x Standard Number

710 a-e,i,n,u Creator

710 a-e,i,n,u Name

710 f,k,l-p,r-t Title

710 x Standard Number

711 a,c,d,e,i,j,n,q,u Name, Creator

711 f,k,l,p,s,t Title

711 x Standard Number

720 a Name

730 a,d,f,g,i,k-p,r-t Uniform Title

730 a,d,f,i,k-p,r-t Title

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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730 x Standard Number

740 a,n,p Title

751 a,e Name

752 a-g Publisher Location

752 a-h Name

753 a,b,c Notes

754 a,c,d,x,z Name

760 a,c,s,t,x Series

760 x,y Standard Number

762 a,c,s,t,x Series

762 x,y Standard Number

765 u,x-z Standard Number

766 u,x-z Standard Number

770 u,x-z Standard Number

773 t,u,x-z Standard Number

774 a Name

774 s,t Title

774 u, x-z Standard Number

774 w Other System Number

776 u,x-z Standard Number

776 x ISSN

780 s,t Title

780 u,x-z Standard Number

785 s,t Title

785 u,x-z Standard Number

787 s,t Title

787 u,x-z Standard Number

800 a-d,g,j,q,u Name

800 a-f,j-v,x Series

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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800 f,k-p,r-t Title

800 x Standard Number

810 a-e,g,n,u Name

810 a-g,k-p,r-t,v,x Series

810 f,k-p,r-t Title

810 x Standard Number

811 a,c,d,e,g,j,n,q,u Name

811 a,c-g,j-n,p-q,s-v,x Series

811 f,k-n,p,s-t Title

811 x Standard Number

830 a,d,f-g,k-p,r-t,v,x Series

830 a,d,f-g,k-p,r-t,v Title

830 a,d,f-g,k-p,r-t,v Uniform Title

830 x Standard Number

852 b Sublocation 

852 c Shelving Location

852 h Classification Part

856 u,z Electronic location and note   

Table 13. MARC Bibliographic Tags - Search Indexes Mapping

Tag  Search Index
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The following table displays the search indexes and the MARC bibliographic 
tags and Alma tables to which they are mapped that are available when 
performing an All Titles search.
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Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
Title 031 d,t

130 a,d,g,k,l,m-p,r-t

210 a

214 a

222 a,b

240 a,d,f,g,k-p,r,s

242 a,b,n,p

243 a,d,f,g,k,l-p,r,s

245 a,b,k,n,p

246 a,b,n,p

247 a,b,n,p

400 a,k,n,p,t

410 a,k,n,p,t

411 k,n,p,t

440 a,n,p

490 a

505 t

630 a,d,e-g,k-p,r-t

700 f,k,l-p,r-t

710 f,k,l-p,r-t

711 f,k,l,p,s,t

730 a,d,f,i,k-p,r-t

740 a,n,p

774 s,t

780 s,t

785 s,t

787 s,t

800 f,k-p,r-t

810 f,k-p,r-t

811 f,k-n,p,s-t

830 a,d,f-g,k-p,r-t,v
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Uniform title 130 a,d,f,g,k-p,r-t

240 a,d,f,g,k-p,r,s

243 a,d,f,g,k-p,r,s

630 a,d,e-g,k-p,r-t

699 a,d,e-g,k-p,r-t

730 a,d,f,g,i,k-p,r-t

830 a,d,f-g,k-p,r-t,v

Serial Title 222 a,b

Creator 100 a-d,j,q,u

110 a-e,n,u

111 a,c-e,n,q,u

700 a-e,j,q,u

710 a-e,i,n,u

711 a,c-e,i,j,n,q,u

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Names 100 a-d,g,j,q,u

110 a-e,g,n,u

111 a,c,d,e,g,n,q,u

245 c 

400 a-d,g

410 a-d,g

411 a,c-e,g,q

505 r

508 a

511 a

600 a-d,g,j,q,u

610 a-e,g,u

611 a,c-e,g,n,q,u

653 a if 2nd indicator =1-5

696 a-g,j-v,x-z

697 a-g,j-v,x-z

698 a,c-g,j-l,n,p,q,s-v,x-z

699 a,d,e-g,k-p,r-t,v,x-z

700 a-e,j,q,u

710 a-e,i,n,u

711 a,c,d,e,i,j,n,q,u

720 a

751 a,e

752 a-h

754 a,c,d,x,z

774 a

800 a-d,g,j,q,u

810 a-e,g,n,u

811 a,c,d,e,g,j,n,q,u

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Subjects 600 a-d,f,g,j-v,x-z

610 a-g,j-v,x-z

611 a,c-g,j-l,n,p,q,s-v,x-z

630 a,d,e-g,k-p,r-t,v,x-z

648 a,v,x-z

650 a-e,v,x-z

651 a,e,v,x-z

653 a

654 a-c,e,v,x-z

655 a-c,v,x-z

690 a-e,v,x-z

696 a-d,f,g,j-v,x-z

697 a-g,j-v,x-z

698 a,c-g,j-l,n,p,q,s-v,x-z

699 a,d,e-g,k-p,r-t,v,x-z

Subjects (LC) 600 a-d,f,g,j-v,x-z

610 a-g,j,l-v,x-z (if indicator 2 = 0)

611 a,c-g,j-l,n,p,q,s-v,x-z (if indicator 2 = 0)

630 a,d,e-g,k-p,r-t,v,x-z (if indicator 2 = 0)

650 a-e,v,x-z (if indicator 2 = 0)

651 a,e,v,x-z (if indicator 2 = 0)

654 a-c,e,v,x-z (if indicator 2 = 0)

655 a-c,v,x-z (if indicator 2 = 0)

690 a-e,v,x-z (if indicator 2 = 0)

691 a,e,v,x-z

696 a-d,f,g,j-v,x-z (if indicator 2 = 0)

697 a-g,j-v,x-z (if indicator 2 = 0)

698 a,c-g,j-l,n,p,q,s-v,x-z (if indicator 2 = 0)

699 a,d,e-g,k-p,r-t,v,x-z (if indicator 2 = 0)

Medical Subjects (MeSH) 650 a-e,v,x-z (if indicator 2 = 2)

655 a-c,v,x-z (if indicator 2 = 2)

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Series 400 a-d,g,k,p,n,t,v,x

410 a-d,g,k,p,n,t,v,x

411 a,c,d,e,q,k,n,p,t,v,x

440 a,n,p,v,x

490 a,v,x 

533 f

534 f

760 a,c,s,t,x

762 a,c,s,t,x

800 a-f,j-v,x

810 a-g,k-p,r-t,v,x

811 a,c-g,j-n,p-q,s-v,x

830 a,d,f-g,k-p,r-t,v,x

Publisher 260 b,f

261 a,b,e

262 b

264 b

502 c

533 c

LC Call Number 050 a

055 a (if indicator 2 = 0-5)

090 a

Dewey Decimal Class Number 082 a

092 a

UDC 080 a

Other Classification Number 084 a

Additional Publication Year 008 07-10

008 11-14

260 c

260 g

264 c

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Publication Year 260 c

Language 008 35-37

041 a,b,d,e,f,g,j

Collection Internal Alma algorithm

LC Control Number 010 a,z

ISBN 020 a,z

ISSN 022 a,y,z

776 x

ISSN link 022 l m

Other Standard ID 024 a,z if 2nd indicator = 2

024_8

Government Document Number 074 a,z

086 a,z

096 a,z

National bibliography number 015 a,z,2 

Publisher number 028 a

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Standard number 010 a,b,z

015 a,z

016 a,z

020 a,z

022 a,l,m,y,z

024 a,z

037 a

088 a,z

490 x

534 o,x,z

700 x

710 x

711 x

730 x

760 x,y

762 x,y

765 u,x-z

766 u,x-z

770 u,x-z

773 t,u,x-z

774 u,x-z

776 u,x-z

780 u,x-z

785 u,x-z

787 u,x-z

800 x

810 x

811 x

830 x

Other System Number 035 a,z

019 a,z

774 w

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Copyright Note 542 g,l,n

Notes 501 a

502 a-d,g,o

504 a

508 a

510 a,c

511 a

518 strip numeric subfields

521 a

522 a

526 a

533 a-f,n

534 a-c,e-f,k-p,t

536 a-h

538 a

541 a,c,d,e

545 a,b

550 a

550 a

561 a

586 a

753 a,b,c

Local notes 59x

Description 505 a,g,r,t

520 a,b

MMS ID 001 (MMS ID)

Bibliographic format LDR

Bibliographic level LDR

Date type status 008

Edition 250 a,b

Has inventory Internal Alma algorithm

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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MMS SIP ID Alma SIP_ID table

Physical description 007

Public note 500 a,3,5,6,8 

Is linked True when the Alma LINK_ID table is not 
empty.

Country of Publication 008 15-17

044 a,c

Genre Form 600 v

610 v

611 v

630 v

648 v

650 v

651 v

653 a (if indicator 2 = 6)

654 v

655 a,b,v,c

690 v

691 v

696 v

697 v

698 v

699 v

Publisher Location 260 a,e

261 f

262 a

264 a

533 b

752 a-g

Material Type Based on LDR 6-

Medium Type 245 h

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Originating System ID Alma ORIGINATING_SYSTEM_ID table

Originating System Alma ORIGINATING_SYSTEM table

Tag Suppressed Alma TAG_SUPPRESSED table

Tag Sync External Catalog Alma 
TAG_SYNC_EXTERNAL_CATALOG 
table

Tag Sync National Catalog Alma 
TAG_SYNC_NATIONAL_CATALOG 
table

Tag Brief TAG_BRIEF 

Electronic location and note 856 u,z

Event Date 033

Other Standard Identifier 024 8,a

Source Record ID 004

Additional Physical Form Available 
Note 

530 a

Carrier type code 338 b

Carrier type term 338 a

Classification Part 852 h

Content type code 336 b

Content type term 336 a

Geographic Area Code 043 a,b,c

MMS creation date Alma CREATE_DATE field

Media type code 337 b

Media type term 337 a

Relator 100 e,4

Shelving Location 852 c

Sublocation 852 b

Table 14. Search Indexes - MARC Bibliographic Tags Mapping

Search Index Tag
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Keyword Search Indexes
The following table displays the fields searched when performing a keywords 
search. 

NOTE:
To determine the MARC fields searched for an All Titles search, refer to 
Table 14.

 All Titles

 Creator

 Government Document Number

 ISBN

 ISMN – MARC 24 a,z

 ISSN

 LCCN

 Subjects (LC)

 Medical Subjects (MeSH)

 Name

 National Bibliography Number

 Electronic Location

 Citation – MARC 510 a,c

 Publisher

 Publisher Number

 Series

 Subjects

 Title

 Uniform Title

 Serial Title

 Date of Publication

 Edition

 Public Note

 Other System Number
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NOTE:
In addition, all subfields of MARC field 774 are searched when 
performing a keywords search.

 Physical Items

 Holding Note

 Barcode

 Item Description

 Fulfillment Note

 Internal Note 1

 Internal Note 2

 Internal Note 3

 Public Note

 Storage Location ID

 Electronic Portfolios

 Package Name

 Creator Name

 Category

 Interface ID

 Collections

 IEC Label

 IEC External System

 IEC External System ID

 Electronic Collection 

 Package Name

 Digital Files

 File Label

 File Note

 Risk Library Identifiers

 File Original Name

 AR Description

 Representation Label

 Authorities – see the following table:
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Table 15. Authority Keyword Search Indexes

Search Index Tag
Corporate Name 110 a-d,n

See Corporate Names 410 a-d,n

See Also Corporate Names 510 a-d,n

Meeting Name 111 a,c,d,n,q

See Meeting Names 411 a,c,d,n,q

See Also Meeting Names 511 a,c,d,n,q

Personal Names 100 a-d,q

See Personal Names 400 a-d,q

See Also Personal Names 500 a-d,q

Subject 148 a,v,x,y,z

150 a,b,v,x,y,z

151 a,v,x,y,z

155 a,v,x,y,z

180 v,x,y,z

181 v,x,y,z

182 v,x,y,z

185 v,x,y,z

See Subjects 448 a,v,x,y,z

450 a,b,v,x,y,z

451 a,v,x,y,z

455 a,v,x,y,z

480 v,x,y,z

481 v,x,y,z

482 v,x,y,z

485 v,x,y,z
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The following table displays MARC holdings tags and the search indexes to 
which they are mapped.

See Also Subjects 548 a,v,x,y,z

550 a,b,v,x,y,z

551 a,v,x,y,z

555 a,v,x,y,z

580 v,x,y,z

581 v,x,y,z

582 v,x,y,z

585 v,x,y,z

Uniform Title 130 a,d,f,k-t

430 a,d,f,k-t

530 a,d,f,k-t

Originating System ID originating_system_id

Table 16. Search Indexes Mapping - MARC Holdings Tags

Index Tag
Accession Number depends on institution configuration

Call Number Suffix 852.m

Carrier type term 338 a

Carrier type code 338 b

elocation 856 u,z

Holdings Note 852 x, z and  
866 x, z

Library 852 b

Media type term 337 a

Media type code 337 b

MMS ID MMS ID

Ownership and Custodial History 561 a

Permanent Call Number 852 k,h,i,j,l,m

Table 15. Authority Keyword Search Indexes

Search Index Tag
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The following table displays Dublin Core terms and the search indexes to which 
they are mapped. 

Permanent Call Number Type 852 1st indicator

Permanent Physical Location 852 c

Summary Holding 866 a

Table 17. Search Indexes Mapping - Dublin Core Terms

Dublin Core Term Index
dc:contributor contributor

dcterms:contributor contributor

dc:creator creator

dcterms:creator creator

dc:date date

dcterms:created date

dcterms:date date

dcterms:dateAccepted date

dc:description description

dcterms:abstract description

dcterms:description description

dcterms:tableOfContents description

dc:identifier identifier

dc:identifier dcterms:ISSN identifier

dc:identifier dcterms:ISBN identifier

dcterms:identifier identifier

dcterms:identifier dcterms:ISBN identifier

dcterms:identifier dcterms:ISSN identifier

dc:identifier dcterms:ISBN isbn

dcterms:identifier dcterms:ISBN isbn

dc:identifier dcterms:ISSN issn

Table 16. Search Indexes Mapping - MARC Holdings Tags

Index Tag
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dcterms:identifier dcterms:ISSN issn

dc:language language

dcterms:language language

dc:subject dcterms:LCSH lcsh

dcterms:subject dcterms:LCSH lcsh

dc:type medium_type

dcterms:type medium_type

dc:subject dcterms:MESH mesh

dcterms:subject dcterms:MESH mesh

dc:coverage notes

dc:rights notes

dc:source notes

dcterms:audience notes

dcterms:bibliographicCitation notes

dcterms:coverage notes

dcterms:educationLevel notes

dcterms:mediator notes

dcterms:rights notes

dcterms:source notes

dcterms:spatial notes

dcterms:temporal notes

dc:publisher publisher

dcterms:publisher publisher

dc:publisher publisher_location

dcterms:publisher publisher_location

dc:subject subjects

dcterms:subject subjects

dc:title title

dcterms:alternative title

Table 17. Search Indexes Mapping - Dublin Core Terms

Dublin Core Term Index
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dcterms:title title

Table 17. Search Indexes Mapping - Dublin Core Terms

Dublin Core Term Index
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List of External Search Resources
The following is a list of external search resources that are currently available in  
Alma (see External System Search for a full explanation of this feature in Alma):

 Abertswyth University Library Catalogue

 AMICUS – requires credentials to access

 Australian National Bibliographic Database (Test) – requires credentials to 
access

 Bavarian Library Network – requires credentials to access

 BDZ (BDS) – requires credentials to access

 BDZ DVD/BLURAY MARC21 Cataloguing Service (BDS) – requires 
credentials to access

 BDZ Music Data MARC21 Cataloguing Service (BDS) – requires credentials 
to access

 Biblioteca Nacional de Espana

 BN-OPALE PLUS (BNF)

 British Library Integrated Catalogue

 British Library Integrated Catalogue (MARC) – requires credentials to 
access

 British National Bibliography (BNB) – requires credentials to access

 CAPITA (BDSAllM21) – requires credentials to access

 CAPITA (BLConM21) – requires credentials to access

 CAPITA (LCAllM21) – requires credentials to access

 CAPITA (NLMAllM21) – requires credentials to access

 CAPITA (UnionM21) – requires credentials to access

 CARM Centre (CAVAL)

 Catalog of U.S. Government Publications (CGP Z39.50) – requires 
credentials to access

 CLICNET Catalog
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 COPAC

 Curtin University Library

 DBC (The Danish Bibliographic Centre)

 Edinburgh University Library

 German National Library – MARC21 – requires credentials to access

 Global Books in Print (Bowker) – requires credentials to access

 Hessische Bibliothekssystem (HeBIS)

 HOLLIS Catalog – Harvard

 James Bennett Online

 Katalog des Bibliotheksverbunds IDS Basel Bern  

 Laval University Library

 Libraries Australia – requires credentials to access

 Libraries Australia Modified – requires credentials to access

 Library of Congress (United States Library of Congress (LOC))

 LIBRIS - Swedish Union Catalogue

 London School of Economics

 MnPALS

 Monash University Library Catalogue

 Monash University of Malaysia

 Monash University South Africa

 National Art Library Victoria and Albert Museum

 National Library of Australia

 National Library of Israel

 National Library of Korea (National Shared Cataloging)

 National Library of Malaysia

 National Library of New Zealand

 National Library of Scotland

 National Library of Wales

 National University of Singapore Library

 Netzwerk von Bibliotheken und Informationsstellen in der Schweiz (NEBIS)

 NLM LocatorPlus (z39 gateway - OPAC)

 OCLC WorldCat (through Libraries Australia) – requires credentials to 
access
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 Ohio Link

 Online Dakota Information Network (ODIN)

 Open Vlacc (Vlaamse Centrale Catalogus) – requires credentials to access

 Oxford University (Oxford University)

 Purdue University Catalogue – requires credentials to access

 Reseau des bibliotheques de Suisse occidentale (RERO)

 RLUK Research Libraries UK – requires credentials to access

 Russian State Library

 South Dakota Library Network (SDLN) 

 State Library of Victoria

 SUDOC (Brief Records USMARC)

 SUNCAT (MARC) – requires credentials to access

 SWB Katalog (Sudwestdeutscher Bibliotheksverbund)

 Swinburne Library – Swinburne University of Technology

 Swiss National Library (NB) – requires credentials to access (idPass 
authentication). 

 Te Puna Search – requires credentials to access

 The National and Copenhagen University Library

 ULI – Israel Union List (MALMAD Israel Center for Digital Information 
Services)  

 ULS (Israel Union List of Serials)

 Universiteit Gent

 University of Malaya Library

 University of Melbourne Library

 University of Ottawa Library

 University of Sydney

 University of the Arts London – Library Catalogue

 WorldCat (OCLC) – requires credentials to access

 Yale University Library

 Zeitschriftendatenbank (ZDB)
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Metadata Management

Opening the Metadata Editor

PERMISSIONS:
To work with metadata, you must have one of the following roles:

 Cataloger

 Catalog Manager

 Catalog Administrator

The Metadata Editor enables you to view and edit bibliographic metadata. You 
can also view and edit holdings and authorities in the Metadata Editor.

The Metadata Editor can be opened from the Alma main menu (Resource 
Management > Cataloging > Open Metadata Editor) or by clicking Edit for a 
specific title in your search results. 

This section includes:

 Opening the Metadata Editor on page 147

 Navigating the MD Editor Page on page 149

 Working with Bibliographic Records on page 172

 Working with Templates on page 181

 Working with Authority Records on page 184

 Working with Normalization Rules on page 220

 Working with Merge Rules on page 254

 Searching External Resources on page 264

 Mapping Call Numbers to Holdings on page 268
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Figure 96: MD Editor Page (Alma Main Menu)
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Figure 97: MD Editor Page (Edit from Search Results)

Navigating the MD Editor Page
The MD Editor is designed to facilitate streamlined cataloging of bibliographic, 
holdings, and authority metadata. 

The MD Editor has the following working areas or panes:

 Left Pane on page 150

 Main Pane on page 150

 Lower Pane on page 150

For an example of these working areas in the MD Editor see MD Editor 
Working Example on page 151.

Other MD Editor details provided in this section include:

 Creating Bibliographic Records with the MD Editor on page 151

 Creating Holdings Records with the MD Editor on page 151

 Creating Local Authority Records Using the MD Editor on page 155

 MD Editor Menu and Toolbar Options on page 155

 Saving Records in the MD Editor on page 164
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 Entering Diacritics and Special Characters in the MD Editor on page 165

Left Pane
The left pane has the following tabs:

 Templates – This tab contains templates that enable you to create new 
records based on a template, or use one of the templates to override existing 
data. For details on this tab, see Working with Templates on page 181.

 Records – This tab contains the brief title information (move the mouse over 
a record and a tool tip displays the full title) and metadata ID linked to the 
MD record. The information presented depends on the type of resource 
being edited. Records are grouped according to type such as MARC21 
bibliographic, MARC21 holdings, LC subject, LC name, NLM MeSH, and 
Dublin Core.

The Local Repository icon  indicates that the record exists in the local 
repository. The Editor icon  indicates that the record has been saved to the 
repository. The Suppressed icon  indicates that the record has been 
suppressed from external discovery systems, including Primo.

 Rules – This tab contains the private and shared normalization rules that 
you or others created and Merge rules. For details regarding this tab, see 
Working with Normalization Rules on page 220 and Working with Merge 
Rules on page 254.

Main Pane
The main pane is the main working area that displays the record information. 
This area includes menu bars and a toolbar. For details, see MD Editor Menu 
and Toolbar Options on page 155.

Lower Pane
The lower pane provides additional assistance for editing a record and includes 
the following tabs:

 Info – This tab contains field sensitive data based on MD registry definitions 
which, by default, is from the Library of Congress. If you are editing DC 
records, the information is from the DC site.

 Alerts – This tab contains field, subfield, indicator, and fixed-field, content-
level warnings based on the MD registry. You can click any error in red (not 
overridable) or warning in yellow (overridable) to link directly to the field 
identified by the alert.
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MD Editor Working Example
The following illustration shows an example of the MD Editor where a record is 
in the process of being edited. At the top of the Main pane, in the red rectangle, 
there is a warning message that the field being edited (in the blue rectangle) has 
incorrect or missing information that is listed in the Alerts tab (in the yellow 
rectangle).

Figure 98: MD Editor Main Page

When you open a record in the repository for editing, it is checked out to you. 
This prevents other users from modifying the same record and perhaps 
overriding your changes.

Creating Bibliographic Records with the MD Editor
For information about working with bibliographic records and how to create 
bibliographic records in the MD Editor, refer to Working with Bibliographic 
Records on page 172 and/or Creating Bibliographic Records on page 173. 

Creating Holdings Records with the MD Editor
Alma provides the MD Editor for creating holdings records. Holdings records 
provide location information for bibliographic records. In order for a holdings 
record to exist, there must be a bibliographic record to which it is linked.
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To create a holdings record:

1 Open (or create) a bibliographic record in the MD Editor.

2 Click File > New > MARC21 Holdings.

Figure 99: File > New > MARC21 Holdings

The MD Editor opens in split pane mode with the MARC21 holdings 
template open in the right area.

Figure 100: MARC 21 Holdings Template (Split Screen Mode)

3 Enter your holdings data. See MD Editor Menu and Toolbar Options on 
page 155 for additional information regarding working with the MD Editor
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4 Click the Save icon. For additional information regarding saving records, 
see Saving Records in the MD Editor on page 164.

Creating the 866/867/868 Fields in a Holdings Record Automatically
Alma provides options to increase your productivity when creating holdings 
records. In particular, you can automatically create the 866/867/868 fields in the 
holdings record from linked 853/854/855 and 863/864/865 fields. To do this you 
need to configure the MARC21 holdings profile.

VIDEO:
Learn how to create a normalization rule that automatically creates 866/7/
8 fields in holdings records in the Automatically Create 866/7/8 Fields in 
Holdings Records video (6:18 mins).

To configure the MARC21 holdings profile to automatically create the 
866/867/868 fields in a holdings record:

1 On the Metadata Configuration List page (Resource Management > 
Configuration > Configuration Menu > Cataloging section > Metadata 
Configuration), click the MARC21 Holding link in the Profile column.

Figure 101: MARC21 Holding Profile Link

The Profile Details page displays.

2 Click the Normalization tab.

3 Add a holdings process.

a Click Add Process.

b Enter Populate 86X Fields, for example, for a process name.

c Enter a description.

d Confirm that Active is the selected Status and click Next.

e Select marc21ExpandHoldingBy86XTask and click Add to Selection.

http://www.youtube.com/watch?v=esYkMYehGQE&hd=1
http://www.youtube.com/watch?v=esYkMYehGQE&hd=1
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f Optionally, you may add other processes from the Process List Pool and 
sequence them in the order that you prefer or add processes at a later 
time by editing (Actions > Edit) the Task List tab of the Populate 86X 
Fields process.

Figure 102: Task List Tab - marc21ExpandHoldingBy86XTask Process Added to Selected List

g Click Next and click Save.

You can now create a holdings record using the MD Editor and the 
system will automatically create the 866/867/868 fields from the 853/854/
855 and 863/864/865 linked fields
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Figure 103: Example of a Holdings Record with the 866 Fields Automatically Created

Creating Local Authority Records Using the MD Editor
For information about working with authority records and how to create local 
authority records in the MD Editor, refer to Working with Authority Records 
on page 184 and/or Creating Local Authority Records Using the MD Editor on 
page 191.

MD Editor Menu and Toolbar Options
The following tables describe the various menu and toolbar options in the MD 
Editor.

NOTE:
To navigate between records that you are working on in the MD Editor, 
use the Alt + --> or <-- (right or left arrows).

 
Table 18. MD Editor – File Menu

Action Description
New Adds an empty record (according to your selection) as a 

draft in order to catalog and save it to the repository (or as a 
template).

Save Draft

(Ctrl+Alt+S)

Runs validation routines and saves the record as a draft. 
Your changes are saved, but the changes are not updated in 
the repository at this time. The record remains checked out 
to you and is not available to other catalogers for editing.

Save Record

(Ctrl+S)

Saves the changes made to the record in the repository but 
does not release the record. Use the Release Record option 
to release the record.
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Save and Release 
Record

(Ctrl+Alt+R)

Saves the record and releases it.

Duplicate Creates a copy of the record.

Release Record Releases the record without saving the changes.

Assign Record to 
Another Cataloger

Reassigns the record to another cataloger. The record is 
displayed in bold in the list of assignments in the MD Editor 
and a note is added under Tools > View Notes.

Release Assignment The Catalog Manager can release locks on bibliographic 
records that are assigned to other catalogers.

Save as Template Saves the current record as a template for recurrent use.

Reload Original 
Record

Reloads (overwrites) the active record with the last version 
of the record saved in the repository and, thereby, 
discarding any draft changes made.

Delete Record

(Ctrl+D)

This option is enabled for a user with the Cataloger 
Extended role. A bibliographic record can be deleted only if 
there are no PO lines or inventory associated with it. For 
information about deleting bibliographic records in bulk, 
see Batch Deleting Bibliographic Records on page 178.

Copy to Catalog Copies a shared bibliographic record to the local repository 
(IZ) of your institution. This copy of the record is unlinked 
from the CZ.

In subsequent activations, the copied bibliographic record is 
not copied again to the IZ. To prevent duplicates, Alma 
attempts to identify the original system ID; and if it matches 
an IZ bibliographic record, the IZ bibliographic record is 
used.

Share with Network Shares a locally created record with the Network Zone.

Options Indicate (in the Placement of New Bibliographic Records 
dialog box) whether to place the record locally or in the 
Network Zone.

Exit

(Ctrl+Q)

Exits the editor, and discards any unsaved changes (unless 
you select to save a draft upon exit). Exiting the editor does 
not release any records, and they remain checked out to you 
until you specifically release them using the Release Record 
option.

Table 18. MD Editor – File Menu

Action Description
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Table 19. MD Editor – Edit Menu

Action Description
Add Field

(F8)

Adds a new empty row that can be set with a field value 
when cataloging.

Remove Field

(Ctrl+F6)

Removes the selected field row.

Add Sub Field

(F9)

Adds a new sub field with a separator $$to allow inline 
cataloging of the active field. 

Add Localized Field Add a localized field to a Network Zone record (fields 9xx, 
09x, 59x, 69x).

Add Alternate Graphic 
Representation

Enables you to edit paired fields without the complexity of 
880 linkage. For example, if you have the 245 field selected, 
this option enables you to choose a relevant script for 
input. An additional line opens in the editor for input in 
the designated script.

Add Rule Add a normalization rule.

Enhance the Record

(Ctrl+Alt+E)

Runs preconfigured normalization routines. 
Normalizations are intended to correct or update metadata 
records. For example, sorting a record's fields, removing 
empty fields, or stripping out fields containing order 
information. 

Expand from Template

(Ctrl+E)

Expands a record's data fields using a specified template. 
The record may be any of the following types: 
bibliographic, holdings, and authority.

For more information, see Expanding a Record from a 
Template on page 165.

Split Editor

(F6)

Enables a side-by-side editing of two records (although 
only one side is active at a time). Click the right panel, and 
click a record from the list of records. This option is also 

available via the Split Editor icon . Pressing F6 again 
removes the split screen.

Full Screen

(F7)

Opens the main editing pane in the entire page. This option 

is also available via the Full Screen icon . Pressing F7 
again reverts to normal view.

Open Form Editor

(Ctrl+F)

Functional only for MARC fixed fields, such as LDR and 
001-009, or for complex fields, such as holdings 852.
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Close Form Editor

(Esc)

Exits the control field editor and returns to the standard 
editor view.

Cut

(Ctrl+X)

Cuts the selected text.

Copy

(Ctrl+C)

Copies the selected text. To copy multiple fields 
simultaneously, press Ctrl and select all the fields to be 
copied.

Paste

(Ctrl+V)

Pastes text that was previously cut or copied. Fields are 
pasted at the cursor location. Pasting multiple fields 
simultaneously pastes the fields in their numerical sort 
order.

Table 20. MD Editor – Other Editing Options

Action Description
Arrow Up Moves the cursor up field by field in a record.

Arrow Down Moves the cursor down field by field in a record.

Arrow Right Moves the cursor to the right across the field, subfield, 
indicator, and content information.

Arrow Left Moves the cursor to the left across the field, subfield, 
indicator, and content information.

Table 21. MD Editor – Tools Menu

Action Description
Search External 
Resources

Enables you to search external bibliographic databases, 
view and select relevant records before importing them to 
the repository. This option is usually chosen for copy 
cataloging workflows.

View Versions Enables you to view and restore a previous version of the 
record.

View Versions of 
Original Record

View previous versions of a local record before you saved 
it to the Network Zone.

Validity Check Executes validation routines on the bibliographic record. 
Validation issues are displayed in the Alerts tab.

Table 19. MD Editor – Edit Menu

Action Description
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Validate in 
Collaborative Zone

Validates the local bibliographic record according to the 
validation rules of the Network Zone.

Browse Call Numbers

(Alt+C)

Opens in split editor mode with options to select a call 
number type (Library of Congress, National Library of 
Medicine, and so forth) and a specific call number in order 
to perform a browse of the holdings records’ 852 $$h 
fields. Note that the way in which this browse works 
cannot be configured.

NOTE:
This functionality is also available by selecting 
Resource Management > Cataloging > Browse 
Shelf Listing from the main Alma menu.

View Notes Displays working copy notes.

Release All Records For 
User

Enables a catalog manager to release all of the 
bibliographic and holdings records assigned to a specific 
user. Consistent with previous capabilities, the released 
records become unassigned and are available to all other 
catalogers for processing.

MARC21 Bibliographic:

Add Holdings

(Ctrl+Alt+H)

Adds a holdings record that is linked to the current 
bibliographic record.

Add Local Portfolio Opens the New Portfolio page (see Managing Local 
Portfolios on page 327).

Create PO Line & Exit

(Ctrl+Alt+O)

Creates a PO line based on the bibliographic information 
in the active record. (This requires the Inventory Operator 
role permissions).

Derive New Record Allows you to create a new bibliographic record based on 
the related bibliographic record and the default template. 
In addition, it also includes the relations supported by 
either the 773 or 775 field. For more information, see 
Deriving a New Bibliographic Record on page 169.

Table 21. MD Editor – Tools Menu

Action Description
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Find Matches

(Ctrl+M)

Checks whether there are matches for the current record 
in your local catalog. To define the correct match profile to 
be used, you must include the appropriate file key in the 
serial_match_profile and 
non_serial_match_profile Parameter Value 
column (Resource Management  > Resource 
Configuration > Configuration Menu > General > Other 
Settings). For detailed information on these file keys, see 
the table in Configuring Other Settings on page 695.

View Inventory

(Ctrl+I)

Checks for the following inventory linked to the 
bibliographic record and displays the results in split 
editor mode:

 Holdings

 Portfolios

 Representations (digital)

 Electronics databases

Since the bibliographic record can be linked to physical, 
digital, or electronic resources, they may all be listed.

View in Search Displays the record in the results list format on the 
Repository Search page.

View Orders Displays the record in the PO line list format on the Select 
PO Line page (when there is an order).

Related Records Checks whether there are records that were defined as 
related to the current record, on which the Record 
Relations job was run. For details, on creating and viewing 
related records, see The 77x Fields in Alma (under 
Alma > Product Documentation> Resource 
Management > How To Presentations).

MARC21 Holdings

Add Another Holding

(Ctrl+Alt+H)

Add another holdings record to the bibliographic record.

Add Item

(Alt+I)

Add an item record to the holdings record.

Duplicate Holding Add a copy of the holdings record to the bibliographic 
record.

Table 21. MD Editor – Tools Menu

Action Description



Chapter 4: Metadata Management

161January 2015

Alma Resource Management

Ex Libris Confidential

View Bibliographic 
Record

(Ctrl+Alt+B)

Display the bibliographic record.

Update from 
Bibliographic

(ALT+U)

Add fields from the bibliographic record to the 852 field in 
the holdings record, according to the following rules:

 For the 0 indicator, replaces the h and i subfields with 
the content of the bibliographic record’s 090 a and b 
subfields (respectively). If there is no 090 field in the 
bibliographic record, the 050 a and b subfields are used 
instead.

 For the 1 indicator, replaces the h and i subfields with 
the content of the bibliographic record’s 082 a and b 
subfields (respectively).

 For the 2 indicator, replaces the h and i subfields with 
the content of the bibliographic record’s 060 a and b 
subfields (respectively). 

 For the 3 indicator, adds the h and i subfields with the 
content of the bibliographic record’s 086 a and b 
subfields (respectively). If the h and i subfields are 
already populated, their values are left as is and not 
replaced.

 For the 8 indicator, adds the h subfield with a 
concatenation of the bibliographic record's 084 a 
subfield values. (If the h subfield is already populated, 
its value is left as is.) Also replaces the i subfield with a 
concatenation of the 084 b subfield values.

NOTE:
The above rules are the out-of-the-box settings, 
which are defined on the Call Number Mapping 
page (Resource Management > Resource 
Configuration > Configuration Menu > General > 
Call Number Mapping). For more information, see 
Mapping Call Numbers to Holdings on page 268.

Relink to a Different 
Bibliographic Record

Relinks the holdings record to a different bibliographic 
record.

Generate Accession 
Number

Generates an accession number for the holdings record in 
the 852 field.

Dublin Core

Find Matches Find the matching bibliographic record.

Table 21. MD Editor – Tools Menu

Action Description
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View Inventory Checks for the following inventory linked to the 
bibliographic record and displays the results in split 
editor mode:

 Holdings

 Portfolios

 Representations (digital)

 Electronics databases

Since the bibliographic record can be linked to physical, 
digital, or electronic resources, they may all be listed.

View in Search Displays the record in the results list format on the 
Repository Search page.

View Orders Displays the record in the PO line list format on the Select 
PO Line page (when there is an order).

Set Management Tags: 

Suppress from 
Discovery

Tags the record to exclude/include it from being published 
to the end-user discovery system (for example, Primo).

If a record has been suppressed, the Suppressed icon  
appears next to the record in the left pane of the MD 
Editor and in the repository search results.

Export to WorldCat Tags the record to be included/excluded in the OCLC 
synchronization.

Select the check mark to indicate how to handle the 
record.

Force export to 
WorldCat

Causes holdings records linked to the bibliographic record 
to be included in the next export to OCLC.

Export to Libraries 
Australia

Tags the record to be included/excluded in the Libraries 
Australia synchronization.

Select the check mark to indicate how to handle the 
record.

Force export to 
Libraries Australia

Causes holdings records linked to the bibliographic record 
to be included in the next export to Libraries Australia.

Table 21. MD Editor – Tools Menu

Action Description



Chapter 4: Metadata Management

163January 2015

Alma Resource Management

Ex Libris Confidential

Brief Indicates that the record does not have full bibliographic 
information. You cannot set the value of this tag since it is 
calculated by the system. 

When a brief record algorithm has been activated for your 
system, Alma checks to determine if a record is brief when 
it is saved to the repository. Subsequently, brief records are 
identified as brief with the highlighted check mark in the 
following manner (from Tools > Set Management Tags): 

Refer to Identifying brief records on page 307 in the Alma 
Administration Guide for more information.

Table 22. MD Editor – Toolbar

Action Description
Add Holdings Adds a holdings record that is linked to the current 

bibliographic record.

Save Record Saves the changes made to the record in the repository but 
does not release the record. use the Release Record option 
to release the record.

Create PO Line & Exit Opens the PO Line Owner and Type page (the first step in 
manually creating a PO line), exits the MD Editor page, 
and creates a PO line based on the bibliographic 
information in the active record. 

See Manually Creating a PO Line in the Alma 
Acquisitions Guide for more information.

(This requires the Inventory Operator role permissions).

Add Item Move to the Physical Item Editor to add an item for this 
holdings record. 

Table 21. MD Editor – Tools Menu

Action Description
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Saving Records in the MD Editor
The MD Editor has an auto-save function that helps prevent changes from being 
lost before you manually save the draft. These records are only available for 
editing to the user working on them and are persistent across Web sessions.

When you save a record in the repository, Alma automatically backs up the 
previous version and saves it for future reference. Previous versions continue to 
be available even after an open record has been saved and released in the 
repository, and may be restored in the repository. When you restore a previous 
version you overwrite the current version in the repository.

When you finish working on a record, you can save the record (from the File 
menu) or press Ctrl+S. The modified record is saved in the repository but 

View Inventory Opens a list of inventory records linked to the 
bibliographic record including links to item records. 
Depending on the inventory contents, the list may include 
holdings (physical resources), representations (digital 
resources) and/or portfolios (electronic resources).

Since the bibliographic record can be linked to physical, 
digital, or electronic resources, they may all be listed.

Delete Bibliographic 
Record

Deletes the bibliographic record from the repository. This 
option is available only if there are no PO lines or 
inventory associated with the bibliographic record. For 
information on deleting bibliographic records in bulk, see 
Batch Deleting Bibliographic Records on page 178.

View Bibliographic 
Record

Opens in split editor mode to display the associated 
bibliographic record when working with MARC21 
holdings.

Split Editor Enables a side-by-side editing of two records (although 
only one side is active at a time). Click the right panel, and 
click a record from the list of records. 

Full Screen Opens the main editing pane in the entire page.

Exit Exits the editor, and discards any unsaved changes (unless 
you select to save a draft upon exit). Exiting the editor 
does not release any records, and they remain checked out 
to you until you specifically release them using the 
Release Record option.

Table 22. MD Editor – Toolbar

Action Description



Chapter 4: Metadata Management

165January 2015

Alma Resource Management

Ex Libris Confidential

remains checked out to you until you specifically release it (File > Release 
Record).

Alternatively, you can reload the original record from the repository. This 
replaces the current draft with the current version of the record and deletes any 
changes you have made. The record remains checked out to you.

While editing a record, you can also save a draft record (without checking the 
record in), by pressing Ctrl+Alt+S.

Entering Diacritics and Special Characters in the MD Editor
When cataloging, you may need to enter diacritics, special characters, or non-
Latin characters in the MD Editor. 

To enter diacritics or special characters into the MD Editor:

1 From the Windows Start menu, select All Programs > Accessories > System 
Tools > Character Map.

2 Select a font from the Font drop-down list.

3 Click the special character that you want to insert into the MD Editor.

4 Click Select, and then click Copy.

5 Paste the character in the MD Editor. 

Expanding a Record from a Template
When the Expand from Template option is applied to a record in the MD Editor, 
the system uses the following process to expand data fields in the record:

1 Regardless of the template's indicators, the system groups all of the 
template's data fields according to their tags, keeping the occurrence order.

2 For each template group, the system performs the following:

a Regardless of the indicators, the system groups all of the record's data 
fields that match the template group's tag, keeping the occurrence order. 

b Performs the following comparisons on the first data field in the 
template's group with the first data field in the record's group as follows 
(followed by the next data field in each group and so forth). 

 If the template's data field contains a subfield that is not in the 
corresponding record's data field, the subfield is added to the 
corresponding record's data field.
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 If there is no corresponding data field in the record's group, the 
entire data field from the template is added to the record. 

For example, if the template's group contains the following data fields:

And the record's group contains only one matching data field:

The system will add the subfields from the first data field in the 
template's group to the first corresponding data field (ignoring the 
indicators) in the record's group, and also add the full second data field 
from the template's group to the record since the bibliographic record 
does not have a second matching data field:

VIDEO:
Learn more about expanding a record using a template in the Expand a 
Record Using a Template video (4:24 mins).

Field 1: 260 _3 $$a Boston $$c 1971
Field 2: 260 _3 $$a Boston $$c 1973

Field 1: 260 __ $$a New York

260 __ $$a New York $$c 1971
260 _3 $$a Boston $$c 1973

https://www.youtube.com/watch?v=PwGbonbgM-s&hd=1
https://www.youtube.com/watch?v=PwGbonbgM-s&hd=1


Chapter 4: Metadata Management

167January 2015

Alma Resource Management

Ex Libris Confidential

To expand a record:

1 Open a record in the MD Editor by clicking Edit for a specific title in your 
search results. The record displays in the MD Editor.

Figure 104: Example Record before Expansion

2 Click Edit > Expand from Template to display the Expand from Template 
dialog box.

Figure 105: Expand from Template Option in Edit Menu
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The following template is used for this example:

Figure 106: Example Expand Template

3 In the Expand from Template dialog box, select a template from the Choose 
Template drop-down list and click Ok to expand the record.

Figure 107: Expand from Template Dialog Box
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The following figure shows the expanded record, which includes new 008 
and 260 fields and expanded 245 and 260 fields:

Figure 108: Example Record after Expansion

Deriving a New Bibliographic Record
The Derive New Record tool on the MARC21 Bibliographic menu in the MD 
Editor allows you to use the related bibliographic record and the default 
template as the basis to create a new record that includes either of the following 
types of relations: 

 Host Item (773) – An analytical record that refers to a specific article in a 
journal that is described by another bibliographic record.

 Other Edition (775) – A record that describes other editions of the same 
bibliographic record.

Each of the above fields includes the following subfields, which are populated 
from the original related record:

 t – The original 245.a (title).

 w – A repeatable subfield that contains the 035.a subfield for each 035 field 
and an additional subfield that contains the original MMS ID.

 x – A non-repeatable ISSN (if it exists in 022.a). The tool uses the first 
occurrence only.

 z – A repeatable ISBN (if it exists in 020.a/020.e).

 g – Related parts. This is a required subfield, but it must be entered 
manually. The tool includes a placeholder in the field.
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 p – Abbreviated title. This is a required subfield, but it must be entered 
manually. The tool includes a placeholder in the field.

 q – Enumeration of first page. This is a required subfield, but it must be 
entered manually. The tool includes a placeholder in the field.

NOTE:
The system removes empty subfields when the new holdings record is 
saved.

In addition, this tool includes the following fields from the original related 
record and combines them with fields from the default template:

 050, 080, and 260 - Includes only the first occurrence from the original 
related record, but also includes other occurrences from the default 
template.

 300.c - Includes all occurrences of the 300 field that have a c subfield from 
the original related record. Note that tool copies only the c subfield from the 
original related record. 

To derive a new record:

1 Open the MD Editor (Resource Management > Cataloging > Open 
Metadata Editor).

2 Specify the default template and open the related record to which you want 
to link.

Figure 26: 

Figure 109: Select the Derive New Record Tool
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3 Select Tools > MARC21 Bibliographic > Derive New Record to open the 
Derive New Record dialog box.

Figure 27: 

Figure 110: Select the 773 or 775 Field

4 Select Host Item (773) or Other Edition (775) from the Choose Record Type 
drop-down list and click OK. The derived record opens.

For example, the following figure shows the fields that were used to 
populate the new derived record:

Figure 28: 

Figure 111: Original Related Record
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The following figure shows the results of the new derived record. The non-
highlighted fields are taken from the default template:

Figure 29: 

Figure 112: Derived Record Showing 775 Field and Other Derived Fields

5 Enter any additional fields and update the empty g, p, and q subfields in the 
773 or 775 field.

6 Save your changes to the new record.

Working with Bibliographic Records
There are many ways that Alma enables you to create, edit, and delete 
bibliographic records. This provides you with the flexibility to customize 
workflows to gain the most efficiency for managing your Alma repository.

The Alma repository can contain bibliographic records that represent physical, 
electronic, and digital resources. Using the Alma Metadata Editor, you can 
manually create bibliographic records for these resources (refer to Creating 
Bibliographic Records on page 173 for more information). 
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You can also create bibliographic records automatically using Alma processes 
for importing bibliographic data that comes from other sources in files that are 
external to the Alma system. For more information, refer to Managing Profiles 
for Record Imports on page 511. Additional information related to working 
with bibliographic records from external resources can be found in Resource 
Management on page 29 in Alma Integrations With External Systems.

The Community Zone is another component of Alma that can be used for 
quickly identifying resources and linking them to your local repository.

VIDEO:
For more information about the Community Zone, see the Alma 
Community Zone Intro and Task List video (14:10 mins).

If your Alma system is part of a collaborative network environment, common 
bibliographic records can be created and link throughout the network. For more 
information, refer to Working with Collaborative Networks (Consortia) in 
Alma on page 3 in the Working With Collaborative Networks in Alma  Guide.

Given the dynamic nature of your repository for adding, deleting, and 
modifying resources, Alma provides the tools needed for managing your 
bibliographic records. Refer to Managing Bibliographic Records on page 178 
regarding these capabilities.

Creating Bibliographic Records
Alma provides the MD Editor for creating individual bibliographic records. To 
customize the process of entering bibliographic records, you can use a template 
that you tailor to your needs (refer to Working with Templates on page 181 for 
more information).

To create a bibliographic record:

1 From the Alma main menu, click Open Metadata Editor.

2 Click File > New > MARC21 Bibliographic.

http://www.youtube.com/watch?v=biKoHRSc5DI&hd=1
http://www.youtube.com/watch?v=biKoHRSc5DI&hd=1
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Figure 113: File > New > MARC21 Bibliographic

The MD Editor opens a template for entering your bibliographic record.

Figure 114: Bibliographic Record Template

3 Enter the data for your bibliographic record. Refer to the section MD Editor 
Menu and Toolbar Options on page 155 for additional information 
regarding working with the MD Editor.

When entering the following fields, the system provides pop-up assistance: 

 260$a

 260$b

 260$e
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 260$f

 505$r

 505$t

 561$a

The pop-up assistance displays after you have typed the first three 
characters (refer to the illustration below).

IMPORTANT:IMPORTANT:
The pop-up assistance provided for these fields is not suggested 
authority/bibliographic headings.
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Figure 30: 

Figure 115: Pop-up Assistance Example (Not Suggested Headings)

To access suggested authority and bibliographic headings, press F3 from the 
field that you are entering/checking. The system opens a list of options from 
which to choose. If no headings suggestions are available, Alma displays No 
matching headings found.
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Figure 31: 

Figure 116: F3 Example - Suggested Authority and Bibliographic Headings

Local authorities are identified with the word (Local) in parentheses.

Preferred terms are identified with a star. Non-preferred terms are blank at 
the left (the absence of a star).

Click View to display the entire authority record.

Click Select to insert the content into the record on which you are working.

For additional information, refer to Working with Authority Records on 
page 184.

4 Click the Save icon. For additional information regarding saving records, 
refer to Saving Records in the MD Editor on page 164.

NOTE:
If you edit a field in an existing record that is related to another field in 
another record, the link between the records is broken when you save the 
edited record. Alma must run the MMS - Build Record Relations job 
(Administration > Manage Jobs > Monitor Jobs – Scheduled tab) in order 
for the link to be recreated. If you edit a field that is not related to a field in 
another record, the link between the records remains intact.
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Managing Bibliographic Records
Alma provides the capability to manage bibliographic records using a 
combination of record sets (refer to Adding and Modifying Sets on page 84) 
and Alma-provided processes (refer to Overview of Jobs on page 285 in the 
Alma Administration Guide). For information on deleting bibliographic records, 
refer to Batch Deleting Bibliographic Records on page 178.

Sometimes, you may find it helpful to modify your records with tools external 
to Alma. To address this requirement, Alma provides a Tools feature in your 
search results that allows you to export records to an Excel spreadsheet. Refer to 
Using the Portfolios List on page 73 for a description of the options Extended 
Export (to Excel) and Excel (current view).

Batch Deleting Bibliographic Records
With the appropriate permissions, you can batch delete bibliographic records 
that are not connected to orders or other records in the database (optional), and, 
for collaborative networks/network zone records, are not linked to other 
members’ records. You can also choose whether you want to delete the 
inventory associated with these records. For more information and instructions, 
see Running the Batch Delete Job on page 178.

Sets for the batch delete process can be saved from an All titles repository 
search. Records that cannot be deleted due to one of the conditions described 
above are identified in the job report (see Job Reports on page 180).

Running the Batch Delete Job

PERMISSIONS:
To run a batch delete job on bibliographic records, you must have one of 
the following roles:

 Cataloger Administrator 

 Cataloger Manager

To run the batch delete job:

1 On the Create Job - Select Job to Run page (Administration > Manage 
Jobs > Run a Job), select the Withdraw filter option or use the quick search 
(Find) feature and the search term delete.

2 From the filtered process list, select Delete bibliographic records and click 
Next.
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Figure 32: 

Figure 117: Delete Bibliographic Records Process Option

3 From the Create Process – Select Set page, select the set that you previously 
created for the delete process and click Next.

Step 3 of the wizard, Enter Task Parameters, opens.
Figure 33: 

Figure 118: Delete Bibliographic Records Task Parameters

4 Select the Do not delete if related to other records check box if you want to 
keep records that are related to other records in the database. To allow these 
records to be deleted, leave the check box blank.

5 Select the Delete all associated inventory resources check box if you want 
to delete the inventory associated with the bibliographic records that are 
being deleted.

6 Click Next.

7 Enter a process name, select the schedule, and click Next.

The Review and Confirm page opens.
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Figure 34: 

Figure 119: Create Process - Review and Confirm Page

8 Review the information provided on the Create Process – Review and 
Confirm page. To make corrections, use the Back link to get access to the 
page containing the change you want to make. When the job is correct, click 
the Submit button.

Alma takes you to the Running tab of the Monitor Jobs page. Your job 
should appear there, unless it ran very quickly or you scheduled it to run at 
a later time. Click the Refresh button to check the progress. 

Job Reports
When a job finishes running, its entry listing moves from the Running tab to the 
Completed tab. You can view a report of it by finding it in the Completed tab, 
then, in its row, selecting Actions > Report.

The job report includes counts for the following and an option to download a 
detailed Excel file (refer to the illustration below) of the report (with MMS IDs):

 Deleted bibliographic records

 Bibliographic records with inventory

 Bibliographic records with POs

 Bibliographic records related to other records

 Bibliographic records linked to collaborative network members’ records



Chapter 4: Metadata Management

181January 2015

Alma Resource Management

Ex Libris Confidential

Figure 35: 

Figure 120: Batch Delete Report Counts

To see the report of deleted bibliographic records for this job—including, for 
collaborative network users, a list of your institutions that are associated with 
retained records—click the Click to download report text.

Figure 36: 

Figure 121: Excel Report Including which CN’s Institutions Using Which Records

Working with Templates
The MD Editor enables catalog managers to create templates in which they can 
predefine the fields that they want to be included, by default, in original 
cataloging records. Catalogers are thus able to increase their productivity by 
working more efficiently with these predefined templates. 

New templates can be created from existing records or from existing templates. 
Templates may be shared among catalogers or private. When you view the 
shared template of another cataloger, the template appears with a Draft icon. 
Currently, you can only edit the shared templates that you created yourself, but 
you cannot edit the shared templates that were created by someone else.
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NOTE:
Out-of-the-box default templates cannot be edited or deleted.  
For default templates (templates that have the Draft icon ), only the 
New, Duplicate, and Properties options are available.

To access existing templates:

1 On the MD Editor page (Resource Management > Cataloging > Open 
Metadata Editor), click the Templates tab in the left panel. The MD Editor 
Templates tab opens.

Figure 122: MD Editor Page Templates Tab

2 Open the required folder (for example, MARC21 - Bib) and browse to the 
template you want to access.
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Figure 123: MD Editor Page Templates Tab Template Selected

3 Click the template and choose one of the following options:

 New Record – Opens a new record in the MD Editor based on the 
selected template.

 Edit – Enables you to edit the template.

Figure 124: MD Editor Page Templates, Edit Record

NOTE:
In the above example, the Alerts tab lists the fields that contain errors and 
require editing.
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 Delete – Click Yes to confirm that you want to delete the template.

 Duplicate – Duplicates the selected template enabling you to modify 
and save it as a new template without affecting the original template. 
Before duplicating the record, the Template Properties dialog box opens 
enabling you to define the properties of the new template.

Figure 125: Template Properties Dialog Box

Enter a Name (required field) and Description for the template and 
specify Private or Shared. If you select Shared and want the template to 
serve as the default template for newly created records, select Default. 
Click Save to save the new template.

 Properties – Enables you to modify the template properties (see 
Figure 125).

Working with Authority Records
Alma provides a set of authority records that are updated and maintained 
regularly by Ex Libris in the Community Zone (CZ). Alma maintains the 
following vocabularies:

 LC Subject (LCSH) – Library of Congress Subject Headings (updated 
weekly)

 LC Name (LCNAF) – Library of Congress Name Authority File (updated 
weekly)

 NLM MeSH – United States National Library of Medicine Medical Subject 
Headings (updated as available)
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 Integrated Authority File (GND) – German National Library - Subjects and 
Names Authorities (updated weekly) 

 BARE (Norwegian Authority System) – BIBSYS Authority Registry - 
Subjects and Names Authorities (initial load performed, currently not 
updated)

Refer to Working with Norwegian Authority System (BARE) Records on 
page 212 for more information.

NOTE:
Multiple subject authorities can be used by Alma, but only one type of 
names authority can be used. For example, if Alma is defined to use 
LC_Names, it cannot also use GND names authorities. 

If local authorities are enabled for your institution (must be enabled by Ex Libris 
Support), you can create local authority records, which override the global 
authority records provided with Alma in the CZ. For more information, refer to 
Creating Local Authority Records on page 190.

Alma runs the following processes automatically every day to authorize the 
bibliographic records in your catalog:

 Authorities - Handle local record authority updates – If local authority 
functionality is enabled (must be enabled by Ex Libris Support), this process 
uses all recently updated local authority records to mark all non-linked 
bibliographic headings that are a match to them. The marked headings are 
then linked to the authority records via the Authorities - Link BIB 
Headings process.

 Authorities - Link bibliographic headings – This job searches all authority 
record fields, including subdivision fields, for complete terms listed in 
bibliographic records (giving priority to local authorities, if enabled). If 
exact matches are found, the bibliographic records are linked to the 
corresponding authority records. If exact matches are not found, the 
subdivision fields are disregarded, a search of all authority records is 
performed once again, and the bibliographic records are linked to the 
matching authority records that are located during the second search.

 Authorities - Preferred term correction – This job performs preferred term 
correction on all biliographic records that are linked to authority records via 
the Authorities - Link bibliographic headings job. For example, if a 
bibliographic record contains the non-preferred term “Narcotics, Control 
of,” and the associated authority record contains the preferred term “Drug 
control,”the Authorities – Preferred Term Correction job replaces 
“Narcotics, Control of” with the preferred term “Drug control.” Note that 
bibliographic records are also updated with any subsequent updates to 
authority records.

For customers in implementation, the Authorities - Preferred Term 
Correction job will be enabled by default upon "Go Live." For customers 
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currently in production, this job is disabled by default. To enable it, you 
must set the disable_preferred_term_correction_job parameter 
(Resource Management > Resource Configuration > Configuration 
Menu > General > Other Settings) to false. Subsequently, access the 
Scheduled tab of the Monitor Jobs page (Administration > Manage 
Jobs > Monitor Jobs) and confirm that the Authorities - Preferred Term 
Correction job is active (yellow check mark in the Active column).

IMPORTANT:IMPORTANT:
The Authorities - Preferred Term Correction job does not handle 
preferred term correction on records retroactively. It handles preferred 
term correction only for authority record updates and link updates that 
occur after the Authorities - Preferred Term Correction job is enabled.

For a list of punctuation rules that are implemented when bibliographic records 
are updated from the authority database, see Punctuation Rules for Updated 
Bibliographic Records on page 210.

To view the details of a completed job, see Viewing Job Reports for Authority 
Processes on page 207.

Additional information provided in this section includes:

 Local authorities in Alma

 Creating Local Authorities on page 187

 Creating Local Authority Records on page 190

 Creating Local Authority Records Using the MD Editor on page 191

 Creating Local Authority Records Using an Import Profile on 
page 193

 Deleting local authorities using the Delete local authority records job – 
see Table 18 in the Alma Administration Guide.

 Export a set of local authorities using the Export Authority records job – 
see Table 18 in the Alma Administration Guide.

 Performing Global Changes on Locally Managed Authority Records 
on page 197

 Managing Authority Records in the MD Editor on page 202

 Viewing Job Reports for Authority Processes on page 207

 Punctuation Rules for Updated Bibliographic Records on page 210

 Handling Deleted Authorities During Metadata Imports on page 212

 Working with Norwegian Authority System (BARE) Records on page 212

 Using Originating System IDs for Linking Bibliographic Records to 
Authority Records on page 215
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VIDEO:
Learn about how to show authority records in the MD Editor in the Show 
Authority Records in MD Editor video (3:27 mins).

Creating Local Authorities
In Alma, you can create local authorities or vocabularies to use when entering 
authority records with the MD Editor or importing authority records using an 
import profile. 

NOTES:
 In order to use local authorities in Alma, Ex Libris Support/your Ex Libris 

Professional Services representative must enable local authority 
functionality for your institution. 

 Multiple subject authorities can be used by Alma, but only one type of 
names authority can be used. For example, if Alma is defined to use 
LC_Names, it cannot also use GND names authorities. Thus, you should 
define only one type of Name or Names and Subjects local vocabulary. 
For information on the code to be used for the defined names authority, 
see the Code entry in Table 23 below.

To create a local authority (vocabulary):

1 On the Resource Management Configuration page (Resource 
Management > Configuration > Configuration Menu), click Metadata 
Configuration in the Cataloging section. The Metadata Configuration List 
page displays.

2 Click Manage Local Authorities.

3 Click Add Local Authority. The Add Local Authority dialog box displays.

Figure 126: Add Local Authority Dialog Box

http://www.youtube.com/watch?v=Qdoidb1Arr0&hd=1
http://www.youtube.com/watch?v=Qdoidb1Arr0&hd=1


Alma Resource Management

January 2015188

Chapter 4: Metadata Management

Ex Libris Confidential

4 Complete the information on the Add Local Authority dialog box (see the 
table below for more information).

Table 23. Add Local  Authority Dialog Box

Parameter Description
Name Enter a name to identify this local authority. This name 

displays in the Vocabulary Name column on the Local 
Authority Registry page where you can select the row 
actions to edit and delete the local vocabularies that 
you have created.

Configuration Enter a name to identify this local authority on the 
Metadata Configuration List page. This name displays 
in the Configuration column on this page and on the 
Local Authority Registry page.

This name also displays in the MD Editor where you 
enter your local vocabulary terms.

Code Enter an identifying code for this local authority that 
displays in the Vocabulary column on the Metadata 
Configuration List page, the Code column on the Local 
Authority Registry page, and the Vocabulary code 
drop-down list on the Import Profile Details page for 
authority profiles.

If the authority indication is in the bibliographic 
record’s second indicator 7, subfield 2, the code must 
match what is in this subfield 2. This is relevant for 
Subject and Names and Subjects types of local 
authorities.

For the Name type of local authority (of which only one 
should be created – see the note above, at the beginning 
of this section), the code must match the 
authority_names customer parameter value that was 
entered for your institution by Ex Libris staff. If you are 
unsure of the defined value for this parameter, contact 
an Ex Libris representative. 

Type Select from the following options available in the drop-
down list:

 Subject

 Name 

 Names and subjects 

NOTE:
No more than one name type of local vocabulary 
should be created.
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5 Click Add and Close. The local authorities vocabulary that you created 
displays on the Local Authority Registry page.

Figure 127: Local Authority Registry Page

6 Click Save. The local authorities vocabulary configuration that you created 
displays on the Metadata Configuration List page.

Figure 37: 

Figure 128: Metadata Configuration List Page

You can now manually enter local authority records or import local 
authority records using the local authority profile that you configured (see 
Creating Local Authority Records on page 190 for more information). The 
local vocabulary that you created displays in the MD Editor File > New 
options and in the Import Profile Details Vocabulary code drop-down list.

Description Use this option to more fully identify the local 
authority that you are creating.

Table 23. Add Local  Authority Dialog Box

Parameter Description
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Figure 129: Create Local Authority Record

Creating Local Authority Records
You can create local authority records by:

 Using the MD Editor (see Creating Local Authority Records Using the MD 
Editor on page 191)

 Using an import profile (see Creating Local Authority Records Using an 
Import Profile on page 193)

NOTES:
 In order to use local authorities in Alma, Ex Libris Support/your Ex Libris 

Professional Services representative must enable local authority 
functionality for your institution.

 To create a local authority record (either via the MD Editor or via an 
import profile) for an authority vocabulary that exists in the Community 
Zone (CZ ), you must first create this local authority (vocabulary) in your 
institution if it does not already exist. For example, if the CZ has a 
defined authority (vocabulary) for REO, but is missing a specific 
authority record that you want to create locally, before you create the 
authority record locally, you must ensure that the local authority 
(vocabulary) for REO exists in your institution. For information on 
creating local authorities (vocabulary), see Creating Local Authorities on 
page 187.

 You can delete local authorities using the Delete local authority records 
job – see Table 18 in the Alma Administration Guide.
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Creating Local Authority Records Using the MD Editor
When you want to create a single local authority record, you can use the MD 
Editor.

To create a local authority record:

1 Open the MD Editor (Resource Management > Cataloging > Open 
Metadata Editor).

2 Click File > New and select from the list of local vocabularies that have been 
created/implemented for your system (see Creating Local Authorities on 
page 187, or if the local authority vocabulary is an extension of a global one, 
it appears here automatically as an option with no predefinition required), 
such as:

 (local) LC Subject (LCSH)

 (local) LC Name (LCNAF)

 (local) NLM MeSH 2013

 (local) Integrated Authority File (GND)

NOTE:
Multiple subject authorities can be used by Alma, but only one type of 
names authority can be used. For example, if Alma is defined to use 
LC_Names, it cannot also use GND names authorities. For more 
information, see Creating Local Authorities on page 187, Table 23.

Figure 38: 

Figure 130: Create New Local Authority Records (Select Vocabulary)

3 Choose a template (see Working with Templates on page 181) and enter the 
authority record data/terms.
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Figure 39: 

Figure 131: Local Authority Record Data Entry

4 Click File > Save and Release Record.

You can view the record you entered using an Authorities search.
Figure 40: 

Figure 132: Local Authority Record Search

You can now create a bibliographic record that uses the local authority record/
terms that you created/saved. Preferred terms are marked with a star as shown 
in the figure below.
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Figure 133: New Bibliographic Record Linking to the Local Authority Record You Created

NOTE:
If you select a non-preferred term, the MD Editor will automatically 
populate the bibliographic record with the preferred term.

Creating Local Authority Records Using an Import Profile
When you want to create multiple local authority records, you can create and 
process an authority import profile.

NOTE:
Multiple subject authorities can be used by Alma, but only one type of 
names authority can be used. For example, if Alma is defined to use 
LC_Names, it cannot also use GND names authorities. For more 
information, see Creating Local Authorities on page 187). Table 23.
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To create local authority records using an import profile:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 
click the Add New Profile button. The Import Profile Details page displays.

2 For the profile type, select Authority or Initial Authority to import 
authority records.

Figure 134: Select Import Profile Type (for Authority Records)

In general, the Authority option is selected for ongoing authority record 
updates; and the Initial Authority option is for your initial load of local 
authority records (when only loading and no normalization or matching is 
required).

NOTE:
In order to use local authorities in Alma, Ex Libris Support/your Ex Libris 
Professional Services representative must enable local authority 
functionality for your institution.

3 Click Next. The Import Profile Details page displays.
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Figure 135: Import Profile Details Page - Authority Profile Type

4 Enter the profile details. Note that the Vocabulary code drop-down list 
contains a list of local authorities that have been created/implemented for 
your system (see Creating Local Authorities on page 187, or if the local 
authority vocabulary is an extension of a global one, it appears here 
automatically as an option, with no predefinition required).

If you choose to create MARC21 XML files (for your source), use the 
standard MARC21 XML format as shown below.

5 Click Next.

<?xml version="1.0" encoding="UTF-8"?>
<collection xmlns="http://www.loc.gov/MARC21/slim">
<record xmlns="http://www.loc.gov/MARC21/slim">
<leader>00096nam a2200049 i 4500</leader>
<controlfield tag="003">EXL</controlfield>
<datafield tag="245" ind1="0" ind2="0">
<subfield code="a">bibliographic record sample</subfield>

</datafield>
<datafield tag="949" ind1="0" ind2="0">
<subfield code="a">1234</subfield>

</datafield>
</record>
<record xmlns="http://www.loc.gov/MARC21/slim">
<leader>00096nam a2200049 i 4500</leader>
<controlfield tag="003">EXL</controlfield>
<datafield tag="245" ind1="0" ind2="0">
<subfield code="a">bibliographic record sample2</subfield>

</datafield>
<datafield tag="949" ind1="0" ind2="0">
<subfield code="a">12345</subfield>

</datafield>
</record>

</collection>
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6 Select the normalization and validation options as needed.
Figure 41: 

Figure 136: Normalization and Validation Options

NOTE:
The normalization and validation options do not display when the Initial 
Authority profile type is selected. By design, this provides the benefit of 
faster processing for the typically larger initial loads.

7 Click Save. Your import profile is saved and displays on the Run Import 
page.

8 For the profile you created, select Actions > Run Import.
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Figure 42: 

Figure 137: Run Import

9 Enter the name of the file to be imported and click Add and Submit the job 
to run.

For additional information regarding import profiles, refer to Configuring New 
Import Profiles on page 512.

Performing Global Changes on Locally Managed Authority 
Records

Alma provides support for making global changes to locally managed 
authorities. This capability is implemented using Drools-based rules similar to 
the Alma capability available for MARC 21 bibliographic normalization jobs.
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To create the Drools-based rule for local authority normalization:

1 Open the Metadata List Configuration page (Resource Management > 
Resource Configuration > Configuration Menu > Cataloging section > 
Metadata Configuration). 

Figure 43: 

Figure 138: Locally Managed Authority Configuration

2 Click the MARC21 Authority link for the local authority for which you want 
to create a Drool-based normalization rule. The Fields tab of the Profile 
Details page opens.

3 Select the Normalization Processes tab.
Figure 44: 

Figure 139: Normalization Processes Tab

4 Click Add Process. The Process Details wizard step 1 page opens. 
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Figure 45: 

Figure 140: Process Details Page - Wizard Step 1

5 Enter the Name, Description, and Status; and click Next. Wizard step 2 of 
the Process Details page opens.

Figure 46: 

Figure 141: Process Details Page - Wizard Step 2

6 Select the MARC Normalization Rules process and click Add to Selection.
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Figure 47: 

Figure 142: - MARC Normalization Rules Process Selected 

7 Click Next. Wizard step 3 of the Process Details page opens.
Figure 48: 

Figure 143: Process Details Page - Wizard Step 3

8 From the drop-down list, select the Drools File Key that you created for this 
process job (refer to Working with Normalization Rules on page 220 for 
additional information).
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9 Click Save. The new normalization rule displays in the Normalization tab of 
the Profile Details page and can be edited, copied, or deleted using the 
Actions options. 

To run a normalization job using the normalization rule/process you 
created:

1 Open the Create Job – Select Job to Run page (Administration > Manage 
Jobs > Run a Job).

2 Select MARC 21 Authority Normalization from the Type filter drop-down 
list. The normalization rules that you have created display on the Create Job 
– Select Job to Run page.

Figure 49: 

Figure 144: MARC 21 Authority Normalization Filter

3 Select the normalization rule/job that you want to run and click Next.

4 Select the set of authority records against which you want to process the 
normalization rule that you selected in the previous step.

5 Select the Drools File Key that contains the normalization logic you want to 
use for this job. The system defaults to the Drools File Key that you selected 
when you created the MARC 21 authority normalization rule.

Figure 50: 

Figure 145: Drools File Key Selection

6 Complete the remainder of the job setup as you normally would.
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Managing Authority Records in the MD Editor
The MD Editor provides catalogers with quick navigation to the authority 
records that are associated with a bibliographic record that is being edited using 
the Alma MD Editor. For additional information, see: 

 Linking an Authority Record to a Bibliographic Record on page 202

 Viewing Linked Names/Subject Headings from a Bibliographic Record 
on page 206

Linking an Authority Record to a Bibliographic Record
The MD Editor allows you to link to a suggested authority record quickly from 
an authority-controlled field (100-199, 600, 610-619, 630, 700 710 730, 800, 810-
819, 830, 440, 490, 648, 650,651, 654, 655, 748, 751, 754) in a bibliographic record. 
It also enables you to a view a read-only version of a suggested authority record 
and view the bibliographic records that are linked to this authority record.

In addition to the Name and Subject Headings authority support for the 
following bibliographic fields that are mapped to authority headings, Alma 
provides mapping for the bibliographic 490$a and 440$a (obsolete) and an F3 
lookup for these fields in the Alma MD Editor. The 490$a (and 440$a) lookup is 
pulled from the authority record 130$a and 430$a:

 130 – Main Entry – Uniform Title

 630 – Subject Added Entry – Uniform Title

 730 – Added Entry – Uniform Title

 830 – Series Added Entry – Uniform Title

With the F3 lookup (refer to the procedure below for more information), you are 
provided the option to select your preferred series statement from a predefined 
list that is displayed in the MD Editor. The system does not do automatic 
linking/preferred term correction as part of the authorities daily processing for 
the 490$a/440$a since the 490$a/440$a series statement represents the 
information (the way that a series is named) on the book itself. (Refer to  
http://id.loc.gov/authorities/names.html for more information.) 
However, you can do an F3 lookup in the MD Editor for the 490$a/440$a series 
statement and optionally Select the preferred authorities to update the 
bibliographic 490$a/440$a. Refer to the example below.
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Figure 51: 

Figure 146: - F3 Lookup for 490$a

To view/link to an authority record from an authority-controlled field:

1 Open a new or existing bibliographic record in the MD Editor.

2 In an authority-controlled field (100-199, 600, 610-619, 630, 700 710 730, 800, 
810-819, 830, 440, 490, 648, 650,651, 654, 655, 748, 751, 754), type at least three 
characters of the author’s name or subject heading and then click F3 to 
display a list of suggestions. 
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Figure 52: 

Figure 147: Suggested Terms List

If you do not see the name or subject heading you are looking for in the list, 
you may need to type additional characters in the field to narrow the results.

3 Click one of the following buttons:

 Select – Links the selected authority name or subject heading to your 
bibliographic record.

 View – Opens a read-only version of the full authority record on the 
right side of the split screen. 

NOTE:
Local authorities are indicated by (Local) to the right of the title. A star to 
the left of the title indicates the preferred term. With any selection, the 
preferred term immediately replaces the non-preferred term.
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For example:
Figure 53: 

Figure 148: Viewing Suggested Authority Headings

If the authority record is local, not locked by another user, and not 
already included in the authority draft list, you are able to add it to your 
authority draft list by clicking the Add Record to Editing List button.

For example:

Figure 149: Viewing Suggested Authority Headings - Local Authority 

To view the bibliographic records that are linked to a suggested authority 
record:

A Bibliographic Records tab is available on the right side of the split screen, 
enabling you to view a list of local bibliographic records that are linked to the 
selected authority record. 
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For example:
Figure 54: 

Figure 150: View Linked Bibliographic Records

When you click the View link for a result, Alma displays a full, read-only 
bibliographic record.

Viewing Linked Names/Subject Headings from a Bibliographic 
Record

The MD Editor allows you to view linked names/subject headings quickly from 
an authority-controlled field (100-199, 600, 610-619, 630, 700 710 730, 800, 810-
819, 830, 440, 490, 648, 650,651, 654, 655, 748, 751, 754). 

To view a linked name/subject heading:

1 Open a bibliographic record in the MD Editor.

If an authority-controlled field is linked to a name/subject heading, a 
magnifying glass icon appears next to the field.
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Figure 55: 

Figure 151: Linked-Field Indicator

2 Click the icon to display the linked name/subject heading in split-screen 
mode. 

Figure 56: 

Figure 152: View Name/Subject Heading in Split-Screen Mode

Viewing Job Reports for Authority Processes
Alma allows you to view the job reports for the authority process jobs. 
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To view a job report:

1 From the Monitor Jobs page (Administration > Manage Jobs > Monitor 
Jobs), select the Scheduled tab.

Figure 57: 

Figure 153: Repository Filter

2 From the Filter list, select Repository.
Figure 58: 

Figure 154: Authority Processes

NOTE:
For a detailed explanation of these jobs, see Working with Authority 
Records on page 184. For information on running and monitoring 
imports, see Running a New Import Job on page 565. For information on 
other authority/local authority jobs that can be run, see: 
 
- the Delete local authority records job described in Table 18 in the Alma 
Administration Guide 
- the Export authority records job described in Table 18 in the Alma 
Administration Guide 
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- the Unlink bib records from authority records job described in Table 18 
in the Alma Administration Guide 
- Performing Global Changes on Locally Managed Authority Records 
on page 197

3 For an authority process, click Job History.
Figure 59: 

Figure 155: Authority Job History

4 For a job in the list, select Actions > Report.
Figure 60: 

Figure 156: Download the Bibliographic Record Correction Report from Alma (.xlsx File)

Figure 61: 

Figure 157: Bibliographic Record Correction Report Example
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The bibliographic record correction report contains the following information:

 MMS record ID

 Vocabulary code

 Field number

 Old value

 New value

Punctuation Rules for Updated Bibliographic Records
The following punctuation rules are implemented when bibliographic records 
are updated from the authority database:

Table 24. Punctuation Rules

(1)
Tag & 
Indicators

(2)
Subfield to 
Which 
Punctuation Is 
Added

(3)
Subfield 
Following the 
Subfield in 
Column (2)

(4)
Punctuation 
to Be Added

(5)
If 
Punctuation 
Exists/Does 
Not Exist 
Condition

1#### a . .

1#### d . -.

100## a 4 .

100## d 4 ,

110## b . .

600## a . .

600## b a ,

600## d a , ,

600## d . .,

600## q . ).

600## t . ).

6#### a . -).

6#### v . .

6#### x . ).

6#### y . .
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Column (1) = This column specifies the tag and indicators to which the rule 
applies.

Column (2) = This column identifies the subfield to which the punctuation may 
need to be added. If nothing is specified in Column (3), the subfield in column 
(2) is assumed to be the last subfield specified for the tag.

Column (3) = This column specifies the subfield that follows the subfield in 
column 2 when punctuation may need to be added.

Column (4) = This column identifies the punctuation that is to be added when 
the rule conditions are met.

Column (5) = This column is used to determine whether or not the punctuation 
in column (4) is added to the subfield identified in column (2). It provides the 
following rule conditions:

6#### z . .

7#### a . -).

7#### a 4 .

7#### a e ,

7#### a d , -).,

7#### d e , -).,

7#### c e , -).,

7#### q e ,

7#### b . .,

7#### b e . .,

7#### d . .,

7#### d t . .

800## t v ; ;

810## t v ; ;

83### a v ; ;

Table 24. Punctuation Rules

(1)
Tag & 
Indicators

(2)
Subfield to 
Which 
Punctuation Is 
Added

(3)
Subfield 
Following the 
Subfield in 
Column (2)

(4)
Punctuation 
to Be Added

(5)
If 
Punctuation 
Exists/Does 
Not Exist 
Condition
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 If any of the punctuation specified in this column exists, the punctuation 
specified in column (4) is not added.

 If there is no punctuation specified in this column (the cell is blank), the 
punctuation in column (4) is added if all other conditions are met.

Handling Deleted Authorities During Metadata Imports
Alma allows you to delete global authority records that have been marked for 
deletion (which is indicated by a d, s, or x in the fifth position of the record's 
LDR) during metadata imports. For example, the following record has the fifth 
position set to d:

Figure 62: 

Figure 158: Record Marked for Deletion

Working with Norwegian Authority System (BARE) Records
Alma provides support for the Norwegian Authority System (BARE) authorities 
in the Community Zone (CZ) and the ability for authorized contributing 
institutions to seamlessly submit approved authority records to the BARE 
database and the Alma CZ in an E2E workflow from directly within Alma.

In order to contribute BARE authority records, your institution needs to be 
configured in the CZ by Ex Libris. Submit a SalesForce case to request Ex Libris 
to configure your authorization in the CZ.
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BARE data has been added to the CZ, and Ex Libris has added and will 
maintain the list of BARE contributing institutions with permission to update 
the BARE database.

With this capability, you can create, update, or delete BARE authority records 
using the Alma MD Editor. When you save a new or updated record or delete a 
BARE record in the Alma MD Editor, a request is sent to BARE for approval (via 
SRU/U protocol). If an approved record response is returned, the record is saved 
in the Alma CZ and the master BARE database. Otherwise, an error message is 
displayed to the user in the MD Editor, and whatever issue BARE has with the 
record will need to be resolved.

Changes accepted by BARE are incorporated into the master BARE database 
and become available to all Alma users through the CZ. Ex Libris will regularly 
update the CZ with BARE changes to include those changes made outside the 
Alma environment.

Using the existing method (F3), MARC 21 bibliographic records can be created 
or edited in the Alma MD Editor using BARE authorities. Refer to the section 
Creating Bibliographic Records on page 173 for more information.

To contribute/submit a BARE record for approval:

1 Open the MD Editor (Resource Management > Cataloging).

2 Click File > New > BARE to create a new record. 
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Figure 63: 

Figure 159: BARE Contribution Option

3 Enter the authority record details.

4 Click the Save icon.

Alma submits the record to BARE for approval. If there is an error, BARE 
responds through the Alma MD Editor with an error message. If the 
contributed record is approved, it is stored in the CZ and the master BARE 
database.
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Using Originating System IDs for Linking Bibliographic 
Records to Authority Records

Alma provides support for using originating system IDs for linking 
bibliographic records to specific authority records. Alma enables this capability 
by using $0 in one of the control fields of a bibliographic record to store the 
originating system ID for the authority record (pulled from the authority record 
035 $a) to which you want to link the current bibliographic record.

The default method in Alma for linking bibliographic records to authority 
records is via text matching as described in Creating Bibliographic Records on 
page 173 and Linking an Authority Record to a Bibliographic Record on 
page 202. If you, additionally, choose to use the originating system ID method 
for linking, you need to have Ex Libris set the use_marc_sf_zero_as_auth_id 
customer parameter to true.

Refer to Table 25 for a list of the control fields that are supported for this 
capability.

Table 25. Control Fields Supported

Type Control Fields
Authority Names

NOTE:
The originating system is determined by the authority_names 
setting Ex Libris defines in your Customer Parameters mapping. 
For example, if authority_names is set to LCNAMES, the 
originating system is the Library of Congress. 

100, 110, 111, 130, 
600, 610, 611, 630, 
700, 710, 711, 730, 
800, 810, 811, 830

Authority Subjects

The originating system is determined by the field’s second indicator as 
identified in the following list:

 0=LCSH

 1=LCSHKIDS

 2=MESH 

 3=NAL

 4

 5=CSH

 6=RVM

 7=as defined in subfield 2

648, 650, 651, 654, 
655, 751 

As defined in subfield 2 751, 752, 754



Alma Resource Management

January 2015216

Chapter 4: Metadata Management

Ex Libris Confidential

Once a bibliographic record has $0 stored with the originating system ID for a 
specific authority record, the Alma daily process to update records will use the 
specific $0 information to update the authority linked bibliographic records.

To insert $0 with the originating system ID into a bibliographic record:

1 Open the bibliographic record to which you want to add $0 in the MD 
Editor.

2 Make the control field to which you want to add the $0 the active row and 
press F3. The headings from authority records are displayed.

Figure 64: 

Figure 160: F3 Authority Suggestions List

3 Click View for the authority record you prefer. The MD Editor displays the 
details of the authority record in Split Editor mode. 
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Figure 65: 

Figure 161: Authority Record Details in Split Editor Mode

4 Review the authority record details, confirm that this is the authority record 
to which you want to link the bibliographic record, and click Select from the 
list of suggestions. 



Alma Resource Management

January 2015218

Chapter 4: Metadata Management

Ex Libris Confidential

Figure 66: 

Figure 162: Click Select for the Preferred Authority

$0 is automatically added to the control field from which you initiated this 
process with the originating system ID pulled from the authority record’s 
035 $a.
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Figure 67: 

Figure 163: $0 Created

5 Save your bibliographic record.

Now that this control field contains $0, pressing F3 displays only the 
authority record with the originating ID that is stored in $0.

Figure 68: 

Figure 164: Only the Authority Record with the Originating ID stored in $0 is Displayed
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Working with Normalization Rules

PERMISSIONS:
To work with normalization rules, you must have the following role:

 Catalog Administrator

The Metadata (MD) Editor enables you to create normalization rules and apply 
them to MARC 21 records, or apply normalization rules that have already been 
created to records, so that changes to MARC 21 bibliographic metadata can later 
be made globally, in bulk. The syntax required for the rules is described in 
Normalization Rules – Syntax and Examples on page 224.

Using the preview functionality, you can:

 View the normalization rules and metadata records side by side

 Preview the outcome of a rule file when run on a metadata record

 Toggle between the rule file and the preview changes

 Edit rules and test immediately

This section describes how to create a normalization rules file, work with 
previously created rules files, and preview the outcome of a rules file when it is 
run on a single metadata record. For information on running a normalization 
rules file on a set of records, see Running Jobs on Defined Sets on page 305.

NOTE:
For additional information on normalization rules, see Using Normalization 
Rules in the Documentation Center. Note that you must be logged in to the 
Documentation Center in order to view this document.

VIDEO:
For a video on Normalization rules, see Normalization Rules (41:07 mins). 
For a detailed Ask the Expert session on configuring normalization rules, 
see Normalization Rules.

https://exlibris.webex.com/exlibris/lsr.php?RCID=6a4c57259454cec10eeb7694c0f44163
http://www.youtube.com/watch?v=l-cpDNfwr6s&hd=1
http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/Using%20Normalization%20Rules.pdf
http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/Using%20Normalization%20Rules.pdf
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To create a new normalization rule file:

1 On the MD Editor page (Resource Management > Cataloging > Open 
Metadata Editor), select File > New > Normalization Rule. The 
Normalization Rules Properties dialog box opens.

Figure 165: Normalization Rules Properties Dialog Box

2 Enter a name (required) and a description for the normalization rule file.

3 Select an access option, Private or Shared. If you select the former, only you 
can work on the rule and the rule cannot be included in a normalization 
process. If you select the latter, your rule will be shared among catalogers. In 
this case, more than one user can view the rule at the same time, and if two 
or more people have the rule open for editing, a warning message appears 
when one of you tries to save changes. (You have the option of keeping your 
changes or allowing the other user to make and save changes.)

4 To enable the rule, click the Enabled check box . (By default, the 
normalization rule file you create is disabled.)

5 Click Save. A text box, in which you enter the rule or rules, opens.

You can include existing rule syntax (Edit > Add Rule >Marc 21 Bib 
Snippet {type of rule}) or define a rule using the syntax described in 
Normalization Rules – Syntax and Examples on page 224.
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The following is an example of a normalization rule:

Figure 166: Normalization Rule Example

6 Click Save. The rule file is added to the list of rule files in the Normalization 
Rules tab.

To work with an existing normalization rule file:

1 On the MD Editor page (Resource Management > Cataloging > Open 
Metadata Editor), click the Rules tab and expand the MARC 21 
bibliographic list to display the saved rule files.

Figure 167: Rules Tab
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2 Click the rule file with which you want to work and select one of the 
following options:

 Edit – Opens the text box with the rule(s) syntax, enabling you to 
modify this syntax (for details, see Normalization Rules – Syntax and 
Examples on page 224).

 Delete – Click Yes to confirm the rule file’s deletion. 

 Duplicate – Duplicates the selected rule file, enabling you to modify and 
save it as a new rule file without affecting the original file.

 Properties – Opens the Normalization Rules Properties dialog box, 
enabling you to modify the properties of the rule file.

To preview the outcome of a rule file:

1 Locate the bibliographic record with which you want to work (via the 
Repository Search or within the MD Editor Records tab) and open it in the 
MD Editor.

2 Select Edit > Split Editor (F6) or click the Split Editor button.

3 Click the Rules tab, expand the MARC 21 bibliographic list to display the 
saved rule files, select the file whose outcome you want to preview, and click 
Edit. The rule file is displayed in the right pane of the Editor.

Figure 168: Normalization Rule – Preview 
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4 Click the Preview button. The rule or rules in the file are applied to the 
record and the outcome is displayed. 

Click Save to save the modifications to the record.

Normalization Rules – Syntax and Examples
Rule files contain one or more rules, which contain one or more actions to be 
applied to candidate records. A record is a candidate for the application of a rule 
if the entire record meets the defined conditions. Each action within a rule can 
be performed on a single field within a record, either unconditionally or subject 
to a defined condition. Note that the actions are performed in the order in which 
they appear within the rule.

VIDEO:
Learn more about creating normalization rules in the Normalization Rules 
video (41:07 mins).  
 
Learn how to create normalization rules that delete specified fields from 
records, or change the contents of these fields in the Normalization Routine 
Syntax for Deletion or Content Change video (9:57 mins).

<conditions on MARC record> contains one or more Boolean clauses that 
apply to the record. If <conditions on MARC record> returns TRUE, the record 
is a candidate for the application of the normalization rule; otherwise, the rule 
will not be applied and the record will not be processed. 

NOTE:
“When” must be the only word in the first line. The condition must be 
placed on a separate line.

Record Elements
Conditions and actions apply to record elements, such as the MARC record, 
fields (one or more), indicators, subfields (one or more), and field/subfield 
contents.

To test a condition or apply an action to a record element, the element must 
match the following syntax:

When 
(<conditions on MARC record>) then
     Action1
     Action2 if condition
     Action3
End

http://www.youtube.com/watch?v=l-cpDNfwr6s&hd=1
http://www.youtube.com/watch?v=VSP4vMBMrTU&hd=1
http://www.youtube.com/watch?v=VSP4vMBMrTU&hd=1
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Consequences
The tables below provide lists of consequences for the following condition 
scenarios:

Table 26. Syntax

Expression Meaning
"<tag>" Represents a field tag, for example, 001, 245, etc.

"<new tag>}" Represents a field tag, for example, 001, 245, etc.

"<oldCode>" Represents a subfield code, for example, a, b, c.

"<newCode>" Represents a subfield code, for example, a, b, c.

"<element>" for a data field The following are the possible values for the 
data field:

 FIELD– for example: 245

 FIELD_VALUE – for example: 245.value*

 FIELD_INDICATOR – for example: 245.{1,2}

 FIELD_SUBFIELD_CODE – for example: 
245.a

 FIELD_INDICATOR_SUBFIELD_CODE – 
for example: 245.{1,2}.a

 FIELD_SUBFIELD_CODE_VALUE – for 
example: 245.a.value*

 FIELD_INDICATOR_SUBFIELD_CODE_VAL
UE – for example: 245.{1,2}.a.value*

"<element>" for a control field The following are the possible values for a 
control field:

 FIELD_POSITION_LENGTH – for example:  
LDR.{17,3}

 FIELD_POSITION_LENGTH_VALUE – for 
example:  LDR.{17,3}.eng

CONDITION at record level The following are the possible values for a 
control field:

 TRUE

  not exists {element}

  not existsControl "{element}"

  exists "{element}"

  existsControl "{element}"
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 When the condition is not satisfied at the field level (Table 27)

 When the condition is satisfied at the field level (Table 28)

 When there is no condition at the field level (Table 29)

Table 27. Consequences for Conditions Not Satisfied

Consequences for Conditions Not Satisfied
addcontrolField "{element}"  if(not exists "{condition}")

addField "{element}"  if(not exists "{condition}")

addSubField "{element}" if(not exists "{condition}")

changecontrolField "{tag}" to "{newTag}" if(not existsControl "{condition}")

changeField "{tag}" to "{newTag}" if(not exists "{condition}")

changeFirstindicator "{tag}" to "{value}" if(not exists "{condition}")

changeSecondindicator "{tag}" to "{value}" if(not exists "{condition}")

changeSubField "{oldCode}" to "{newCode}" if(not exists "{condition}")

changeSubFieldExceptFirst "{oldCode}" to "{newCode}" if(not exists "{condition}")

changeSubFieldOnlyFirst "{oldCode}" to "{newCode}" if(not exists "{condition}")

copycontrolField "{tag}" to "{element}" if(not existsControl "{condition}")

copyField "{tag}" to "{element}" if(not exists "{condition}")

Prefix "{element}" with "{prefix}" if(not exists "{condition}")

removecontrolField "{tag}" if(not existsControl "{condition}")

removeField "{tag}" if(not exists "{condition}")

removeSubField "{element}" if(not exists "{condition}")

replacecontents "{element}" with "{newValue}" if(not exists "{condition}")

replacecontentsExceptFirst "{element}" with "{newValue}" if(not exists "{condition}")

replacecontentsOnlyFirst "{element}" with "{newValue}" if(not exists "{condition}")

replacecontrolcontents "{element}" with "{newValue}" if(not existsControl "{condition}")

Suffix "{element}" with "{suffix}" if(not exists "{condition}")
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Table 28. Consequences for Conditions Satisfied

Consequences for Conditions Satisfied
addcontrolField "{element}"  if(exists "{condition}")

addField "{element}"  if(exists "{condition}")

addSubField "{element}" if(exists "{condition}")

changecontrolField "{tag}" to "{newTag}" if(existsControl "{condition}")

changeField "{tag}" to "{newTag}" if(exists "{condition}")

changeFirstindicator "{tag}" to "{value}" if(exists "{condition}")

changeSecondindicator "{tag}" to "{value}" if(exists "{condition}")

changeSubField "{oldCode}" to "{newCode}" if(exists "{condition}")

changeSubFieldExceptFirst "{oldCode}" to "{newCode}" if(exists "{condition}")

changeSubFieldOnlyFirst "{oldCode}" to "{newCode}" if(exists "{condition}")

copycontrolField "{tag}" to "{element}" if(existsControl "{condition}")

copyField "{tag}" to "{element}" if(exists "{condition}")

Prefix "{element}" with "{prefix}" if(exists "{condition}")

removecontrolField "{tag}" if(existsControl "{condition}")

removeField "{tag}" if(exists "{condition}")

removeSubField "{element}" if(exists "{condition}")

replacecontents "{element}" with "{newValue}" if(exists "{condition}")

replacecontentsExceptFirst "{element}" with "{newValue}" if(exists "{condition}")

replacecontentsOnlyFirst "{element}" with "{newValue}" if(exists "{condition}")

replacecontrolcontents "{element}" with "{newValue}" if(existsControl "{condition}")

Suffix "{element}" with "{suffix}" if(exists "{condition}")

Table 29. Consequences for No Conditions

Consequences for No Conditions
addcontrolField "{element}"

addField "{element}"

addSubField "{element}"

addSystem[nN]umber "{element}" from "{tag}" prefixed by "{prefixTag}"



Alma Resource Management

January 2015228

Chapter 4: Metadata Management

Ex Libris Confidential

The Boolean OR operator can be used in a consequence statement by using the 
pipe (|) symbol. Refer to the table below for an example.

NOTE:
In cases where the pipe symbol may be part of the value compared, you 
need to use four backslashes (\\\\) as the escape string. For example: 
removeField "866" if (exists "866.8.0\\\\|99")

changecontrolField "{tag}" to "{newTag}"

changeField "{tag}" to "{newTag}"

changeSubField "{oldCode}" to "{newCode}"

changeSubFieldExceptFirst "{oldCode}" to "{newCode}"

changeSubFieldOnlyFirst "{oldCode}" to "{newCode}"

changeFirstindicator "{tag}" to "{value}"

changeSecondindicator "{tag}" to "{value}"

copycontrolField "{tag}" to "{element}"

copyField "{tag}" to "{element}"

Prefix "{element}" with "{prefix}"

removecontrolField "{tag}"

removeField "{tag}"

removeSubField "{element}"

replacecontents "{element}" with "{newValue}"

replacecontentsExceptFirst "{element}" with "{newValue}"

replacecontentsOnlyFirst "{element}" with "{newValue}"

replacecontrolcontents "{element}" with "{newValue}"

Suffix "{element}" with "{suffix}"

Table 29. Consequences for No Conditions

Consequences for No Conditions

Table 30. Boolean OR Operator Example

removeField "866" if (not exists "866.8.0|99")
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Wildcards
The asterisk (*)is used to match any string. For example, 
"<tag>.<*>.<value>" applies to all the subfields in the tag <tag> that have the 
value <value>.

Empty fields, subfields, or indicators are indicated by a dash (-). For example, 
"<tag> {-,<ind2>}" returns all the fields where the MARC tag is <tag>, the 
first indicator is not defined, and the second indicator is <ind2>.

General Structure of Conditions
Conditions are divided into the following two groups:

1 exists <element> – at least one match is found

There is a further differentiation between data fields and control fields:

 exists <element> – applies to data fields

 existsControl <element> – applies to control fields

2 not exists <element> – no match is found

There is a further differentiation between data fields and control fields

 not exists <element> – applies to data fields

 not existsControl <element> – applies to control fields

Conditions can be defined at the entire rule level (WHEN), or at a specific action 
level (IF). The same condition will behave differently depending on the level at 
which it is defined.

 WHEN clause – defines a condition that must be met by the entire record in 
order to determine whether the record is a candidate for the application of 
the rule

 IF (within an action) – defines a condition that applies to a single field in 
order to determine whether the specific action will be taken on that single 
field

General Structure of Actions
Table 31 describes the general structure of actions.

Table 31. General Structure of Actions

Action Condition Comment
Action 1 none/blank Action 1 will be executed unconditionally.

Action 1 If (condition 1) Action 1 will be executed only if condition 1 is 
true.
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List of Actions
Table 32 provides a list of available actions.

Table 32. List of Actions

Action Condition Comment
Replacing 
fields and 
subfields with 
other fields 
and subfields

ChangeControlField "<tag>" to 
"new tag"

Example: ChangeControlField 
"007" to "008"

Changes the tag identifier of 
a control field; does not 
modify contents.

ChangeField "<tag>" to "new 
tag"

Example: ChangeField "245" to 
"246"

Changes the tag identifier; 
does not modify indicators or 
subfields. 

ChangeSubField "<tag>.<code>"  
to "new code"

Example: ChangeSubField "035.b" 
to "a"

Changes the subfield 
"<code>" to the subfield 
"new code" in field "<tag>".  

ChangeFirstIndicator "<tag>" 
to "<value">

ChangeSecondIndicator "<tag>" 
to "<value">

Example: ChangeFirstIndicator 
"245" to "3"

Sets the value of the specified 
indicator in tag <tag>. If the 
indicator has a value, it will 
be changed. 

Adding fields 
and subfields

AddField  "<tag>.<code>. 
<value>"   

AddField  
"<tag>.{<ind1>,<ind2>}.<code>. 
<value>"   

Example: AddField 
"999.a.RESTRICTED"

Adds the field to the MARC 
record. Sets the value of the 
subfield to the indicated 
value.

AddControlField 
"<tag>"."<value>"

Example: AddControlField 
"008.820305s1991####nyu#######
####001#0#eng##"

Adds the control field to the 
MARC record. Sets the value 
of the subfield to the 
indicated value.

AddSubfield 
"<tag>.<code>.<value>"

AddSubfield 
"<tag>.{<ind1>,<ind2>}.<code>. 
<value>"

Example: AddSubfield 
"245.h.[Journal]"

Adds the subfield <code> 
with value <value> to field 
<tag>. If the field does not 
exist, nothing is done.
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Examples
The following table provides a list of (and links to) all the normalization 
examples provided below.

Removing 
fields and 
subfields

RemoveField "<tag>"

Example: RemoveField "880"   

Removes all occurrences of 
the field <tag>.

RemoveSubfield "<tag>.<code>"

Example: RemoveSubfield "245.h"

Removes the subfield <code> 
from the indicated field.

Replacing text 
in fields or 
subfields

ReplaceControlContents 
"<tag>.{<position>,<length>}. 
<value>" with "new value"

Example: ReplaceControlContents

 "LDR.{7,1}.s" with "m"

Replaces <value> with  "new 
value" in starting position 
<position> to 
<position>+<length> of 
control field <tag>. Replaces 
only the text that matches 
<value>.

ReplaceContents  
"<tag>.<code>.<value>" with 
"new value"

Example: ReplaceContents 
"245.h.[Journal]" with 
"[Book]"

Replaces the string <value> 
in the subfield <code> of field 
"<tag>" with "new value". 
The string or part of the 
string that does not match 
<value> is not modified. 

Prefix "<tag>.<code>" with 
"<value>"

Example: "035.b" with "(OCoLC)"

Adds a prefix to the value of 
subfield "<code>" in the field 
"<tag>".

Table 32. List of Actions

Action Condition Comment

Table 33. Normalization Rule Examples Overview and Links

Link to 
Example

Condition Consequence Action

Example 1 not exists addField Add field 901 with $$a 
with the text 
Architecture Dept if it 
does not exist

Example 2 exists

not exists

addField Add field 901 with $$a 
with the text 
Architecture Dept only 
if the 902 $$b contains 
034-ARC.
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Example 3 TRUE removeSubfield Remove $$b and $$c 
from the 260 field.

Example 4 TRUE replaceContents Replace the text apple 
with the text orange in 
the 650 $$a 
(unconditionally).

Example 5 TRUE replaceContents Replace the text apple 
with the text orange in 
any subfield of the 650 
field (unconditionally).

Example 6 exists replaceContents Replace the text apple 
with the text orange in 
650 $$a only if the 049 
has $$a OCM

Example 7 Not exists replaceContents Replace the text apple 
with the text orange in 
650 $$a only if the 049 
does not have $$a 
OCM.

Example 8 TRUE

Not exists

addSubField Add $$h to the 245 
field with the text 
[Journal] 
(unconditionally).

Example 9 TRUE

Not exists

addSubField Add $$h to the 245 
field with the text 
[Journal] if there is no 
$$h.

Example 10 Not exists addDataField Add field 999 with $$a 
CR_RESTRICTED if it 
does not exist.

 Example 11 TRUE copySubField Copy the 035 $$b to the 
035 $$a.

Example 12 TRUE

Not exists

Not exists

copySubField Copy the 035 $$b to the 
035 $$a if it does not 
exist with the prefix 
(YBP).

Example 13 Exists 
Control

Not Exists

addSubField Create 245 $$h [Video] 
if position 6 of the LDR 
is g.

Table 33. Normalization Rule Examples Overview and Links

Link to 
Example

Condition Consequence Action
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Example 14 Exists 
Control

Not Exists

addSubField Create 041 $$a with 
ger if position 35-37 
in the 008 field is ger.

Example 15 Exists 
Control

Not Exists

addSubField Add $$h to the 245 
field with the text 
[Journal] if there is not 
$$h in the 245 field and 
022 exists or position 7 
in the LDR is s.

Example 16 Exists 
Control

exists

Not Exists

addSubField Add the 940 field with 
the first indicator of 1, 
the second indicator 
empty, and $$a with 
the text YBPDDA.

Example 17 TRUE addField Change the second 
indicator of the 856 
field to 0 (zero) if its 
value is 1 (one).

Example 18 TRUE changeControlField Move the 001 field to 
the 009 field.

Example 19 Not exists changeControlField Move the 001 field to 
the 009 field if 009 does 
not already exist.

Example 20 TRUE changeField Move the 300 field to 
the 901 field.

Example 21 Not exists addField Add the 0820 field with 
$$a with the text 296.5 
YLK if it does not 
already exist in either 
the 082 or the 0820.

Example 22 exists changeControlContents Replace position 6 of 
the LDR field with e 
if the 245 $$h is 
[Map] or [Carte].

Table 33. Normalization Rule Examples Overview and Links

Link to 
Example

Condition Consequence Action
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Example 23 exists replaceControlContents Replace position 6 of 
the LDR field with e 
if the 245 $$h is 
[Map] or [Carte] 
and the position 6 of 
the LDR field is a.

Example 24 TRUE replaceControlContents Replace position 6 of 
the LDR field with e 
all the time.

Example 25 TRUE removeField Delete all the 9XX 
fields.

Example 26 TRUE removeField Delete all the 92X 
fields.

Example 27 TRUE removeField Delete all the 035 fields 
which start with (MBU) 
and end with 01bosu.

Example 28 TRUE removeField

addField

addSubField

Remove the existing 
100 field and add a new 
100 field with 1001 $$a 
Smith, John $$d1971-.

Example 29 TRUE removeSubField Remove $$b from the 
900 field.

Example 30 TRUE

Not exists

suffix Append (ONLINE) to 
050.b.

Example 31 TRUE prefix Preface 050.a with 
(ONLINE).

Example 32 TRUE copyField Copy the 001 field to 
the 035 field.

Example 33 TRUE copyField Copy the 035 field to 
the 982 field.

Example 34 TRUE addSystemNumber Add System Number 
035.a from 001 prefixed 
by 003.

Table 33. Normalization Rule Examples Overview and Links

Link to 
Example

Condition Consequence Action
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Example 35 TRUE

exists

TRUE

removeField

changeField

Delete the 035 field that 
starts with (OCoLC) 
and then change the 
existing 035 field to 996 
using the priority 
factor, which must be 
used when a rule 
contains multiple rules. 

Example 36 TRUE

exists

removeField Delete the the 900 field 
when it contains $a 
Local as in the figure 
below.

Example 37 TRUE

exists

copyField Copy field 24514 to the 
90299 field. Only the 
24514 is copied. If the 
245 has other indicators 
it is not copied.

Example 38 TRUE

exists

copyField Copy field 24514 to the 
90214 field.  Only 24514 
is copied. If the 245 has 
other indicators it is not 
copied.

Example 39 TRUE

exists

copyField Copy field 24514 to the 
902 field with no 
indicators. Only 24514 
is copied. If the 245 has 
other indicators it is not 
copied.

Example 40 TRUE copyField Copy the 300 field to 
the 901 field.  The 300 
field is copied 
regardless of whether 
or not it has indicators 
and regardless of what 
the indicators are.

Example 41 TRUE copyField Copy the 300 field to 
the 90112 field. The 300 
field is copied 
regardless of whether 
or not it has indicators 
and regardless of what 
the indicators are.

Table 33. Normalization Rule Examples Overview and Links

Link to 
Example

Condition Consequence Action
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Example 42 existsControl replaceControlContents Change the blank in 
position 17 of the 
leader (LDR) field to an 
i.

Example 43 existsControl replaceControlContents Change the u in 
position 17 of the 
leader (LDR) field to 8.

Example 44 TRUE copyField Copy 245 only subfield 
c to 900 subfield b.

Example 45 TRUE removeField Remove the 866 only if 
the 866 subfield 8 does 
not have a 0 or a 99 in 
it.

The pipe is now a 
Boolean OR. 

Example 46 not exists addField If you want to use the 
pipe as a pipe to add a 
field, you need to add 
\\\ (three backslashes) 
before it.

If you want to use the 
pipe as a pipe and 
check if it is in a field, 
you need to add \\\\ 
(four backslashes) 
before it.

Example 47 TRUE

not exists

removeField Delete the 866 fields if 
they have a subfield x 
or a subfield z.

Example 48 exists

not exists

addField Add field 901 if the 900 
field exists with 
Architecture or 
Design in subfield a. 
Use a pipe for the OR.

Example 49 TRUE removeControlField Remove control field 
009 from a record 
unequivocally.

Table 33. Normalization Rule Examples Overview and Links

Link to 
Example

Condition Consequence Action
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Example 1
Add field 901 with $$a with the text Architecture Dept if it does not exist.

Back to Normalization Rule Examples Table

Example 2
Add field 901 with $$a with the text Architecture Dept only if the 902 $$b 
contains 034-ARC.

Back to Normalization Rule Examples Table

Example 50 TRUE changeSubFieldOnlyFirst Change the first 
occurrence of the 040 
subfield d to subfield a 
and do not change the 
other ones.

Example 51 existsControl addField Add field 900 with 
subfield a Govt. Doc 
if the 008 has a u in 
position 17 and an f in 
position 21.

Table 33. Normalization Rule Examples Overview and Links

Link to 
Example

Condition Consequence Action

rule "Add field 901 with sub field a with text Architecture 
Dept. if it doesnt exist"
when
not exists "901.a.Architecture Dept"

then
addField "901.a.Architecture Dept"

end

rule "Add field 901 with sub field a with text Architecture 
Dept. only if 902 $$b has 034-ARC"
when
((exists "902.b.034-ARC") AND (not exists 

"901.a.Architecture Dept"))
then
addField "901.a.Architecture Dept"

end
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Example 3
Remove $$b and $$c from the 260 field.

Back to Normalization Rule Examples Table

Example 4
Replace the text apple with the text orange in the 650 $$a (unconditionally).

Back to Normalization Rule Examples Table

Example 5
Replace the text apple with the text orange in any subfield of the 650 field 
(unconditionally).

Back to Normalization Rule Examples Table

rule "Remove subfields b and c from 260"
when
(TRUE)

then
removeSubField "260.b"
removeSubField "260.c"

end

rule "Replace text apple with orange in 650 $$a 
(unconditional)"
when
(TRUE)

then
replaceContents "650.a.apple" with "orange"

end

rule "Replace text apple with orange in 650 any subfield 
(unconditional)"
when
(TRUE)

then
replaceContents "650.*.apple" with "orange"

end
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Example 6
Replace the text apple with the text orange in 650 $$a only if the 049 has $$a 
OCM.

Back to Normalization Rule Examples Table

Example 7
Replace the text apple with the text orange in 650 $$a only if the 049 does not 
have $$a OCM.

Back to Normalization Rule Examples Table

Example 8
Add $$h to the 245 field with the text [Journal] (unconditionally).

Back to Normalization Rule Examples Table

rule "Replace text apple with orange in 650 $$a only if 049 
has $$a OCM"
when
(exists "049.a.OCM")

then
replaceContents "650.a.apple" with "orange"

end

rule "Replace text apple with orange in 650 only if 049 does 
not have $$a OCM"
when
(not exists "049.a.OCM")

then
replaceContents "650.a.apple" with "orange"

end

rule "Add subfield h to 245 with text [Journal] 
(unconditional)"
when
(TRUE)

then
addSubField "245.h.[Journal]" if (not exists 

"245.h.[Journal]")
end
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Example 9
Add $$h to the 245 field with the text [Journal] if there is no $$h.

Back to Normalization Rule Examples Table

Example 10
Add field 999 with $$a CR_RESTRICTED if it does not exist.

Back to Normalization Rule Examples Table

Example 11
Copy the 035 $$b to the 035 $$a.

Back to Normalization Rule Examples Table

Example 12
Copy the 035 $$b to the 035 $$a if it does not exist with the prefix (YBP).

rule "Add subfield h to field 245 with text [Journal] if there 
is no subfield h"
when
(TRUE)

then
addSubField "245.h.[Journal]" if (not exists "245.h")

end

rule "Add data field 999 with subfield a = CR_RESTRICTED if it 
doesnt exist"
when
(not exists "999.a.CR_RESTRICTED")

then
addField "999.a.CR_RESTRICTED"

end

rule "Copy 035 subfield b to 035 subfield a"
when
(TRUE)

then
changeSubField "035.b" to "a"

end
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Back to Normalization Rule Examples Table

Example 13
Create 245 $$h [Video] if position 6 of the LDR is g.

Back to Normalization Rule Examples Table

Example 14
Create 041 $$a with ger if position 35-37 in the 008 field is ger.

Back to Normalization Rule Examples Table

Example 15
Add $$h to the 245 field with the text [Journal] if there is not $$h in the 245 field 
and 022 exists or position 7 in the LDR is s.

rule "Copy 035 subfield b to 035 subfield a if it doesnt 
exist, prefix with (YBP)"
when
(TRUE)

then
prefix "035.b" with "(YBP)" if (not exists "035.b.*YBP*")
changeSubField "035.b" to "a" if (not exists "035.a")

end

rule "Create 245 $$h [Video]   if position 6 of LDR is g"
when
((existsControl "LDR.{6,1}.g") AND (not exists 

"245.h.*[Video]*"))
then
replaceContents "245.h.*" with "[Video]"
addSubField "245.h.[Video]" if (not exists "245.h")

end

rule "Create 041 subfield a with ger if position 35-37 in 008 
is ger"
when
((existsControl "008.{35,3}.ger") AND (not exists 

"041.a.ger"))
then
addField "041.a.ger"

end
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Back to Normalization Rule Examples Table

Example 16
Add the 940 field with the first indicator of 1, the second indicator empty, and 
$$a with the text YBPDDA.

Back to Normalization Rule Examples Table

Example 17
Change the second indicator of the 856 field to 0 (zero) if its value is 1 (one).

Back to Normalization Rule Examples Table

Example 18
Move the 001 field to the 009 field.

rule "Add subfield h to field 245 with text [Journal] if there 
is no subfield h in field 245 and 022 exists or pos.7 in LDR = 
s"
when
((existsControl "LDR.{7,1}.s") OR (exists "022"))

then
replaceContents "245.h.*" with "[Journal]"
addSubField "245.h.[Journal]" if (not exists "245.h")

end

rule "Add field 940 with 1st indicator =1, second indicator 
empty, subfield a with text YBPDDA"
when
(TRUE)

then
addField "940.{1,-}.a.YBPDDA"

end

rule "Change second indicator of field 856 to 0 if its value 
is 1"
when
(TRUE)

then
changeSecondIndicator "856" to "0" if (exists "856.{*,1}")

end
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Back to Normalization Rule Examples Table

Example 19
Move the 001 field to the 009 field if 009 does not already exist.

Back to Normalization Rule Examples Table

Example 20
Move the 300 field to the 901 field.

Back to Normalization Rule Examples Table

Example 21
Add the 0820 field with $$a with the text 296.5 YLK if it does not already exist in 
either the 082 or the 0820.

rule "Move field 001 to 009"
when
(TRUE)
then
changeControlField "001" to "009"
end

rule "Move field 001 to 009"
when
(not existsControl "009")
then
changeControlField "001" to "009"
end

rule "Move field 300 to 901"
when
(TRUE)
then
changeField "300" to "901"
end
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Back to Normalization Rule Examples Table

Example 22
Replace position 6 of the LDR field with e if the 245 $$h is [Map] or [Carte].

Back to Normalization Rule Examples Table

Example 23
Replace position 6 of the LDR field with e if the 245 $$h is [Map] or [Carte] and 
the position 6 of the LDR field is a.

Back to Normalization Rule Examples Table

Example 24
Replace position 6 of the LDR field with e all the time.

rule "Add field 0820 with subfield a with text 296.5 YLK if it 
doesnt already exist in either 082 or 0820"
when
((not exists "082.{0,-}.a.296.5 YLK") AND (not exists 
"082.a.296.5 YLK"))
then
addField "082.{0,-}.a.296.5 YLK"
end

rule "edit LDR pos 6 for maps"
when
((exists "245.h.[Map]") OR (exists "245.h.[Carte]"))
then
replaceControlContents "LDR.{6,1}" with "e"
end

rule "edit LDR pos 6 for maps"
when
((exists "245.h.[Map]") OR (exists "245.h.[Carte]"))
then
replaceControlContents "LDR.{6,1}.a" with "e"
end
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Back to Normalization Rule Examples Table

Example 25
Delete all the 9XX fields.

Back to Normalization Rule Examples Table

Example 26
Delete all the 92X fields.

Back to Normalization Rule Examples Table

Example 27
Delete all the 035 fields which start with (MBU) and end with 01bosu.

Back to Normalization Rule Examples Table

rule "edit LDR pos 6 for maps"
when
(TRUE)
then
replaceControlContents "LDR.{6,1}" with "e"
end

rule "Remove all 9XX"
when
(TRUE)
then
removeField "9*"
end

rule "Remove all 92X"
when
(TRUE)
then
removeField "92*"
end

rule "delete the 035 Starts with (MBU)Ends with 01bosu"
when
TRUE
then
removeField "035" if(exists "035.*.(MBU)*01bosu")
end
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Example 28
Remove the existing 100 field and add a new 100 field with 1001 $$a Smith, John 
$$d1971-.

Back to Normalization Rule Examples Table

Example 29
Remove $$b from the 900 field.

Back to Normalization Rule Examples Table

Example 30
Append (ONLINE) to 050.b.

Back to Normalization Rule Examples Table

rule "remove data field 100 and add new one"
when
(TRUE)
then
removeField "100"
addField "100.{1,-}.a.Smith, John"
addSubField "100.d.1971-"
end

rule "remove subfield b from 900 field"
when
(TRUE)
then
removeSubField "900.b" 
end

rule "Suffix 050.b with (ONLINE) if not already"
when
(TRUE)
then
suffix "050.b" with " (ONLINE)" if (not exists "050.b.*ONLINE")
end
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Example 31
Preface 050.a with (ONLINE).

Back to Normalization Rule Examples Table

Example 32
Copy the 001 field to the 035 field.

Back to Normalization Rule Examples Table

Example 33
Copy the 035 field to the 982 field.

Back to Normalization Rule Examples Table

Example 34
Add System Number 035.a from 001 prefixed by 003.

rule "Prefix 050.a with (ONLINE) if not already"
when
(TRUE)
then
prefix "050.a" with "(ONLINE)" if (not exists "050.a.ONLINE")
end

rule "Copy 001 Field to 035 Field"
when
(TRUE)
then
copyField "001" to "035.a"
end

rule "copy 035 Field to 982 Field"
when
(TRUE)
then
copyField "035" to "982.a"
end
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Back to Normalization Rule Examples Table

Example 35
The following rule first deletes the 035 field that starts with (OCoLC) and then 
changes the existing 035 field to 996 using the priority factor, which must be 
used when a rule contains multiple rules. Note that actions stipulated in the rule 
with the higher priority are performed first. For example, the action in the rule 
with priority 2 below is performed before the action in the rule with priority 1.

Back to Normalization Rule Examples Table

rule "Add system number 035.a from 001 prefixed by 003"
when
(TRUE)
then
addSystemNumber "035.a" from "001" prefixed by "003"
end

rule "delete the 035 Starts with (OCoLC)"
priority 2
when
TRUE
then
removeField "035" if (exists "035.a.(OCoLC)*")
end

rule "change 035 to 996"
priority 1
when
TRUE
then
changeField "035" to "996"
end
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Example 36
Use the rule below to delete the the 900 field when it contains $a Local as in the 
figure below.

NOTE:
This normalization rule will not delete any other 900 fields that exist.

Back to Normalization Rule Examples Table

Example 37 
Copy field 24514 to the 90299 field. Only the 24514 is copied. If the 245 has other 
indicators it is not copied.

Back to Normalization Rule Examples Table

Example 38
Copy field 24514 to the 90214 field.  Only 24514 is copied. If the 245 has other 
indicators it is not copied.

rule "remove 900 field if it has subfield a with local"
when
(TRUE)
then
removeField "900" if (exists "900.a.Local")
end

rule "copy 24514 to 90299"
when
  TRUE
then
  copyField "245" to "902.{9,9}" if(exists "245.{1,4}")
end
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Back to Normalization Rule Examples Table

Example 39
Copy field 24514 to the 902 field with no indicators. Only 24514 is copied. If the 
245 has other indicators it is not copied.

Back to Normalization Rule Examples Table

Example 40
Copy the 300 field to the 901 field.  The 300 field is copied regardless of whether 
or not it has indicators and regardless of what the indicators are.

Back to Normalization Rule Examples Table

Example 41
Copy the 300 field to the 90112 field. The 300 field is copied regardless of 
whether or not it has indicators and regardless of what the indicators are.

rule "copy 24514 to 90214"
when
  TRUE
then
  copyField "245" to "902.{1,4}" if(exists "245.{1,4}")
end

rule "copy 24514 to 902"
when
  TRUE
then
  copyField "245" to "902{ , }" if(exists "245.{1,4}")
end

rule "copy 300 to 901"
when
  TRUE
then
  copyField "300" to "901"
end
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Back to Normalization Rule Examples Table

Example 42
Use the following normalization rule to change the blank in position 17 of the 
leader (LDR) field to an i.

NOTE:
The # symbol displays in Alma to represent blanks in fixed fields.

Back to Normalization Rule Examples Table

Example 43
Use the following normalization rule to change the u in position 17 of the leader 
(LDR) field to 8.

Back to Normalization Rule Examples Table

Example 44
Copy 245 only subfield c to 900 subfield b. 

rule "copy 300 to 90112"
when
  TRUE
then
  copyField "300" to "901.{1,2}"
end

rule "edit LDR pos 17 to i when blank"
when
   existsControl "LDR.{17,1}. "
then
   replaceControlContents "LDR.{17,1}" with "i"
end

rule "edit LDR pos 17 to 8 when u"
when
   existsControl "LDR.{17,1}.u"
then
   replaceControlContents "LDR.{17,1}" with "8"
end
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Back to Normalization Rule Examples Table

Example 45
Use the following to remove the 866 only if the 866 subfield 8 does not have a 0 
or a 99 in it.

The pipe is now a Boolean OR. 

Back to Normalization Rule Examples Table

Example 46
If you want to use the pipe as a pipe to add a field, you need to add \\\ (three 
backslashes) before it.

If you want to use the pipe as a pipe and check if it is in a field, you need to add 
\\\\ (four backslashes) before it. 

Back to Normalization Rule Examples Table

Example 47
Use the following to delete the 866 fields if they have a subfield x or a subfield z. 

rule "copy 245 subfield c to 900 subfield b"
when
   TRUE
then
   copyField "245.c" to "900.b"
end 

rule "remove 866 except for ones which have a 0 or a 99 in the 
subfield 8"
when
(TRUE)
then
removeField "866" if (not exists "866.8.0|99")
end

rule "Add 491 1 $$a P|pes in code if it does not already 
exist"
when
not exists "490.{1,-}.a.P\\\\|pes in code"
then
        addField "490.{1,-}.a.P\\\|pes in code"
end
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Back to Normalization Rule Examples Table

Example 48
Use the following to add field 901 if the 900 field exists with Architecture or 
Design in subfield a. Use a pipe for the OR. 

Back to Normalization Rule Examples Table

Example 49
Use the following to unequivocally remove the control field 009 from a record.   

Back to Normalization Rule Examples Table

rule "one"
when
(TRUE)
then
removeField "866" if (exists "866.x")
end
rule "two"
when
(TRUE)
then
removeField "866" if (exists "866.z")
end

rule "Add field 901 if 900 exists with Architecture or Design 
in subfield a"
when
((exists "900.a.Design|Architecture") AND (not exists 
"901.a.248365-613"))
then
addField "901.{-,-}.a.248365-613"
end

rule "remove 009"
when
(TRUE)
then
removeControlField "009"
end
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Example 50
Use the following to change the first occurrence of the 040 subfield d to 
subfield a and do not change the other ones.

Back to Normalization Rule Examples Table

Example 51
Use the following to add field 900 with subfield  a Govt. Doc if the 008 has a u 
in position 17 and an f in position 21.

Back to Normalization Rule Examples Table

Working with Merge Rules

PERMISSIONS:
To work with merge rules, you must have the following role:

 Catalog Administrator

The MD Editor enables catalogers to create merge rules and apply them to 
MARC 21 records, or apply merge rules that have already been created. The 
syntax to be used for the rules is described in Merge Rules - Syntax and 
Examples on page 258.

When merging two records, one is the preferred record and the other is the non-
preferred record. The preferred record serves as the basis for the merged record 
and the merge rules remove, add, and/or replace fields in the preferred record 
with values from the non-preferred record.

rule "change the first occurrence of 040 subfield d to a and 
do not change the other ones"
when
(TRUE)
then
changeSubFieldOnlyFirst "040.d" to "a"
end

rule "Add field 900 with subfield a Govt. Doc if 008 has a u in 
pos 17 and an f in pos 21"
when
existsControl  "008.{17,1}.u" AND existsControl  "008.{28,1}.f"
then
addField "900.a.Govt. Doc" if (not exists "900.a.Govt. Doc")
end
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The identity of the preferred and non-preferred records differs depending on 
whether you are importing records using an import profile or copy cataloging 
via an external resource:

 When importing MARC records using an import profile (see Managing 
Profiles for Record Imports on page 511 or Importing Records from OCLC 
Connexion in the Alma Integrations with External Systems Guide for details), 
the preferred record is the local record in Alma. The local Alma record 
serves as the basis for the merged record. Fields from the incoming record 
are taken and merged into the existing, local metadata according to the 
merge rules defined. For example, if a merge rule stipulates the addition of 
the 650 field, the 650 field is taken from the incoming record and added to 
the existing, local Alma record.

 When copy cataloging via an external resource (such as WorldCat or LoC), 
the preferred record is the incoming external record. The incoming record 
serves as the basis for the merged record. Fields from the local Alma record 
are taken and merged into the incoming record metadata according to the 
merge rules defined. For example, if a merge rule stipulates the addition of 
the 650 field, the 650 field is taken from the local Alma record and added to 
the incoming external record.

Because the merge methods for import profiles and copy cataloging work in 
opposite ways, a merge rule written for an import profile cannot work for copy 
cataloging (and vice versa). You therefore require two sets of merge rules—one 
for import profiles and another for copy cataloging. An example of each type of 
rule can be found in Examples of Rules for Import Profiles and Copy 
Cataloging on page 258.

A merge rule file contains one rule that specifies one or more actions that apply 
to the merged record. Each action can be performed unconditionally or may be 
subject to a condition on the preferred record. The order of the actions specified 
is important, as it impacts the intended end result.



Alma Resource Management

January 2015256

Chapter 4: Metadata Management

Ex Libris Confidential

To create a merge rule:

1 On the MD Editor page (Resource Management > Cataloging > Open 
Metadata Editor), click the Rules tab. The Merge Rules folder is displayed.

Figure 169: Rules Tab

2 Select File > New > Merge rules and enter your merge rule properties in the 
Normalization Rule Properties dialog box.

Figure 170: Merge Rule Properties

3 Click Save. The rules editor opens.
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4 Enter your rule details.

a Select Edit > Add Rule > Merge Snippet custom rule. This provides an 
initial template for entering your merge rule.

Figure 171: Merge Snippet Custom Rule

b Enter the specific information for your merge rule. For information on 
the syntax to be used, see Merge Rules - Syntax and Examples on 
page 258.

Figure 172: Merge Rule Details

5 Click Save. The saved merge rules display in the Rules tab.
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Figure 173: Saved Merge Rules

The saved merge rules can be edited, deleted, and duplicated (to create new 
merge rules).

Figure 174: Saved Merge Rule Options

NOTE:
Unlike normalization rules, merge rules cannot be previewed.

Merge Rules - Syntax and Examples
The merge rules follow a specific syntax. See the examples below.

Examples of Rules for Import Profiles and Copy Cataloging
Below are examples of merge rules that can be used in a scenario such as the 
following: You have a record in Alma containing basic metadata, most of which 
you want to replace with metadata from the incoming record. However, for the 
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following fields, you want to keep the local record metadata: 001, 019, 035, 59X, 
9XX.

You would use a merge rule such as the following for import profiles:

You would use a merge rule such as the following for copy cataloging:

Rule Syntax
Conditions and actions apply to record elements, such as the MARC record, 
fields (one or more), indicators, subfields (one or more), and field/subfield 
contents.

Conditions apply to the preferred record elements. To apply an action to a 
record element, the element must match the syntax in the table below.

rule "Replace all fields except local data and match keys"
when
merge
then
replace MARC.XXX excluding "001,019,035,59X,9XX"
end

rule "Replace all fields except local data and match keys"
when
merge
then
replace MARC."001"
replace MARC."035"
replace MARC."019"
replace MARC."59"X
replace MARC."9"XX
end

Table 34. Merge Rule Syntax

Expression Meaning
remove MARC."{prefix}"X Removes the fields prefixed by {prefix}.

For example, the following removes all fields 
between 920 and 929:

remove MARC."92"X

remove MARC."{prefix}"XX Removes the fields prefixed by {prefix}.

For example, the following removes all fields 
between 900 and 999:

remove MARC."9"XX
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remove MARC."{tag}" Removes the field specified in the {tag}.

For example, the following removes the 950 field:

remove MARC."950"

remove MARC."{prefix}"X excluding 
"{list}"

Removes the fields prefixed by {prefix}, 
excluding the specified list of fields. 

For example, the following removes all fields 
between 990 and 999, except 990 and 991:

remove MARC."99"X excluding "990,991"

remove MARC."{prefix}"XX 
excluding "{list}"

Removes the fields prefixed by {prefix}, 
excluding the specified list of fields. 

For example, the following removes all fields 
between 900 and 999, except 950 and 951:

remove MARC."9"XX excluding "950,951"

replace MARC."{tag}" if exists Replaces the content of the field specified in the 
{tag} only if the field exists. If the field does not 
exist, it is not added.

For example, the following replaces the 950 field, if 
the field exists:

replace MARC."950" if exists

replace MARC."{tag}" Replaces the content of the field specified in the 
{tag}. If the field does not exist, it is added.

For example, the following replaces the 950 field:

replace MARC."950"

replace MARC."{prefix}"X if exists Replaces the content of the fields prefixed by 
{prefix} if these fields exist. If these fields do not 
exist, they are not added.

For example, the following replaces all fields 
between 920 and 929, if these fields exist:

replace MARC."92"X if exists

replace MARC."{prefix}"X Replaces the content of the fields prefixed by 
{prefix}. If these fields do not exist, they are 
added.

For example, the following replaces all fields 
between 920 and 929:

replace MARC."92"X

Table 34. Merge Rule Syntax

Expression Meaning
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replace MARC."{prefix}"XX if 
exists

Replaces the content of the fields prefixed by 
{prefix} if these fields exist. If these fields do not 
exist, they are not added.

For example, the following replaces all fields 
between 900 and 999, if these fields exist:

replace MARC."9"XX if exists

replace MARC."{prefix}"XX Replaces the content of the fields prefixed by 
{prefix}. If these fields do not exist, they are 
added.

For example, the following replaces all fields 
between 900 and 999:

replace MARC."9"XX

replace MARC."{prefix}"X 
excluding "{list}"

Replaces the content of the fields prefixed by 
{prefix}, excluding the specified fields. 

For example, the following replaces the content of 
all fields between 990 and 999, except that of 990 
and 991. Note that if the fields do not exist, they are 
created:

replace MARC."99"X excluding "990,991"

replace MARC."{prefix}"XX 
excluding "{list}"

Replaces the content of the fields prefixed by 
{prefix}, excluding the specified fields. 

For example, the following replaces the content of 
all fields between 900 and 999, except that of 950 
and 951. Note that if the fields do not exist, they are 
created:

replace MARC."9"XX excluding "950,951"

replace MARC.XXX excluding 
"{list}"

Replaces the content of all MARC fields, excluding 
the specified fields.

For example, the following replaces the content of 
all fields in the non-preferred record with that of 
the preferred record, except for the specified fields. 
Note that if the fields do not exist, they are created:

replace MARC.XXX excluding 
"100,245,9XX,5XX"

Table 34. Merge Rule Syntax

Expression Meaning
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replace MARC."{prefix}"X 
excluding 
MARC."{exclTag}"("{exclInd1}"," 
{exclInd2}")

Replaces the content of fields prefixed by 
{prefix}, excluding the specified fields and 
indicators. 

For example, the following replaces the content of 
all fields between 990 and 999, except for MARC 
field 995(0,1). Note that MARC field 995(1,1) is 
replaced.

If the fields do not exist, they are created:

replace MARC."99"X excluding 
MARC."995"("0","1")

replace MARC."{prefix}"XX 
excluding 
MARC."{exclTag}"("{exclInd1}"," 
{exclInd2}")

Replaces the content of fields prefixed by 
{prefix}, excluding the specified fields and 
indicators. 

For example, the following replaces the content of 
all fields between 900 and 999, except for MARC 
field 995(0,1). Note that MARC field 995(1,1) is 
replaced.

If the fields do not exist, they are created:

replace MARC."9"XX excluding 
MARC."995"("0","1")

replace MARC."{tag}" excluding 
MARC."{exclTag}"("{exclInd1}"," 
{exclInd2}")

Replaces the field specified in the {tag}, excluding 
the specified fields and indicators.

For example, the following replaces the 995 field, 
except for 995(0,1). Note that MARC field 995(1,1) 
is replaced.

If the field does not exist, it is created:

replace MARC."995" excluding  
MARC."995"("0","1")

replace MARC.XXX excluding 
MARC."{exclTag}"("{exclInd1}"," 
{exclInd2}")

Replaces the content of all MARC fields, excluding 
the specified fields and indicators. 

For example, the following replaces the content of 
all fields in the non-preferred record with that of 
the preferred record, except for 995(0,1). Note that 
MARC field 995(1,1) is replaced.

If the field does not exist, it is created:

replace MARC.XXX excluding  
MARC."995"("0","1")

Table 34. Merge Rule Syntax

Expression Meaning
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replace MARC."{tag}" when 
MARC."{condtag}"."{condsf}" does 
not contain "{condstring}" 
excluding 
MARC."{exclTag}"("{exclInd1}"," 
{exclInd2}")

Replaces the field specified in the {tag} when the 
stipulated field/subfield does not contain the 
specified string, except in the case of the stipulated 
field and indicators.

For example, the following replaces the 995 field 
when 995a does not contain the text “history.” 
995(0,1) is not replaced, but 995(1,1) is replaced.

If the field does not exist, it is created:

replace MARC."995" when MARC."995"."a" 
does not contain "history" excluding 
MARC."995"("0","1")

replace MARC.control."{ctrl}" Replaces the specified MARC control field.

For example, the following replaces the content of 
the MARC 008 control field in the non-preferred 
record with that of the preferred record. 

If the field does not exist, it is created:

replace MARC.control."008" 

add MARC."{tag}" Adds the content of the field specified in the {tag}.

For example, the following adds the content of the 
950 field:

add MARC."950"

add 
MARC."{tag}"("{ind1}","{ind2}")

Adds the content of the field specified in the {tag}, 
as well as the stipulated indicators.

For example, the following adds the content of the 
950 field, with indicators 0 and 1:

add MARC."950"("0","1")

add MARC."{tag}" if does not 
exists

Adds the content of the field specified in the {tag} 
if this field does not already exist.

For example, the following adds the 950 field if this 
field does not already exist:

add MARC."950" if does not exists

add MARC."{prefix}"X Adds the content of the fields prefixed by 
{prefix}.

For example, the following adds the content of all 
fields between 920 and 929:

add MARC."92"X

Table 34. Merge Rule Syntax

Expression Meaning
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Searching External Resources
Alma supports copy cataloging by integrating the search and import of records 
located in external databases directly into the MD Editor. External databases can 
be searched from within the MD Editor interface, and records displaying in the 
results of the searches can be imported directly into Alma from the search 
results screen. In addition, Alma can search your repository for records that 
match the imported record, merge the variant records into a single record, or 
overlay the existing record with the imported record.

add MARC."{prefix}"XX Adds the content of the fields prefixed by 
{prefix}.

For example, the following adds the content of all 
fields between 900 and 999:

add MARC."9"XX

add MARC."{prefix}"X excluding 
"{list}"

Adds the content of the fields prefixed by 
{prefix}, excluding the specified fields and 
subfields. 

For example, the following adds the content of all 
fields between 990 and 999, except that of 990 and 
991:

add MARC."99"X excluding "990,991"

add MARC."{prefix}"XX excluding 
"{list}"

Adds the content of the fields prefixed by 
{prefix}, excluding the specified fields and 
subfields. 

For example, the following adds the content of all 
fields between 900 and 999, except that of 950 and 
951:

add MARC."9"XX excluding "950,951"

add MARC."{tag}" when 
MARC."{condtag}"."{condsf}" 
contains "{condstring}"

Adds the field specified in the {tag} when the 
stipulated field/subfield contains the specified 
string.

For example, the following adds the 950 tag only if 
the 250.a field contains the text "history."

add MARC."950" when MARC."250"."a" 
contains "history"

Table 34. Merge Rule Syntax

Expression Meaning
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NOTE:
To define the correct match profile to be used, you must include the 
appropriate file key in the serial_match_profile and 
non_serial_match_profile Parameter Value column (Resource 
Management  > Resource Configuration > Configuration Menu > 
General > Other Settings). For detailed information on these file keys, see 
the table in Configuring Other Settings on page 695.

The external search, therefore, enables you to search external bibliographic 
databases and view and select relevant records before importing them into the 
repository.

The search external resources function is available from the Alma menu, in 
addition to the MD Editor. When you have a record selected in the MD Editor 
and perform a search of external resources, the split editor option is 
automatically activated, and the relevant search fields are automatically 
populated with information from the current record in view. 

To search external resources:

1 Select Cataloging > Search External Resources from the Resource 
Management menu, or in the MD Editor, select Tools > Search External 
Resources.

The MD Editor Search External Resources page opens.

Figure 175: MD Editor Search External Resources Page

If there was a draft open in edit mode and the external resources search was 
accessed from the Tools menu, the search fields are automatically populated 
with search terms from the draft record, as shown in the following example.
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Figure 176: MD Editor Search External Resources Page Record Selected

2 From the Search Cataloging Profile drop-down list, select one of the 
predefined search profiles. For details on defining a search profile, see 
External System Search in the Alma Integrations with External Systems Guide.

3 Enter the search values in any of the available fields according to the field 
name and select the required input expectation for the fields that you enter. 
You can select the input expectations from:

 Contains Phrase

 Contains Keywords

 Starts With

NOTE:
The Year of Publication field must contain four digits.

4 Select whether you want each of the search fields to have And/Or options 
between them.

5 Click Search. The MD Editor External Search page refreshes and shows the 
results of the search. 
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Figure 177: External Search Results Page

In the above example, the results from the external search are shown in the 
tab of the Search Cataloging Profile that you chose in step 2. If there are 
additional external databases configured, tabs for these databases are 
displayed. If you want to perform the search on one of these database, click 
the tab for the database and execute the search.

NOTE:
The Held by indication is displayed for OCLC (WorldCat) records only.

6 To view the bibliographic record details of an item on the External Search 
Results page, click the title of the item or click the View link beneath the 
title. The MD Editor page refreshes as follows:
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Figure 178: External Search Results, View Bibliographic Record

Click Back to Results to return to the External Search Results page.

7 To import the bibliographic record of an item on the External Search Results 
page, click the Import link beneath the title; or if you are viewing the 
bibliographic record details (step 6), click Import. The bibliographic record 
is imported into the Drafts folder of the editor (and has a Drafts icon  next 
to it), where you can manipulate it like any other bibliographic record.

Mapping Call Numbers to Holdings 

PERMISSIONS:
To customize the mapping rules, you must have one of the following 
roles:

 Cataloger Administrator 

 General System Administrator

The Call Number Mapping mapping table allows you to customize the way call 
number information maps from the bibliographic record to the holdings record. 
The following methods, which map call number information from the 
bibliographic records to the holdings records, utilize this mapping table:

 Save a new holdings record in the MD Editor. Note that the call numbers are 
not mapped to modified holding records unless you use one of the other 
methods. 
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 Run the Update from Bibliographic tool for a new or modified holdings 
record from the Tools > MARC21 Holdings menu in the MD Editor.

 Run an import profile job.

Alma uses the first matching row in the mapping table to map the call number 
for each record. To determine the matching row, Alma compares each record 
with each enabled mapping row (starting at the top of the table) and stops 
checking when a mapping row matches all of the following conditions:

1 The first indicator of the 852 field in the holdings record matches the 
indicator specified in the 852 Ist Ind column of the mapping table. 

2 If the first indicator of the 852 field in the holdings record is a 7, the value 
specified in the 852 Subfield 2 column must also match the corresponding 
value in the holdings record. 

3 The MARC tag specified in the Bib Field to Copy column of the mapping 
record exists in the bibliographic record.

If a matching row is found, the fields and subfields specified in the Bib Field 
Copy and Bib Subfields to Copy columns are copied from the bibliographic 
record to the 852 subfields specified in the 852 Subfield Destinations columns. 
If all conditions are not met, the system continues to the next row in the 
mapping table. 

Out of the box, the mapping table uses the following rules to map the 
information:

 For the 0 indicator, replaces the h and i subfields with the content of the 
bibliographic record’s 090 a and b subfields (respectively). If there is no 090 
field in the bibliographic record, the 050 a and b subfields are used instead.

 For the 1 indicator, replaces the h and i subfields with the content of the 
bibliographic record’s 082 a and b subfields (respectively).

 For the 2 indicator, replaces the h and i subfields with the content of the 
bibliographic record’s 060 a and b subfields (respectively). 

 For the 3 indicator, adds the h and i subfields with the content of the 
bibliographic record’s 086 a and b subfields (respectively). If the h and i 
subfields are already populated, their values are left as is and not replaced.

 For the 8 indicator, adds the h subfield with a concatenation of the 
bibliographic record's 084 a subfield values. (If the h subfield is already 
populated, its value is left as is.) Also replaces the i subfield with a 
concatenation of the 084 b subfield values.

VIDEO:
For more information about mapping call numbers to holdings, see the 
Call Number Mapping to Holdings Record video (6:00 mins).

http://youtu.be/Sll11qLnME8
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To add a call number mapping row:

1 On the Resource Management Configuration page  
(Resource Management > Resource Configuration > Configuration Menu), 
click Call Number Mapping under General.

The Call Number Mapping page opens.
Figure 69: 

Figure 179: Call Number Mapping Table

2 In the Quick Add section, enter the following fields and click Add to add a 
new mapping row to the bottom of the list:

 Bib Field To Copy – Enter the 5-digit field from which to map the call 
number from the bibliographic record to the holdings record. To specify 
wildcards, use a question mark (for example, 963??). This is a required 
field.

 Bib Subfields To Copy – Specify which subfields are to be copied from 
the field specified in the Bib Field to Copy field to the holdings record. 
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Multiple subfields must be separated by a comma with no spaces. This 
is a required field.

 852 1st Indicator – Enter the value of the first indicator to be matched in 
the holdings record. This is a required field.

 852 Subfield Destinations – Enter the 852 subfields to which the call 
number is mapped in the holdings record. Multiple subfields must be 
separated by a comma with no spaces. This is a required field.

 Description – Enter an optional description for the rule.

3 Click the up and down arrows in the new mapping row to change the order 
in which the rule is checked.

4 Disable or delete any rules that are no longer needed.

5 Click Save.
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Inventory

Introduction to Alma Inventory
Alma inventory provides you with the capability to manage the following types 
of resources: 

 Electronic (see Managing Electronic Resources on page 279)

 Digital (see Managing Digital Resources on page 426)

 Physical (see Managing Physical Resources on page 446)

Alma’s inventory menu interface (Resource Management > Create Inventory), 
designed for non-catalogers, enables staff to enter library information for: 

 Holdings

 Items

 Activated electronic resources

 Digital objects 

Refer to the figure below for an illustration of the inventory component as it 
relates to the overall Alma architecture.

This section includes:

 Introduction to Alma Inventory on page 273

 Managing Electronic Resources on page 279

 Managing Digital Resources on page 426

 Managing Physical Resources on page 446

 Managing Collections on page 489

 Working with the Community Zone Updates Task List on page 503
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Figure 180: Alma Inventory for Resources

See the following links for related topics:

 Alma Inventory Components on page 274

 Alma Inventory Resource Type Examples on page 275

 Linking Versus Copying on page 278

 Managing Linked Electronic Records on Import on page 278

For information on the Alma Community Catalog—its scope, standards, 
policies, and merge logic, see Alma Community Catalog: Cataloging Standards, 
Policies, Rights, and Responsibilities.

Alma Inventory Components
The basic Alma inventory design is comprised of the intellectual entity (IE), 
middle level, and item.

http://www.exlibrisgroup.com/files/Products/Alma/AlmaCommunityCatalogCatalogingStandardsPolicies.pdf
http://www.exlibrisgroup.com/files/Products/Alma/AlmaCommunityCatalogCatalogingStandardsPolicies.pdf
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Figure 181: Basic Alma Inventory Design

Intellectual Entity (IE)
The IE is the resource that is managed that provides a pointer to the MMS 
record at the inventory level. Within Alma, the IE is mostly transparent and 
is not discoverable on its own, but allows Alma to point to a combination of 
community and institutional records from the local inventory.

Middle Level
The middle level of the inventory design serves as a grouping level for the 
different resource types. These are physical, electronic, and digital.

For the physical resource type, the middle level contains the holdings 
information such as the Main library or Law library holdings.

For the electronic resource type, the middle level contains the service 
information such as full text or selected full text.

For the digital resource type, the middle level contains the representation 
information such as master copy or derivative copy.

Item
The item is the inventory level for fulfillment and usage. This level of the 
inventory design contains information about the physical item, the 
electronic portfolio, or the digital file.

Alma Inventory Resource Type Examples
The following illustrations highlight examples of physical, electronic, and 
digital inventory resource types.
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Physical
The following physical inventory example illustrates a book with three copies 
with holdings in the main stacks and off-site storage.

Figure 182: Inventory Physical Example (Books)

The following physical inventory example illustrates an ongoing serial with 
three issues with holdings in Periodicals.

Figure 183: Inventory Physical Example (Serials)

NOTE:
At the item level, book copies are handled differently from serial issues. 
Each issue of a serial contains different content and is not generally 
interchangeable for fulfillment purposes. Book copies can be 
interchangeable for fulfillment purposes.
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Electronic
For electronic inventories, Alma uses the concept of an electronic collection, 
which is the inventory unit that is purchased, activated, and maintained. The 
following example illustrates a single title that is offered by two vendors.

Figure 70: 

Figure 184: Inventory Electronic Example

When bibliographic data is sufficient in the Community Zone (CZ), you can 
have the  resource and title list linked from the CZ on activation of your 
electronic collection. Activation can include a complete vendor bundle  or 
specific titles for a selective service.

Linking through the CZ allows your local inventory to benefit from any changes 
to global access or descriptive information.

Digital
The following digital example illustrates a thesis with a master and a derivative 
representation.

Figure 185: Inventory Digital Example
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Linking Versus Copying
In Alma, inventory records are linked to metadata (MMS) records. The metadata 
records, when published, provide the discovery content for patrons seeking the 
inventory. The records in the Institution Zone are ideally linked to the global 
records in the Community Zone (CZ). With this inventory model, when the CZ 
records are updated, your institution benefits by being able to automatically 
access the updated information through the links between the Institution Zone 
and the CZ.

Alternately, you can copy records from the CZ (similar to copy cataloging from 
any other source). The record is copied directly to your Institution Zone catalog. 
The drawback to this method is that the link to the CZ is severed and the copied 
record does not participate in the updates made to the global version in the CZ.

Managing Linked Electronic Records on Import
To provide additional flexibility for linking metadata (MMS) content, Alma 
offers an option to unlink records when importing electronic resource records. 
E-resource records that are activated from the Community Zone (CZ) can, 
during an import to the Institution Zone, be unlinked and overlaid (or merged) 
with full MARC records. With this option, the portfolios remain linked to the 
CZ and benefit from any future CZ updates.

This function is implemented through the match profile (part of the import 
profile—see the procedure below). It applies to the Repository type of import 
profile and embedded order data (EOD) imports. 

To configure the unlink option:

1 From the Alma main menu > Resource Management > Resource 
Configuration, click Configuration Menu.

2 From the Record Import section, click Import Profiles.

3 Edit an existing Repository type of import profile.

a From the filter drop-down list, select Repository.

b For the profile you want to modify, click Actions > Edit.

c Click the Match Profile tab.

The new option displays in the Match Actions section.
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Figure 186: Unlink Bibliographic Records from the Community Zone Import Option

d Select the Unlink bibliographic records from community zone option.

e Click Save.

Refer to Unlink bibliographic records from Community Zone on page 526 in 
the Import Profile Details Wizard - Page 4 Fields on page 525 table for 
additional information regarding the Unlink Records from the Community 
Zone option and importing.

Managing Electronic Resources
Alma allows you to create and maintain electronic collections and standalone 
portfolios using various editors and processes. For details on how to manage 
your electronic inventory, see the following sections:

 Adding Group Settings to Electronic Resources on page 280

 Managing Electronic Collections on page 287

 Managing Local Portfolios on page 327

 Activating Electronic Resources on page 392

 Managing Patrons’ Access to E-Resources Using Alma Resolver on 
page 410

 Using the Alma Resolver Electronic Services Page on page 418

 Using the Alma Resolver Debugger Tool on page 420

VIDEO:
For an introduction to Electronic Resources, see the Electronic Resource 
Fundamentals video. Note that you need to download an ARF player to 
view this video.

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1025
http://learn.exlibrisgroup.com/mod/resource/view.php?id=1025
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Adding Group Settings to Electronic Resources

PERMISSIONS:
To add group settings to electronic resources, you must have the 
following role:

 Electronic Inventory Operator

Within a multicampus environment or collaborative network, access to 
electronic resources is sometimes restricted to certain campuses,  libraries, or 
members (institutions). 

To manage the availability of electronic resources for groups, you need to:

1 Define your management groups (see Configuring Inventory Available For 
Management Groups for Multicampus Environments on page 730 or 
Configuring Inventory Available For Management Groups for 
Collaborative Environments on page 48 in the Alma Consortia Guide).

2 Add group settings (Available For) to your electronic resources (collections, 
services, and/or portfolios). This section describes how to add group 
settings to your electronic resources by using the Add Settings for Group 
parameters.

NOTE:
The procedures used for associating Available For groups is the same for 
the following Alma topologies: 
- Multicampus 
- Collaborative network 
Both topologies use the Add Settings for Group parameters described in 
the procedures in this section. 

Group settings utilize a variety of parameters depending on the type of 
electronic resource (collection, service, or portfolio) you are restricting. Refer to 
the procedures in this section for more information.

NOTE:
The Add Settings for Group parameters that you enter and save override 
the settings for the resource in the context of the group that is specified. 

The parameters that are defined as part of the group setting will be used by the  
Alma Resolver when calculating and resolving electronic services (refer to 
Managing Patrons’ Access to E-Resources Using Alma Resolver on page 410 
for additional information).

Staff can view the results of these parameter settings on the Electronic Services 
page using the Test access option (refer to Managing Electronic Resource 
Activation on page 395).
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The procedures in this section describe the steps to use Add Settings for Group 
for the following electronic resources:

 Electronic collections

 Electronic services

 Portfolios

To configure group settings for Available For groups for electronic 
collections:

1 Complete a repository search for an electronic collection.

2 Click Edit (for a specific collection). The Electronic Collection Editor opens 
for that collection.

Figure 187: Electronic Collection Editor

3 Select the Group Settings tab and click Add Settings for Group. 
Figure 71: 

Figure 188: Add Settings for Group Button - Electronic Collections

The Available For Information dialog box opens.
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Figure 189: Electronic Collection Available For Information Dialog Box

4 Select a group from the available options in the drop-down list and update 
the Parameters section to match your requirements

For more information regarding groups and how to configure them, see 
Configuring Inventory Available For Management Groups for 
Multicampus Environments on page 730 or Configuring Inventory 
Available For Management Groups for Collaborative Environments on 
page 48 in the collaborative network documentation.

5 Click Save Settings in the Available for Information dialog box. 

6 Click Save. 

To configure group settings for electronic services:

1 Complete a repository search for an electronic collection.

2 Click Edit Service (for a specific collection). The Electronic Service Editor 
opens for that collection.
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Figure 190: Electronic Service Editor

3 Go to the Group Settings tab and click Add Settings for Group. 
Figure 72: 

Figure 191: Add Settings for Group Button - Electronic Services

The Available For Information dialog box opens.
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Figure 192: Electronic Service Available For Information Dialog Box

4 Select a group from the available options in the drop-down list (refer to 
Configuring Inventory Available For Management Groups for 
Multicampus Environments on page 730 for more information) and update 
the Parameters section to match your requirements using the following 
parameters:

 Proxy enabled (yes, no, or use the resource default)

Refer to the Resolver Proxies section in the Alma Integrations with 
External Systems Guide for information regarding proxy relationships 
among portfolios, electronic collections, and services.

 Proxy selected (select from the available options in the drop-down list)

Refer to the Resolver Proxies section in the Alma Integrations with 
External Systems Guide for information regarding how to create a proxy 
profile. 

 Authentication note

 Public note



Chapter 5: Inventory

285January 2015

Alma Resource Management

Ex Libris Confidential

HINT:
Additionally, you can set linking parameter values in the Linking 
Information tab on the Electronic Service Editor page. The linking 
parameters that are set for the group are used to create the appropriate 
link by the Alma Resolver. 
 

For more information regarding groups and their configuration, see 
Configuring Inventory Available For Management Groups for 
Multicampus Environments on page 730 or Configuring Inventory 
Available For Management Groups for Collaborative Environments on 
page 48 (if you are part of a collaborative network environment) in the 
collaborative network documentation.

5 Click Save Settings. 

6 Click Save.

To configure group settings for electronic portfolios:

1 Complete a repository search for an electronic portfolio.

2 Click Edit (for a specific portfolio). The Electronic Portfolio Editor opens.
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Figure 193: Electronic Portfolio Editor

3 Go to the Group Settings tab and click Add Settings for Group.
Figure 73: 

Figure 194: Add Settings for Group Button - Electronic Portfolios

The Available For Information dialog box opens.
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Figure 195: Electronic Portfolio Available For Information Dialog Box

4 Select a group from the available options in the drop-down list and 
complete the Add Date Information, Embargo/Rolling Year, and Parameters 
sections to match your requirements using the parameters below.

For more information regarding groups/configuring groups, refer to 
Configuring Inventory Available For Management Groups for 
Multicampus Environments on page 730 or Configuring Inventory 
Available For Management Groups for Collaborative Environments on 
page 48 (if you are part of a collaborative network environment) in the 
collaborative network documentation.

5 Click Save Settings. 

6 Click Save.

Managing Electronic Collections

PERMISSIONS:
To manage electronic collections, you must have the following roles:

 Electronic Inventory Operator

 Electronic Inventory Operator Extended (required for delete operations)
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Electronic collections are Alma’s method of organizing and preparing electronic 
resources for delivery and publication. Resources can include electronic 
journals, portfolios, databases, or e-books, among others, and they can be 
accessed through a service such as fulltext, or by way of bibliographic records 
and URLs, or by a combination of these.

NOTE:
Portfolios may be defined as standalone entities or as part of an electronic 
collection. Alma allows you to enter your portfolio information as a step 
in the procedure to create an electronic collection or as an independent 
procedure that simply creates portfolios. The procedure for adding 
electronic collections and their associated portfolios is provided in the 
section called Adding a Local Electronic Collection on page 288. The 
procedure for adding a portfolio independent of adding an electronic 
collection is provided in the section called Managing Local Portfolios on 
page 327.

The following sections focus on electronic collections and describe:

 How to add an electronic collection (refer to Adding a Local Electronic 
Collection on page 288)

 How to modify a service (refer to Modifying a Service on page 304)

 How to work with database type electronic collections (refer to Working 
with Electronic Collections of the Database Type on page 310)

 How to link a local electronic collection to the CZ (refer to Linking a Local 
Electronic Collection to the Community Zone on page 320)

Adding a Local Electronic Collection

VIDEO:
For a demonstration on creating an electronic collection, see the Add an 
Electronic Collection video (3:47 mins).

Electronic collections combine both types of resources, packages and databases, 
into one entity that can contain any combination of portfolios, online databases, 
services, URLs, and bibliographic records. You can create and activate local 
electronic collections from Community Zone records or directly from vendor 
resources. depending on whether your resources exist in the Community Zone 
or you obtain your resources from a publisher or publisher aggregator or agent.

http://www.youtube.com/watch?v=ePNnwdARlmE&hd=1
http://www.youtube.com/watch?v=ePNnwdARlmE&hd=1
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To add a local electronic collection:

1 On the Electronic Collection Editor page (Resource 
Management > Inventory > Add Local Electronic Collection), enter the 
basic collection information.

Figure 196: Electronic Collection Editor Page With Transitional Collection Types

Consult the table below for a description of the information to enter.

Table 35. Initial Collection Information

Option Description
Public name Enter the name you want to display in the discovery 

search results.

NOTE:
For local electronic collections, this name can be 
modified later (after the electronic collection has 
been saved) from the Electronic Collection 
Description tab using the Electronic Collection 
Editor.

Public name (override) Enter the name you want to display in place of the 
public name for this electronic collection.

Description Enter the description you want to display in the search 
results.

Internal description Enter a description for internal reference only.
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2 Click Save and Continue. 

If you selected a service type of None, then the Electronic Collection Editor 
page opens. If you selected a service type, the Electronic Service Editor page 
opens to the Activation Information tab.

Collection type Select one of the following types:

 Selective Package – Only the portfolios that you 
select from a package are activated.

 Aggregator Package – The entire package of 
portfolios is added to your collection and activated 
automatically.

 Database –  Your collection begins with an online 
database record.

The remaining database types should be avoided with 
new collections as they will be deprecated after an 
initial transitional period.

Service Type Select one of three drop-down options: full text, 
selective full text (selections from the full text), or none 
(the default for database types).

Library The owning library associated with the electronic 
collection.

Ownership determines the organizational unit that 
manages the resource. It does not, however, determine 
or have an effect on who has access to the resource. 
Library ownership is not required.

Electronic resource ownership defaults to the 
institution level. 

Table 35. Initial Collection Information

Option Description
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Figure 74: 

Figure 197: Electronic Service Editor Page, Activation Information Tab

3 Enter the activation information as described in the following table.
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Figure 75: 
Table 36. Activation Information Tab Options

Field Description
Service activation status If you want the service to be active, click Available. If 

you want the service to be inactive for now, click Not 
Available.

Activate new portfolios 
associated with service 
automatically?

Select Yes or No.

NOTE:
This option is available for aggregator and 
selective packages.

Activation from date Enter a specific activation date. If you do not enter a 
date, the activation starts from the current date (today).

Active until date Enter a specific end date. Otherwise, the activation 
continues indefinitely.

Service temporarily 
unavailable

Select Yes or No.

Service unavailable as of 
date

Enter a specific date for when the service becomes 
unavailable. Otherwise, it uses the current date (today).

NOTE:
When the service is unavailable, all associated 
portfolios become unavailable.

Service unavailability 
reason

Enter the reason text.

Use the Alma Resolver to preview on the Electronic 
Services page what will display in the discovery 
interface for patrons.

See Figure 198 and Figure 199.
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Figure 198: Service Temporarily Unavailable Setting of Yes

Figure 199: Display of the Service Temporarily Unavailable Message

4 Click the Linking Information tab.

The Linking Information tab opens.
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Figure 76: 

Figure 200: Electronic Service Editor Page, Linking Information Tab

5 Enter information related to linking. Use the following table for descriptions 
of the fields.
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Figure 77: 
Table 37. Linking Information Tab Options

Option Description
Parser Enter the destination service.

(Example: AIP:SCITATION)

Parser (override) Enter an override to the parser, if needed.

Parser parameters Enter the linking/access information for the service.

(Example: url1=http://link.aip.org/link/? & url2=http://
publish.aps.org/ & url3=http://link.aps.org/abstract/ & 
agg=sfx)

Parser parameters 
(override)

Enter an override to the parser parameter if an alternative 
one is specified by the service.

Service is free? Specify if the service is free.

Crossref supported Specify if cross reference access is supported (Yes/No).

Crossref enabled Specify if a cross reference capability is enabled (Yes/No/
Inherit).

Proxy enabled Specify if a proxy has been enabled (Yes/No).

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
regarding proxy relationships among portfolios, electronic 
collections, and services. 

Proxy selected Select a proxy profile option from the drop-down list. When 
you specify Yes for Proxy enabled, you need to identify 
which proxy profile is to be used for authentication (of 
users outside the library’s network) to access the online 
database you have created.

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
regarding how to create a proxy profile. 

Linking level Specify the linking level or unit to which the electronic 
collection will link.

Linking Parameters If needed, specify the values for the parameters configured 
in the parser parameter fields above. See the table below for 
more information.

NOTE:
For the $$U_SHIBBOLETH parameter, the relevant 
entity ID must be specified. In addition, the value Yes 
must be entered for $$SHIBBOLETH.
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Some electronic collections within Alma require parameters that are specific to 
your library. For SFX customers, this information is migrated from SFX. For 
non-SFX customers, you must enter the values for the electronic collections to 
which you subscribe. See the following table for a description of which 
parameters require information for which electronic collections. 

NOTE:
This table is not exhaustive. Additional electronic collections that are not 
listed in this table may require information for their parameters. For more 
information, refer to the SFX Target and Alma E-Collection Configuration 
Guide in the Documentation Center. (Note that you must be logged in to 
the Documentation Center in order to view this guide.)

Table 38. Library-Specific Parameters

Collection Parameters Explanation
ABC CLIO 
Databases

USERNAME 

PASSWORD

An ABC representative can provide you 
with your user name and password.

http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Cross-Product/Technical%20Documentation/Target%20and%20E-Collection%20Configuration/SFX%20Target%20and%20Alma%20E-Collection%20Configuration.pdf
http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Cross-Product/Technical%20Documentation/Target%20and%20E-Collection%20Configuration/SFX%20Target%20and%20Alma%20E-Collection%20Configuration.pdf
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CCC 
(Copyright 
Clearance 
Center) service

BILL, ID, INST, 
MAIL, and 
SOURCE

A CCC representative can provide you with 
the details for each of the following linking 
parameters:

 BILL – The email address used for 
billing.

 MAIL – The email address used for 
sending an article.

 SOURCE – The university system code, 
which is provided by CCC.

 INST – The campus name code (for 
example, Fullerton), which is provided 
by CCC.

 ID – The libraryUserID of EZProxy 
users, which is provided by CCC.

If the university system and the institute are 
the same, the Get It Now service expects the 
SOURCE and INST parameters to have the 
same value.

NOTE:
Testing access to CCC Get It Now 
services (using the test access action 
in the staff search results) will not 
lead the staff user to an article 
because the electronic resource from 
which test access is performed is at 
the journal level.

Ebook Library LIBID 

URL_DOMAIN

Library’s code assigned by EBL. No input is 
required.

Eureka CUSTOMER_ID A Eureka representative can provide you 
with your customer ID.

Table 38. Library-Specific Parameters

Collection Parameters Explanation
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Factiva NAMESPACE, 
PASS, USER

Or: 

SID

A Factiva representative can provide your 
namespace, user, and password 
information.

Or:

Specify your XSID value.

NOTE:
When linking to Factiva with your 
XSID, there is no need to provide 
other parameters.

All Gale 
Databases

LOC_ID 

ART

DATABASE

A Gale representative can provide you with 
your institution’s LOC_ID.

No input required for this parameter.

The DATABASE parameter is only relevant 
for the following collections:

 Galegroup IT Custom Journals

 Galegroup IT Custom Newspapers

 Galegroup Military Intelligence

 Galegroup Religion Philosophy 
Collection

Journals at 
Ovid

USERNAME 

PASSWORD

Libraries can connect to Ovid Journal using 
IP authentication or logon credentials. If 
your library uses a user name and 
password, provide us with these values.

IPAUTH If your institution is authenticated by IP 
authorization, type yes in the Value 
column. In this case, there is no need to 
provide a user name and password.

CSA Databases USERNAME Provide your library’s user name and access 
values.

ACCESS

Table 38. Library-Specific Parameters

Collection Parameters Explanation
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6 Click the Portfolios tab. The Electronic Service Editor page opens to the 
Portfolios tab. 

Figure 78: 

Figure 201: Electronic Service Editor Page, Portfolios Tab

From the Portfolios tab, you can:

 Add single portfolios  (step 7)

ProQuest 
Databases

CLIENTID A Client ID is necessary for users in a 
consortia environment. In other cases, the 
Client ID is not necessary for linking to 
ProQuest databases, but may enable 
additional services, depending on your 
institution’s license with ProQuest.

A ProQuest representative can provide you 
with your Client ID.

NOTE:
For Chadwyck Literature Online, you 
must populate the $$SERVER_LOC 
parameter with a value 
corresponding to your geographic 
location. If you are accessing this 
service from Europe, the parameter 
value should be UK and not EUR.

Westlaw SPONSORCODE A Westlaw representative can provide you 
with your customer code.

Table 38. Library-Specific Parameters

Collection Parameters Explanation
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 Load multiple portfolios from an Excel spreadsheet using batch 
processing (see Loading Multiple Portfolios in an Electronic 
Collection (Batch File Processing) on page 339)

 Add portfolios from an existing set (click Add from set to open available 
sets, then select one)

7 To add a single local portfolio, click Add Local Portfolio. 

The New Portfolio page opens. 
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Figure 79: 

Figure 202: New Portfolio Page (Part 1 of 2)
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Figure 80: 

Figure 203: New Portfolio Page (Part 2 of 2)

This enables you to add a single portfolio and associate it with the collection 
as part of the collection creation process, or you can skip this step and add 
the portfolio information later by doing one of the following:

 Editing the electronic collection and adding the portfolio information

 Adding local portfolios using the Add Local Portfolio option accessed 
from Resource Management > Create Inventory > Add Local Portfolio 
(see Adding a Portfolio to an Electronic Collection on page 333)

If you choose to add a single portfolio in this step, use Table 42  on page 329 
for a description of the fields on the New Portfolio page.

NOTE:
For additional information on adding local portfolios to local electronic 
collections, see How to Add Local Portfolios to Local Packages. (Packages are 
now considered electronic collections.) Note that you must be logged in to 
the Documentation Center in order to view this document.

8 When you have completed the information on the New Portfolio page, or 
finished loading portfolios or a set, click Save or Submit and click through 
any confirmation boxes.

Alma saves the portfolio(s) and refreshes the Portfolios tab of the Electronic 
Service Editor page with options for activating the portfolio.

http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Add%20Local%20Portfolios%20to%20Local%20Packages.pdf
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Figure 81: 

Figure 204: New Portfolio Activation Options

9 To activate or deactivate one or more portfolios, select the check box(es) of 
the portfolio(s) you want to activate or deactivate and click the activation 
action you want. (Alternately, for just one portfolio, you can select the 
Actions button in the portfolio’s row and make your selection there.)

10 Additionally to enter a note for the collection, click the Notes tab, type your 
note in the Quick Add box, and click Add. Repeat the Quick Add process for 
all your notes.

Authentication notes and public notes are both displayed in the discovery 
system. Authentication notes are specifically authentication-related.

For collaborative network and multicampus institutions, if you want to 
designate group access settings for the resource(s), click the Group Settings 
tab and enter the necessary information. For a description of group settings 
for electronic collections, services, and portfolios, refer to Adding Group 
Settings to Electronic Resources on page 280.

11 Click Save to save all the entries and changes on the Electronic Service 
Editor page and return to the Electronic Collection Editor page.

Alma returns you to the Additional Information tab of the Electronic 
Collection Editor page.
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Modifying a Service
During the addition of a service, the system uses a wizard to obtain relevant 
information. You can use the Electronic Service Editor page to update this 
information on tabs that correspond to the steps of the wizard. 

Figure 82: 

Figure 205: Electronic Service Editor - Service Description Tab

To modify a service:

1 Search for the electronic collection that you want to update. For more 
information, see Using the Alma Repository Search on page 18.

The brief results display for the electronic collection. 

2 Click Edit Service.

The Electronic Service Editor page opens. 

3 Update the fields on each tab as needed. Refer to the following table for 
more information.
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Table 39. Electronic Service Editor Page

Field Description
Electronic Collection name Displays the title of the electronic collection that 

contains the portfolio.

Service Type Displays the type of service for the electronic 
collection., full text or select full text.

Service Description tab:

Public description Displays the description given to end users.

Internal description Displays an additional description given to staff users.

Public description 
(override)

Allows you to override the public description.

Authentication note Provides a field for you to enter any note related to 
authentication (to be displayed in the discovery 
system).

Public note Allows you to share information about the service 
with patrons. (The note is displayed in the discovery 
system.)

Activation Information tab:

Service activation status Allows you to activate or deactivate a service 
immediately. The valid choices are Not Available or 
Available.

Activate new portfolios 
associated with service 
automatically

Displays whether new portfolios are automatically 
activated when they are added to this service.

The option to automatically activate new portfolios 
associated with a service is available for selective 
electronic collections in addition to aggregator 
electronic collections. 

(This option can be configured from both the 
Activation Wizard for new services and in the 
Electronic Services Editor for existing services.)

Active from date Allows you to specify an activation range start date. 

Active until date Allows you to specify an activation range end date. 

Service temporarily 
unavailable

Allows you to temporarily deactivate a service 
immediately. The valid choices are No or Yes.

Service unavailable as of 
date

Allows you to deactivate a service starting on a specific 
date.

Service unavailability 
reason

Allows you to specify an unavailability reason.
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Linking Information tab:

Parser Displays the destination service specified for the 
electronic collection.

Parser (override) Allows you to override the parser information shown 
in the Parser field.

Service parser parameters Displays the linking/access information for the service.

Parser parameters Displays the linking/access information for this 
service.

Parser Parameters 
(override)

Enter either the parser parameters or the URL for 
accessing the portfolio. 

Example: url1=http://link.aip.org/link/? & url2=http://
publish.aps.org/ & url3=http://link.aps.org/abstract/ & 
agg=sfx

For information on library-specific parameters, see 
Table 38  on page 296.

URL Displays the URL for accessing the service. 

URL (override) Enter either the Parser parameters field or the URL 
field for accessing the portfolio. The URL overrides the 
URL created based on the parameters taken from the 
electronic collection and service.

Example: http://link.aip.org/link/?

Service is free? Indicates whether the service is free. If a subscription is 
needed, the system displays Not Free.

Crossref Supported Indicates whether cross references are enabled for the 
electronic collection.

Crossref Enabled Allows you to specify the cross-reference options for 
this service:

 No – cross references are not enabled.

 Yes – cross references are enabled.

 INHERIT – cross reference options are inherited 
from the electronic collection.

Proxy enabled Specify whether a proxy has been enabled (Yes/No).

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
regarding proxy relationships among portfolios, 
electronic collections, and services

Table 39. Electronic Service Editor Page

Field Description
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Proxy selected Select a proxy profile option from the drop-down list. 
If you specified Yes for Proxy enabled, you need to 
identify which proxy profile is to be used for 
authentication (of users outside the library’s network) 
to access the online database you have created.

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
on how to create a proxy profile. 

Linking level Displays the linking level for the service (such as Book, 
Journal, Article, or Volume).

Portfolios tab:

Add Local Portfolio Allows you to add a local portfolio to the service. For 
more information, see Adding a Portfolio to an 
Electronic Collection on page 333.

Add Portfolios from 
Community

Displays the Portfolios List page from which you can 
select portfolios to be added.

Add All Portfolios from 
Community

Activates all the portfolios from the Portfolios List 
page.

Load Portfolios Opens a file upload wizard by which you can select an 
Excel-formatted file to load multiple portfolios. For 
more information, see Loading Multiple Portfolios in 
an Electronic Collection (Batch File Processing) on 
page 339

Link Local Portfolios to 
Community

Provides the option to link locally created portfolios to 
the CZ.

Table 39. Electronic Service Editor Page

Field Description
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Actions Allows you to select the following operations per 
portfolio:

 Edit – Opens the Electronic Portfolio Editor in edit 
mode. For more information, see Modifying a 
Portfolio Using the Electronic Portfolio Editor on 
page 349.

 Delete – Displays the Delete Confirmation dialog 
box and provides the following options for how to 
handle childless bibliographic records when 
deleting the portfolio:

 Delete bibliographic record

 Do nothing

 Suppress bibliographic record

 View – Opens the Electronic Portfolio Editor in 
view-only mode.

 Test Access – Displays the associated portfolio on 
the Electronic Services page.

 Deactivate – Deactivates the associated portfolio.

Activate Selected Allows you to activate portfolios that you have 
selected in the list.

Deactivate Selected Allows you to deactivate portfolios that you have 
selected in the list.

Deactivate All Allows you to deactivate all portfolios in the list

Activate All Allows you to activate all portfolios in the list

Delete Selected Allows you to delete selected portfolios from the list.

This action displays the Delete Confirmation alert box 
and provides the following options for how to handle 
childless bibliographic records:

 Delete bibliographic record

 Do nothing

 Suppress bibliographic record

Table 39. Electronic Service Editor Page

Field Description
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Tools  Extended Export –  exports the list of portfolios 
with extended information to Excel

 Excel (Current View) – exports only the fields 
displayed in the list of portfolios to Excel

Exporting can include inactive (Not Available) 
portfolios.

Diacritics in titles can be exported (and imported).

Notes tab:

Note Use this option to enter a staff note regarding the 
portfolio.

Group Settings tab (for collaborative network environments):

Add Group Info Allows you to define:

Group – Select the group name from the drop-down 
list.

Date Information – See the Date Information 
(override) section above for details.

Embargo/Rolling Year – See the Embargo/Rolling Year 
(override) section above for details. 

Table 39. Electronic Service Editor Page

Field Description
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4 Click Save to save your changes to the service.

Working with Electronic Collections of the Database Type
Electronic collections that rely primarily on an online database are set up 
somewhat differently from the primarily service-based package types.

Incorporating online databases in your inventory involves adding the online 
database records to your inventory, performing inventory-related tasks, and 
activating the online databases for patron discovery.

History tab:

The History tab displays a list of changes related to the 
electronic service. For each change that is saved, the 
following information is shown on the History tab:

 Dates of the change

 Operator that made the change

 Name of the field that was changed

 Old (previous) value

 New value

For fields/columns that are blank or empty, a dash 
displays in the History tab columns.

You can use the Find function to locate a specific 
change by searching for a specific Field name or 

Operator name. Click the  icon next to the ID in 
the Operator column to view the following details 
about the operator in the pop-up window that opens:

 Name

 Primary identifier

 Home address

 Office address

 Email

 Telephone

VIDEO:
For more information about the History tab, 
refer to the History Tab for Electronic 
Resources video (4:26 mins).

Table 39. Electronic Service Editor Page

Field Description

http://www.youtube.com/watch?v=PV_MIwPwb-s&hd=1
http://www.youtube.com/watch?v=PV_MIwPwb-s&hd=1
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To add a local database to the inventory:

1 Click Add Local Electronic Collection from Resource Management > 
Create Inventory. The Electronic Collection Editor page opens.

2 Enter the initial database information. Refer to the following table for a 
description of the information to be entered.

Figure 206: Electronic Collection Editor - Database Collection Type

Table 40. Initial Database Information

Option Description
Public name Enter the name that is to display in the discovery 

search results.

Public name (override) Enter a name that you want to display (in the discovery 
search results) as an override to the name identified in 
Public name.

Description Enter the description that is to display in the search 
results.

Internal description Enter a description for internal reference only.

Collection type Select Database (refer to the illustration below).

Library Click the Find icon  and select a library from the list 
to identify the library associated with the database.
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3 Click Save and Continue. The Electronic Collection Editor opens to the 
General Information tab (see Figure 207).

Figure 83: 

Figure 207: Add Local Electronic Collection for a Database

4 Enter the information on the tabs as needed for the database that you are 
adding to the inventory. Refer to Table 41 for information about the fields.

Table 41. Electronic Collection Editor Tabs and Fields

Option Description
Electronic Collection Description tab:

Public name Displays the name that you previously entered.

Public name (override) Displays the public name override that you entered or 
allows you to add this information for the first time or 
edit the information you previously entered.

This name also displays above the tabs.
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Description Displays the description that you previously entered or 
allows you to enter a description if one was not initially 
entered.

Internal description Displays the initial description that you may have 
entered and allows to edit that information or add it for 
the first time.

Library Displays the library you initially selected to associate 
with the database and allows you to search for and 
select a different library from the list.

General Information tab:

Electronic collection type Displays the collection type that you previously 
entered. This can be edited if you decide to follow a 
more service-oriented ordering model.

Interface name Select the vendor for this database.

A link to the interface description is provided when an 
interface name has been entered.

Services This information displays if it is available.

Process type This information displays if it is available.

Access rights Displays the list of access rights; select the relevant one 
for this database.

Created by Displays the user ID of the operator that created the 
database inventory record and the date that the record 
was created.

Updated by Displays the user ID of the operator that updated the 
database inventory record and the date that the record 
was modified.

PO line Use this option to identify the PO line created for the 
database being added.

NOTE:
When adding a database, you may skip this 
option and process the order information later 
after saving the database inventory record.

PO line details Provides the PO line details, if available.

Activation date Enter the activation date.

Expected activation date Enter the expected activation date.

Table 41. Electronic Collection Editor Tabs and Fields

Option Description
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Active license Click the search icon to display the list of licenses and 
amendments. Select the vendor license for the database 
that you are adding.

View license details Displays a link to the license details when an active 
license is selected.

Authentication note Specify any note related to authentication (to be 
displayed in the discovery system).

Public note Use this note option to share information about the 
database with patrons. (This note is displayed in the 
discovery system.)

Additional Information tab:

Source This is a placeholder for future development for 
external resources.

Source ID This is a placeholder for future development for 
external IDs.

Creator This is a placeholder for future development for 
external resources.

Alternative title This is a placeholder for future development for 
external resources enabling an alternative title (to the 
external resource) to be specified.

URL Enter the URL for the database.

Database is free? Specify if the database is free.

Proxy enabled Select Yes or No.

Proxy selected Select a proxy profile option from the drop-down list. 
When you specify Yes for Proxy enabled, you need to 
identify which proxy profile is to be used for 
authentication (of users outside the library’s network) 
to access the online database you have created.

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
regarding how to create a proxy profile. 

Language Specify the language of the database from the drop-
down list.

Category Specify the subject that the online database handles.

Table 41. Electronic Collection Editor Tabs and Fields

Option Description
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Additional descriptive 
information

Click the Find icon  to display the Repository Search 
page and search for the MARC bibliographic record to 
link with the database that you are adding.

IMPORTANT:IMPORTANT:
The MARC bibliographic record selected for 
this option displays in the discovery (Primo) 
search results. This is the MARC 
bibliographic record that the library’s 
cataloger has created specifically for the 
database being added.

Notes tab:

Note Enter a note and click Add. Click Clear to remove all 
text that you have entered.

Use this option to enter multiple notes that can be 
referenced by staff. Row actions allow you to edit and 
delete notes.

Group Settings tab (for collaborative network/multicampus environments):

Add Settings for Group Allows you to define the following Available For 
details:

 Group (select the group name from the drop-down 
list)

 Parameters:

 Electronic collection proxy enabled (Yes, No, or 
Resource Default)

 Electronic collection proxy selected (select from 
the drop-down list of preset proxies)

 Public name

 Authentication note

 Public note

Table 41. Electronic Collection Editor Tabs and Fields

Option Description
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5 After completing the information on the tabs, click Save. The Repository 
Search page opens displaying the database record that you have added 
(refer to the figure below). With this record, you can process other tasks 
related to the online database such as placing an order.

History tab:

The History tab displays a list of changes related to the 
electronic service. For each change that is saved, the 
following information is shown on the History tab:

 Dates of the change

 Operator that made the change

 Name of the field that was changed

 Old (previous) value

 New value

For fields/columns that are blank or empty, a dash 
displays in the History tab columns.

You can use the Find function to locate a specific 
change by searching for a specific Field name or 

Operator name. Click the  icon next to the ID in the 
Operator column to view the following details about 
the operator in the pop-up window that opens:

 Name

 Primary identifier

 Home address

 Office address

 Email

 Telephone

VIDEO:
For more information about the History tab, 
refer to the History Tab for Electronic Resources 
video (4:26 mins).

Table 41. Electronic Collection Editor Tabs and Fields

Option Description

http://www.youtube.com/watch?v=PV_MIwPwb-s&hd=1
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Figure 208: Local  Electronic Collection Record Added

NOTE:
The institution icon displays in grey (not color) since the database 
resource has not yet been activated and made available to patrons.

To place an order:

1 Click the Order link.
Figure 84: 

Figure 209: Order Link

The PO Line Owner and Type page opens.

Figure 210: PO Line Owner and Type

2 Enter the Purchase Type and PO Line Owner and click Create PO Line.
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Figure 211: PO Line Owner and Type Entered

3 Enter the PO line information for the online database. (Refer to Manually 
Creating a PO Line in the Alma Acquisitions Guide for additional information 
regarding entering PO lines.)
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Figure 85: 

Figure 212: Add PO Line Information

4 When you have completed entering the PO line information, select Order 
Now from the drop-down list and click Go.

5 When the Confirmation Message box appears, click Confirm.

The Purchase Order Lines in Review page opens and your usual 
acquisitions workflow can be completed.

NOTE:
Once the order has been completed, an electronic resource activation task 
is automatically added to the Electronic Resource Activation Task List. 
Refer to Activating Electronic Resources on page 392 for additional 
information.
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To confirm/verify the discovery interface display:

1 Complete an All titles repository search for the online database.

The search results display for the online database. Refer to the figure below 
for an example.

Figure 213: All Titles Repository Search Results for Online Database

NOTE:
To locate the online database inventory record with an All titles search 
requires that the online database record includes a repository link. The 
repository link is entered on the Additional Information tab in the 
Additional descriptive information option.  
 

2 Click View It. The Electronic Services page opens.

3 Optionally, click Display in a new window to view the URL link stored 
with the online database settings.

Linking a Local Electronic Collection to the Community Zone
Alma provides the capability to link local electronic collections (including 
services and portfolios) to the Community Zone (CZ). This provides the benefits 
of CZ updates to the electronic collections/portfolios that you link to the CZ. 

When you initially link an electronic collection to the CZ, you are provided the 
options to attempt to link the electronic collection, the service, and all the local 
portfolios. Once an electronic collection is linked to the CZ, you have the option 
to attempt to link any local portfolios that are part of the electronic collection to 
CZ portfolios that are part of the electronic collection (refer to Linking a Local 
Portfolio to the CZ When the Portfolio is Part of a CZ-Linked Service/
Electronic Collection on page 377 for related information).

This capability is implemented with the Link to Community action (refer to the 
procedure below) that is the first step in the process of linking resources to the 
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CZ. As part of this implementation, the system automatically executes a job to 
process your linking request to the CZ and provides a report of the results 
through Monitor Jobs (Administration > Manage Jobs).

The linking job called Link local electronic resources to the Community Zone 
job provides the following report information when the job has completed 
running:

 Total number of local portfolios processed

 Number of local portfolios linked to the CZ

 Number of local portfolios with no match

 Number of multiple bibliographic records with matches (with a link to a set 
containing MMS IDs)

 Number of multiple portfolio matches (with a link to a set containing MMS 
IDs)

 Number of bibliographic records linked to the Network Zone for 
collaborative networks (with a link to a set containing MMS IDs)

 Number of duplicate portfolios

The following local collection, service, and portfolio information is kept when 
the linking job is run:

 Group settings

 PO line and license

 Public name (electronic collection)

 Description

 Notes

 Library

 PDA ID (portfolios)

VIDEO:
For more information about linking local electronic collections to the CZ, 
see the Link a Local Electronic Collection to a Community Zone Collection 
video (6:11 mins).

http://www.youtube.com/watch?v=5n3xlDozjgY&hd=1
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To link a local electronic collection to the Community Zone:

1 Search for a local electronic collection that you want to link to the CZ. Your 
search results display the Link to Community action. 

Figure 86: 

Figure 214: Electronic Collection Link to Community Action

2 Click Link to Community. The Link Electronic Resources to Community 
page opens. The page contains the following sections:

 Local Information. Within this section, the following information is 
provided:

 Electronic collection name – This is the local electronic collection name 
that displayed in your search results

 Type – This is the collection type (Selective package, Aggregator 
package, or Database)

 Interface name

 Service type (Full text, Select full text, or None)

 Total number of portfolios

 Number of local portfolios

 Community Information. Use this section to identify the name of the 
electronic collection to which you want to link in the CZ. Once you have 
specified this information, the Type, Interface name, and Service type 
information is updated based on the information provided by the CZ link.

 Bibliographic Records Configuration. Use this section to identify how you 
want the system to use the bibliographic record information available in the 
CZ. If you select Yes and a portfolio match is found in the CZ, the 
bibliographic record associated with the linked portfolio is the CZ 
bibliographic record. If you select No and a portfolio match is found in the 
CZ, the portfolio that is linked to the CZ portfolio will use the local 
bibliographic record. The match routine for this job uses either the ISSN or 
the ISBN identifier to confirm a match between the local portfolios in the 
electronic collection being linked with portfolios in the CZ. 
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Figure 87: 

Figure 215: Link Electronic Resources to Community Page

3 Using the browse capability of the Electronic collection name option, locate 
the electronic collection in the CZ to which you want to link. 

Figure 88: 

Figure 216: Browse CZ for Electronic Collection to Link To

Figure 89: 

Figure 217: Enter Browse Criteria
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Figure 90: 

Figure 218: Browse Results

4 Select an electronic collection (radio button) from the list of results and click 
the Select button.

Figure 91: 

Figure 219: Select from the Results List

Alma displays your selection and related information on the Link Electronic 
Resources to Community page.
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Figure 92: 

Figure 220: Electronic Collection Name Selected from the CZ

NOTE:
The fields in the Community Information section and the Bibliographic 
Records Configuration sections are dynamically updated once you have 
selected/entered the electronic collection name from the CZ.

5 Select Yes or No for the Use the community bibliographic records option 
and click Link. A pop-up dialog box opens with a summary/warnings 
regarding the linking selections that you have made.

Figure 93: 

Figure 221: Linking Summary/Warnings
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6 Review the information in the pop-up dialog box and, if everything is in 
order, click Confirm. The system displays a successful confirmation 
message that the linking job (your request) has been submitted. (This is the 
linking job that Alma automatically runs when you process a CZ link 
request as described in the previous steps.)

Figure 94: 

Figure 222: Job Submitted Successfully Message

7 Check the Job Monitor to review the status of your CZ linking job.

a Open the Monitor Jobs page (Administration > Manage Jobs).
Figure 95: 

Figure 223: Monitor Jobs Page

b Select the Completed tab.
Figure 96: 

Figure 224: Monitor Jobs Completed Tab
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c Locate the Link local electronic resources to the Community Zone job 
to display your job results.

d Select Actions > Report (or click the Link local electronic resources to 
the Community Zone job link in the Name column). The Job Report 
page opens. 

Figure 97: 

Figure 225: CZ Linking Job Report

Managing Local Portfolios

PERMISSIONS:
To manage local portfolios, you must have the following roles:

 Electronic Inventory Operator

 Electronic Inventory Operator Extended (required for delete operations)

Portfolios may be defined as standalone entities or as part of an electronic 
collection. As a result, Alma allows you to create and update portfolios 
separately from the workflow used to add local electronic collections. For more 
information on adding local electronic collections, see Adding a Local 
Electronic Collection on page 288.

Alma provides inventory operators the ability to perform the following tasks for 
local portfolios: 

 Adding a Standalone Portfolio on page 328

 Adding a Portfolio to an Electronic Collection on page 333

 Adding a Set of Standalone Local Portfolios to a Local Electronic 
Collection on page 333
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 Removing a Local Portfolio from a Local or CZ Electronic Collection on 
page 337

 Loading Multiple Portfolios in an Electronic Collection (Batch File 
Processing) on page 339

 Working with the Excel Batch File on page 343

 Modifying a Portfolio Using the Electronic Portfolio Editor on page 349

 Modifying a Portfolio in an Electronic Collection Using the Electronic 
Service Editor on page 363

 Adding Multiple Electronic Resources to a PO Line Using the Electronic 
Portfolio Editor on page 365

 Performing Global Changes on Portfolios on page 368

 Deleting Portfolios on page 372

 Linking a Local Portfolio to the CZ When the Portfolio is Part of a CZ-
Linked Service/Electronic Collection on page 377

 Associating a License at the Portfolio Level on page 384

NOTE:
After you add a standalone portfolio, you can locate it using the repository 
search and link it to a matching portfolio in the Community Zone (CZ). 
For details, see the explanation for Link to community in .

Adding a Standalone Portfolio
Alma allows you to add standalone portfolios individually.

NOTE:
After you add a portfolio, you can locate it using the repository search and 
link it to a matching portfolio in the Community Zone (CZ). For details, 
see the explanation for Link to community in .
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To add a local portfolio:

1 Select Create Inventory > Add Local Portfolio from the Resource 
Management menu. The New Portfolio page opens.

Figure 226: New Portfolio Page Options

2 Enter the required portfolio information as described in the following table, 
when Portfolio Type is set to Standalone. (For a portfolio that is part of an 
electronic collection, see Adding a Portfolio to an Electronic Collection on 
page 333.)

Table 42. New Portfolio Page Options (Standalone and Electronic Collection)

Field Description
Descriptive Information:

Creation Type Either create a new title or use an existing title from the 
system.
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Choose Title Select an existing title. Click the Find icon  to open 
the Repository Search page and select a bibliographic 
record that links to the repository.

Title Enter a new title.

Alternative Title 1 Use these options to provide additional information if 
you created a new title.

Alternative Title 2

ISSN

e-ISSN

ISBN

e-ISBN

General Information:

Portfolio Type Select Standalone or Part of an electronic collection.

Electronic Collection 
(for part of an electronic 
collection)

Links to an electronic collection in the repository.

Click the Find icon to open the Repository Search page 
and select the electronic collection.

NOTE:
When you create a portfolio as a step in creating 
an electronic collection, the electronic collection 
link defaults to the one being created.

Service 
(for part of an electronic 
collection)

Select the service (such as Full Text) from the available 
service options for the selected electronic collection.

Interface name 
(for standalone)

Enter a vendor interface for the standalone portfolio. 
Use the Find icon to search  from the available list of 
vendor interfaces.

Library 
(for standalone)

Enter the owning library. Ownership determines the 
organizational unit that manages the resource. (It does 
not determine who has access to the resource.) Library 
ownership is not required.

Electronic resource ownership defaults to the 
institution level. 

Table 42. New Portfolio Page Options (Standalone and Electronic Collection)

Field Description



Chapter 5: Inventory

331January 2015

Alma Resource Management

Ex Libris Confidential

Coverage Information:

Date Information:

From Year

Coverage parameters that indicate the content that was 
purchased/activated. These parameters affect service 
resolution (such as Primo). Coverage is displayed in 
the repository search results.

Until Year

From Volume

Until Volume

From Issue

Until Issue

Embargo/Rolling Year:

Operator

Provides a moving wall of availability.Number of Years

Number of Months

Inventory Information:

Linking Information:

Parser 
(for part of an electronic 
collection)

Provides the necessary linking information (if these 
details are not the same as the electronic collection 
linking information).

Example: EBSCO_HOST::ebsco_am

This defaults to the parser information available with 
the electronic collection that you selected in the 
General section.

Service parser parameters 
(for part of an electronic 
collection)

Provides the electronic collection’s parser parameters.

Example:  
db_host=poh&ebscohosturl = http://
search.ebscohost.com & linkurl=http://
openurl.ebscohost.com/linksvc/linking.aspx & 
shib=$$SHIBBOLETH & 
customer_id=$$CUSTOMER_ID

This defaults to the service’s parser parameters 
available with the electronic collection that you 
selected in the General section.

Table 42. New Portfolio Page Options (Standalone and Electronic Collection)

Field Description
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3 Click Save and Continue if you want to save the new portfolio and add 
additional portfolios or Save if you want to save the new portfolio and 
return to the Alma home page.

Once you have saved a portfolio, you can test the link access using the Alma 
Resolver that displays results on the Electronic Services page. Refer to Using 
the Alma Resolver Debugger Tool on page 420.

Parser Parameters

or

URL

Enter one of the following optional parameters as 
needed:

 The portfolio-level parser parameters (part of an 
electronic collection), if this setting is different from 
the Service Parser Parameters previously identified 
(above). Alma uses the portfolio-level parser/parser 
parameters when they are different from the 
service-level parser/parser parameters.

 The URL (standalone or part of an electronic 
collection) for accessing the portfolio. This URL 
overrides the URL created based on the parameters 
taken from the electronic collection, service, and 
portfolio.

Proxy Enabled Specify Yes or No.

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
regarding proxy relationships among portfolios, 
electronic collections, and services.

Proxy Selected If you specify Yes for Proxy Enabled, you need to 
select a proxy from the drop-down list.

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
on how to create a proxy profile. 

Availability Status Indicate whether the portfolio is active or inactive.

Notes:

Authentication Note Use this note to specify additional information related 
to authentication

Public Note Use this option to enter a note regarding the portfolio 
that displays for patrons.

Internal Description Use this option to provide additional information to 
staff regarding the portfolio.

Table 42. New Portfolio Page Options (Standalone and Electronic Collection)

Field Description
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Adding a Portfolio to an Electronic Collection 
Alma allows you to add portfolios individually to electronic collections at any 
time.

To add a portfolio to an electronic collection:

1 Select Create Inventory > Add Local Portfolio from the Resource 
Management menu. The New Portfolio page opens.

2 Enter the required portfolio information as described in Table 42, making 
sure that Portfolio Type is set to Part of an Electronic Collection and the 
associated electronic collection and service are specified. (For a standalone 
portfolio, refer to Adding a Standalone Portfolio on page 328.)

3 Click Save and Continue if you want to save the new portfolio and add 
additional portfolios or Save if you want to save the new portfolio and 
return to the Alma home page.

NOTE:
For additional information, refer to the presentation How to Add Local 
Portfolios to Local Electronic Collections located in the Documentation 
Center. Remember, you must be logged in to the Documentation Center in 
order to view this presentation.

Adding a Set of Standalone Local Portfolios to a Local Electronic 
Collection

By adding a set of standalone local portfolios to a local electronic collection 
service, you can more easily manage portfolios (activate, deactivate, export, and 
delete as a group versus individually, one at a time). Once portfolios are 
grouped into an electronic collection, you can use the portfolio loader 
capabilities to maintain the portfolios. (Refer to Loading Multiple Portfolios in 
an Electronic Collection (Batch File Processing) on page 339 for information 
about using Load Portfolios.)

To add a set of local standalone portfolios to a local electronic collection:

1 Create a set of local standalone portfolios.

2 To add the set of standalone portfolios to an existing local electronic 
collection, do the following or skip to step 3.

a Complete a search to locate the existing local electronic collection.

b Click Edit Service and continue with step 4.

3 To add the set of standalone portfolios to a new local electronic collection:

http://intranet/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Add%20Local%20Portfolios%20to%20Local%20Electronic%20Collections.pdf
http://intranet/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Add%20Local%20Portfolios%20to%20Local%20Electronic%20Collections.pdf
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a On the Electronic Collection Editor page (Resource Management > 
Create Inventory > Add Local Electronic Collection), enter the Public 
name for the electronic collection and other details. 

NOTE:
You can specify the service type (Full Text or Selected Full Text) on the 
Electronic Collection Editor page (eliminating additional steps to make 
this specification).

Figure 98: 

Figure 227: Electronic Collection Editor Page

b Click Save and Continue. The Electronic Service Editor page opens.

4 Select the Portfolios tab.

5 Click the Add from set button. The Add From Set page opens.

6 Search/select the set name (that you created/saved in step 1).

Figure 228: Standalone Portfolio Set

7 Click Submit. An electronic collection confirmation message opens.
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Figure 229: Electronic Collection Confirmation Message

8 Click Confirm. The Electronic Service Editor page shows a job submitted 
message, and a System Job Notification message is emailed with the job 
details.

Figure 230: Job Submitted Message

Figure 231: Emailed Job Report Example
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9 Click Save. The Electronic Collection Editor page displays with an electronic 
collection successfully updated message.

Figure 232: Electronic Collection Successfully Updated Message

10 Click Full Text in the Available Services section and select the Portfolios tab 
to view the standalone portfolios added to the electronic collection.
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Figure 233: Standalone Portfolios Added to Electronic Collection

NOTE:
For end-result examples of where the Electronic Collection name displays 
in your search results in Alma and Primo related to the local portfolios 
that you’ve added to an electronic collection, refer to the “Viewing the 
Local Electronic Collection in Alma” pages in How to Add Local Portfolios to 
Local ElectronicCollections. (You need to be logged in to the Documentation 
Center in order to view this document.)

Removing a Local Portfolio from a Local or CZ Electronic Collection
Alma provides the option to remove a local portfolio from a local or CZ 
electronic collection. By removing a local portfolio from a local or CZ electronic 
collection, you turn it into a standalone portfolio.

To remove a local portfolio from a local or CZ electronic collection:

1 Complete a repository search for the local or CZ electronic collection 
containing the local portfolio that you want to remove.

2 For the electronic collection, in your search results, containing the local 
portfolio to be removed, click Edit Service.

3 Select the Portfolios tab. The electronic collection contents display.

http://www.customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Add%20Local%20Portfolios%20to%20Local%20Electronic%20Collections.pdf
http://www.customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Add%20Local%20Portfolios%20to%20Local%20Electronic%20Collections.pdf
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Figure 234: List of Standalone Portfolios in the Electronic Collection

4 Select Actions > Remove for the local portfolio to be removed from the 
electronic collection. 

This causes the local portfolio to be reverted back to a standalone portfolio.

Figure 235: Actions > Remove Standalone Portfolio

The page refreshes to display the collection contents minus the local 
portfolio that was removed.
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Figure 236: Updated Portfolio List Minus the Removed Local Portfolio

5 Click Save.

Loading Multiple Portfolios in an Electronic Collection (Batch File 
Processing)

You can create, update, and delete portfolios for an electronic collection in batch 
mode by uploading an Excel spreadsheet that contains a list of portfolios. For 
more information these Excel spreadsheets, see Working with the Excel Batch 
File on page 343.

The file upload wizard allows you to load a complete set of portfolios or just the 
ones that have been updated since the last load.

To add multiple portfolios using a batch process:

1 Click Load Portfolios from the Portfolios tab on the Electronic Service 
Editor page.

Figure 99: 

Figure 237: Electronic Service Editor Page Portfolios Tab/Load Portfolios

The Activation Wizard File Upload page opens. Refer to Working with the 
Excel Batch File on page 343 for details regarding the structure and content 
of the Excel file for the batch upload. 
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Figure 100: 

Figure 238: Activation Wizard File Upload Page - Wizard Step 1

2 Enter the name and path of the Excel file (with either the .xls or .xlsx 
extension) you prepared (refer to Working with the Excel Batch File on 
page 343), or click Browse  to select the file.

3 Select one of the following Loading Policy Types in the Select Loading 
Policy section:

 Complete – Loads a complete set of portfolios, overwriting any existing 
portfolios. The following options are available when the Complete 
loading policy type is selected:

 Add local portfolios – Selecting this option indicates that you want 
the system to process the portfolios (in the input Excel file) in the 
following manner:

If a match is found in the CZ for the portfolio, the portfolio is added 
and linked to the CZ.

If a match is not found in the CZ for the portfolio (based on the 
identifier), a match is attempted in the IZ and, if found, the portfolio 
is added as a local portfolio in the electronic collection. Otherwise, a 
new local portfolio record is created and added to the electronic 
collection.

 Update portfolios – Alma updates existing local portfolios with the 
information listed in the Excel file for the matching portfolios when 
this option is selected. For portfolios linked to the CZ, only the 
override information in the portfolio is updated when this option is 
selected.
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 Delete portfolios – Select this option to indicate that:

– If portfolios are in the CZ-linked electronic collection and not in the 
Excel file, they will be deleted

– If portfolios are in the Excel file but not in the CZ-linked electronic 
collection, they will be activated from the CZ (if they exist in the CZ)

This differs from how the system processes the Excel file contents 
when the Delete option for the Incremental loading policy type is 
selected (refer to the description below).

The Delete portfolios option provides the following additional 
options to enable you to specify how you want to handle 
bibliographic records when deleting portfolios results in 
bibliographic records without inventory:

– Delete bibliographic record(s)

– Suppress bibliographic record(s)

– Do nothing

 Incremental – Loads a file that includes only the incremental changes to 
the portfolio list of a specific electronic collection. With this option, you 
can load only the portfolios that have been updated since the last load.

When you choose Incremental, the page refreshes to display the 
following incremental options:

 Add New – This operation adds all portfolios that are listed (in the 
file provided) as new local portfolios to the electronic collection.

 Update – This operation updates the details of all electronic 
collection portfolios that are listed in the file.

 Delete – Select this option to indicate that:

– If local portfolios are in the Excel file and in the electronic 
collection, they will be deleted

– If portfolios are in the Excel file and not in the electronic collection, 
they will be activated from the CZ (if they exist in the CZ)

This differs from the Delete portfolios option under the Complete 
loading policy type (refer to the description above).

The Delete option provides the following additional options to 
enable you to specify how you want to handle bibliographic records 
when deleting portfolios results in bibliographic records without 
inventory:

 Delete bibliographic record(s)

 Suppress bibliographic record(s)

 Do nothing
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4 From the Select Loading Policy section, select Complete and Add local 
portfolios (for this example of using the wizard). 

NOTE:
For additional examples of the loading policy types, refer to Using the 
Alma Portfolio Loader - Examples. (You need to be logged in to the 
Documentation Center in order to view this document.)

5 Click Next. The Excel file is validated and imported.

If there are errors in the Excel file, the Activation Wizard File Upload page 
specifies that errors exist. Click the Download Excel file to correct 
validation errors link and open the file. Correct the errors in your original 
Excel file and re-import/upload the file as described in the previous steps. 

Figure 101: 

Figure 239: Download Excel File to Correct Validation Errors Link

If the file has no errors and is validated, the Activation Wizard: Activation 
Summary page opens, displaying the number of portfolios to be activated as 
well as the number of portfolios to be created locally.

http://www.customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/Using%20the%20Alma%20Portfolio%20Loader%20-%20Examples.pdf
http://www.customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/Using%20the%20Alma%20Portfolio%20Loader%20-%20Examples.pdf
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Figure 102: 

Figure 240: Activation Wizard: Activation Summary Page - Wizard Step 2

To view information and warnings in the Excel file, click the Download 
Excel file to view information and warnings link.  

6 Click Load. Alma returns to the Electronic Service Editor page and displays 
a confirmation message that the upload job has been submitted.

7 Click Save. Alma displays a confirmation that the data has been successfully 
updated.

Working with the Excel Batch File

VIDEO:
Refer to Portfolio Export/Import Improvements for a detailed description of 
enhancements available when exporting and importing the electronic 
portfolios of a given service (8:30 mins). Note that this video was 
produced in December 2013 and that some elements that are shown may 
have changed in Alma since then.

Portfolio information such as proxy settings, URL, parser parameters, and 
Available For groups can be imported and exported via an Excel spreadsheet.

http://www.youtube.com/watch?v=jHbJ2IDLgYs&hd=1
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The following table describes the fields that the Excel file (located in the 
Alma > Product Documentation > Resource Management folder in the 
Documentation Center) should contain. 

NOTES:
 The supported formats are .xls and .xlsx.

 Local portfolios can be loaded, using Load Portfolios (refer to Loading 
Multiple Portfolios in an Electronic Collection (Batch File Processing) 
on page 339) without an identifier such as an ISSN, ISBN, or portfolio ID.

Table 43. Excel File Fields

Field Description
ISSN Enter one or more (for cases in which more than one 

ISSN—such as an E-ISSN—exists) ISSN identifiers. Alma 
uses the first identifier that provides a successful match.

NOTE:
At least one of the following must be available in 
the Excel file: PORTFOLIO_PID, ISSN, or ISBN.

ISBN Enter one or more (for cases in which more than one 
ISBN—such as an E-ISBN—exists) ISBN identifiers. 
Alma uses the first identifier—ISBN10 or ISBN13—that 
provides a successful match.

NOTE:
At least one of the following must be available in 
the Excel file: PORTFOLIO_PID, ISSN, or ISBN.

PORTFOLIO_PID The internal PID number used for the portfolio in Alma. 
This identifier is available only if you clicked the 
Extended Export button and exported portfolios listed 
in the Electronic Service Editor Page Portfolios tab to 
Excel. It is exported in cases where there is no ISSN or 
ISBN.

MMS This field is used for the Alma MMS ID.

TITLE Enter the 245 |a to apply for this title. This field is 
added to the local portfolio information when Add local 
portfolios is selected (see procedure below) and no 
match is found.

FROM_YEAR The coverage start date of the title (in YYYY format).

TO_YEAR The coverage end date of the title (in YYYY format).

portfolio loader.xls
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FROM_VOLUME The numeric volume number from which the title 
coverage begins.

TO_VOLUME The numeric volume number at which the title coverage 
ends.

FROM_ISSUE The numeric issue number from which the title coverage 
begins.

TO_ISSUE The numeric issue number at which the title coverage 
ends.

WARNINGS This field provides an Alma system-generated message 
to let you know that multiple coverages have been 
defined and that only the first coverage defined is being 
exported.

PUBLICATION_DATE_
OPERATOR

Embargo date operator. Use one of the following: >, <, or 
=

PUBLICATION_DATE_
YEAR

Enter the number of years for coverage information. This 
relates to the Number of Years field for Embargo/
Rolling Year under Coverage Information for a portfolio 
(refer to Table 42). 

PUBLICATION_DATE_
MONTH

Enter the number of months for coverage information. 
This relates to the Number of Months field for 
Embargo/Rolling Year under Coverage Information for a 
portfolio (refer to Table 42). 

GLOBAL_FROM_YEAR This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

GLOBAL_TO_YEAR This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

GLOBAL_FROM_ 
VOLUME

This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

GLOBAL_TO_VOLUME This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

GLOBAL_FROM_ISSUE This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

Table 43. Excel File Fields

Field Description
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GLOBAL_TO_ISSUE This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

GLOBAL_WARNINGS This field provides an Alma system-generated message 
to let you know that multiple global coverages have 
been defined and that only the first coverage defined is 
being exported.

GLOBAL_ 
PUBLICATION_DATE_
OPERATOR

This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

GLOBAL_ 
PUBLICATION_DATE_
YEAR

This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

GLOBAL_ 
PUBLICATION_DATE_
MONTH

This field is used for global coverage information as 
shown on the Electronic Portfolio Editor > Coverage 
Information tab.

AVAILABILITY Specify one of the following values: 

 ACTIVE 

 INACTIVE

PUBLISHER Free text. This field is added to the local portfolio 
information when Add local portfolios is selected and 
no match is found.

URL Use this field to provide a URL that is only intended for 
overriding URLs of global portfolios or for setting a URL 
on local portfolios. This field is added to the local 
portfolio information when Add local portfolios is 
selected and no match is found. 

PARSER_PARAMETERS Use this field to specify linking information (like on the 
Linking Information tab in the Electronic Service 
Editor).

Table 43. Excel File Fields

Field Description
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PROXY_ENABLE Specify true or false (until the June release, use 
lowercase letters).

True is the same as selecting the Yes radio button for 
Proxy enabled on the Linking Information tab  in the 
Electronic Portfolio Editor.

False is the same as selecting the No radio button for 
Proxy enabled on the Linking Information tab  in the 
Electronic Portfolio Editor.

NOTE:
The “portfolio” PROXY_LEVEL must be specified 
in order to use PROXY_ENABLE.

PROXY_SELECTED When you specify true for the PROXY_ENABLE field, 
you need to specify the proxy to be used.

NOTE:
The “portfolio” PROXY_LEVEL must be specified 
in order to use PROXY_ENABLE.

PROXY_LEVEL Specify portfolio or service.

AUTHOR Free text. This field is added to the local portfolio 
information when Add local portfolios is selected and 
no match is found.

ELECTRONIC_ 
MATERIAL_TYPE

Specify one of the values from the drop-down list.

OWNERSHIP Use this field to specify the name of the library that owns 
the portfolio.

GROUP_NAME Use this field to enter the name of the Available For 
group. Multiple group names may be specified in this 
field when separated by a semicolon.

NOTE:
This field is specific to collaborative network and 
multicampus institutions and should be left blank 
otherwise.

AUTHENTICATION_ 
NOTES

This field is used for authentication notes as shown in 
the Electronic Portfolio Editor > Portfolio Information 
tab.

PUBLIC_NOTES This field is used for public notes as shown in the 
Electronic Portfolio Editor > Portfolio Information tab.

Table 43. Excel File Fields

Field Description
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INTERNAL_ 
DESCRIPTION

This field is used for an internal description as shown in 
the Electronic Portfolio Editor > Portfolio Information 
tab.

COVERAGE_ 
STATEMENT

Use this field for one of the following coverage 
statements that displays on the Coverage Information 
tab in the Electronic Portfolio Editor:

 Only local

 Global and local

 Global or local

 Only global

ACTIVATION_DATE This field is used for the activation date information as 
per the Electronic Collection Editor > General 
Information tab.

EXPECTED_ 
ACTIVATION_DATE

This field is used for the expected activation date 
information as per the Electronic Collection Editor > 
General Information tab.

LICENSE This field is used for the license details information as 
per the Electronic Collection Editor > General 
Information tab and the Electronic Portfolio Editor > 
Portfolio Information tab.

NOTE:
When using the Extended Export tool from a 
portfolio list resulting from a Repository search 
(refer to Figure 241), the exported Excel file 
contains an extra License Name column. This 
column is not used during an import/portfolio 
load.

PDA This field is used to identify patron-driven acquisitions 
as shown in the Electronic Portfolio Editor > Portfolio 
Information tab.

NOTES Enter any notes you would like included in the 
portfolio’s public note field.

NOTE:
Notes are appended to existing note content when 
imported. Duplicate note content may occur when 
you export notes and, subsequently, import the 
same note content.

Table 43. Excel File Fields

Field Description
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Figure 103: 

Figure 241: Extended Export Tool

The Excel spreadsheet is formatted with the first row containing the heading 
information (for each field) and each subsequent row containing the 
information for a single portfolio. Refer to the example below.

Figure 242: Upload Portfolios Partial Spreadsheet Example

Modifying a Portfolio Using the Electronic Portfolio Editor
During the creation of a portfolio, the system uses the New Portfolio page to 
add portfolios to an electronic collection or to create standalone portfolios. The 
Electronic Portfolio Editor page allows you to update this information on the 
following tabs: 

 Portfolio Information

 Linking Information

 Coverage Information

 Notes

 Group Settings (for collaborative network/multicampus environments)
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Figure 104: 

Figure 243: Electronic Portfolio Editor - Default Tab (Coverage Information)

To modify an electronic portfolio:

1 Search for the electronic portfolio that you want to update. For more 
information, see Using the Alma Repository Search on page 18.

The brief results display for the electronic portfolio. 

2 Click Edit.

The Electronic Portfolio Editor page opens. 

3 Update the fields on each tab as needed. Refer to the following table for 
more information.
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Table 44. Electronic Portfolio Editor Page

Field Description
Resource Description Displays the title of the electronic portfolio. Click the 

title to display the simple view of the MARC record.

Relink to another 
bibliographic record

Use this option for times when a portfolio is associated 
with an incorrect descriptive record; or perhaps, there 
is a better descriptive record for a portfolio and you 
want to relink it to a different bibliographic record. 
Refer to the procedure To relink a portfolio to a 
different bibliographic record: on page 357 for more 
information.

This functionality applies to:

 Local standalone portfolios

 Portfolios that are part of a Community Zone 
collection or a local collection

Attach to a collection Use this option to link a single, standalone portfolio to 
an existing electronic collection via the Electronic 
Portfolio Editor.

NOTE:
The Attach to a collection button only displays 
for standalone portfolios.

Refer to the procedure To link a standalone portfolio 
to an electronic collection (from the Electronic 
Portfolio Editor): on page 360 for more information.

Electronic Collection 
Name

(Electronic Collection only) Displays the electronic 
collection name.

Interface Name (Standalone only) Displays the interface name for 
standalone portfolios.

Service Type Displays the type of service for the portfolio.

Portfolio Information tab:

Portfolio availability Indicates whether the portfolio is active. 

When activated, the current date is entered in the 
Activation date field.

When inactivated, the Expected activation date field is 
enabled.
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Electronic material type For standalone portfolios, select the electronic material 
type from the drop-down list of options.

NOTE:
The material type manifests itself only in the Get 
It and Details tabs in Primo. 
 
To customize the labels of the material types, see 
Configuring Physical Item Material Type 
Descriptions on page 740

Activation date Indicates the date on which the portfolio was 
activated.

Expected activation date When the portfolio is inactive, this field allows you to 
specify an expected date of activation.

Interface name (Standalone only) Allows you to choose an interface 
from the Select Vendor Interfaces page.

Library (Standalone only) Specify the name of the owning 
library.

Electronic Collection PO 
Line

(Electronic Collection only) Displays the PO line for 
the electronic collection.

PO Line This option is for your PO line information.

PO line details Provides the PO line details, if available.

License Click the Find icon  and select the active license 
from the Licenses and Amendments page.

Table 44. Electronic Portfolio Editor Page

Field Description
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PDA Use this option to associate migrated electronic books 
to a PDA program without the extra steps of recreating 
the PDA program from the beginning for those 
resources. Click the Browse icon to display the Patron 
Driven Acquisition List page and select a PDA from 
the list to assign to the portfolio.

NOTE:
To assign a PDA to a set of electronic portfolios, 
run the Change electronic portfolio 
information job (Administration > Manage 
Jobs > Run a Job and filter on 
Type=Information Update). Refer to 
Performing Global Changes on Portfolios on 
page 368 for more information.

VIDEO:
For more information about assigning a 
PDA to an electronic portfolio, refer to the 
Assign a PDA to Electronic Portfolios video 
(5:08 mins).

View PDA details Click the PDA link (ID) to view details regarding the 
patron-driven acquisition.

Created by Displays the name of the staff user who created the 
portfolio.

Updated by Displays the name of the staff user who updated the 
portfolio last.

Authentication note Specify any note related to authentication (to be 
displayed in the discovery system).

Public note Use this note option to provide information about the 
database to patrons. (The note is displayed in the 
discovery system.)

Internal description Use this note option to provide information to staff 
users. (The note is displayed only to staff.)

Linking Information tab:

Parser (Service Level) (Electronic Collection only) Displays the destination 
service specified for the electronic collection.

Table 44. Electronic Portfolio Editor Page

Field Description

http://www.youtube.com/watch?v=SK4tU3Qn0Ck&hd=1
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Service Parser Parameters (Electronic Collection only) Displays the linking/access 
information for the service.

Parser Parameters (Electronic Collection only) Displays the linking/access 
information for this portfolio.

Parser Parameters 
(override)

(Electronic Collection only) Enter either the parser 
parameters to override the electronic collection parser 
parameters or enter a URL for accessing the portfolio. 

Example: url1=http://link.aip.org/link/? & url2=http://
publish.aps.org/ & url3=http://link.aps.org/abstract/ & 
agg=sfx

For information on library-specific parameters, see 
Table 38.

URL (Electronic Collection only) Enter the URL for 
accessing the portfolio. The URL can be specified as an 
alternative to the Parser Parameters (override) option. 

(Standalone only) Displays the URL for accessing the 
portfolio.

URL (override) This URL overrides the URL created based on the 
parameters taken from the electronic collection, 
service, and portfolio.

Example: http://link.aip.org/link/?

Proxy enabled Specify whether a proxy has been enabled (Yes/No).

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
regarding proxy relationships among portfolios, 
electronic collections, and services.

Proxy selected Select a proxy profile option from the drop-down list. 
If you specified Yes for Proxy enabled, you need to 
identify which proxy profile is to be used for 
authentication (of users outside the library’s network) 
to access the online database you have created.

Refer to the Resolver Proxies section in the Alma 
Integrations with External Systems Guide for information 
regarding how to create a proxy profile. 

Test access Use this button to test access to the resource.

Table 44. Electronic Portfolio Editor Page

Field Description
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Coverage Information tab:

Which coverage statement 
will be applied?

Newly activated resources come with a global 
coverage statement that you can accept entirely (ONLY 
global), select portions from based on your institution’s 
preferences (ONLY local), or require a BOTH/AND or 
an OR/EITHER presence of coverage.

Specify the coverage statement within an electronic 
collection:

 ONLY local: Fulltext will be displayed if the issue 
date of the article is included in the local coverage 
added to the portfolios.

 global AND local: Fulltext will be displayed if the 
issue date of the article is included in the local 
coverage added to the portfolios AND in the 
coverage defined in the CKB.

 global OR local: Fulltext will be displayed if the 
issue date of the article is included EITHER in the 
local coverage added to the portfolios OR in the 
coverage defined in the CKB.

 ONLY global: Fulltext will be displayed if the issue 
date of the article is included in the coverage 
defined in the CKB.

Coverage Information tab - Date Information section: (Standalone only)

From Year

Enter the coverage parameters that indicate the 
content that was purchased/activated. These 
parameters affect service resolution (such as Primo). 
Coverage is displayed in the repository search results. 
For example, if the resource is available from 1980, 
enter 1980 in the From Year field.

Until Year

From Volume

Until Volume

From Issue

Until Issue

Table 44. Electronic Portfolio Editor Page

Field Description
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Coverage Information tab - Date Information (override) section:

From Year

See the description above.

Until Year

From Volume

Until Volume

From Issue

Until Issue

Coverage Information tab - Embargo/Rolling Year section (Standalone only)

Operator Provides a moving wall of availability. Enter these 
details to match the specifics of your portfolio. For 
example, if the portoflio is available from 1980, but the 
last five years are not available, enter 1980 in the From 
Year (as indicated above), select Greater than from the 
Operator drop-down list, and enter 5 in the Number 
of Years box.

Number of Years

Number of Months

Coverage Information tab - Embargo/Rolling Year (override) section:

Operator

See the description above.Number of Years

Number of Months

Notes tab:

Note Use this option to enter a staff note regarding the 
portfolio.

Group Settings tab (for collaborative network and multicampus institutions):

Refer to Adding Group Settings to Electronic Resources on page 280 that describes 
group settings for electronic collections, electronic services, and electronic portfolios.

Table 44. Electronic Portfolio Editor Page

Field Description
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4 Click Save to save your changes to the portfolio.

To relink a portfolio to a different bibliographic record:

1 Using Repository Search, locate the portfolio that you want to relink and 
open it in the Electronic Portfolio Editor. 

2 Click the Relink to Another Bibliographic Record button. 

History tab:

The History tab displays a list of changes related to the 
electronic portfolio. For each change that is saved, the 
following information is shown on the History tab:

 Dates of the change

 Operator that made the change

 Name of the field that was changed

 Old (previous) value

 New value

For fields/columns that are blank or empty, a dash 
displays in the History tab columns.

You can use the Find function to locate a specific 

change. Click the  icon next to the ID in the 
Operator column to view the following details about 
the operator in the pop-up window that opens:

 Name

 Primary identifier

 Home address

 Office address

 Email

 Telephone

VIDEO:
For more information about the History tab, 
refer to the History Tab for Electronic 
Resources video (4:26 mins).

Table 44. Electronic Portfolio Editor Page

Field Description

http://www.youtube.com/watch?v=PV_MIwPwb-s&hd=1
http://www.youtube.com/watch?v=PV_MIwPwb-s&hd=1
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Figure 105: 

Figure 244: Relink to Another Bibliographic Record

The Relink Confirmation dialog box opens.
Figure 106: 

Figure 245: Relink Confirmation Dialog Box

3 Browse for the bibliographic record to which you want to relink the 
portfolio. 
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Figure 107: 

Figure 246: Identify Bibliographic Record for Relinking

4 Select the bibliographic record to which you want to relink and click Select.

The Relink Confirmation dialog box opens with the selected title displayed.
Figure 108: 

Figure 247: Selected Title Displays

5 Select one of the following options for Handling bibliographic records 
without inventory:

 Delete bibliographic record(s)

 Do nothing

 Suppress bibliographic record(s)

With these options, you can now indicate how you want to handle the 
unlinked bibliographic record.
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6 Click Confirm.

The system processes your relinking request and displays the Electronic 
Portfolio Editor page with the updated Resource description and a 
successfully linked message.

Figure 109: 

Figure 248: New Resource Description for Relinked Portfolio

To link a standalone portfolio to an electronic collection (from the 
Electronic Portfolio Editor):

1 Using Repository Search, locate the standalone portfolio that you want to 
link to an electronic collection and open it in the Electronic Portfolio Editor.

(Hint: Use the Is Standalone electronic portfolio search option in Advanced 
Search.)

2 Click Attach to a Collection.
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Figure 110: 

Figure 249: Attach to a Collection Button

The Select a Collection and Service dialog box opens.
Figure 111: 

Figure 250: Select Electronic Collection and Service for the Standalone Portfolio

3 Browse to select the electronic collection to which you want to add the 
portfolio. The Find drop-down list is limited to the Electronic Collection 
option.
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Figure 112: 

Figure 251: Browse for Electronic Collection

4 Identify the electronic collection to which you want to add the portfolio and 
click Select.

5 In the Select a Collection and Service dialog box, select the type of service 
and click Confirm.

The system processes your change and displays The portfolio successfully 
attached to … message to confirm its successful completion. The Electronic 
Portfolio Editor page updates to display the electronic collection to which 
the portfolio has been added and the service type that was selected.
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Figure 113: 

Figure 252: Electronic Collection and Service Type Selected

Modifying a Portfolio in an Electronic Collection Using the Electronic 
Service Editor

Alma provides the flexibility to manage your work with electronic portfolios on 
an individual level or as part of a collection. This section describes modifying a 
portfolio that is part of a collection using the Electronic Service Editor.

To modify a portfolio in an electronic collection using the Electronic 
Service Editor:

1 Complete a search for an electronic collection.

2 Click Edit Service for a specific collection. 



Alma Resource Management

January 2015364

Chapter 5: Inventory

Ex Libris Confidential

Figure 114: 

Figure 253: Edit Service Link

The Electronic Service Editor opens to the Activation Information tab.

3 Select the Portfolios tab.
Figure 115: 

Figure 254: Electronic Service Editor Portfolios Tab

The Portfolios tab opens. In addition to the information here, you can see 
other services and related electronic resources by clicking the View all 
services link above the tabs. This opens the Electronic Collection Editor 
page that contains the total number of portfolios, how many of the 
portfolios are active, and the active from/until dates by service type (see 
below).
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Figure 116: 

Figure 255: Additional Portfolio Information (Accessed from the View all services link)

4 In the row of the portfolio that you want to edit, select Actions > Edit.

5 To complete your edits, see Modifying a Portfolio Using the Electronic 
Portfolio Editor on page 349. 

Adding Multiple Electronic Resources to a PO Line Using the 
Electronic Portfolio Editor

You can associate multiple electronic resources with the same PO line using the 
relevant Electronic Resource Editor. For portfolios, use the Electronic Portfolio 
Editor.

NOTE:
The following is an example of adding multiple electronic resources to a 
PO line for a portfolio. Similarly, this capability also applies to electronic 
collections of all types.
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To add multiple electronic resources to a PO line using the Electronic 
Portfolio Editor:

1 Identify/locate the PO line number to which you want to add an electronic 
resource. For example, PO line POL-63922 (see below):

Figure 117: 

Figure 256: PO Line Number Example

2 In the Portfolio Information tab on the Electronic Portfolio Editor page 
(Resource Management > Repository Search), select Electronic Portfolio, 
enter your search criteria, and click Edit for the electronic resource that 
you want to add to the PO line. Enter the PO line number that you 
identified in the previous step to connect the electronic resource that you are 
editing to the existing PO line, and select the PO line that openss. The 
system dynamically updates the PO line details.

Figure 118: 

Figure 257: Enter PO Line Number
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Figure 119: 

Figure 258: Select the PO Line Listed

Figure 120: 

Figure 259: PO Line Details Dynamically Updated

3 Click Save. The system displays a successfully updated confirmation 
message.

Figure 121: 

Figure 260: Save/Update Confirmation Message
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Performing Global Changes on Portfolios
Alma allows inventory operators to make global changes to portfolios that have 
been added to a set. Alma supports the following types of global changes to 
portfolios:

 Remove local coverage

 Set a proxy

 Update URLs (such as removing the EZproxy prefix, for example)

 Associate portfolios with a license

 Activate/deactivate portfolios

 Delete portfolios (with the appropriate permissions)

For information on using a job to delete portfolios, see Deleting Portfolios 
on page 372.

Previously, global changes could be made only by using the portfolio loader for 
electronic collections. 

To perform global changes on portfolios:

1 From the Alma main menu > Use the Information Update filter on the Run 
a Job – Select Job to Run page (Administration > Manage Jobs > Run a Job 
and filter on Type=Information Update).

2 Select the Change electronic Portfolio information job.
Figure 122: 

Figure 261: Select Job to Run

3 Click Next and select the set to process. For information on sets, see Adding 
and Modifying Sets on page 84.

4 Click Next to enter task parameters.
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Figure 123: 

Figure 262: Enter Task Parameters

5 Select the check boxes to match your criteria. See the table below for a 
description of each parameter that is applied to the set of records selected in 
Step 2 of the wizard.

For each parameter in the table below, select one of the following conditions 
from the associated drop-down list:
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 Unconditionally – The system will always perform the change to the 
field.

 If field empty – The system will perform the change only when the field 
has no value.

 If field not empty – The system will perform the change only when the 
field has a value.

Table 45. Change Electronic Portfolio Task Parameters

Parameter Description
Set Interface Name (for 
standalone portfolios)

Select the vendor interface name from the drop-down 
list.

NOTE:
This parameter applies to standalone portfolios.

Set Owner Select the owning library from the drop-down list.

Remove Available For 
Groups

Use this parameter to remove the Available For Group 
setting in the set of records that you selected in Step 2 
of the wizard. Use click, Shift+click, or Ctrl+click to 
select the Available For Group(s) to remove.

NOTE:
This parameter is specific to collaborative 
network or multicampus institutions.

Add Available For Groups Use this parameter to add the Available For Group 
setting in the set of records that you selected in Step 2 
of the wizard. Use click, Shift+click, or Ctrl+click to 
select the Available For Group(s) to add.

NOTE:
This parameter is specific to collaborative 
network or multicampus institutions.

VIDEO:
Refer to Assign Available For Groups to a Set of 
Portfolios Using a Job for a detailed 
description of running a batch job which 
assigns Available For groups to a set of 
electronic portfolios, allowing quick 
handling of many portfolios in a single job 
(7:03 mins).

http://www.youtube.com/watch?v=4o_URWOM-PU&hd=1
http://www.youtube.com/watch?v=4o_URWOM-PU&hd=1
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Electronic Material Type Use this parameter to identify a specific material type 
such as Book, Database, Dissertation, Musical Score, 
Streaming Video

Your selection for this option is applied to the set of 
records that you selected in Step 2 or the wizard.

Remove Local Coverage Select this option to remove all types (date information/
embargo) of local coverage to the set of records that 
you selected in Step 2 of the wizard.

Set License Select the license from the drop-down list. This license 
setting is applied to the set of records you selected in 
Step 2 of the wizard.

Set PDA Use this option to associate migrated electronic books 
to a PDA program without the extra steps of recreating 
the PDA program from the beginning for those 
resources. Click the Browse icon to display the Patron 
Driven Acquisition List page and select a PDA from the 
list to assign to the set of electronic portfolios. 

To assign a single portfolio to a PDA, you can use the 
Electronic Portfolio Editor. Refer to the procedure To 
modify an electronic portfolio: on page 350 for more 
information.

Delete or replace URL’s 
prefix/with

Specify the prefix to remove or replace in the first (left) 
field. If you are replacing the URL prefix, enter the new 
value in the with field at the right.

Enable Proxy Select Yes or No from the drop-down list.

Set Proxy If you specified Yes for Enable Proxy, select the proxy 
profile from the drop-down list.

Set Available Status Specify Active or Inactive.

Override Public Note Enter a free-form text note that is applied to the set of 
records that you selected in Step 2 of the wizard. This 
note displays for patrons.

Override Authentication 
Note

Use this parameter to update the authentication note 
for the set of records that you selected in Step 2 of the 
wizard.

Override Internal 
Description

Use this parameter to update the internal description 
(that displays for staff users) in the set of records that 
you selected in Step 2 of the wizard.

Set Activation Date Use this parameter to define the activation date for the 
set of records that you selected in Step 2 of the wizard.

Table 45. Change Electronic Portfolio Task Parameters

Parameter Description
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6 Click Next, specify the job name, and select the schedule for the job.

7 Click Next, review your job specifications (example below), and click Save if 
everything is specified correctly.

Figure 263: Review and Confirm Page

8 Click Save.

Deleting Portfolios
Alma allows users with the role Electronic Inventory Operator Extended to 
delete portfolios by performing the Delete portfolios job on a set of portfolios.

Set Expected Activation 
Date

Use this parameter to identify the expected activation 
date for the set of records you selected in Step 2 of the 
wizard.

Table 45. Change Electronic Portfolio Task Parameters

Parameter Description
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NOTE:
When a portfolio is deleted, electronic resource activation tasks associated 
with the portfolio are also deleted.

To delete portfolios by running a job:

1 On the Run a Job – Select Job to Run page (Administration > Manage 
Jobs > Run a Job), select Withdraw to filter the list.

2 Select the Delete portfolios job and click Next.

Figure 264: Delete Portfolios job

3 Select the set of portfolios to be deleted (that was previously saved using the 
repository search) and click Next.

The Run a Job – Enter Task Parameters page displays the parameters for the 
Delete portfolios job.

Figure 265: Delete Portfolio Parameters

4 Select from the following parameters and click Next.
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 Portfolio is linked to an active PO line

 Delete portfolio

 Skip

 Portfolio is linked to an active e-Activation task

 Delete portfolio

 Skip

 How to handle childless bibliographic record?

 Delete bibliographic record

 Do nothing

 Suppress bibliographic record

5 Enter a job name, select the scheduling option, and click Next.

The Run a Job – Review and Confirm page opens.

6 Review the job selections that you have made; if they are correct, click Save.

To manually delete a local standalone portfolio:

HINT:
The Electronic Inventory Operator Extended role is required for delete 
operations.

1 Locate the portfolio that you want to delete using repository search.

2 Click the Delete link and click Next. 
Figure 124: 

Figure 266: Delete Link

The Delete confirmation pop-up window displays.
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Figure 125: 

Figure 267: Delete Confirmation

3 Select the Handling bibliographic records without inventory option that 
you prefer and click Confirm.

A successful deletion message displays when processing is complete.
Figure 126: 

Figure 268: Successful Deletion Message
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To manually delete a local portfolio that is part of a local or CZ electronic 
collection:

HINT:
The Electronic Inventory Operator Extended role is required for delete 
operations.

1 Locate the portfolio that you want to delete using repository search.
Figure 127: 

Figure 269: Local Portfolio to be Deleted

2 Click Actions > Delete. 
Figure 128: 

Figure 270: Actions > Delete

The Delete confirmation pop-up window displays. 
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Figure 129: 

Figure 271: Delete Confirmation

3 Select the Handling bibliographic records without inventory option that 
you prefer and click Confirm.

When processing is complete, Alma displays a deleted confirmation 
message.

Figure 130: 

Figure 272: Successful Deletion Message

Linking a Local Portfolio to the CZ When the Portfolio is Part of a CZ-
Linked Service/Electronic Collection

Alma provides the capability to link local portfolios that are part of a CZ-linked 
electronic collection to the CZ. This provides the benefits of CZ updates to the 
electronic portfolios that you link to the CZ. 

This capability is implemented with the Link Local Portfolios to Community 
option (refer to the procedure below) for portfolios in the Electronic Service 
Editor. As part of this implementation, the system automatically executes a job 
to process your linking request to the CZ and provides a report of the results 
through Monitor Jobs (Administration > Manage Jobs).

Refer to Linking a Local Electronic Collection to the Community Zone on 
page 320 for related information.
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To link local portfolios to the CZ from the Electronic Service Editor page 
when the portfolios are part of a CZ-linked service/electronic collection:

1 Locate the CZ-linked electronic collection that contains the local portfolios 
you want to link to the CZ.

Figure 131: 

Figure 273: Electronic Collection Search Results

2 Click Edit Service for the electronic collection containing the local portfolio 
that you want to link to the CZ. The Electronic Service Editor page opens.

3 Select the Portfolios tab.
Figure 132: 

Figure 274: Portfolios Tab

4 Click Link Local Portfolios to Community.
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Figure 133: 

Figure 275: Select Local Portfolio and Link to CZ

The Link Electronic Resources to Community page opens. 
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Figure 134: 

Figure 276: Link Electronic Resources to Community Page

5 In the Bibliographic Records Configuration section, select Yes or No for the 
Use the community bibliographic records option and click Link. The 
system displays a pop-up dialog box with a summary/warning of the 
linking actions. 
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Figure 135: 

Figure 277: Linking Summary/Warning

6 Review the information that is provided and if everything is acceptable, 
click Confirm. The link electronic resources job successfully submitted 
message displays on the Electronic Service Editor page. 

Figure 136: 

Figure 278: Successfully Submitted Message

7 Check the Job Monitor to review the status of your linking job.

a Open the Monitor Jobs page (Administration > Manage Jobs).

b Select the Completed tab.

c Locate the Link local electronic resources to the Community Zone job.
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Figure 137: 

Figure 279: Linking Job on the Completed Tab

d Select Actions > Report or click the Link local electronic resources to 
the Community Zone job link in the Name column to display the job 
report.
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Figure 138: 

Figure 280: Linking Job Report

8 Confirm your linking results.

a Search for the electronic collection containing the portfolio that you 
linked to the CZ and click Edit Service for that collection.

b Select the Portfolios tab.
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Figure 139: 

Figure 281: Confirm CZ Link

Associating a License at the Portfolio Level
Alma is able to associate license information with individual portfolios that are 
part of an electronic collection. With the appropriate role, you can access the 
options to specify a license for an individual portfolio; or when one is not 
specified at the portfolio level, the system associates the electronic collection 
license (when one has been identified for the electronic collection) with the 
portfolio. 

In addition to the capability provided in the Electronic Portfolio Editor to 
support this feature, the following related options also provide support for this 
feature:

 More info

The number of licenses displays in the More info dialog box (refer to Using 
the Portfolios List on page 73 for additional information). Click the license 
number link to display the details of the license information. 



Chapter 5: Inventory

385January 2015

Alma Resource Management

Ex Libris Confidential

Figure 140: 

Figure 282: More Info License Information

NOTE:
For an electronic collection, the More info licenses number represents the 
number of different licenses related to the electronic collection. This 
includes the license associated with the electronic collection and the 
different licenses that may be associated with the portfolios within the 
collection. 

 View It/Alma Resolver Show license link

When you use the View It link to display a resource’s information using 
Alma Resolver, the Show (Hide) license link on the Alma Resolver page 
displays the license information defined at the portfolio level. 
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Figure 141: 

Figure 283: Alma Resolver Show (Hide) License Link

 Acquisitions license details Inventory tab

In Acquisitions, the filter in the Active Resources section and the History of 
Resources section of the Inventory tab for license details provides filter 
options for both electronic collections and portfolios. The Resource Type 
column displays the electronic collection or portfolio information in the 
Inventory tab.

For related information, refer to Managing Licenses and Amendments in 
the Alma Acquisitions Guide.
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Figure 142: 

Figure 284: Active Resources Section Filter

Figure 143: 

Figure 285: History of Resources Section Filter
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Figure 144: 

Figure 286: Resource Type Column

VIDEO:
For more information about manageing licenses, see the Manage License of 
an Electronic Portfolio video (2:47 mins).

To associate a license to an individual portfolio that is part of an 
electronic collection:

1 Locate the electronic collection that contains the portfolio to which you want 
to add license information. For this example, note the number of Licenses 
identified in the More info pop-up dialog box, and click Edit to view the 
license information for the SpringerLink Books Biomedical and Life Sciences 
electronic collection (that displays in the General Information tab).

Figure 145: 

Figure 287: Note Licenses for the Example

http://www.youtube.com/watch?v=wZqFsSuaZ1Q&hd=1
http://www.youtube.com/watch?v=wZqFsSuaZ1Q&hd=1
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Figure 146: 

Figure 288: General Information Tab

2 From your search results, click the Portfolio List <number of portfolios> 
link (for this example, the SpringerLink Books Biomedical and Life Sciences 
electronic collection). The list of portfolios displays for the SpringerLink 
Books Biomedical and Life Sciences electronic collection. 

Figure 147: 

Figure 289: Portfolio List Example

3 Click Edit for the portfolio to which you want to assign a different license. 
The Coverage Information tab on the Electronic Portfolio Editor page opens.

4 Select the Portfolio Information tab.
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5 Browse (from the License field) to locate the license that you want to assign 
to this portfolio (different from the license for the electronic collection in 
which this portfolio is a member).

Figure 148: 

Figure 290: Browse for License

Figure 149: 

Figure 291: Licenses and Amendments Page/Options

NOTE:
Use the Find option to narrow the list of licenses displayed.

6 Select the radio button next to the license to be assigned to the portfolio and 
click Select. 
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Figure 150: 

Figure 292: Select License

The new license information displays in the license field in the Portfolio 
Information tab on the Electronic Portfolio Editor page. 

Figure 151: 

Figure 293: Portfolio License Information Selected

7 Click Save. The system returns you to the list of portfolios page for the 
SpringerLink Books Biomedical and Life Sciences electronic collection with 
a confirmation message indicating that the portfolio record was successfully 
updated (with the new license information). 

Figure 152: 

Figure 294: List of Portfolios

8 Click the More info link. It now displays 2 for Licenses instead of 1.
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Figure 153: 

Figure 295: Licenses Updated to 2

Activating Electronic Resources

PERMISSIONS:
To manage electronic resource activation, you must have the following 
roles:

 Electronic Inventory Operator or Repository Manager

 Electronic Inventory Operator Extended (required for delete operations)

Activation of electronic resources begins when you receive an electronic 
material delivery. A resource awaiting activation can be one of the following 
types:

 Electronic collection – Requires completion of the Activation Wizard before 
the resource is activated

 Portfolio – Requires only a confirmation that the resource can be activated

For details on managing electronic resource activation, see:

 Managing Electronic Resource Activation on page 395

 Using the Activation Wizard on page 406
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The workflow for receiving electronic material is as follows:

Figure 296: Receiving Electronic Material Within the Purchasing Workflow

The following is a detailed description of the steps within this workflow (with 
the numbers corresponding to the numbers in the diagram):

1 The electronic material that was ordered from the vendor arrives and is 
processed in Alma. 

2 The electronic material is activated.
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3 The system checks whether the PO line type is continuous. If the type is 
continuous, the system proceeds to step 4. If the type is not continuous, the 
system proceeds to step 5. 

4 The renewal is processed (see Renewals in the Alma Acquisitions Guide).

5 The final step in the receiving workflow is to await the invoice from the 
vendor or create the invoice in Alma (see Invoicing in the Alma Acquisitions 
Guide).

Assigned and Unassigned Electronic Resources
An electronic resource can either be assigned or unassigned.

A resource for activation is assigned to you by your supervisor. Resources that 
you are working on (whether pre-assigned or self-assigned) appear as review 
tasks in your personal task list under the heading Electronic resources assigned 
to you for activation, accessible from the Tasks link on the Alma home page.

Figure 297: Link to Electronic Resources for Activation

When you click this link, the Electronic Resource Activation Task List page 
opens, displaying the electronic resources assigned to you for activation review 
in the Assigned to Me tab.

Only the person assigned to the electronic resource can edit the resource 
information. For details on assigning resources, see the relevant procedure in 
Managing Electronic Resource Activation on page 395. Purchasing managers 
can view the electronic resources assigned to other library staff in the Assigned 
to Others tab.



Chapter 5: Inventory

395January 2015

Alma Resource Management

Ex Libris Confidential

NOTE:
Electronic resources cannot be edited from the Assigned to Others tab.

If an electronic resource is unassigned, it is included in the number of 
unassigned PO lines listed in the Tasks list.

Figure 298: Link to Unassigned Electronic Resources

When you click this link, the Electronic Resource Activation Task List page 
opens, displaying the unassigned resources in the Unassigned tab.

Any staff person with review permissions is authorized to edit unassigned 
electronic resources.

Managing Electronic Resource Activation
After an electronic resource has been added to the inventory, there are other 
tasks that may need to be completed prior to making the resource visible to 
patrons. For example, you may want to test access to the e-resource to confirm 
that the access is working properly. In Alma, these tasks are handled through 
the options provided on the Electronic Resource Activation Task List page 
(Resource Management > Manage Inventory > Manage Electronic Resource 
Activation).
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Figure 154: 

Figure 299: Electronic Resource Activation Task List Page

Electronic resources are automatically added to the Electronic Resource 
Activation Task List page if they are ordered from the Community Zone or 
Institution Zone. They are not automatically added if the Activate option is used 
from the Community Zone search results and there has been no ordering 
process.

In addition, resources may be added to the Electronic Resource Activation Task 
List page by clicking Create E-Activation Task from the Electronic Portfolio 
search results in an IZ repository search.

Figure 155: 

Figure 300: Create E-Activation Task Link

On the Electronic Resource Activation Task List page, you can locate specific 
resources using Find at the top of the resource list. You can select the following 
options from the in drop-down list:

 All

 PO Line

 Title

 Type

When you select the Type option from the in drop-down list, the values that you 
specify in the Find field indicate the electronic resource material type.

NOTE:
Titles without an electronic resource material type have a value of 
Portfolio. The electronic resource material type is determined when the 
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activation task is created, and it cannot be edited. The material type 
manifests itself in Primo’s Get It/Details tabs.

From the Expected Activation Date drop-down list you can filter the list 
according to the following options:

 All – All activation tasks are displayed

 Passed – Only the activation tasks whose activation date has passed are 
displayed

 Not Passed – Only the activation tasks whose activation date has not passed 
are displayed

In the Modified By column that displays on the Electronic Resource Activation 
Task List page, you can click the icon next to the user ID to view additional 
information about the user who modified the title.

From the Electronic Resource Activation Task List page, you can perform the 
row actions described in the following table. 

Table 46. E-Resource Activation Action Options

Action Description
View Use this option to view the activation task.

Edit Use this option to edit the activation task. You can 
change the status and due date and add attachments 
(files, URLs, and related notes) and notes (to describe 
activation task actions and progress, for example).

NOTE:
The value displayed in the Notes tab for the task 
and the resource’s URL are both exported to 
Excel when exporting information on electronic 
resources.

VIDEO:
For more information, see the Due Date 
Added to Activation Tasks List video.

Edit Resource Use this option to edit the e-resource. This opens the 
Electronic Collection Editor page enabling you to edit 
the e-resource in the various tabs. For information on 
the various tabs in the Electronic Collection Editor, see 
Adding a Local Electronic Collection on page 288. (In 
particular, note Table 38 for an explanation of the 
parameters required for some electronic collections.)

https://www.youtube.com/watch?v=yES0VfdY-1k&hd=1
https://www.youtube.com/watch?v=yES0VfdY-1k&hd=1
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Click the Actions button:

 to view a resource’s status and due date

 to edit a resource’s status and due date

Test Access Use this option to test the system access to the database 
resource.

If the electronic collection has a BIB and URL associated 
with it OR if the electronic collection has services 
associated with it, this option will appear. 

If the electronic collection has a BIB/URL with no 
services, clicking it shows the "ViewIt" page as was 
previously done for databases.

If the electronic collection has services associated with 
it and no BIB/URL, clicking this will show the Portfolio 
List.

If the electronic collection has both, clicking this will 
show the Portfolio List as was previously done for 
packages.

Activate (Deactivate) Use this option to activate the e-resource. Selecting 
Activate makes the e-resource available for publishing 
for discovery (Primo). This is the mechanism that 
reveals or suppresses (Deactivate) the MARC 
bibliographic record linked to the database e-resource.

Assign To Use this option to manage operator assignments in the 
Electronic Resource Activation Task List.

Release Assignment Use this option to release an assignment in the 
Electronic Resource Activation Task List. Released 
assignments display on the Unassigned tab.

Done Use this option to change the activation task status to 
Done. When this option is selected:

 Interested Users receive an email notification that 
activation of the electronic resource is complete. For 
details on adding interested users to a PO line, see 
the To create a PO line: procedure in the Alma 
Acquisitions Guide.

 The task is removed from the Opened Tasks list and 
displays only when the All or Done status views are 
selected.

Delete Use this option to remove the electronic resource 
management task.

Table 46. E-Resource Activation Action Options

Action Description
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 To add an attachment to a resource

 To add a note to a resource

 to edit a resource’s details

 to view a resource’s content

 to activate a resource

 to change a resource’s assignment

 to release a resource’s assignment

 to mark a resource as done

To view a resource’s status and due date:

Select Actions > View for a resource. The E-Activation Task Details page opens 
in view-only mode.

Figure 301: View E-Activation Task Details Page

To edit a resource’s status and due date:

1 Select Actions > Edit for a resource. The E-Activation Task Details page 
opens in edit mode.

Figure 302: Edit E-Activation Task Details Page
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2 Select the status to which you want to change the resource from the Status 
drop down list. The available options are:

 Access Confirmed

 Check Access

 Done

 Not Yet Online

3 Click the calendar icon and select a new due date. When the due date 
passes, a notification is sent to the user that is assigned the e-resource 
activation task and an alert is displayed in the user’s list of tasks. For 
information on creating a default due date, see Configuring Other Settings 
on page 695. For more information, see the Manually Creating a PO Line 
section of the Alma Acquisitions Guide. 

VIDEO:
For more information, see the Due Date Added to Activation Tasks List video.

4 Click Save.

NOTE:
You can also edit the status of multiple resources on the Electronic 
Resource Activation Task List page by selecting the check box of the 
relevant resources, selecting the status from the drop-down list at the 
bottom of the page, and clicking Change Status. Refer to the figure below.

https://www.youtube.com/watch?v=yES0VfdY-1k&hd=1
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Figure 303: Change Status for Multiple Tasks from the Task List Page

To add an attachment to a resource:

1 Select Actions > Edit for a resource. The E-Activation Task Details page 
opens in edit mode.

2 Click the Attachments tab.

3 Click the Browse icon in the File name field and select a file.

4 Add a URL and/or note, if required.

5 Click Add Attachment. The attachment is displayed in the list of 
attachments in the Attachments tab.
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Figure 304: Attachment Tab Options

To add a note to a resource:

1 Select Actions > Edit for a resource. The E-Activation Task Details page 
opens in edit mode.

2 Click the Notes tab.

3 Enter a note into the Note area.

4 Add a URL and/or note, if required.

5 Click Add. The note is displayed in the list of notes in the Notes tab.

Figure 305: Notes Tab
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To edit a resource’s details:

Select Actions > Edit Resource for a resource. The Electronic Collection Editor 
page opens. For details on the Electronic Collection Editor page, see Adding a 
Local Electronic Collection on page 288. (In particular, note Table 38 for an 
explanation of the parameters required for some electronic collections.)

To view a resource’s content:

1 Select Actions > Test Access for a resource.

 If the resource does not contain a portfolio, the Electronic Services page 
opens with a link to the resource’s full text.

 If the resource contains a portfolio, the Portfolios List page opens.

Figure 306: Portfolios List Page

The following table describes the options available on the Portfolios List 
page.

Table 47. Portfolios List Page Options

Option Description
Edit Displays the Electronic Portfolio Editor page, 

containing the portfolio details (see Modifying a 
Portfolio Using the Electronic Portfolio Editor on 
page 349).
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Activate Activates or deactivates the portfolio, depending on its 
current status. The updated status is displayed at the 
top of the Portfolios List page.

NOTE:
To activate/deactivate multiple resources, select 
the check box for the resources, select Activate or 
Deactivate from the drop-down list (at the top or 
bottom right side of the page), and click Execute.

View Enables viewing portfolio information on the Electronic 
Portfolio Editor page. Information accessed through 
this option is read-only.

Document delivery Displays the Create Request page, where a request for 
the resource is configured (see Creating a Request in 
the Alma Fulfillment Guide).

Create e-activation task Creates an electronic activation task for the resource. 
The updated status is displayed at the top of the 
Portfolios List page.

Test access The Electronic Services page opens with a link to the 
resource’s full text.

More info A dialog box is displayed containing additional 
information about the resource.

 Title—The resource title

 Related—Indicates whether there are any related 
resources

 Records—Indicates whether the resource contains 
any records

 Orders—A link to orders that have been placed for 
the resource (if relevant). When clicking the link, the 
Select PO Line page is displayed for the resource.

 Licenses—Indicates whether there are any licenses 
for the resource

 Number of linked courses

VIDEO:
For information on displaying the courses 
associated with a title, see the View Courses 
Linked to a Title video (2:43 mins).

Table 47. Portfolios List Page Options

Option Description

http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
http://www.youtube.com/watch?v=PBY0HTvroBo&hd=1
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2 Click Back to return to the Electronic Resource Activation Task List page.

To activate a resource:

Select Actions > Activate for a resource.

 If the selected PO line is for a standalone or single title, a confirmation box 
opens. When you click Confirm to activate the resource, the Activation 
Feedback dialog box opens, asking if you want to edit the resource. Click 
Confirm to open the Electronic Collection Editor page and edit the resource, 
or click Cancel to return to the PO Lines Waiting for Activation page. For 
details on the Electronic Collection Editor page, see Adding a Local 
Electronic Collection on page 288.

 If the selected PO line is for an electronic collection, the Activation Wizard: 
Electronic Collection and Services Setup page opens (see Using the 
Activation Wizard on page 406).

Figure 307: Activation Wizard: Electronic Collection and Services Setup Page
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To change a resource’s assignment:

1 Select Actions > Assign To for a resource. The Assign To dialog box opens.

2 From the Assign to drop down list, select a user to whom you want to 
assign the resource.

3 In the Note area, enter a note, as needed.

4 Select Send as e-mail to send a notification to the user through email.

5 Click Assign To to assign the resource to the indicated user.

To release a resource’s assignment:

Select Actions > Release assignment for a resource. The resource is displayed in 
the Unassigned tab.

To mark a resource as done:

Select Actions > Done for a resource. The PO line continues to the next stage of 
the workflow, as follows:

 If the PO line is One Time, it closes when fully invoiced. If it is not fully 
invoiced, it is marked as Waiting for Invoice in the Invoice status field of 
the PO Line Summary page, and awaits invoicing (see Invoicing in the Alma 
Acquisitions Guide).

 If the PO line is Continuous, it is marked for renewal and is displayed on 
the PO Lines to Renew page.

Using the Activation Wizard
1 Enter the required information in the Activation Wizard: Electronic 

Collection and Services Setup Page, as described in the following table:

Table 48. Activation Wizard: Electronic Collection and Services Setup Fields

Field Description
Local Electronic Collection Information:

Public name If you want to override the electronic collection name that is 
exposed to the public, enter a new name in this field.

Library Click the Find icon to see a list of available libraries and select 
one.
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Electronic 
Collection Level 
URL

Enter the URL for accessing the electronic collection. 

NOTE:
When publishing portfolio bibliographic records, the 
system checks for a URL from this field. If no URL is 
found in this field, the portfolio bibliographic record is 
not published

Additional 
descriptive 
information

Click the Find icon to display the Repository Search page and 
search for the collection to link.

Electronic 
Collection Proxy 
Enabled

Specify if a proxy has been enabled (Yes/No).

Refer to the Resolver Proxies section in the Alma Integrations 
with External Systems Guide for information regarding proxy 
relationships among portfolios, electronic collections, and 
services.

Electronic 
Collection Proxy 
Selected

When you specify Yes for Proxy enabled, you need to identify 
which proxy profile is to be used for authentication (of users 
outside the library’s network) to access the online database you 
have created. Select a proxy profile option from the drop-down 
list. 

Refer to the Resolver Proxies section in the Alma Integrations 
with External Systems Guide for information regarding how to 
create a proxy profile. 

Full Text Service:

This section lists the types of electronic collection services available for the resource 
being activated. Each electronic collection service is listed separately, and the fields 
described in this table must be completed for each electronic collection service that 
you want to activate.

Activate this 
electronic collection 
service

Select this option to activate an electronic collection service. If 
your electronic collection has more than one service, selecting 
this check box enables you to indicate the service you want to 
activate. (You also must select this check box even when there 
is only one service for the electronic collection.)

Make service 
available

Select this option to activate the service.

NOTE:
Staff may select Activate this service and not select 
Make service available in order to test the service before 
making it available for publishing to patrons.

Table 48. Activation Wizard: Electronic Collection and Services Setup Fields

Field Description
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2 Click Next. The Activation Wizard: Select Activation Method page opens.

Activate from date Click in the Activate from date box and select the required date 
from the Calendar dialog box. If you do not enter an Activate 
from date, the activation starts from the current date (today).

Activate until date Click in the Activate until date box and select the required date 
from the Calendar dialog box. If you do not enter an Activate 
until date, the activation continues indefinitely.

Access rights You can restrict access to the electronic collection to users with 
specific access rights. The types of access rights are predefined 
by an administrator and can be selected from the Access rights 
drop-down list.

Automatically 
activate new 
portfolios

Select this check box if you want to automatically activate new 
portfolios associated with this electronic collection. The option 
to automatically activate new portfolios associated with a 
service is available for selective as well as aggregator electronic 
collections. 

(This option can be configured from both the Activation 
Wizard for new services and in the Electronic Services Editor 
for existing services.)

Service public name If you want to override the service name that is exposed to the 
public, enter a new name in this field.

Service note Enter any service notes for the electronic collection (to be 
displayed in the discovery system).

Service 
authentication note

Enter any service authentication-related notes for the electronic 
collection. These notes are displayed in the discovery system.

Table 48. Activation Wizard: Electronic Collection and Services Setup Fields

Field Description
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Figure 308: Activation Wizard: Select Activation Method Page

3 In the Select Activation Type area, select one of the following:

 Activate all – Activate all the portfolios in the electronic collection

 Activate electronic collection and selected portfolios via Excel file 
upload

 Manual activation – Activate the electronic collection and manually 
select the portfolios you want

4 Click Next.

 If you selected Activate electronic collection and selected portfolios via 
Excel file upload in the previous step, the Activation Wizard: File 
Upload page opens.

In the Select File area, browse to the location of the Excel file you want 
to upload and select the file. Select loading policy preferences.

NOTE:
If you want to change any information in the wizard, click Back to take 
you to the page you want to modify and modify the information as 
needed.

 If you did not select Activate electronic collection and selected 
portfolios via Excel file upload, the Activation Wizard: Activation 
Summary page opens. 
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Figure 156: 

Figure 309: Activation Summary Page for Selective Load

 Verify that the information displayed in the Activation Summary area is 
correct. 

5 Click Activate. Alma activates the titles in the manner you specified and 
returns you to the previous Repository Search page.

Managing Patrons’ Access to E-Resources Using Alma 
Resolver

In addition to associating patrons with a campus/library based on the patron IP 
address, Alma is able to associate a patron with a campus/library for the 
purpose of resolving electronic services based on group settings used by the 
Alma Resolver that display on the Electronic Services page. (For collaborative 
environments, refer to Configuring Inventory Available For Management 
Groups for Collaborative Environments on page 48 in the collaborative 
network documentation for more information regarding group settings.)

Alma is able to associate a patron with campus/library information from the 
following sources:

 Logged in user – The patron is associated with the campus with which his/
her logged-in user ID is affiliated.

 OpenURL base URL – The OpenURL base URL can now include the 
campus/library and, using this, associate the patron with the campus/library 
that is part of the OpenURL. 

See the figure below where –MAIN in the OpenURL request is the campus.
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Figure 310: OpenURL Request URI Example Where -MAIN is the Campus

Once the user is associated with a campus/library from the various sources, 
Alma can locate the relevant Available For groups (refer to Adding Group 
Settings to Electronic Resources on page 280 and Configuring Inventory 
Available For Management Groups for Multicampus Environments on 
page 730 for more information regarding Available For group settings) in order 
to determine the appropriate services to offer to the user via the Alma Resolver 
(View It). The goal is to present the user with only the electronic services which 
he may access.

Link Resolving Examples
Refer to the tables below (Table 49 and Table 50) for use case examples where a 
patron uses an OpenURL-compliant third-party database (such as Google 
Scholar, EBSCO, or ProQuest) or Primo to search for and successfully find a title 
and how the Alma link resolver processes/determines the relevant services to 
present to the patron. The following are key pieces of information that enable 
the Alma link resolver to successfully identify the relevant services to present:

 Campus (location)

 Campus group association (refer to Configuring Inventory Available For 
Management Groups for Multicampus Environments on page 730)

 IP

 OpenURL

http://<base URL>/view/uresolver/01PRIN_INST/openurl-MAIN?&
u.ignore_date_coverage=true&rft.mms_id=996706770000121&rfr_id=
info:sid/primo.exlibrisgroup.com&svc_dat=viewit&test_access=true

Table 49. Use Case Examples - Delivery from Third Party

Use 
Case 
(See 

Figures 
Below)

Patron 
Physical 
Location

Logged 
In to 

Primo

Third-
Party 

Database

Information 
Provided to 
Alma Link 
Resolver

Services 
Presented to 

the Patron

1 Main 
Campus

No

(User is 
unknown)

Accessing 
the Google 
Scholar 
account for 
the Main 
Campus

IP=Main 
Campus

OpenURL= 
Main Campus

Services that are 
associated with the 
Available For groups 
of which the Main 
Campus is a part
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2 Main 
Campus

No

(User is 
unknown)

Accessing 
the Google 
Scholar 
account for 
the City 
Campus

IP=Main 
Campus

OpenURL= 
City Campus

Services that are 
associated with the 
Available For groups 
of which the Main 
Campus and City 
Campus are a part

NOTE:
For a City 
Campus 
resource, the 
patron may be 
challenged 
with a proxy 
for the City 
Campus.

3 Off Campus No

(User is 
unknown)

Accessing 
the Google 
Scholar 
account for 
the Main 
Campus

IP=?

OpenURL= 
Main Campus

Services that are 
associated with the 
Available For groups 
of which the Main 
Campus is a part

Table 49. Use Case Examples - Delivery from Third Party

Use 
Case 
(See 

Figures 
Below)

Patron 
Physical 
Location

Logged 
In to 

Primo

Third-
Party 

Database

Information 
Provided to 
Alma Link 
Resolver

Services 
Presented to 

the Patron
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Figure 311: Delivery from Third Party - Use Case 1

Figure 312: Delivery from Third Party - Use Case 2



Alma Resource Management

January 2015414

Chapter 5: Inventory

Ex Libris Confidential

Figure 313: Delivery from Third Party - Use Case 3

Table 50. Use Case Examples - Delivery from Primo

Use 
Case 
(See 

Figures 
Below)

Patron 
Physical 
Location

Logged In to 
Primo

Primo 
View

Information 
Provided to 
Alma Link 
Resolver

Services 
Presented to 

the Patron

1 Main 
Campus

No

(User is 
unknown)

Accessing 
the Primo 
view for the 
Main 
Campus

IP=Main Campus

OpenURL= 
Main Campus

Services that are 
associated with 
the Available For 
groups of which 
the Main Campus 
is a part
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2 Main 
Campus

No

(User is 
unknown)

Accessing 
the Primo 
view for the 
City 
Campus

(not this 
user’s own 
view)

IP=Main Campus

OpenURL= 
Main Campus

NOTE:
Primo also 
identies the 
IP of the 
user which 
in this case 
is 
connected 
to the Main 
Campus.

Services that are 
associated with 
the Available For 
groups of which 
the Main Campus 
is a part

3 Main 
Campus

Yes 

NOTE:
His 
affiliation 
is with the 
City 
Campus

Accessing 
the Primo 
view for the 
Main 
Campus

User=City 
Campus

IP=Main Campus

OpenURL= 
City Campus

Services that are 
associated with 
the Available For 
groups of which 
the Main Campus 
and City Campus 
are a part

NOTE:
For a City 
Campus 
resource, 
the patron 
may be 
challenged 
with a 
proxy for 
the City 
Campus.

4 Off 
Campus

No

(User is 
unknown)

Accessing 
the Primo 
view for the 
City 
Campus

IP=?

OpenURL= 
City Campus

Services that are 
associated with 
the Available For 
groups of which 
the City Campus 
is a part

Table 50. Use Case Examples - Delivery from Primo

Use 
Case 
(See 

Figures 
Below)

Patron 
Physical 
Location

Logged In to 
Primo

Primo 
View

Information 
Provided to 
Alma Link 
Resolver

Services 
Presented to 

the Patron
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Figure 314: Delivery from Primo - Use Case 1

Figure 315: Delivery from Primo - Use Case 2
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Figure 316: Delivery from Primo - Use Case 3

Figure 317: Delivery from Primo - Use Case 4
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Using the Alma Resolver Electronic Services Page
The Electronic Services page is the location where you can:

 View the results of electronic linking settings when you test access (refer to 
Managing Electronic Resource Activation on page 395)

 Debug services (refer to Using the Alma Resolver Debugger Tool on 
page 420)

The Electronic Services page displays the following metadata, when available, 
for a book:

 Book title

 ISBN

 Author last name

 Author first name (or initials)

 Year information

Figure 318: Electronic Services Page Metadata

The Electronic Services page displays the following metadata, when available, 
for a journal:

 Journal title

 ISSN

 Year

Group settings also determine what is available for patrons to view. For 
additional information regarding group settings see:

 Configuring Inventory Available For Management Groups for 
Multicampus Environments on page 730

 Configuring Inventory Available For Management Groups for 
Collaborative Environments on page 48 in the consorital documentation

The Electronic Services page displays a no full text services message when there 
are no full text services available for the OpenURL request.
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Figure 319: No Full Text Available Message

The wording of the no full text services message may be customized to match 
your requirements.

Figure 320: Customized No Full Text Available Message

To customize the wording for the no full text message:

1 On the Fulfillment Configuration page (Fulfillment > Fulfillment 
Configuration > Configuration Menu), click Labels under Discovery 
Interface Display Logic. The Discovery Interface Labels code table page 
opens.

2 Locate the row with c.uresolver.emptyList in the Code column.

Figure 321: c.uresolver.emptyList Code Table Option

3 Click the Customize button for this row. The Description column for the 
row opens for you to enter your customized message text. 

4 Enter the text you want to display on the Electronic Services page when no 
full text is available.

NOTE:
If you prefer that no message be displayed when no full text is available, 
leave this option blank.

5 Click the page Customize button.
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Figure 322: Page Customize Button

OCLC Number Matching with Alma Resolver
The Alma Resolver provides comprehensive matching on OCLC numbers when 
processing an OpenURL with rft.oclcnum in the statement, as in the following 
example:
http://<host>/openurl/EX/example_services_page&rft.oclcnum=12345678

This is achieved by separately indexing the 035 $a and 035 $z subfields.

Using the Alma Resolver Debugger Tool
Alma provides a debugger tool to analyze the context services that are offered 
by Alma Resolver, enabling staff to perform basic troubleshooting. The tool 
consists of an OpenURL input message that allows you to request an XML 
debugger response from Alma Resolver. From the XML response, you can:

 Determine the service calculation

 View the context object that was calculated based on the OpenURL 
parsing, augmentation, and related service

 Understand how the context services object was generated

 What were the potential services

 Which services were added based on the calculation of related 
services

 Which services were filtered out based on coverage or rules for 
general electronic services and display logic

 Determine the link resolution and how the OpenURL was generated

 Which target parser was used

 Was a proxy used

 Was it a static URL on the portfolio level

 Is there a direct link

 View the end-result URL

 View the original OpenURL in the debugging content provided
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To run the debug tool:

1 Search the repository for the electronic title or portfolio that you want to test 
access. The list of brief results opens.

2 Depending on the type of results, click View It (electronic titles) or Test 
Access (electronic portfolios) for an item in the list. You can also test access 
from the Portfolios List page and the Portfolios tab on the Electronic Service 
Editor page. The Electronic Services page opens.

Figure 323: Alma Electronic Services Page

3 Right-click the frame on the Electronic Services page and select the option to 
view the page or frame source. The options are somewhat different for each 
browser.

Figure 324: Select View Page Source Option

4 Locate the DEBUG section at the top of the source view and copy the URL.
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Figure 157: 

Figure 325: Highlight and Copy the DEBUG URL

5 Open a new browser page or tab, paste the debug URL that you copied in 
the previous step into the address bar of the new page or tab, and press 
ENTER. The XML displays starting with the <context object> element.
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<uresolver_content xmlns="http://com/exlibris/urm/uresolver/
xmlbeans/u" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
  <context_object>
    <keys>
      <key id="genre">book</key>
      <key id="available_services">viewit</key>
      <key id="available_services">getit</key>
      <key id="rft.jtitle">Current opinion in neurobiology</key>
      <key id="debug">true</key>
      <key id="u.ignore_date_coverage">true</key>
      <key id="abbrevTitle">Current opinion in neurobiology</key>
      <key id="stitle">Current opinion in neurobiology</key>
      <key id="rft.pubdate">Began with v. 1, issue 1 published June 
1991.</key>
      <key id="ctx_id">505326480000121</key>
      <key id="rft.issn">0959-4388</key>
      <key id="journalTitle">Current opinion in neurobiology</key>
      <key id="rft.object_type">JOURNAL</key>
      <key id="rft.oclcnum">36905829</key>
      <key id="eISSN">1873-6882</key>
      <key id="rft.stitle">Current opinion in neurobiology</key>
      <key id="rft.genre">book</key>
      <key id="req.id" xsi:nil="true"/>
      <key id="rft.title">Current opinion in neurobiology</key>
      <key id="ISSN">0959-4388</key>
      <key id="test_access">true</key>
      <key id="rfr_id">info:sid/primo.exlibrisgroup.com</key>
      <key id="inventory_id">517970130000121</key>
      <key id="rft.eissn">1873-6882</key>
      <key id="objectType">JOURNAL</key>
      <key id="Incoming_URL">http%3A%2F%2Fil-
urm01.corp.exlibrisgroup.com%3A1807%2Fview%2Furesolver%2FEXLDEV1_IN
ST%2Fopenurl%3Fdebug%3Dtrue%26svc_dat%3DCTO%26debug%3Dtrue%26debug%
3Dtrue%26u.ignore_date_coverage%3Dtrue%26rft.mms_id%3D9932733600001
21%26rfr_id%3Dinfo%3Asid%2Fprimo.exlibrisgroup.com%26svc_dat%3Dview
it%26test_access%3Dtrue</key>
    </keys>
  </context_object>
  <context_services>
    <context_service context_service_id="824182260001021" 
service_type="getFullTxt">



Alma Resource Management

January 2015424

Chapter 5: Inventory

Ex Libris Confidential

      <keys>
        <key id="portfolio_PID">5310538980000121</key>
        <key id="package_name">Elsevier ScienceDirect</key>
        <key id="package_public_name">Elsevier SD Elsevier Current 
Trends</key>
        <key id="package_display_name">Elsevier SD Elsevier Current 
Trends</key>
        <key id="package_pid">6110539390000121</key>
        <key id="service_type_description">Full text available via</
key>
        <key id="parser_program">ELSEVIER::SCIENCE_DIRECT</key>
        <key id="parse_parameters">host=http://
www.sciencedirect.com/science/ &amp; prefsite = sd &amp; shib=</
key>
        <key id="proxy_enabled">false</key>
        <key id="proxy_selected">DEFAULT</key>
        <key id="related_title">@TITLE (@RelationType)</key>
        <key id="crossref_enabled">yes</key>
        <key id="character_set">null</key>
        <key id="interface_name">Elsevier ScienceDirect</key>
        <key id="Is_free">0</key>
      </keys>
      <target_url>www.another.exl?url=http://www.sciencedirect.com/
science/journal/09594388</target_url>
      <is_error>false</is_error>
      <error_code>null</error_code>
    </context_service>
    <context_service context_service_id="824182250001021" 
service_type="getFullTxt">
      <keys>
        <key id="portfolio_PID">537987300000121</key>
        <key id="package_name">Elsevier ScienceDirect</key>
        <key id="package_public_name">Elsevier SD Corporate 
Edition</key>
        <key id="package_display_name">Elsevier SD Corporate 
Edition</key>
        <key id="package_pid">617950310000121</key>
        <key id="service_type_description">Full text available via</
key>
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Figure 326: Example XML Debugger Output

6 Scroll through the XML to analyze/debug your search result issues.

After the <context object> element is the <context services> element 
that contains information regarding service type, parsing, proxy, the target 
URL, and so forth.

Notice that in cases where records were filtered out from displaying in the 
results, the XML output contains key IDs for Filter (true or false) and Filter 
reason. For example, if the Filter reason parameter contains Date Filter and 
the OpenURL input specified a data parameter of year=2010, this may 
indicate that the record was filtered because it was outside of the specified 
date range.

        <key id="parser_program">ELSEVIER::SCIENCE_DIRECT</key>
        <key id="parse_parameters">host=http://
www.sciencedirect.com/college/ &amp; prefsite = sd &amp; shib=</
key>
        <key id="proxy_enabled">false</key>
        <key id="proxy_selected">DEFAULT</key>
        <key id="related_title">@TITLE (@RelationType)</key>
        <key id="crossref_enabled">yes</key>
        <key id="character_set">null</key>
        <key id="interface_name">Elsevier ScienceDirect</key>
        <key id="Is_free">0</key>
      </keys>
      <target_url>www.another.exl?url=http://www.sciencedirect.com/
college/journal/09594388</target_url>
      <is_error>false</is_error>
      <error_code>null</error_code>
    </context_service>
  </context_services>
  <performance_counters>
    <performance_counter name="TOTAL" duration="0.0"/>
    <performance_counter name="MMS_LOOKUP" duration="0.0"/>
    <performance_counter name="ENRICH" duration="0.0"/>
    <performance_counter name="PARSE" duration="0.0"/>
    <performance_counter name="GET_SERVICES" duration="0.017"/>
    <performance_counter name="FILTER" duration="0.01"/>
    <performance_counter name="SAVE" duration="0.0060"/>
    <performance_counter name="GET_SINGLE_SERVICE" duration="0.0"/>
    <performance_counter name="EXECUTE_TARGET_PARSER" 
duration="0.0"/>
    <performance_counter name="GET_URESOLVER_CONTENT" 
duration="0.0"/>
    <performance_counter name="UPDATE_SELECTED" duration="0.0"/>
  </performance_counters>
</uresolver_content>
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Managing Digital Resources

PERMISSIONS:
To manage digital resources, you must have the following roles:

 Digital Inventory Operator

 Digital Inventory Operator Extended (required for delete operations)

A digital resource is content that is stored in digital formats (as opposed to print, 
microform, or other media) and accessible through computers. This content may 
be converted from a physical medium (such as paper) using digitization. Once 
the digital content has been produced, it can be stored in a local storage network 
or the Alma cloud and then viewed by end users.

In Alma, digital resources contain the following levels, which are configured 
with an associated editor and linked to a bibliographic MMS record:

 Digital IE – The Digital Representation Resource Editor defines additional 
metadata associated with a digital title, and lists the associated 
representations.

 Digital representation – The Digital Representation Resource Editor defines 
additional metadata for each digital representation of the digital title, and 
lists the associated digital files.

 Digital file – The Digital File Resource Editor defines the metadata 
associated with a specific digital file. A digital representation may have 
more than one file associated with it.

Figure 158: 

Figure 327: Digital Resource Hierarchy
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Alma provides the capability for:

 Updating metadata at each level as follows:

 Updating Title-Level Metadata

 Updating Representation-Level Metadata

 Updating File-Level Metadata

 Adding Digital Representations

 Deleting Digital Inventory, Representations, and Files

 Running Reports and Services

Updating Title-Level Metadata
During the creation and submission of digital resources, metadata is stored with 
the digital object. The Digital IE Resource Editor allows you to update or include 
additional metadata at the title level.

To update metadata at the title level:

1 Search for the digital title that you want to update. For more information, 
see Using the Alma Repository Search on page 18.

The brief results display for the digital title.

Figure 328: Brief Results for Digital Title

2 Click Edit.

The Digital IE Resource Editor page opens.
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Figure 329: Digital IE Resource Editor Page

3 Click the General Information tab.

4 Enter the metadata information as described in the following table.

Table 51. General Information Tab Fields

Field Description
General IE Characteristics section:

Submission Reason Enter the reason for submitting this digital tile.

IE Entity Type Select the type of content (such as book, journal, or 
album) that this digital title represents.

Status Enter the status of this digital title.

Status Date Enter the date of the status provided.

User Defined A, B, and C Currently not used by the system.

Collection If you want the digital title added to a specific collection, 
enter the collection name.

Access rights section:

Access rights Select the type of access that is allowed for users.

If no value is selected, access is enabled according to the 
access_right_default_policy setting on the 
CustomerParameters Mapping Table (see Configuring 
Other Settings on page 695).

The specified access right is invoked according to the 
rules with which it is associated (see Configuring 
Access Rights in the Alma Fulfillment Guide).
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5 Click Save.

Updating Representation-Level Metadata
During the creation and submission of digital resources, metadata is stored with 
the digital object. The Digital Representation Resource Editor allows you to 
update or include additional metadata at the representation level. 

To update metadata at the representation level:

1 Search for the digital title that you want to update. For more information, 
see Using the Alma Repository Search on page 18.

The brief results display for the digital title. 

2 Click Edit.

The Digital IE Resource Editor page opens. 

3 Click the Representations tab.

The Representations tab opens. 

Figure 330: Representations Tab

4 Select Actions > Edit for a representation. 

The Digital Representation Resource Editor opens.
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Figure 331: Digital Representation Resource Editor

5 Click the General Information tab.

6 Enter the metadata information as described in the following table.

Table 52. General Information Tab Fields

Field Description
Label Enter the display label for the digital representation.

Representation Entity 
Type

Differentiates between digital representations. For 
example, it could indicate that the files are stored in a 
specific format (such as TIFF) in order to determine the 
appropriate viewer for delivery.

Context Type Currently not used by the system.

Hardware Used Describes the hardware that is needed to render the 
files. Currently not used by the system.

Physical Carrier Media Describes the carrier (such as tape or disk) of the 
physical content.

Delivery Priority Prioritizes the digital representation and files for 
delivery. Currently not used by the system.

Ordering Sequence Determines the order of files for delivery. Currently not 
used by the system.

Digital Original Indicates whether the digital title was originally digital 
(such as a Word file), not a digitization of a physical 
resource (such as a book). Select Yes or No.
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7 Click Save.

Updating File-Level Metadata
During the creation and submission of digital resources, metadata is stored with 
the digital object. The Digital File Resource Editor allows you to update or 
include additional metadata at the file level. 

To update metadata at the file level:

1 Search for the digital title that you want to update. For more information, 
see Using the Alma Repository Search on page 18.

The brief results display for the digital title. 

2 Click Edit.

The Digital IE Resource Editor page opens. 

3 Click the Representations tab.

The Representations tab opens. 

4 Select Actions > Edit for a representation. 

The Digital Representation Resource Editor opens.

Derived from ID If this object is a copy or a migrated copy of a different 
object, enter the original object's ID.

Task ID The ID of the task that was performed in the 
preservation system to update the digital object.

Original Name The name of the original file before it was loaded into 
the preservation system.

User Defined A, B, and C Currently not used by the system.

Table 52. General Information Tab Fields

Field Description
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Figure 332: Digital Representation Resource Editor

5 Click the Files List tab.

6 Select Actions > Edit for a file. 

The Digital File Resource Editor opens.

Figure 333: Digital File Resource Editor

7 Click the General Information tab.

8 Add a display label or any additional notes for this file.

9 Click Save.
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Adding Digital Representations
If a new digital representation is produced for a title, it is necessary to add the 
representation to the title in Alma so that it can be viewed by end users. 

To add a digital representation:

1 Select Add Digital Representation from the Resource Management menu.

The Representation Details page opens.

Figure 334: Representation Details Page - Step 1

2 Click the blue arrow in the Select Title field.

The Repository Search page opens.

3 Search for the title for which you want to add a representation. For more 
information, see Using the Alma Repository Search on page 18.

The brief results display for the digital title. 
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Figure 335: Repository Search Results

4 Select the radio button next to the title and click Select.

The Representation Details page reopens and places the selected title in the 
Select Title field. 

5 In the Representation Details section, enter the optional metadata 
information as described in the following table.

Table 53. Optional Representation Details Fields

Field Description
Label Enter the display label for the representation.

Preservation Type Select the preservation type from the drop-down list. 
The valid values are Derivative Copy, Modified 
Master, and Preservation Master.

Representation Code Differentiates between the resolutions of derivative 
digital representations. The valid values are High, 
Medium, Low, and None.

Usage Type Currently not used by the system.

Submission Reason Enter the reason for submitting this representation.
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6 Click Next.

The Upload Files page opens. 

7 Select the upload method and then upload the digital files for the 
representation:

 Load files using the applet – Uploads multiple files at a time:

Figure 336: Load Files Applet Option

a In the left pane, select the folder that contains the digital files.

b In the right pane, select the digital files to upload.

c Click Send.

d If the files are located in multiple folders, return to step a to upload from 
another folder. 



Alma Resource Management

January 2015436

Chapter 5: Inventory

Ex Libris Confidential

 Load files manually – Uploads one file at a time:

Figure 337: Load Files Manually Option

a In the File field, click the folder icon to open the Choose File to Upload 
page.

b Select the file and click Open.

The Choose File Folder closes and the selected file displays in the File 
field. 

c Enter an optional label and note.

d On the Upload Files page, click Add.

The selected file displays in the Selected Files section. 

e If the representation contains multiple files, return to step a to upload 
another digital file. 

8 Click Done.
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Deleting Digital Inventory, Representations, and Files
Alma allows you to delete digital inventory at the following levels:

 Inventory – See Deleting a Title’s Digital Inventory on page 437). In 
addition, you can delete digital inventory for a set of titles (see Deleting 
Digital Inventory from a Set of Titles on page 441).

 Representation – See Deleting a Digital Representation on page 438.

 File – See Deleting a Digital File on page 439.

Deleting a Title’s Digital Inventory
This method deletes a title’s digital inventory (which includes all 
representations and files). During the deletion process, you may decide whether 
to keep the bibliographic record if the title has no physical, electronic, and 
digital inventory.

To delete a title's digital inventory (including all representations and files):

1 Perform a repository search for the digital title that you want to delete.

2 Click the Edit link in the title's results to open the record's details on the 
Digital IE Resource Editor page.

3 On the Reports and Services tab, click Delete IE under the Services section. 
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Figure 159:  

Figure 338: Digital IE Resource Editor - Delete All Digital Representations

During the deletion process, you may receive the following confirmation 
messages:

 Digital inventory has representations. Delete anyway? – Click 
Confirm if you want to continue deleting the digital title.

 Handling bibliographic records without inventory – This indicates 
that the title has no physical, electronic, and digital inventory. Specify 
one of the following options to handle the bibliographic record for the 
title:

 Delete – deletes the bibliographic record

 Do nothing – retains the bibliographic record

 Suppress – retains the bibliographic record and suppresses the 
record from discovery

Deleting a Digital Representation
This method deletes all files in a digital representation. During the deletion 
process, you may decide whether to keep the bibliographic record if the title has 
no physical, electronic, and digital inventory. 
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To delete a digital representation (including all files):

1 Perform a repository search for the digital title that you want to update.

2 Click the Edit link in the title's results to open the record's details on the 
Digital IE Resource Editor page.

3 On the Representations tab, click Actions > Delete next to the representation 
that you want to delete.

Figure 160:  

Figure 339: Digital IE Resource Editor - Delete a Digital Representation

During the deletion process, you may receive the following confirmation 
messages:

 Representation contains files. Delete anyway? – Click Confirm if you 
want to continue deleting the digital representation.

 Handling bibliographic records without inventory – This indicates 
that the title has no physical, electronic, and digital inventory. Specify 
one of the following handling options: Delete, Do nothing, or Suppress.

Deleting a Digital File
This method deletes a single file in a digital representation. During the deletion 
process, you may decide whether to keep the following objects:

 the digital representation if it has no files

 the bibliographic record if the title has no physical, electronic, and digital 
inventory

To delete a digital file:

1 Perform a repository search for the digital title that you want to update.

2 Click the Edit link in the title's results to open the record's details on the 
Digital IE Resource Editor page.
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3 On the Representations tab, click Actions > View Files next to the 
representation that you want to update.

Figure 161:  

Figure 340: Digital IE Resource Editor - View Digital Files

4 On the Digital Representation Resource Editor page, click Actions > Delete 
next to the file that you want to delete.

Figure 162:  

Figure 341: Digital Representation Resource Editor - Delete Digital File

During the deletion process, you may receive the following confirmation 
messages:

 Delete file? – Click Confirm if you want to continue deleting the file.

 Last file of representation was deleted. Do you want to delete the 
representation? – Click Confirm if you want to also delete the 
representation.
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 Handling bibliographic records without inventory – This indicates 
that the title has no physical, electronic, and digital inventory. Specify 
one of the following handling options: Delete, Do nothing, or Suppress.

Deleting Digital Inventory from a Set of Titles
This method uses the Withdraw remote representations job to delete all of the 
local and remote digital objects belonging to a set of titles that you specify. By 
default, the bibliographic records remain intact in your repository, whether you 
have the objects deleted or not.

To run the job for deleting digital objects:

1 From the Alma main menu, follow the path to the Create Job wizard 
(Administration > Manage Jobs > Run a Job).

2 Use the Filter to narrow the list of jobs down to Withdraw.
Figure 163: 

Figure 342: Select Job from Withdraw Type

3 Select Withdraw digital representations and click Next.
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Figure 164: 

Figure 343: Select Set on Which to Run Job

4 Select the set on which you want to run the job deleting digital objects. Click 
Next.

Figure 165: 

Figure 344: Task Parameters

5 On the Run a Job - Enter Task Parameters page, select one of the following 
options:

 Do nothing – retain the bibliographic records.

 Delete bibliographic records – remove the bibliographic records from 
the repository.

 Suppress bibilographic records – retain the bibliographic records, but 
suppress them from discovery.

6 Click Next.

7 On the Run a Job - Job Details and Schedule page, enter a name for the job 
and the schedule on which you want the job to run. Click Next. 

The Run a Job - Review and Confirm page opens.
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Figure 166: 

Figure 345: Review and Confirm Job Terms

8 Review the information on the Review and Confirm page. If everything is 
correct, click Save. To go back and change something, use the Back button.

Running Reports and Services
The Reports and Services tab for each digital resource editor allows you to run 
various reports and services. The following table lists the reports and services 
available per digital resource level.

Table 54. Reports and Services

Report/Service Editor
Reports:

Generate Full Administrative Metadata 
Report for this resource

All digital resource editors

Report of events where this item is 
involved

All digital resource editors

Services:

Export IE Digital IE Resource Editor

Delete IE Digital IE Resource Editor

Export Representation Digital Representation Resource Editor
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To run a report:

1 From the digital resource editor, click the Reports and Services tab.

In the following example, the Reports and Service tab opens for the Digital 
IE Resource Editor.

Figure 346: Reports and Services Tab - Digital IE Resource Editor

2 In the Reports section, click the name of the report.

In the following example, the Generate Full Administrative Metadata 
Report for this resource report was selected.
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Figure 347: DNX Viewer - Full Metadata Report for Title

3 Click Back to return to the Reports and Services tab.

To run a service:

1 From the digital resource editor, click the Reports and Services tab.

In the following example, the Reports and Service tab opens for the Digital 
IE Resource Editor.
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Figure 348: Reports and Services Tab - Digital IE Resource Editor

2 In the Services section, click the name of the service.

3 Click Back to return to the Reports and Services tab.

Managing Physical Resources
Alma allows you to create and maintain physical resources using various 
editors and jobs. For details on how to manage your physical inventory, see the 
following sections:

 Adding Physical Resources on page 447

 Using Prediction Patterns (Inventory Creation) on page 453

 Updating Item-Level Information on page 465

 Performing Withdrawals on page 471

 Performing Global Changes on Holdings Records on page 477

 Performing Global Changes on Item-Level Information on page 479

 Managing Physical Holdings Records (Moves/Deletes) on page 484
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Adding Physical Resources

PERMISSIONS:
To add and/or manage physical resources, you must have the following 
roles:

 Physical Inventory Operator

 Physical Inventory Operator Extended (required for delete operations)

You can add physical items to your inventory using the Quick Cataloging 
pages. The following types of items can be added:

 Existing items – Adding an Existing Physical Item on page 447

 New items – Adding a New Book or Journal Article on page 449

Adding an Existing Physical Item
If the item already exists in the library and you only need to catalog it, use the 
option for adding an existing item.

NOTE:
You must know the item’s barcode to complete this procedure.

To add an existing item to your inventory:

1 From the Choose Holdings Type dialog box (Resource Management > 
Create Inventory > Add Physical Item), select the Existing option and click 
Choose.

Figure 167: 

Figure 349: Choose Holdings Type



Alma Resource Management

January 2015448

Chapter 5: Inventory

Ex Libris Confidential

The Quick Cataloging page for existing resources opens.
Figure 168: 

Figure 350: Quick Cataloging for Existing Physical Items

2 In the Resource Information section, find the title of your item by either:

 Typing all or part of the title, clicking the magnifying glass icon, and 
selecting your complete title from the drop-down list

 Clicking the find (arrow) icon that opens a Repository search form for 
you to search and select your title

When you select your title, the Title field populates with your selection. The 
Library and Location fields are populated based on the Title selection.

3 Enter the barcode for the item and, optionally, add the following remaining 
parameters:

 Description – The text you enter will display in the list of holdings for 
the item.

 Material Type – Use the magnifying glass drop-down menu or the find 
(arrow) icon to find and select a value for Material Type. The material 
type manifests itself only in Primo’s Get It andDetails tabs. For 
information on customizing the labels of the material types, refer to 
Configuring Physical Item Material Type Descriptions on page 740.

 Item Policy – Use the magnifying glass drop-down menu or the find 
(arrow) icon to find and select a value for Item policy. 
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Figure 169: 

Figure 351: Quick Cataloging for Existing Physical Item

4 Click Save. The item is added to the inventory. The Quick Cataloging page 
closes, and the Alma home page opens.

Adding a New Book or Journal Article
If the item you want to add to your inventory is new, use the New holdings 
option to add it to your inventory.

To add a new physical item to the inventory:

1 From the Choose Holdings Type dialog box (Resource Management > 
Create Inventory > Add Physical Item), click the New option.

Figure 170: 

Figure 352: New Holdings Type and Citation Type Selection
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2 Select the Citation Type (Book or Article) from the drop-down menu and 
click Choose. The Quick Cataloging form opens. Parameters differ slightly 
between the book and journal entries.

Figure 171: 

Figure 353: Quick Cataloging Form for Book (Left Side) or Article (Right Side)

3 Enter values in the Resource Information fields for the book or article using 
the table below for information about the parameters.
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4 In the Item Information section, type and select the name of the library 
where you want the item to be located, or click the arrow icon to open a list 
of the libraries and select one. Once you select a library, the page refreshes 
and additional fields appear below the Library field, including one 
additional required field. Enter the values for the Item Information section 
using the table below that provides a description of the parameters.

Table 55. Resource Information Fields

Field Description
Title/Article/Chapter Title 
(Required)

The title of the book, article, or chapter

Journal Title (article) The title of the journal that contains the article

Author The author of the book or article

Publisher (book) The name of the publisher of this edition of the book

Year (book) Year of publication of this edition of the book

Edition (book) Edition number of the book

Volume (article) The volume number of the journal that contains the 
article

Issue (article) The issue number of the journal that contains the article

ISBN/ISSN The International Standard Book Number (ISBN) or 
International Standard Serial Number (ISSN) that 
identifies the book or article

Place of publication The place in which the book or article was published

Additional person name The name of an additional contact

Call number The call number of the book. Indicates the library shelf 
on which the book is located

Note A field for notes, as needed

Chapter The chapter number in the journal that contains the 
article

Pages The page numbers in the journal that contain the article

Year The year the journal was published

Suppress from discovery Select to block the bibliographic record from publishing 
to Primo.
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Figure 172: 

Figure 354: Additional Fields After Library Selection

5 Click Save. Alma saves the Quick Catalog record and opens a Repository 
Search screen with the entry just added as the search result.

Table 56. Item Information Fields

Field Description
Library The name of the library where the item is stored. Click 

the arrow to see a list of all existing available libraries. 
To change the library after entering it, click the broom 
icon to delete it and repeat the selection.

Location The location within the library where the physical item 
is kept. Use the drop-down menu feature or click the 
arrow to open a list of available locations for this 
library.

Barcode The barcode of the item.

Material Type The material type of the item. Use the drop-down menu 
or the arrow to open a list of possible types. The 
material type manifests itself only in Primo’s Get It/
Details tabs. (For information on customizing the 
material type labels, see Configuring Physical Item 
Material Type Descriptions on page 740.)

Item Policy The check-out policy for the item, as in term length and 
other restrictions. Use the drop-down menu or the 
arrow to open a list of available policies.
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Figure 173: 

Figure 355: New Physical Item After Saving

Using Prediction Patterns (Inventory Creation)
Alma provides prediction pattern support to enable you to more easily manage 
serials. With prediction pattern support, it is possible to create serial items in 
advance of their receive date based on a prediction template. 

This capability uses the 853-855 holdings record fields for the predicted item 
information such as enumeration, chronology, date, and so forth. With this 
feature, Alma provides many predictive pattern templates from which you can 
select to enter the 853-855 field information. 

Once you have created the predicted items, they can be viewed using the 
Acquisitions Received Items List to manage their receipt. 

To create a holdings record with predictive pattern content:

1 Locate the holdings record (connected to a physical subscription order type) 
to which you want to add the predictive pattern information and open it in 
the MD Editor.

(The order provides the vendor Subscription interval information that is 
used in combination with the Next Predicted’s Item Information (see 
below) to calculate the expected arrival date information.)
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Figure 174: 

Figure 356: Open Holdings Record

2 Select Edit > Expand from Template, select a relevant predictive pattern 
template that fits your requirements from the ones provided in Alma, and 
click OK.

Since the journal used in this procedure is a quarterly publication, the Serial 
prediction quarterly months template is selected.

Figure 175: 

Figure 357: Quarterly Publication
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Figure 176: 

Figure 358: Expand from Template Predictive Pattern Options

The system adds an 853 field row (or 854/855 field depending on which 
template you selected) to the holdings record and a 590 field row that 
contains a description of the template. 
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Figure 177: 

Figure 359: 853/590 Rows Added to the Holdings Record

Optionally, you can manually enter the 853/854/855 field. You can also create 
your own custom prediction pattern template, a new one or by duplicating 
an existing prediction pattern template and modifying the duplicate. 

3 Click the magnifying glass icon in the 853 (or 854/855) row to open the form 
with the next predicted item’s information. You can also click F3 to open the 
form when the 853 (or 854/855) is the active row or you can select Tools > 
MARC21 Holdings > Next predicted item’s information. (You can also use 
F3 to open the form when you have manually entered the 853/854/855 field 
and no magnifying glass icon is displayed.)
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Figure 178: 

Figure 360: Next Predicted Item's Information

4 Make any changes you may require for the next predicted item and click 
Close. Your entries on this form determine the beginning of the prediction 
pattern starting with the next predicted item. Clicking Remove clears the 
form.

5 Select Tools > MARC21 Holdings > Open predicted item to view the 
pattern that Alma has created for this holdings record. The predicted 
pattern that is created includes the expected arrival date (refer to the figure 
below). 

Each prediction cycle is for one year. If you want to create predicted items 
for more than one year, you can repeat the Open predicted item step.
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Figure 179: 

Figure 361: Predicted Items Created

6 Click Save to save the predicted items that have been created, or click 
Discard if you do not want to save the predicted items. This closes the 
Predicted Items form.

7 Click the Save Record icon when you have completed making your 
changes.

To view the holdings changes that you have made after creating 
predicted items:

1 In the MD Editor, open the bibliographic record that has the holdings for 
which you created the predicted items.

2 Click View Inventory (Tools > MARC21 Bibliographic > View Inventory).

The predicted items that you created increment the No. of Items total that 
displays on the Holdings tab in the MD Editor (Tools > MARC 
Bibliographic > View Inventory) for the bibliographic record of this 
continuous holdings record. 
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Figure 180: 

Figure 362: Number of Items Increments for Bibliographic Record Holdings

3 Click View Items.

The four predicted items of the cycle (quarterly per year) have been created 
with no receiving date (because they have not yet been received).

Figure 181: 

Figure 363: List of Items Page - No Receiving Dates

While viewing the details of the List of Items page, also observe the Open 
Predicted Items button that can be used to create another cycle of predicted 
items.

4 For one of the predicted items, select Actions > Edit to open the Physical 
Item Editor page and observe the Expected receiving date that has been set 
by the prediction pattern.
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Figure 182: 

Figure 364: Expected Receiving Date

To create additional predicted items using the Open Predicted Items 
button from the List of Items page using Repository Search:

1 Using Repository Search, enter the search criteria for the record to which 
you want to create an additional cycle of predicted items, and click the 
Items link.

Figure 183: 

Figure 365: Search Results

The List of Items Page opens with the new Open Predicted Items button.
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Figure 184: 

Figure 366: List of Items Page for Holdings with Predicted Items

2 Click Open Predicted Items. The list of new Predicted Items opens. 
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Figure 185: 

Figure 367: Predicted Items List from Repository Search Results List of Items Page

The Tools feature for this list provides you the option to view/save the list in 
Excel format.

Figure 186: 

Figure 368: Predictive Pattern List in Excel
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3 Click Save Items to save the predicted items and close the list.

4 Click Back to return to your search results page.

To process/manage receiving predicted items:

1 Open the Receive New Material page (Acquisitions > Receiving and 
Invoicing > Receive), and select the Continuous tab.

2 Filter the Receive New Material page to locate the PO line that contains the 
predicted item(s) you want to receive.

3 For the PO line containing the predicted item(s), select Actions > Manage 
Items. The Received Items List page opens. 

Figure 187: 

Figure 369: Received Items List Page

When receiving and managing items, you can tell which items have already 
arrived and which are still waiting to arrive by reviewing the Date Received 
column. 
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Figure 188: 

Figure 370: Date Received Column

4 Use the Sort routine, Receiving status, and Location options in the PO Line 
Items section to organize and locate the predict item(s) to be received. 

a Select Receiving date from the drop-down list for Sort routine.

b Select Not Received for the Receiving Status.

c Select the specific location/library for Location. 
Figure 189: 

Figure 371: Sort/Filter Options Selected

5 Select Actions >Receive for a specific predicted item, or select the check 
boxes for multiple rows, and click the Save and Receive button that allows 
you to save and receive multiple items.

6 Repeat the receiving steps until you have completed receiving the predicted 
item(s).
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Updating Item-Level Information
The Physical Item Editor enables staff to update item-level information for 
physical items.

Figure 190: 

Figure 372: Physical Item Editor Page - General Information Tab
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To update item-level information for a physical item:

1 Search for the physical item that you want to update. For more information, 
see Using the Alma Repository Search on page 18.

NOTE:
You must be searching for a physical item—not title—for this procedure 
to have the outcomes described below.

Results for your search are returned in brief form. 

2 Click Edit for the item you want to update. The Physical Item Editor page 
opens to the item you selected.

3 If it is not already open, select the General Information tab and refer to the 
following table for updating information for each field.

Table 57. Physical Item Editor Page - General Information Tab

Field Description
Barcode The item’s barcode.

Copy ID The item’s copy ID, used to identify individual copies of the 
same title when multiple copies exist at the same location.

Material Type The item’s physical form, such as a book or CD-ROM. 
Select from the predefined drop-down list. Note that the 
material type manifests itself only in Primo’s Get It/Details 
tabs. (For information on customizing the material type 
labels, see Configuring Physical Item Material Type 
Descriptions on page 740.)

Item Policy The item’s override policy for loan rules. Defines the 
conditions under which a request for this item can be 
fulfilled. Select from items in the drop-down list 
(predefined in Fulfillment Configuration > Physical 
Fulfillment > Item Policy).

Inventory date Not currently in use. The date on which inventory was last 
checked. Date can be selected from the calendar drop-
down box.

Provenance The item’s origin, as selected from options in the drop-
down menu.

PO Line Clicking the Find icon  opens a list of PO lines for the 
item. Use the Filter and Find tools to find the PO line for the 
item. Select one and click the Select button. 

Is Magnetic Indicates whether the item contains a magnet which can 
cause it to be damaged when scanned by a self-check 
machine.
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Receiving date The date the material was actually received/activated for 
the first time. Click the Receiving date box and select the 
receiving date from the calendar dialog box.

Expected receiving 
date

The date the item was expected to be received.

Enumeration A The main level of enumeration—usually the volume.

Enumeration B The second level of enumeration, such as quarter.

Chronology I The main level of chronology—usually the year.

Chronology J The second level of chronology—usually the month.

Description (Generate/
Clear)

System-generated description based on entries in the 
Enumeration and Chronology fields above. Click Generate 
to have the system enter the Description or Clear to remove 
the description. To configure a description template, see 
Configuring Description Templates on page 725.

Replacement cost The charge administered to the patron if the item is lost.

Receiving operator The Operator who received the item

Process type Displays the configured work order types. When selecting 
a value in this field, the At field displays the location in 
which the work order is performed.

After saving the item, the following information displays 
on the Repository Search page:

 Process type: Indicates the selected work order type

 Status: Value is Item not in place

Work order information also displays on the Resource 
Request Monitoring page (see Monitoring Requests and 
Work Orders in the Alma Fulfillment Guide).

To remove an existing work order from an item, clear this 
field when accessing the Physical Item Editor page from 
the Edit link for an item. The Status of the item displays on 
the Repository Search page as Item in place.

VIDEO:
For more information about assigning a work 
order process to an item, see the Assign a Process 
to an Item video (2:54 mins).

Table 57. Physical Item Editor Page - General Information Tab

Field Description

http://www.youtube.com/watch?v=OEfd2wJQzEE&hd=1
http://www.youtube.com/watch?v=OEfd2wJQzEE&hd=1
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At Select a work order department for the work order that 
displays in the Process type field.

After saving the item, value of this field (that is, the 
location of the item) displays on the Repository Search 
page as the At: field value.

Location Information:

Permanent Library The library that permanently houses the item. To change 
the library, click the Find magnifying glass and browse for 
a new holdings library, then select it as the permanent 
library.

Permanent Location The name of the item’s permanent location within the 
permanent library. To change the location, click the Find 
magnifying glass and browse for another location, then 
select it as the permanent location.

Alternative Call 
Number Type

An alternative identification number type to the call 
number. Select, for example, Library of Congress, Dewey 
Decimal, or a shelving control number from the drop-down 
list.

Alternative Call 
Number

The ID number for the item that corresponds to the 
alternative call number type.

Inventory Number Not currently in use.

Storage Location ID The ID number of the location where the item is stored.

Pages The item’s number of pages.

Pieces The item’s number of pieces.

Additional Information

Item is in Temporary 
Location (Yes/No)

Indicates if the item is located in a temporary location.

When this option is set to Yes, it can be reset to No for one 
or more records in a set using the Change physical items 
batch job to process the change and selecting the Remove 
temporary item indication option. Refer to Performing 
Global Changes on Item-Level Information on page 479.

VIDEO:
For more information about modifying this 
setting using the Change physical items batch 
job, see the  Remove Temporary Item Location 
Indicator video (5:27 mins).

Table 57. Physical Item Editor Page - General Information Tab

Field Description

http://www.youtube.com/watch?v=ZNeZQpr1br8&hd=1
http://www.youtube.com/watch?v=ZNeZQpr1br8&hd=1
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4 Click the Notes tab to view/edit notes relating to the item. Refer to the table 
below for a description of the different types of notes. 

Temporary Library The item’s temporary library, selected from the 
Organizational Lists page.

Temporary Location The item’s temporary location, selected from the 
Organizational Lists page.

Temporary Call 
Number Type

The call number type used for the item at the temporary 
location.

Temporary Call 
Number

The item’s call number when using the temporary call 
number type at the temporary location.

Temporary Item Policy The item’s temporary override policy. Policies are 
configured and appear in the drop-down list.

Due Back Date The date the item is due back from the lender.

Table 58. Description of Item Notes

Note Type Description
Public note Contains note content that is displayed in the Primo Get It tab 

under the Holdings column. Refer to Displaying Public Notes 
in the Primo Get It Tab on page 145in the Integrations wtih 
Primo Guide.

Fulfillment note Contains note content that is displayed during the circulation 
process. For example, the content may contain the statement 
“Check for discs” to prompt the circulation desk at item 
checkin.

Internal Notes:

Internal note 1 Contains note content regarding an item for internal use by 
Alma staff.

Internal note 2 Contains note content regarding an item for internal use by 
Alma staff.

Table 57. Physical Item Editor Page - General Information Tab

Field Description
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5 Select the History tab and refer to the following table for information 
regarding each parameter.

Internal note 3 Contains note content regarding an item for internal use by 
Alma staff. 

Specifically, this note may contain content regarding a shipped 
resource sharing lending item, as sent to Alma by the NCIP 
source system in the NCIP message's shipping note. The 
shipping note displays in the following format:

||Shipping Note||<text of shipping note>||Shipping Note||

The shipping note is used by NCIP implementers, such as 
OCLC Navigator, to update the library system with additional 
information about shipped resource sharing lending items 
such as information about the resource itself, the requester, 
and the locations from where it is requested and is to be picked 
up.

Statistics Notes:

Statistics note 1 Contains note content that is exposed in Analytics under 
New > Analysis > Physical Items.

Statistics note 2 Contains note content that is exposed in Analytics under 
New > Analysis > Physical Items.

Statistics note 3 Contains note content that is exposed in Analytics under 
New > Analysis > Physical Items.

Table 58. Description of Item Notes

Note Type Description

Table 59. Physical Item Editor Page - History Tab

Field Description
Report type:

Item changes This report displays the changes made to the item as 
visible/editable on the General tab of the Physical Item 
Editor page. This report identifies the name of the operator 
who made the change, the date the change was made, the 
field that was changed, and the before and after values.

Holdings changes This report displays changes to the library (852 $$b), 
location (852 $$c), call number type (852 first indicator), call 
number (852 h, i, j, k, l, m), and accession number. This 
report identifies the operator name that made the change, 
the date the change was made, the field that was changed, 
and the before and after values.
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Figure 373: History Tab Report Types

Performing Withdrawals
A withdrawal is the process of removing items from the catalog to ensure that 
the catalog is up to date and represents only those items that are actually in the 
collection. Although withdrawn items are not displayed in Alma or published 
to Primo, Alma also allows librarians and staff users to view a historical record 
of these items in Analytics reports. (Note that withdrawn items appear as Life 
Cycle = Deleted in Analytics.)

This section describes the methods that are used to withdraw items:

 Withdrawing an Item on page 472

 Withdrawing Sets of Items on page 475

Fulfillment activities This report displays loan/return activity. It identifies the 
date the change was made, the action type completed (loan/
return), the name of the operator/desk name that made the 
change, the borrower name, and the borrower ID. In-house 
loan/usage information displays on the page.

Table 59. Physical Item Editor Page - History Tab

Field Description
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Withdrawing an Item

PERMISSIONS:
To remove items from the physical inventory, you must have the 
following role:

 Physical Inventory Operator Extended

Alma allows you to withdraw individual items as needed. While withdrawing 
an item, you may decide to delete or suppress holdings records that do not have 
any items. Depending on the settings of the following parameters in the 
CustomerParameters table (Resource Management > Configuration Menu > 
Other Settings), Alma may also suppress bibliographic records:

 suppressBibWithDeletedHol – If set to true, Alma will suppress 
bibliographic records that do not have any holdings records.

 suppressBibWithSuppressedHol – If set to true, Alma will suppress 
bibliographic records that only contain suppressed holdings records.

To withdraw an item:

1 Enter the barcode for the physical item in the Persistent Search box. For 
more information, see Using the Persistent Search Box on page 16.

The Repository Search page opens and displays the brief results for the item.

Figure 374: Repository Search Page

2 Click Items.

The List of Items page opens if the holdings record contains more than one 
item.
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Figure 375: List of Items Page

If the holdings record contains a single item, the Physical Item Editor page 
will open first. Click View all items to display the List of Items page.

Figure 376: Physical Item Editor Page

3 Select Actions > Withdraw.

The Confirmation Message dialog box opens.
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Figure 377: Confirmation Message Dialog Box

4 Click Confirm. 

If the last item was removed from the holdings record, the Last Item dialog 
box opens.

Figure 378: Last Item Dialog Box

Select one of the following options and then click Go.

 Don’t change the holdings record – Select this option if you do not want 
to withdraw or suppress the holdings record.

 Delete the holdings record – Select this option if you want to withdraw 
the holdings record.

 Suppress the holdings record from externalization – Select this option 
if you do not want to withdraw the holdings record, but you want to 
prevent the record from displaying in Primo or an external discovery 
system.
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Withdrawing Sets of Items

PERMISSIONS:
To remove items from the physical inventory, you must have the 
following roles:

 Repository Manager

 Physical Inventory Operator Extended (required for delete operations)

Alma allows you to withdraw items that have been added to a set.

To withdraw a set of items:

1 Create a set of items to withdraw. For more information on creating sets, see 
Adding Itemized Sets on page 84.

2 Execute the Withdraw job. For more information on running jobs, see 
Running Jobs on Defined Sets on page 305.

a On the Run a Job – Select Job to Run page (Administration > Manage 
Jobs > Run a Job), find the Withdraw job using the filters, sort options, 
and navigation links available.

Figure 379: Run a Job – Select Job to Run Page

b Select the Withdraw items job, and click Next. 

The Run a Job - Select Set page opens.

c Select the set that you created in the first step and click Next.

The Run a Job - Enter Task Parameters page opens.



Alma Resource Management

January 2015476

Chapter 5: Inventory

Ex Libris Confidential

Figure 380: Run a Job - Enter Task Parameters Page

d Select one of the following withdraw parameters to apply to holdings:

 How to handle holdings without items and bibliographic records

– Keep holdings and bibliographic records – Keep both holdings 
and bibliographic records

– Delete holdings; delete bibliographic records that have no other 
holdings – Delete the holdings records without items, and the 
associated bibliographic records that have no other holdings

– Suppress holdings from publishing; suppress bibliographic 
records that have no other holdings from publishing – Suppress 
holdings records without items and the associated bibliographic 
records (that have no other holdings) from publishing

– Delete holdings; suppress bibliographic records that have no 
other holdings from publishing – Delete holdings records without 
items and suppress the associated bibliographic records (that have 
no other holdings) from publishing

 Do not withdraw items with active requests

 Do not withdraw items with nonactive requests in the queue

 Do not withdraw items with work orders

e Click Next to open the Run a Job - Job Details and Schedule page.

f Enter a name (required) for the job.
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NOTE:
The value you enter identifies this job for editing and monitoring (see 
Monitoring Jobs in the Alma Administration Guide).

g Select a schedule for the job if more than one option is listed. Options 
may include a specific date and time, an interval, or As Soon As 
Possible.

h Click Next to open the Run a Job - Review and Confirm page.

i Review the displayed information and click Save to run the job 
according to the selected schedule. You can monitor the progress of the 
job on the Monitor Jobs page (see Monitoring Jobs in the Alma 
Administration Guide).

Performing Global Changes on Holdings Records

PERMISSIONS:
To remove items from the physical inventory, you must have one of the 
following roles:

 Repository Manager

 Catalog Manager

Alma allows staff to update holdings information for physical items that have 
been added to a set. 

After the job is run, the job report identifies how many records were updated 
and whether any records failed. 

To perform global changes on holdings records:

1 On the Run a Job – Select Job to Run page (Administration > Manage 
Jobs > Run a Job), select the Information Update filter from the drop-down 
list.

2 Select the Change holding information job.
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Figure 191: 

Figure 381: Select Job to Run

3 Click Next and select the set to process. For information on sets, refer to 
Adding and Modifying Sets on page 84.

4 Click Next to enter task parameters.
Figure 192: 

Figure 382: Enter Task Parameters

5 Specify the task parameters. See the table below for a description of each 
parameter.



Chapter 5: Inventory

479January 2015

Alma Resource Management

Ex Libris Confidential

6 Click Next, specify the job name, and select the schedule for the job.

7 Click Next, review the job, and click Save if everything is specified correctly.

8 Click Save.

Performing Global Changes on Item-Level Information

PERMISSIONS:
To update physical inventory, you must have the following role:

 Repository Manager

Alma allows staff to update item-level information for physical items that have 
been added to a set. 

After the job is run, the job report identifies how many records were updated 
and whether any records failed. 

NOTE:
For instances where running the Change Physical Item job requires a 
location change, a new holdings record is created with the new location 
information. If the previous holdings record with the old location 
information (that was changed by running theChange Physical Item job) 
was linked to a PO line, the PO line link is broken. It no longer exists. For 
the new holdings record created with the new location information, you 
will need to manually associate the PO line using the Actions > Associate 
a PO Line option on the List of Holdings page (refer to the illustration 
below).

Table 60. Change Holdings Information Task Parameters

Parameter Notes
Apply only for Library/
location

Allows you to apply changes to items located at a 
specific library/location only. 

You must specify a location if a library has been 
selected in the drop-down list.

Update call number from 
Bibliographic record

Select the check box to globally update the call number 
using the value stored in the bibliographic record.

Correct the data using 
normalization rules

Select the check box and the normalization rules from 
the drop-down list.

Suppress record/s from 
publish/delivery

Select this check box to prevent records from being 
published to external discovery systems, including 
Primo.
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Figure 193: 

Figure 383: Manually Associate a PO Line

To perform global changes on item-level information:

1 On the Run a Job – Select Job to Run page (Administration > Manage 
Jobs > Run a Job), select the Information Update filter from the drop-down 
list.

2 Select the Change Physical Item job.
Figure 194: 

Figure 384: Select job to Run

3 Click Next and select the set to process. For information on sets, refer to 
Adding and Modifying Sets on page 84.

4 Click Next to enter task parameters.
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Figure 195: 

Figure 385: Enter Task Parameters
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5 Specify the task parameters. These parameters correspond to the options 
available on the Physical Item Editor tabs (see below) that can be accessed 
by doing a repository search for physical items and clicking Edit for one of 
the items in the search results list. Refer to Using the Repository Search 
Results List on page 35 and Updating Item-Level Information on page 465.

For each parameter row, you must select the check box at the beginning of 
the row for which you want to make a change.

NOTE:
The Change type field (changing the temporary or permanent location) 
affects only the Change Location Fields section and not the Change Other 
Fields section. 
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Figure 386: Physical Item Editor Parameters
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For each parameter, select one of the following conditions from the 
associated drop-down list:

 Unconditionally – The system will always perform the change to the 
field.

 If field empty – The system will perform the change only when the field 
has no value.

 If field not empty – The system will perform the change only when the 
field has a value.

NOTE:
Items are updated as missing only if the status is empty (Condition = If 
field empty) or if the item is defined as Technical (migration).

6 Click Next, specify the job name, and select the schedule for the job.

7 Click Next, review the job, and click Save if everything is specified correctly.

8 Click Save.

Managing Physical Holdings Records (Moves/Deletes)

PERMISSIONS:
To update physical inventory, you must have the following role:

 Repository Manager

 Physical Inventory Operator

 Purchasing Manager

 Purchasing Operator

Alma provides tools that enable you to manage your physical holdings records. 
This is accomplished with options to:

 Delete holdings records that do not have any items

 Move items from one holdings record to another holdings record
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To move items and delete holdings:

1 Complete a physical title or all titles search for something in the database 
with multiple holdings.

Figure 387: Multiple Holdings

2 From the results list, click Items. The List of Items page opens.

Figure 388: List of Items Page

3 Select the item(s) to move and click Move Items.
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Figure 389: Select Item(s) and Click Move Items

The List of Holdings page opens.

Figure 390: List of Holdings Page

4 Select the holdings location to which you want to move the items and click 
Select.
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Figure 391: Select a Holdings Location to Identify the Move to Location for the Items

The List of Items page displays an informational message to confirm what 
has been processed.

Figure 392: Move Confirmation Message

5 Click the View all holdings link. 

The updated List of Holdings page opens.
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Figure 393: View All Holdings Display

6 To delete the Medical Library/Reference holdings with zero items, select that 
holdings (row) and click Delete Holdings.

Figure 394: Select and Delete Holdings

7 When the delete confirmation alert box opens, click Confirm.
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Figure 395: Delete Holdings Confirmation Message

The List of Holdings page refreshes with an informational message 
regarding the change and the holdings record (Medical Library/Reference in 
this example) removed from the list.

Figure 396: Informational Message and Updated List of Holdings

Managing Collections
A collection is an entity that can aggregate all three resource types (physical, 
digital, and electronic) into one entity with its own bibliographic record. It can 
be based entirely on topic or subject matter, such as, for example, a collection 
titled “The Beatles” (based on the popular rock music band/cultural 
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phenomenom), which would hold records of physical items including 
biographies and sheet music, digital audio and video of live performances and 
studio recording sessions, and any number and type of song and record album 
holdings.

Structurally, collections can have child- or sub-collections and parent collections 
that behave in hierarchical relationship to each other. A collection like “The 
Beatles” could have sub-collections based on chronology, geography, biography 
of individual band members, or any other category that your institution finds 
useful. “The Beatles” collection itself could be  a sub-collection of a larger 60s 
pop music or Rock ‘n Roll genre collection.

Collections can be used in searches (as facets and as in searching by collections) 
and in other areas of the system such as publishing: resources of all types can be 
published with their collection details, including parent and child collections.

This section includes the following topics:

 Adding a Top Level Collection on page 490

 Adding a New Collection Using the Community Zone (CZ) on page 492

 Viewing the Collection Page on page 495

 Creating, Editing, and Deleting Collections on page 496

Adding a Top Level Collection

PERMISSIONS:
To add a top-level collection to your inventory, you must have one of the 
following roles:

 Collection Inventory Operator 

 Collection Inventory Operator Extended

Collections are managed resources that include any number of inventory items 
grouped together. They provide levels of organization and management to 
digital collections and other resources.

To add a top-level collection to your inventory:

1 From the Alma main menu, go to Resource Management > Create 
Inventory > Add Top Level Collection.

The Add New Collection page opens (Figure 397).
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Figure 196: 

Figure 397: Add New Collection Form

2 Use the following table to enter required and optional fields on the form.

3 Click Save to save your work and move on to another task, or Save and 
continue to save the collection and open the Collection Resource Editor 
page, where you can enter further information for the new collection.

Table 61. Add New Collection Fields

Field Description
Collection Title Corresponds to 245 $a - Title. Required.

Description Corresponds to 520 $a - Description

Collection Name Internal name for the collection (rather than the 
bibliographic record name). Required.

External ID When the collection is created automatically by the 
import job (OAI set), this is the ID of the collection 
assigned by the remote system. Additionally, users can 
store IDs in this field to be used later in the published 
metadata, and Primo can use it during discovery.

External System When the collection is created automatically by the 
import job (OAI set), this is the name of the external 
system

Library The library where the collection is stored (select from 
drop-down options). Required.



Alma Resource Management

January 2015492

Chapter 5: Inventory

Ex Libris Confidential

Adding a New Collection Using the Community Zone (CZ)

PERMISSIONS:
To add a new collection to your inventory using the CZ, you must have 
the following role:

 Repository Administrator

Alma provides the capability to create new collections using data stored in the 
Community Zone (CZ). 

VIDEO:
For information about the imporing electronic portfolios into a global 
electronic collection (a collection in the Community Zone), see the Import 
an Electronic Portfolio into a Global Collection video (6:15 mins).

To add a new collection to your inventory using the CZ:

1 Complete a Repository Search in the CZ for the new electronic collection 
that you want to add. The CZ collection search results list opens.

Figure 398: Community Zone Search Results List

http://www.youtube.com/watch?v=PeHfcT8zFi0&hd=1
http://www.youtube.com/watch?v=PeHfcT8zFi0&hd=1
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2 For the collection that you want to add, click Activate. Step 1 of the 
Activation Wizard opens.

Figure 197: 

Figure 399:  Collection Activation Wizard Step 1

3 Complete Step 1 of the Activation Wizard using Table 62 for a description of 
the available options and click Next.

Table 62. Collection Activation Wizard Step 1

Field Description
Public name Enter the local name that you want to display for this 

collection.

Library Specify the library for this collection.

Activate this  collection 
service

Select this check box to activate this collection.

Make service available Select this check box to make the service available.

Active from date Specify the beginning of the active date range for this 
collection.

Active until date Specify the ending date of the date range covered by 
this collection.
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4 Enter the linking information in Step 2 of the Activation Wizard and click 
Next.

Figure 400: Collection Activation Wizard Step 2

5 Specify one of the following activation methods (Step 3) and click Next:

 Activate all - Activation of the complete collection with no selection of 
portfolios

 Activate collection and selected portfolios

 Manual activation - activate collection and manually select portfolios

6 Review your collection activation selections on the Activation Summary 
page (Step 4 of the Activation Wizard).

Automatically activate 
new portfolios

Select this option to indicate that new portfolios added 
to the collection should be automatically activated.

The option to automatically activate new portfolios 
associated with a service is available for electronic 
collections of both the selective type and the aggregator 
type. 

(This option can be configured from both the 
Activation Wizard for new services and in the 
Electronic Services Editor for existing services.)

Service public name Use this option to specify a service name that you want 
to display.

Public note Use this free-text field to enter a note that displays to 
patrons.

Authentication note Use this free-text field to share additional information 
related to authentication.

Table 62. Collection Activation Wizard Step 1

Field Description
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Figure 401: Collection Activation Wizard Step 4

7 When you have confirmed that your activation selections are complete and 
accurate, click Activate.

Viewing the Collection Page
The top-level collection page provides a single page where Collection Inventory 
Managers can access and manage all top-level collections in the system.

To access this page:

Under Resource Management > Search and Sets, click the Top Level 
Collections link.

The Repository Search page opens to a list of all the collections in the system.
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Figure 198: 

Figure 402: Top-Level Collection Page

For details about the links on this page, refer to Creating, Editing, and Deleting 
Collections on page 496.

Creating, Editing, and Deleting Collections
Because collections allow you to group records of different types (physical, 
digital, and electronic) and from different sources (internal, external, remote) , 
digital asset management systems often use them to aggregate the many types 
of resources into organized hierarchical units. As part of this job, institutions 
may
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 Construct sub-collections

 Assign thumbnails to collections

 Add items, sets, and remote digital objects to collections and sub-collections

 Integrate collection assignment with import profiles

NOTE:
Alma collections reference local and remote objects, but all remote objects 
remain in their remote locations while the Alma collection stores object 
metadata only.

This functionality builds on the top-level root collection management. 

PERMISSIONS:
The following roles can create, edit, and manage collections and sub-
collections:

 Collection Inventory Operator

 Collection Inventory Operator Extended

To work with collections, first access an existing collection by clicking the Top 
Level Collections link under Resource Management > Search and Sets, 
performing a search, and using the filter to display only Collections.
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Figure 199: 

Figure 403: Filtering for Collections

From the list of available collections, under each brief listing, four links are 
consistently available:

 Edit: opens the collection for viewing in the metadata editor

 Edit Collection: opens the collection for viewing in the Collection Resource 
Editor (see below)

 View Collection: opens the collection in the Collection Resource Editor 
without the ability to edit, apply, or save changes

 Delete: allows you to delete the collection if it does not contain any sub-
collections or items.

Additional links may also appear on the same line:

 Title List (#titles): Lists all the sub-collections of this collection

 More info: Displays related information such as related records and 
publishing information in a pop-up box on the page

You can click the Requests/Work orders link on the More Info pop-up 
window to open the Resource Request Monitoring page and view work 
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order information for the item (refer to Monitoring Requests and Work 
Orders in the Alma Fulfillment Guide).

To create a new collection or sub-collection:

1 From the list of available collections, access the parent collection for your 
new collection and click Edit Collection. The Collection Resource Editor 
page opens to the Summary tab, which displays title and library information 
for your parent collection as well as thumbnail information and identifiers. 

Figure 200: 

Figure 404: Collection Resource Editor, Summary Tab

(To add a thumbnail for the parent collection, click the Customize 
thumbnail image link and follow the browse and selection prompts.)

The blue squares to the left of the tab labels indicate that information has 
been added to that tab.

2 Click the Sub-collections tab to begin entering information for a new 
collection under this parent.
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Figure 201: 

Figure 405: Sub-collections Tab in the Collection Resource Editor

Any previous collections added to the parent collection are listed in the table 
in the Sub-collections section below the Add Sub-collections button. The 
Actions drop-down button for each row allows editing, viewing, and 
deleting.

3 Click the Add Sub-collection button. The Add New Collection page opens. 
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Figure 202: 

Figure 406: Add Child Collection

NOTE:
The Collection Parent at the top of the Resource Information section is the 
parent collection from the previous Collection Resource Editor page.

On the Add New Collection form, information entered in the Resource 
Information section goes to the bibliographic record. Item information 
applies to the item itself (object, source). This is used in the XML. (External 
ID and External System can be manually added or automatically added 
during an import of external material.)

3 Enter the required fields for adding a collection. See Adding a Top Level 
Collection on page 490 for a discussion of top-level collections that includes 
a table that defines each field.

4 Click Save and continue. 

The Collection Resource Editor opens with your new collection added to the 
Sub-collections section.

5 To add titles to the collection, click the Title List tab. 

A Title List section opens. Any existing titles are listed in the table below the 
Add titles buttons.
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Figure 203: 

Figure 407: Collection Title List Tab

6 To manually add single titles to the collection, click the Add Title button and 
select from the list that opens. To add titles by the set, click the Add Titles 
By Set button and make your selection from the sets listed. 

You can also:

 Select check boxes for items to delete, then click Delete Selected

 Delete all items using the Delete All button

 Edit, view, or delete single items using the Actions drop-down menu for 
the particular item.

7 When you have completed your new collection or made the updates you 
want, return to the Summary tab and click: 

 Save to save your work and return to the list of collections or

 Apply to save your work and remain on the Collection Resource Editor 
page for the parent collection.
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Working with the Community Zone Updates Task 
List

PERMISSIONS:
To work with the Community Zone Updates Task List, you must have the 
following role:

 Repository Manager

The Community Zone Updates Task List page in Alma displays changes that 
were made to your Institutional Zone (IZ) during updates from the Community 
Zone (CZ). These changes are specific to your institution and may include 
modifications to bibliographic records as well as changes to holdings, 
availability, security requirements, and parser parameters. 

For more details, refer to:

 Community Zone Updates Task List Page - Tabs on page 503

 Activation of CZ Collections on page 504

 Using the Community Zone Updates Task List Page on page 506

 Exporting the Community Zone Updates Task List on page 509

 Incorporating the Community Zone Updates Task List into Your 
Workflow on page 509

Updates are synchronized on Sundays at midnight in your time zone. 

NOTE:
Additional updates such as enrichments and authorities may occur during 
the week in order to prevent overload to your system.

VIDEO:
For more information about the Community Zone Updates Task List, see 
the Alma Community Zone Intro and Task List video (14:10 mins).

Community Zone Updates Task List Page - Tabs
The Community Zone Updates Task List shows all changes relevant to your 
institution on the All tab of the page. 

The Community Zone Updates Task List page contains two tabs:

 The Review tab is open by default. It includes changes made to your records 
that you may want to review and take action on. For example, a parameter 

http://www.youtube.com/watch?v=biKoHRSc5DI&hd=1
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change may not fit your institution’s requirements. You can manually revert 
to the old value by using the Edit action. 

 The All tab shows information for all changes that were made to your 
records or that are relevant to your institution.

Activation of CZ Collections
The way you activate a collection from the CZ determines the actions that you 
can take following a CZ update.

The activation can be processed in one of two ways:

1 Auto-active collection: activating an electronic collection of the aggregator 
package type and selecting the check box to indicate that the source should 
be updated automatically.

2 Non auto-active collection: activating an electronic collection  of the selective 
package type (or of the aggregator package type) and setting it to not use 
automatic updates.

Available actions vary depending on the above options. See Table 63 for details.
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Table 63. Actions for CZ Updates

Type Action Name Action Taken Tab
Both (Auto-
activation and 
Non auto-
activation)

Electronic 
Collection linking 
parameters 
update 

The action is performed. Users 
can undo it by clicking the Edit 
option and manually restoring 
the previous value.

Both 
(Review 
and All)

Electronic 
Collection base 
url updated 

The action is performed. Users 
can undo it by clicking the Edit 
option and manually restoring 
the previous value.

Both 
(Review 
and All)

Electronic 
Collection service 
deleted

The electronic collection is 
unlinked from CZ and set to 
inactive. The institution icon 
(single building) shows beside 
the electronic collection in the 
repository search. Users can 
decide to keep the electronic 
collection, in which case they 
should use the Edit option and 
manually manage the electronic 
collection, or they can decide to 
delete it, in which case they will 
need to find the electronic 
collection in the repository 
search and manually delete it.

Both 
(Review 
and All)

Portfolio 
coverage update 

The action is performed. All only

Electronic 
Collection 
deleted 

The electronic collection is 
unlinked from CZ and turned 
inactive. The institution icon 
(single building) shows beside 
the electronic collection in the 
repository search. Users can 
decide they want to keep the 
electronic collection, in which 
case they should use the Edit 
option and manually manage 
the electronic collection, or they 
can decide to delete it, in which 
case they will need to find the 
electronic collection in the 
repository search and manually 
delete it.

All only
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Currently, the update job handles updates to CZ resources only. If an institution 
adds an IZ portfolio to a CZ electronic collection, the job does not update it. The 
IZ portfolio is created as a duplicate, and no automatic job deletes it. 

You can see new CZ portfolios added to electronic collections in the All tab, and 
you need to manually delete the existing IZ portfolios following the update.

Using the Community Zone Updates Task List Page

NOTE:
The Review tab includes only the changes for which you can take action. 
The view (All) feature of this page functions as a log and can be used by all 
institutions for all updates. To do this, click the All tab from the 

Auto-
activation

Portfolio added to 
auto active 
electronic 
collection 

The action is performed. All only

Non auto-
activation 

Portfolio added to 
non auto- active 
electronic 
collection

No action is performed. In the 
All tab, users can see added 
portfolios to the CZ electronic 
collection. In order for them to 
add the portfolios to their 
electronic collection, they will 
need to manually go into the 
CZ, find the portfolio, and 
activate it. Alternatively, they 
can add it as a local portfolio 
manually.

All only

Auto-
activation

Portfolio deleted 
from auto active 
electronic 
collection

The action is performed. All only

Non auto-
activation

Portfolio deleted 
from non auto-
active electronic 
collection

The portfolio is not deleted but 
it is unlinked from the CZ and 
saved as a local portfolio. Users 
will see this action in the 
Review tab and will be able to 
manually delete the portfolio by 
using the Edit option. They can 
keep the local portfolio by 
clicking the Dismiss action.

Both 
(Review 
and All)

Table 63. Actions for CZ Updates

Type Action Name Action Taken Tab
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Community Zone Updates Task List page and use the search and filter 
features to help you find the changes you want to view.

See Exporting the Community Zone Updates Task List on page 509 if you want 
to export the list of tasks to an Excel file.

To work with the Community Zone Updates Task List:

1 From the Alma main menu, go to Resource Management > Manage 
Inventory, and click Community Zone Updates Task List.

The Community Zone Updates Task List page opens to the Review tab by 
default, displaying the following columns of information: 

 Report Type

 Electronic Collection Name – When available, this column provides a 
link for the resource to the appropriate Alma editor.

 Title  – When available, this column provides a link for the resource to 
the Electronic Portfolio Editor.

 Submit Date

 Before Change/After Change  – The information in the Before Change 
and After Change columns represents the changes made globally as part 
of the Community Zone update job.

 Local Information  – The information in the Local Information column 
identifies the local override information maintained by the library.
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Figure 204: 

Figure 408: Local Information Details Example

Any changes that have affected the resources set to manual (non auto-
active) in your configuration and on which a Repository Manager from your 
institution can take action (such as manually updating a URL or deleting a 
resource that has been unlinked by the CZ in the synchronization) appear 
on this tab.

2 Use the Find search field, the date range with the Apply Filter button, and/
or the report type filter drop-down list to narrow the scope of your view.

The report type filter provides the following options:

 All

 Electronic collection deleted

 Electronic collection linking parameters update

 Electronic collection base URL updated

 Portfolio coverage update

 Portfolio deleted from non auto-active package

 Electronic collection service deleted

NOTE:
Items in the filter reflect the report types on both tabs. 
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The date filter allows you to search for items based on a date range of when the 
item was submitted. The range goes back as far as your implementation of Alma 
and is never purged from the system.

3 Process items on the Review tab as follows:

a Click Actions > Dismiss to remove a row from the list (and take no 
further action on it).

b Click Actions > Edit to make changes to a collection or portfolio.

For an electronic collection report type, the Electronic Service Editor 
opens for making changes.

For a portfolio report type, the Electronic Portfolio Editor opens for 
making changes. For more information, see Modifying a Portfolio 
Using the Electronic Portfolio Editor on page 349.

c Use the check box options to selectively dismiss or dismiss all of the 
rows in the list and click Execute.

Exporting the Community Zone Updates Task List
The Tools menu on the Community Zone Updates Task List page allows you to 
run the following export options:

 Extended Export – Select Tools > Extended Export to export all tasks to an 
Excel file. If the list contains more than 5000 tasks, the job runs in the 
background. You can use the Monitor Job page (Administration > Manage 
Jobs > Monitor Jobs) to monitor the job’s progress and view the Excel files. 
Note that each file may contain up to 50,000 rows before the task list is split 
into additional files. Lists with fewer tasks are also saved to an Excel file, but 
the job is run in the foreground.

 Excel (current view) – Select Tools > Excel (current view) to export all tasks 
to an Excel file. Note that this export does not support task lists that are 
greater than 5000 tasks. If there are more than 5000 tasks, this option is 
disabled.

Incorporating the Community Zone Updates Task List into 
Your Workflow

Refer to the procedure below for a suggested method of incorporating the 
Community Zone Updates Task List into your workflow. 
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To incorporate the Community Zone Updates Task List into your workflow:

1 Access the Community Zone Updates Task List once per week.

2 Review the updates made to your IZ records from the CZ updates.

a Apply the Community Zone Updates Task List filters that are useful for 
your particular institutional workflow. You may find it more useful to 
apply the filters and check the collection-level changes before applying 
the filters and checking the portfolio-level changes.

b As you filter and view the entries, look for:

 Deleted portfolios

These are portfolios that were deleted in the CZ and have become 
local portfolios. You will need to decide if the portfolio should be 
deleted. This decision will most likely be determined by whether 
there is still access to the resource.

 Portfolios that were added to the aggregator collection but were not 
automatically activated 

The portfolio is not automatically activated if it was initially chosen 
on the collection level. You need to decide if the portfolio should be 
activated.

 Portfolios where the global coverage was updated and the library has 
local coverage 

You will need to determine if you want to remove the local coverage.

3 Dismiss the records for which you have accepted the update using Dismiss 
Selected or Dismiss All (refer to the procedure To work with the 
Community Zone Updates Task List: on page 507 for more information). 
The expectation is that the vast majority, if not all, of the entries will be 
dismissed.

Using the Community Zone Updates Task List eliminates the time-
consuming process of manually reviewing and implementing each change.

NOTE:
Entries that have been dismissed are still available in the All tab. This 
ensures that you have a history of the entries which were dismissed.
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Managing Profiles for Record Imports

About Import Profiles
Import profiles are components of the Resource Management infrastructure that 
are closely tied to other areas of the system. They can interact with various 
Acquisition functionalities, such as purchase orders and the Embedded Order 
Data (EOD) import workflow. They can also be used to import bibliographic or 
authority records without EOD.

Import profiles enable you to define how to import metadata and order 
information in the Alma repository. Profile definitions include source format, 
mapping definitions, and normalization routines to be executed during the 
import process.

EOD Imports
If you are importing using EOD, you can use one or more profiles that have 
been created for a particular vendor with specific configurations for the kinds of 
purchases that are being processed. A vendor can have multiple import profiles 
with specific configurations for a particular purchase type. For example, 
different import profiles might exist for purchases being funded through 
different funds, or for purchases for different libraries in the institution.

This section includes:

 About Import Profiles on page 511

 Configuring New Import Profiles on page 512

 Managing Import Profiles on page 554

 Defining Import Profiles for Multiple Item Creation on page 560

 Running a New Import Job on page 565

 Resolving Import Issues on page 582
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EOD files are provided by vendors. They contain the order information for 
material being purchased from the vendor. When an EOD file is processed, it is 
matched with a specific import profile for the type of purchase on the EOD file.

Configuring New Import Profiles

PERMISSIONS:
To configure or create import profiles, you must have the following role:

 Catalog Administrator

Authorized users can create import profiles that define how input file records 
are imported into Alma and how they are mapped to corresponding records in 
the Alma system.

NOTE:
For information on defining import profiles in order to create multiple 
items in multiple libraries and locations, see Defining Import Profiles for 
Multiple Item Creation on page 560.

You can choose to create a new profile (see Profile Types below), or copy an 
existing import profile (see Copying Import Profiles on page 558) and edit it for 
your new requirements (see Editing and Viewing Import Profiles on page 555).

VIDEO:
See Importing Bibliographic Records and Creating Inventory for a detailed 
training Webex session on importing records (49 mins). Note that you 
must be logged on to the Ex Libris Learning Center to access this session.

Profile Types
Before beginning the new import profile wizard, determine which type of 
import profile you need.

The following profile types are available:

 New Order – Used for loading bibliographic records with embedded 
order data (EOD), resulting in the import of bibliographic information 
and the creation of PO lines and physical/electronic inventory according 
to the parameters configured in the import profile.

 Update Inventory – Used for updating inventory associated with PO 
lines, based on the PO line reference number or vendor reference 
number. For an in-depth explanation of this profile type, see 
Understanding the Update Inventory Import Profile below.

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1016
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 Repository – Used for loading bibliographic records, resulting in the 
import of bibliographic information and the creation of physical/
electronic inventory according to the parameters configured in the 
import profile. 

 Authority – Used for a complete reload of authority records. If matching 
authority records exist, they will be deleted and replaced by the new 
ones. (Available only if the authority usage policy is set to local by Ex 
Libris and if you have local authority records in your repository)

 Initial Authority – Used for the ongoing updates of authority records. 
Existing authority records that are matched with imported ones 
(according to the parameters configured in the import profile) will be 
updated and new imported authority records will be added. (Available 
only if the authority usage policy is set to local by Ex Libris)

 Remote Digital – Used for harvesting metadata from digital repositories 
external to Alma (such as Primo, Rosetta, or Dspace), then creating 
records in Alma. Searching in Alma will return the record information, 
but to view the objects you must go to the external repository or 
resource. For information about setting up a remote repository, see 
Remote Digital Repositories on page 680.

NOTE:
The Digital Inventory Operator role is required in order to view/select the 
Remote Digital profile type.

VIDEO:
See Importing Bibliographic Records and Creating Inventory for a detailed 
training Webex session on importing records (49 mins). Note that you 
must be logged on to the Ex Libris Learning Center to access this session.

Understanding the Update Inventory Import Profile
Using the Update Inventory import profile, you can update inventory as part of 
a bulk import. This profile allows you to handle shelf-ready workflows, where 
the vendor provides resources that are already barcoded.

When Alma imports bibliographic records according to an Update Inventory 
profile, for each record, it attempts to match on either a PO line reference 
number received from the vendor or a vendor reference number. 

On finding one of these, Alma runs the standard import/overlay logic, but 
unlike other import methods, it updates the inventory linked to the 
bibliographic record. (In all other cases, Alma simply creates new inventory; 
Update Inventory is currently the only way to update existing inventory.)

A part of the import/overlay logic also addresses the need for consistency 
between call numbers in Alma and the actual call numbers/spine labels of 

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1016
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existing physical items to insure that items can be found on the shelf. As a result, 
when a new PO line is created and a PO line and holdings record already exist, 
the existing holdings record does not get changed. Instead, a new holdings 
record is created with the call number of the bibliographic record.

VIDEO:
Learn how to use the PO line number to match a record file to inventory in 
the PO Line Information in Vendor Import File video (9:10 mins).

NOTE:
Priority is given to the PO line reference number over the vendor 
reference number.

You can configure the actual record field used for matching by specifying the 
Additional PO Line Reference and/or Vendor reference number field in the 
PO Line Information tab. For the vendor reference number to work as a match 
field, you must also enter a vendor reference number type on the line below the 
reference number field and subfield.

For example:

http://www.youtube.com/watch?v=7xF8z7Z9t0U&hd=1
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Figure 205: 

Figure 409: Mapping the PO Line Number and Vendor Reference Number and Type Fields

Note that in order to avoid the duplication of barcodes in the repository, the 
conditions under which an item is updated operate as follows:

Alma attempts to match items based on the incoming barcode, for both the 
Basic and Advanced mapping profiles.

 If the barcode exists in the repository and the item was updated before, the 
item will be skipped (for both the Basic and Advanced mapping profiles).

 If the barcode exists in the repository and the item was not updated before, 
the item will be updated (for both the Basic and Advanced mapping 
profiles).

 If the barcode does not exist in the repository and the Basic mapping profile 
is used, it will update an item that was not updated before, regardless of the 
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barcode match. If all of the items were already updated, the incoming record 
will be ignored. 

If the barcode does not exist in the repository and the Advanced mapping 
profile is used, the barcode will be set for items that do not have barcodes. 

Selecting a Profile Type
After you have decided on the appropriate profile type for your material, you 
can start the import profile wizard and select the type.

To select the import profile type:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 
click the Add New Profile button (Figure 410).

Figure 206: 

Figure 410: Add New Profile Run Import Page

The Import Profile Details wizard opens (Figure 411). 
Figure 207: 

Figure 411: Import Profile Details Wizard - Page 1

2 Select the profile type from the choices listed.
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NOTE:
The wizard begins on this page, as indicated by the circled number one (1) 
at the top of the page. The remaining number of steps in the process 
depends on the profile type you choose. For example, if you choose Initial 
Authority (if it is available to you), the wizard is two steps. If you choose 
New Order, the wizard is seven steps. When you click Next after choosing 
your type, the full number of steps appears as determined by your choice.

3 Click the Next button.

The system processes your type selection and displays the remaining 
number of steps of your profile at the top of the following page (page two of 
the wizard— Figure 412).

Creating the Profile Using the Wizard
After you have selected your profile type and clicked the Next button, Step 2, 
the Profile Details form, opens (see Figure 412).

Figure 208: 

Figure 412: Import Profile Details Wizard - Page 2

NOTE:
This example describes how to create the New Order import profile. The 
information below, however, pertains to all import profile wizards. Where 
a single field or option applies to only one type of profile, this is noted in 
the description.
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To create the import profile:

1 On the Profile Details page (step 2) of the Import Profile Details wizard (see 
Profile Types on page 512), enter a name and details for the import profile. 
Use the following table for information about the fields on this page.

NOTE:
Some of your selections may impact other choices on this form. For 
example, if you choose FTP for File Upload Method, two additional 
sections appear on this form. See Figure 413. 
 
These sections are also documented in the table below.

Figure 209: 

Figure 413: Import Profile Details with FTP as File Upload Method

Table 64. Import Profile Details Wizard - Page 2 Fields

Field Description
Profile Details section:

Use Network Zone For an explanation of this option, see Working With Import 
Profiles for the Collaborative Network in the Alma online 
help.

Profile name  
(required)

A name for the profile. The name appears on the list of import 
profiles in the Profile Name column.
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Profile description A free text description of the profile that shows on the list of 
import profiles in the Profile Description field. Enter salient 
details that allow you to identify the profile as matching the 
requirements of a specific EOD file when importing data.

Originating system The type of originating system such as the Library of 
Congress or OCLC. The available options are predefined by 
an Administrator.

Physical source 
format

The physical source format of the import file. The available 
options are MARC21 XML or MARC21 Binary.

NOTE:
For the binary format, Alma supports only .mrc files 
and not .mrk files.

Library (Remote 
Digital type only)

The library that owns the imported digital resources.

Remote Digital 
Repository Instance 
(Remote Digital type 
only)

The name of the remote digital repository instance used by 
this profile.

Collection 
Assignment 
(Remote Digital type 
only)

The collection name to which the imported records will be 
assigned.

Source format 
(view only)

The source format of the bibliographic, authority, or EOD file, 
such as MARC21 Bibliographic.

File upload method The way the bibliographic, authority, or EOD file is to be 
uploaded to Alma. If FTP is selected, Import Processing and 
FTP Information must be entered. If Upload File is selected, 
the file of records to be imported must reside on a local or 
network drive.

If OAI is selected (remote digital only), additional fields and a 
new section open on the page. For more information, see the 
OAI Details section.

File name patterns Enter a file name pattern (such as *.xml) if you want to filter 
out certain records that do not conform to the pattern you 
specify. For example, FTP loads may contain additional files 
or records that should not be included in an import.

Cross walk Currently not in use.

Table 64. Import Profile Details Wizard - Page 2 Fields

Field Description
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Target format 
(view only)

The format for the target file. For example, Marc21 
Bibliographic.

Active The default is True. This means that the import profile can be 
used. Select False from the Active drop-down list if you do 
not want the import profile to be available for use at this time.

Vocabulary code 
(Authority and 
Initial Authority 
profile types only)

Drop-down: When importing authority records, select a 
vocabulary code: LCNAMES and LCSH are two options, as is 
MeSH.

Imported File Processing section:

Appears only if FTP has been selected as the File Upload Method.

Files to import Select All for all files found in the FTP location. Select New to 
select only those files that have not yet been imported.

Scheduler To schedule this import job, select one of the scheduling 
options from the drop-down list. Examples may include Not 
scheduled, The 15th of every month, Every 6 hours, Every day 
at 2am. (The exact time depends on your time zone and the 
server you are using.) 

Email Notifications Opens the Email Notifications for Scheduled Jobs page, which 
allows you to specify which users and email addresses will 
receive email notifications when the publishing profile has 
completed. You will have the option to choose whether to 
send the notifications for successful jobs and/or jobs that 
contain errors.

Scheduler status Select Active to put the Scheduler to use, Inactive to disable 
the Scheduler.

FTP Information section:

Appears only if FTP has been selected as the File Upload Method.

Description Enter a description of the FTP submission format that is 
defined in this section.

Server/Port Specify the IP address and port of the FTP server sending or 
receiving the files.

User name/
Password

Enter the username and password for logging on to the server 
that is sending or receiving the files.

Input directory Enter the path of the submission format’s input directory.

Max. number of files Not in use. Accept the default value.

Table 64. Import Profile Details Wizard - Page 2 Fields

Field Description
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Max file size/Size 
type

Not in use. Accept the default value.

FTP server secured Select to use a secure FTP transfer (SFTP)

Test Connection Click this button to run a test of the FTP connection

Imported File Processing section:

Appears only if OAI has been selected as the File Upload Method.

Files to import Set by default to All, which means that all records that are 
returned by the OAI data provider will be processed.

Scheduler Enables the scheduling of this import job, selecting one of the 
scheduling options from the drop-down list. Examples may 
include Not scheduled, The 15th of every month, Every 6 
hours, Every day at 2am. (The exact time depends on your 
time zone and the server you are using.)

Email Notifications Opens the Email Notifications for Scheduled Jobs page, which 
allows you to specify which users and email addresses will 
receive email notifications when the publishing profile has 
completed. You will have the option to choose whether to 
send the notifications for successful jobs and/or jobs that 
contain errors.

Scheduler status Select Active to enable the Scheduler, Inactive to disable the 
Scheduler.

Table 64. Import Profile Details Wizard - Page 2 Fields

Field Description
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NOTE:
From this step of the wizard through the last, you can click the Save Draft 
button to save the profile you are creating. The Import Profile Details 
wizard closes, and the import profile is added to the Run Import page 
with a Status of Inactive. To continue building the profile or to make 
additional changes later to the import profile, click Actions > Edit in the 
row of the profile and follow the instructions for Editing and Viewing 
Import Profiles on page 555.

2 When you have entered values in all the fields you need, click Next. 
 

OAI Details section:

Appears only if OAI has been selected as the File Upload Method.

OAI Base URL The OAI provider’s URL, which OAI harvesters can use to 
load metadata.

Connect and Edit 
button

Refreshes the form with the relevant OAI information. 

Repository Name From the OAI provider, populated by the system when 
Connect and Edit is clicked.

Earliest Date Stamp The earliest that data exists in the OAI provider records, 
populated by the system when Connect and Edit is clicked

Admin's E-Mail OAI provider admin's email, populated by the system when 
Connect and Edit is clicked.

Metadata Prefix The available MD prefixes from the OAI provider, populated 
by the system when Connect and Edit is clicked.

Set OAI repository available sets, populated by the system when 
Connect and Edit is clicked.

Harvest Start Date When submitting a new import job and after the job 
completes successfully, the Harvest Start Date is updated 
automatically with the job’s ending time.

Encode Date If the repository does not support the encoding of dates, clear 
this check box.

Open Test Page Allows you to test the OAI connection and flow. See Testing 
OAI Flow for a Remote Digital Repository on page 547.

Table 64. Import Profile Details Wizard - Page 2 Fields

Field Description
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(For Initial Authority types, the wizard is completed at this step and you can 
click Save, Save Draft, or Cancel.)

Page 3 of the Import Profile Details wizard opens (Figure 414). This page 
contains selections for normalization and validation of profile data.

Figure 210: 

Figure 414: Import Profile Details Wizard - Page 3

The following table describes the Normalization and Validation selections on 
this page:

3 Enter information in the fields as needed, then click Next.  
 
(For Authority types, the wizard is completed at this step and you can click 
Save, Save Draft, or Cancel.)

Page 4 of the Import Profile Details wizard opens (Figure 415).

Table 65. Import Profile Details Wizard - Page 3 Fields

Field Description
Normalization section:

Correct the data 
using

Predefined normalization rules can be selected with this 
option as part of the import profile to correct the data. For 
information on normalization rules, see Working with 
Normalization Rules on page 220.

Validation Exception Profile section:

Handle invalid data 
using

The method used to handle invalid data as it is being 
imported. For more information, see Working with 
Validation Exception Profiles on page 652. 

For import profiles, Ex Libris recommends using the 
MarcXML Bib Import validation exception profile.
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Figure 211: 

Figure 415: Import Profile Details Wizard - Page 4

Page 4 of the wizard contains information related to profile matching. The 
following table provides detailed information about the fields.

NOTE:
Fields may vary depending on your selections on previous pages or as 
you move down the page. Conditions are noted, where relevant, in the 
table below.
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Table 66. Import Profile Details Wizard - Page 4 Fields

Field Description
Match Profile section: 
For information on profiles and profile variables, see Creating the Profile Using the 
Wizard on page 517.

Serial match method 
 
(For Update 
Inventory type, the 
field Match Method 
is read-only.)

The method used to match serial data. For a detailed 
description and examples of some of these methods, see 
Match Methods – Explanations and Examples on page 548. 
See also Understanding the Update Inventory Import 
Profile on page 513.

Non-serial match 
method 
 
(Repository and New 
Order types only)

The method used to match non-serial data. For a detailed 
description and examples of some of these methods, see 
Match Methods – Explanations and Examples on page 548.

Match Actions section:

Handling method The method for handling a match. You can select from:

 Automatic (default) - The system resolves the matching 
according to the selected Upon match behavior. If you 
select this option, additional options are displayed in the 
Automatic Multi Matches Handling section on this page.

 Manual – If the imported bibliographic record has a 
match in Alma, the import process is set to the status 
Manual Handling Required and the user must choose 
whether or not to import the record. Note, however, that 
if there are more than 150 matches, the system operates as 
if no match has been found and the record is imported. 

Upon match The action to perform when there is a match. You can select 
from:

 Import New Record (New Order and Repository only) – 
The record is imported, but there may be redundant data

 Do not import (default)   
(New Order and Repository only) 
The new record is discarded

 Merge – Merge the records according to the options 
chosen in the profile configuration

 Overlay – Keep the old record only, but change its 
internal data according to the new record. This enables 
the history of all of the linking performed for this record 
to be retained.



Alma Resource Management

January 2015526

Chapter 6: Managing Profiles for Record Imports

Ex Libris Confidential

Match Actions section - Merge Overlay subsection:

Merge method 
(Applies only when 
Upon match is set to 
Merge)

The method used to merge the data. The available 
predefined options are:

 Conditional subject headings

 Overlay all fields but local

 Replace 245 and 035 OCoLC if exist

Allow bibliographic 
record deletion

When checked, allows Alma to delete a matching record 
under the following conditions:

 The imported record includes a d in LDR position 5. 

 No PO line or inventory resources are associated with the 
bibliographic record.

 For PDA portfolios, a portfolio that is associated with the 
bibliographic record has the same PDA ID as the PDA 
profile.

VIDEO:
Learn how to allow record deletion in import 
profiles in the Allow Record Deletion in Import 
Profiles video (5:58 mins).

Unlink bibliographic 
records from 
Community Zone

Applies to Upon match selections Merge and Overlay only. 
When checked, the records are handled as separate, local 
records going forward.

NOTE:
This field appears only if the ignore_cz_records 
parameter is set to false in the CustomerParameters 
mapping table (Resource Management > Resource 
Configuration > Configuration Menu > Other 
Settings).

VIDEO:
For more information on overlaying community 
zone records in the network zone, see the Overlay 
Community Zone Records in the Network Zone video 
(9:51 mins).

Table 66. Import Profile Details Wizard - Page 4 Fields

Field Description

http://www.youtube.com/watch?v=B91s4XfqdDc&hd=1
http://www.youtube.com/watch?v=B91s4XfqdDc&hd=1
http://www.youtube.com/watch?v=VW1ZGW8q6nw&hd=1
http://www.youtube.com/watch?v=VW1ZGW8q6nw&hd=1
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Do not override/
merge a nonbrief 
record with a brief 
version

In order to prevent a situation in which a good quality record 
is overlaid with a lower quality imported record, this 
parameter provides additional control when an imported 
record is overlaid or merged. 

When you select the Do not override/merge a non-brief 
record with a brief record parameter, Alma uses the brief 
record algorithm configured by Ex Libris at installation to 
determine what constitutes a brief record. When this option 
is selected and the matched record is identified as brief, the 
imported record will not overlay/merge the matched record. 
Refer to the Identifying brief records description in the table 
System-Defined Jobs per Content Type on page 306 in the 
Alma Administration Guide for more information. 

VIDEO:
For more information about preventing a brief 
record overlay, refer to the Import Profile: Prevent 
Overlay by Brief Record video (6:28 mins).

Automatic Multi Matches Handling section:

Disregard matches 
for CZ-linked records

This option instructs Alma to disregard matches for CZ-
linked records (that is, bibliographic records in the 
Institution Zone that are linked to the CZ) and process only 
matches on local records. This enables Alma to automatically 
resolve cases in which there is a multiple match because 
there is both a local and CZ record that match the incoming 
record. In such a case, only the local record will be 
considered a match.

NOTE:
This field appears only if the ignore_cz_records 
parameter is set to false in the CustomerParameters 
mapping table (Resource Management > Resource 
Configuration > Configuration Menu > Other 
Settings).

Automatic Multi Matches Handling section - Unresolved Records subsection:

Skip and do not 
import

This option instructs Alma not to import multiple matches. 
Instead of multiple matches being sent to the Matching 
section of the Resolve Import Issues page, they are added to 
a new report that has been created (Download records that 
were skipped due to multi-match automatic handling).

Table 66. Import Profile Details Wizard - Page 4 Fields

Field Description

http://www.youtube.com/watch?v=u8fKN4jBaPQ&hd=1
http://www.youtube.com/watch?v=u8fKN4jBaPQ&hd=1
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4 Enter match information in the fields and click Next. 

Page 5 of the Import Profile Details wizard opens (Figure 416).

Figure 416: Import Profile Details Wizard - Page 5

Fields on this page determine management tags for all records imported using 
this profile. See the following table for information on how to make selections.

No Match section (New Order and Repository types only):

Upon no match Select one of the following options when there is no match:

 Do not import 

 Import 

The default varies by import profile type.

Table 66. Import Profile Details Wizard - Page 4 Fields

Field Description

Table 67. Import Profile Details Wizard - Page 5 Fields

Field Description
Set Management Tags section:

Suppress records from 
publish/delivery

Select the check box if you want to suppress records 
from publishing or delivery in Primo.

Synchronize with OCLC Select one of the drop-down menu options for 
synchronizing with the Online Computer Library 
Center, Inc. (OCLC)

 Publish bibliographic records 

 Publish holdings only

 Don’t publish
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5 Enter set management tag information in the fields and click Next. 

NOTE:
The Remote Digital profile completes on Step 5 of the wizard and can be 
saved, closed, and tested. For testing instructions, see Testing OAI Flow 
for a Remote Digital Repository on page 547

Page 6 of the Import Profile Details wizard opens (Figure 417).

Figure 417: Import Profile Details Wizard - Page 6

6 In the Inventory Operations section, select Electronic, Physical, None, or 
Mixed for the type of material being imported.

For Electronic inventory, the page refreshes to include new fields for 
electronic profiles. Options for updating standalone or collected portfolios, 
using single or multiple URLs, are provided in the E-Book Mapping section 
of the page. See Figure 418 and continue with step a  on page 530.

For Physical inventory, the page refreshes with fields specific to physical 
materials. See Figure 419 and continue with step b on page 534.

For Mixed inventory, the page refreshes with fields displayed for both 
electronic and physical inventory, and the fields specific to mixed materials. 
See Figure 423 and continue with step c on page 540.

When working with a Repository profile type, you can select the None 
option, which indicates that a bibliographic record of the item is created, but 
no actual inventory is created. Proceed with step 7 on on page 541.

Synchronize with 
National Catalog

Select one of the drop-down menu options for 
synchronizing with the National Catalog:

 Publish bibliographic records 

 Don’t publish

Table 67. Import Profile Details Wizard - Page 5 Fields

Field Description
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Figure 212: 

Figure 418: Import Profile Details Wizard - Page 6 Electronic

a Enter information for the E-Book Mapping section using the Electronic 
Fields table below. When you finish, skip to step 7.
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Table 68. Import Profile Details Wizard - Page 6 Electronic Fields E-Book Mapping Section

Field Description
Delete/deactivate portfolios 
when bibliographic record 
marked for delete

Select this option to indicate how to process 
portfolios when linked bibliographic records are 
identified for deletion with a d in position 5 of the 
leader. 

This option is available when:

 Creating or modifying Repository or Update 
Inventory import profiles

 Allow bibliographic record deletion has been 
selected in the Match Profile tab of the import 
profile (page 4 of the wizard)

 Part of an electronic collection portfolio type 
has been selected on this tab (Inventory 
Information, page 6 of the wizard)

When the system tries to delete a portfolio and 
there is a PO line connected, it deactivates the 
portfolio instead. 

NOTE:
A portfolio can be deleted only when there 
is no PO line connected to it.

Import reporting provides information regarding 
electronic portfolios deactivated during the import 
process.

VIDEO:
For information about deactivating/
deleting electronic portfolios using by 
running an import job, see the  Delete/
Deactivate and Electronic Portfolio Using 
Import Profile video (7:39 mins).

Portfolio type Standalone or Part of an electronic collection. 
Determines whether the import is handled as 
standalone inventory (not grouped into an 
electronic collection) or as part of the selected 
electronic collection.

http://www.youtube.com/watch?v=4qVHHB72zpE&hd=1
http://www.youtube.com/watch?v=4qVHHB72zpE&hd=1
http://www.youtube.com/watch?v=4qVHHB72zpE&hd=1
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Electronic Collection (for Part 
of an electronic collection 
Portfolio type only)

Select the electronic collection to which you want 
to import the portfolios. After you select an 
electronic collection, Alma refreshes the Service 
drop-down list (see next field entry) to display the 
relevant services for the selected electronic 
collection.

Service (for Part of an 
electronic collection Portfolio 
type only)

Select the appropriate electronic collection service.

NOTE:
All electronic titles in the import file must 
belong to the same electronic collection 
service.

Material type A list of material types for electronic resources 
(such as Book, CD-ROM, Dissertation, Journal, 
Musical Score). Select one from the drop-down list.

Enable proxy (for Standalone 
Portfolio type only)

The default is False. Select True to enable a proxy 
to redirect the URL.

NOTE:
For Part of an electronic collection, the 
proxy field is hidden. Enabling the proxy is 
available at the electronic collection level.

Multiple portfolio/Single 
portfolio

Whether the material to be imported exists in 
multiple portfolios or in a single portfolio.

NOTE:
Standalone imports do not have the 
multiple portfolio option. They can only use 
the single portfolio.

Extract portfolio information 
from field (for Multiple 
portfolio only)

The MARC field used as the source for gathering 
information for multiple portfolios

Extract access URL from field 
and subfield

The field/subfield combination that contains the e-
book URL. To have Alma skip fields based on 
indicators, use indicator pairs separated by 
commas.

Extract interface name from 
field/subfield (for Standalone 
portfolio types only)

The MARC field and/or subfield from which to 
take the interface name.

Table 68. Import Profile Details Wizard - Page 6 Electronic Fields E-Book Mapping Section

Field Description
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Default interface name (for 
Standalone portfolio types 
only)

The default field if the interface name field in the 
record is empty. Click the search icon to select 
from a list of available vendors.

Extract internal description 
note from field/subfield

The source record’s field/subfield that contain(s) 
the internal description note. Single portfolios can 
use MARC fields and subfields. Multiple 
portfolios use only the subfield here and in 
remaining extractions because the main field has 
already been entered in Extract portfolio 
information from field.

Default internal description 
note

The default value if the internal description field in 
the record is empty. Enter optional text for the 
internal description field

Extract authentication note 
from field/subfield

The source record’s field/subfield that contain(s) 
the authentication note. Single portfolios can use 
MARC fields and subfields. Multiple portfolios 
use only the subfield here and in remaining 
extractions because the main field has already 
been entered in Extract portfolio information 
from field.

Default authentication note The default value if the authentication notes field 
in the record is empty. Enter optional text for the 
authentication notes field.

Extract public note from field/
subfield

The source record’s field/subfield that contain(s) 
the authentication note. Single portfolios can use 
MARC fields and subfields. Multiple portfolios 
use only the subfield here and in remaining 
extractions because the main field has already 
been entered in Extract portfolio information 
from field.

Default public note The default value if the public note field in the 
record is empty. Enter optional text for the public 
notes field.

Available for field The field/subfield that determines whether the 
electronic inventory is available only to some 
groups and not others.

VIDEO:
Learn more about this feature in the 
Assign "Available For" Groups Using an 
Import Profile video (6:04 mins).

Table 68. Import Profile Details Wizard - Page 6 Electronic Fields E-Book Mapping Section

Field Description

http://www.youtube.com/watch?v=4GWiNDGfSdc&feature=youtu.be
http://www.youtube.com/watch?v=4GWiNDGfSdc&feature=youtu.be
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For physical inventory, the page refreshes to include new fields for Physical 
Item Mapping (see Figure 419). This section allows you to choose the policy 
(Advanced or Basic) used to map additional item-level fields from the 
import records into Alma. 

VIDEO:
For more information about the Advanced import option, see the Add 
Item- Level Attributes to Import Records video (3:40 mins).

The following figure shows the fields associated with the Basic mapping 
policy.

Figure 213: 

Figure 419: Import Profile Details Wizard - Page 6 Physical (Basic Method)

Default available for A drop-down list containing all the groups in the 
consortium that might have access to inventory. 
Select one as the default group for this profile.

Activate resource Select the check box to automatically activate the 
resource after the import. 

Table 68. Import Profile Details Wizard - Page 6 Electronic Fields E-Book Mapping Section

Field Description

http://youtu.be/Vq0CaW5jsKI
http://youtu.be/Vq0CaW5jsKI
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The following figure shows the fields associated with the Advanced 
mapping policy.

Figure 214: 

Figure 420: Import Profile Details Wizard - Page 6 Physical (Advanced Method)

b Enter values for the fields using the relevant table below. When you 
finish, skip to step 7.

NOTE:
If you want to create multiple items in multiple libraries and locations, see 
Defining Import Profiles for Multiple Item Creation on page 560.
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Table 69. Import Profile Details Wizard - Page 6 Physical Fields - Basic Mapping Policy

Field Description
Physical Item Mapping section (Basic mapping policy):

Material type A list of material types for physical resources (such as Art Original, 
Audiobook, Book, DVD, Transparency). Select one from the drop-
down list.

Mapping 
policy

Select Basic to map physical item-level fields from the import 
records into Alma. Note that the Advanced mapping allows you to 
load additional information. For more information on Advanced 
mapping, see the following table.

Library field 
and subfield 
(not required)

If the incoming file of bibliographic records contain your library 
code, you can map it here (for example, if the vendor is sending 
bibliographic records with your library code in the 999x).

If the vendor is using EOD, this field/subfield indicates the library 
for which the material referenced in the EOD and resulting PO 
lines will be ordered. 

Location field 
and subfield 
(not required)

The field/subfield indicating the location in the library for which 
the material referenced in the EOD and resulting PO lines will be 
ordered. 

Default library If you are not using the Library Field to map, or if the data is not 
found in the mapped Library field, this is the default library that 
will be used for either regular or EOD imports. 

If you are using EOD, the default library for which the material 
referenced in the EOD and resulting PO lines will be ordered. Click 
the search icon to select a library from the available list of libraries.

Default 
location

If you are not using the Location Field to map, or if the data is not 
found in the mapped Location field, this is the default location that 
will be used for either regular or EOD imports. 

If you are using EOD, the default location is the library for which 
the material referenced in the EOD and resulting PO lines will be 
ordered. Click the search icon to select a location from the available 
list of locations.

Map library/ 
location

Select the check box if you want to map the library location. 

If you select this check box, you must enter the Location Mapping 
after you save the import profile (see step 3 on page 557).

Number of 
items field and 
subfield

The field/subfield found in the incoming bibliographic record that 
stores the number of items (not required, will use default if not 
entered). 

Default 
number

The default number to assign if the Number of items field is 
empty.
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Barcode field 
and subfield

The field/subfield found in the incoming bibliographic record that 
stores the barcode (not required, will use default if not entered).

Item policy 
field and 
subfield

The field/subfield used by incoming bibliographic records to map 
copies to specific locations.  

NOTE:
Field and subfield must be entered as codes.

Alternative 
Call Number

Add an item level alternative call number. This is useful to keep 
track of a group of items that are placed in a special location, for 
example. This option is available when creating New Order, 
Update Inventory, and Repository profiles. The alternative call 
number type is taken from the call number type defined for the 
location. When running the import profile, this field is updated 
with its default value.

Call Number Mapping section:

Update 
holdings call 
number

Select the check box to enable the update of a holdings record with 
the call number that is part of an imported bibliographic record.

Table 69. Import Profile Details Wizard - Page 6 Physical Fields - Basic Mapping Policy

Field Description

Table 70. Import Profile Details Wizard - Page 6 Physical Fields - Advanced Mapping Policy

Field Description
Physical Item Mapping section (Advanced mapping policy):

Material type A list of material types for physical resources (such as Art Original, 
Audiobook, Book, DVD, Transparency). Select one from the drop-
down list.

Mapping 
policy

Select Advanced if you want to map temporary location 
information, enumeration and chronology subfields, and notes 
subfields as well as the information that the Basic mapping policy 
supports. For more information on the Basic mapping policy, see 
the previous table.

Item 
information 
field

Specify the field from which you want to map item-level 
information from the input records. Unlike the basic mapping 
option, all subfields are taken from a single field in the input 
record.

General Information Subfields subsection:

Barcode The subfield that contains the barcode.

Item policy The subfield that contains the item's policy.
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Default item 
policy

The item policy that is mapped by default if the item's policy is 
empty in the input record.

Permanent Location Subfields subsection:

Library The subfield that contains the library information.

Location The subfield that contains the location information.

Default library The library that is mapped by default if the item's library 
information is empty in the input record.

Default 
location

The location that is mapped by default if the item's location 
information is empty in the input record.

Map library/ 
location

Select the check box if you want to map the library location. 

If you select this check box, you must enter the Location Mapping 
after you save the import profile (see step 3 on page 557).

Alternative call 
number

The subfield that contains the alternative call number.

Alternative call 
number type

The subfield that contains the alternative call number type.

Default 
alternative call 
number type

The alternative call number type that is mapped by default if the 
alternative call number type is empty in the input record.

Temporary Location Subfields subsection:

Temporary 
library

The subfield that contains the temporary library information.

Default 
temporary 
library

The temporary library that is mapped by default if the item's 
library information is empty in the input record.

Temporary 
location

The subfield that contains the temporary location information.

Default 
temporary 
location

The temporary location that is mapped by default if the item's 
location information is empty in the input record.

Map temporary 
library/location

Select this check box if you want to map the library location. 

If you select this check box, you must enter the location mapping in 
the Mapping tab.

Temporary call 
number

The subfield that contains the temporary call number.

Table 70. Import Profile Details Wizard - Page 6 Physical Fields - Advanced Mapping Policy

Field Description
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Temporary call 
number type

The subfield that contains the temporary call number type.

Default 
temporary call 
number type

The temporary call number type that is mapped by default if the 
temporary call number type is empty in the input record.

Temporary 
item policy

The subfield that contains the temporary item policy.

Default 
temporary item 
policy

The temporary item policy that is mapped by default if the item's 
item policy is empty in the input record.

ENUM/CHRON Information Subfields section:

Year of issue The subfield that contains the year of issue.

Enumeration 
A, B, and C

The subfields that contain the enumerations.

Chronology I, J, 
K

The subfields that contain the chronologies.

Description The subfield that contains the description.

Notes Subfields section:

Public note The subfield that contains the public note.

Fulfillment 
note

The subfield that contains the fulfillment note.

Internal note 1, 
2, and 3

The subfields that contain the internal notes.

Statistics note 
1, 2, and 3

The subfields that contain the statistics notes.

Call Number Mapping section:

Update 
holdings call 
number

Select the check box to enable the update of a holdings record with 
the call number that is part of an imported bibliographic record.

Table 70. Import Profile Details Wizard - Page 6 Physical Fields - Advanced Mapping Policy

Field Description
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NOTE:
The format of the file when using the advanced mapping is such that 
every item is represented by the occurrence of a specific field and all of the 
item's attributes are represented by the field's subfields.

The following figures show an example of an import profile definition and a 
sample import profile:

Figure 215: 

Figure 421: Import Profile Details - Advanced Inventory Mapping Example

Figure 216: 

Figure 422: Sample Import Profile

For mixed inventory, the page refreshes with fields for both electronic and 
physical inventory as well as fields specific to mixed materials (see 
Figure 423).
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Figure 423: Import Profile Details Wizard - Page 6 Mixed

c In the Inventory Operations section, enter the values in the Resource 
type (MARC 21 field number) and subfield fields to indicate the field in 
the EOD file to be referenced to determine the material type being 
imported. The specified subfield must reference a field in the EOD file 
that contains one of the following values:

 E – Indicates that the resource being imported is electronic

 P – Indicates that the resource being imported is physical

NOTE:
These field values are case sensitive.

For details on the fields in the E-Book Mapping section, see Table 68.

For details on the fields in the Physical Item Mapping section, see Table 69.

VIDEO:
For information about importing both physical and electroinc records 
using a single import profile, see the Importing Physical and Electronic 
Material in One File video (5:00 mins).

7 When you have finished entering values for the material type, click Next. 
 

http://www.youtube.com/watch?v=2wcILpr6v9M&hd=1
http://www.youtube.com/watch?v=2wcILpr6v9M&hd=1
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(For Repository profile types, the wizard is completed at this step and you 
can click Save, Save Draft, or Cancel.)

Page 7 of the Import Profile Details wizard opens. This page contains PO 
line information and instructions for the profile (see Figure 424). It applies 
only to New Order profile types and Update Inventory profile types. For the 
Update Inventory profile type, it may appear as a page 6 in the wizard 
(because the Set Management Tags step is not needed).

Figure 424: Import Profile Details Wizard - Page 7 - Electronic
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8 Enter the EOD general parameters and mapping information. Use the 
following table for information about the fields: 

Table 71. Import Profile Details Wizard - Page 7 Electronic/Physical Fields

Section Field Description
EOD General 
Parameters

Electronic PO line type  
(required)

Displayed when either Electronic or 
Mixed is selected in the Inventory 
Operations section on page 6 of the 
wizard (see step 6 on page 529). 
Indicates the type of electronic 
material for the PO line. Options are 
predefined by an Administrator and 
may include electronic books, maps, 
journal subscriptions, sound 
recordings, and remote files. For a 
detailed explanation of the PO line 
types and their ramifications for the 
order workflow and inventory, see 
Explanation of Purchase Types 
Workflow and Inventory in the 
Alma Acquisitions Guide.

Physical PO line type  
(required)

Displayed when either Physical or 
Mixed is selected in the Inventory 
Operations section on page 6 of the 
wizard (see step 6  on page 529). 
Indicates the type of physical 
material for the PO line. Options are 
predefined by an Administrator and 
may include microforms, printed 
books or journals, computer disks, 
mixed media, or original 
manuscripts. For a detailed 
explanation of the PO line types and 
their ramifications for the order 
workflow and inventory, see 
Explanation of Purchase Types 
Workflow and Inventory in the 
Alma Acquisitions Guide.
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Multiple vendors Select to configure New Order 
import profiles for multiple 
vendors. This is necessary for cases 
in which an order is fulfilled by a 
third party that sends the order to 
multiple vendors. Configuring New 
Order import profiles for multiple 
vendors allows Alma to read EOD 
files that contain data from multiple 
vendors. When selected, the Map 
vendors check box, Vendor field 
and subfield, and Vendor account 
field and subfield fields appear.

VIDEO:
For more information on 
Multiple Vendors, see the 
Multiple Vendors in EOD 
Import File video (8:56 
mins).

Map vendors Appears when the Multiple 
vendors check box is selected. Select 
to map the vendor name as it 
appears in Alma with the vendor 
name as it appears in the EOD file. If 
you select this check box, you must 
enter the Vendor Mapping after you 
save the import profile (see step 3 on 
page 557).

Vendor field/subfield Appears when the Multiple 
vendors check box is selected. Enter 
the vendor field and subfield 
numbers that indicate where in the 
EOD file the vendor names are 
located.

Vendor account field/
subfield

Appears when the Multiple 
vendors check box is selected. Enter 
the vendor account field and 
subfield numbers that indicate 
where in the EOD file the vendor 
account is located.

Table 71. Import Profile Details Wizard - Page 7 Electronic/Physical Fields

Section Field Description

http://www.youtube.com/watch?v=YqNRe-jL1mo&hd=1
http://www.youtube.com/watch?v=YqNRe-jL1mo&hd=1
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Vendor The vendor to whom the PO is 
eventually sent. Click the Find 
button to select a vendor from the 
displayed list of vendors.

Vendor account The particular vendor account used 
by the Vendor. Click the Find button 
to select a vendor account from the 
displayed list of vendor accounts.

PO line currency The currency for the PO line.

Decimal point location The location of the decimal point in 
the price of the material for the PO 
line. For example, if your vendor 
enters the price as “1000” for $10.00, 
enter 2 decimals. If they enter the 
price as “10.00,” leave the decimal 
location at 0.

Acquisition method The type of acquisition method for 
the PO line. For detailed 
information on acquisition methods, 
see Table 3 in the Alma Acquisitions 
Guide.

EOD Mapping Additional PO Line 
Reference and subfield

Map these fields to the appropriate 
EOD field/subfield as described in 
Working with EOD Field Mapping 
on page 552

NOTE:
The PO Line and Vendor 
reference number fields can 
be used as match points for 
vendor orders containing 
updates to inventory.   

This can be done using the 
Update Inventory profile. For 
more information, see 
Understanding the Update 
Inventory Import Profile on 
page 513.

Figure 217: 

Vendor reference number 
field and subfield

Vendor reference number 
type field and subfield

List price field and 
subfield

Vendor title number field 
and subfield

Volume part number field 
and subfield

PO number field and 
subfield

PO line owner field and 
subfield

Table 71. Import Profile Details Wizard - Page 7 Electronic/Physical Fields

Section Field Description
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EOD Mapping 
(continued)

Default PO line owner The organization unit responsible 
for the PO line. Click the Find 
button to select an organizational 
unit from the displayed list of 
organizational units.

Fund distribution field Map these fields to the appropriate 
EOD field/subfield as described in 
Working with EOD Field Mapping 
on page 552.

Name subfield

Percent subfield

Default fund The fund that will be funding the 
PO. Click the Find button to select a 
fund from the displayed list of 
funds.

Map funds Select the check box if you want to 
map the vendor fund to another 
fund. 

If you select this check box, you 
must enter the Fund Mapping after 
you save the import profile (see step 
2 on page 557.

Reporting code Map these fields to the appropriate 
EOD field/subfield as described in 
Working with EOD Field Mapping 
on page 552.

Interested users

Vendor invoice number

Do not create e-task Select the check box to indicate that 
Newly created PO lines will proceed 
through the duration of the 
workflow without requiring manual 
changing of the PO line status.

Rush request The MARC field/subfield that 
determine that the order should be 
treated as a rush. Valid values for a 
rush order are Y, y, TRUE, 
True, affirmative.

Receiving note The MARC field/subfield that 
contains the text of the receiving 
note for the EOD.

Note to vendor The MARC field/subfield that 
contains the text of a note for the 
vendor. This field maps to the PO 
line Notes tab.

Table 71. Import Profile Details Wizard - Page 7 Electronic/Physical Fields

Section Field Description
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9 Click Save. The new import profile is saved and appears on the Run Import 
page.

Testing OAI Flow for a Remote Digital Repository
If you are using OAI as your File upload method, you may run a test check that 
demonstrates the import profile flow in the following steps:

1 Connect to the OAI base URL.

2 Harvest a single record.

3 Convert a record to a marc21 format record.

4 Generate a digital remote representation resource .

Select test options:

 Test by ID – Enter a full record identifier and harvest this record.

 Test First Record – Harvest the first record in the set.

 Test Random Record – Harvest a random record in the set.

If the flow failed, an error will appear in the Status field.

If the flow passed successfully, it will return:

 Status – indicates that process passed successfully 

 Record Identifier

 Link to remote file (according to the setting defined in the Object Template 
of the Remote Digital Repository set for this profile - see Delivery (Wizard 
Step 3) on page 693)

 Link to thumbnail object (according to setting defined in Thumbnail 
Template set for this profile - see Delivery (Wizard Step 3) on page 693)

 Source record – original record that was harvested

 Marc record – the bibliographic record received after converting to marc21 
format

EOD Mapping 
(continued)

Ordered ISBN/ISSN The ISBN field/subfield that 
contains the identifier for the item 
you are mapping in the EOD.

The identifier that is referenced by 
this field displays on the PO Line 
Summary page (see Figure 12 in 
Manually Creating a PO Line in the 
Alma Acquisitions Guide).

Table 71. Import Profile Details Wizard - Page 7 Electronic/Physical Fields

Section Field Description
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 Inventory structure – an xml structure of generated digital remote 
representation

Match Methods – Explanations and Examples
Match methods are used to determine the circumstances in which an incoming 
record is considered to be a duplicate of an existing record. 

NOTE:
Alma matches serial records with serial records and non-serial records 
with non-serial records.

The following serial match methods are available:

Table 72. Serial Match Methods

Field Description
001 to MMS ID Match 
Method (predefined by Ex 
Libris)

Matches based on the Alma ID. To be used when 
importing a record that was previously exported 
from Alma.

Fuzzy Serial Match Method Uses the following algorithm:

Alma attempts to find records with at least one of 
the following matching IDs: 

 ISSN

 ISBN

 LCCN

 CODEN

 OCLC unique number

 Other system number

If no matches are found through this attempt:

 If the incoming record has authors, Alma 
attempts to find records that have at least one 
matching combination of title + author. 

 If the incoming record does not have authors, 
Alma attempts to find records that have at least 
one matching title.

If no matches are found in either attempt, Alma 
issues a message that no matches have been found.

ISSN 024/035 Match Method Matches based on any one of the following fields: 
022, 024, or 035. If a field contains several values, any 
one of the values is used to match. The 022 and 035 
fields are checked first.
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The following non-serial match methods are available:

024/035 Match Method Matches based on the 024 or 035 fields. If a field 
contains several values, any one of the values is used 
to match. 

ISSN Match Method Matches based on the 022 field only.

LCCN Serial Match Method Matches based on the 010a field only.

035 (Other System Identifier) Matches based on the system control number that 
uses any 035 field. If the 035 field contains several 
values, any one of these values is used to match. 
Note that the values in the input file and the library 
record, including contents in parentheses, must be 
identical (although the contents in parentheses do 
not have to be a recognized OCLC prefix).

Unique OCLC Identifier 
Match Method

This method attempts to locate matching records 
based on a matching OCLC prefix and number. Any 
one of the following prefixes in the 035 field, 
subfields a or z, regardless of any zero-padded data 
is considered to be the same for matching purposes: 
(OCoLC), ocm, ocn, or on. (In other words, the 
OCLC prefix in the library record and in the input 
file do not have to be identical in order for a match to 
be made.)  

Table 72. Serial Match Methods

Field Description

Table 73. Non-Serial Match Methods

Field Description
001 to MMS ID Match 
Method (predefined by Ex 
Libris)

Matches based on the Alma ID. To be used when 
importing a record that was previously exported 
from Alma.
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Fuzzy Non-serial Match 
Method

Uses the following algorithm:

Alma attempts to find records with at least one of 
the following matching IDs: 

 ISSN

 ISBN

 LCCN

 CODEN

 OCLC unique number

 Other system number

If no matches are found through this attempt:

 If the incoming record has authors, Alma 
attempts to find records that have at least one 
matching combination of title + author. 

 If the incoming record does not have authors, 
Alma attempts to find records that have at least 
one matching title.

If no matches are found in either attempt, Alma 
issues a message that no matches have been found.

ISBN 024/035 Match Method Matches based on any one of the following fields: 
020, 024, or 035. If a field contains several values, any 
one of the values is used to match. The 020 and 035 
fields are checked first.

024/035 Match Method Matches based on the 024 or 035 fields. If a field 
contains several values, any one of the values is used 
to match. 

ISBN Match Method Matches based on the 020 field only.

LCCN Match Method Matches based on the 010a field only.

035 (Other System Identifier) Matches based on the system control number that 
uses any 035 field. If the 035 field contains several 
values, any one of these values is used to match. 
Note that the values in the input file and the library 
record, including contents in parentheses, must be 
identical (although the contents in parentheses do 
not have to be a recognized OCLC prefix). For a 
comparison of the way in which this match method 
and the Unique OCLC Identifier Match Method 
work, see 

Table 73. Non-Serial Match Methods

Field Description
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NOTE:
The F numbers (such as F1, F2, F3) are for internal purposes only and 
should be disregarded.

Comparison Between 035 (Other System Identifier and Unique OCLC 
Identifier Match Methods

The following table compares these two match methods.

NOTE:
The text ocm, without parentheses, is an OCLC prefix. The text (ocm), 
with parentheses, is not an OCLC prefix.

Unique OCLC Identifier 
Match Method

This method attempts to locate matching records 
based on a matching OCLC prefix and number. Any 
one of the following prefixes in the 035 field, 
subfields a or z, regardless of any zero-padded data 
is considered to be the same for matching purposes: 
(OCoLC), ocm, ocn, or on. (In other words, the 
OCLC prefix in the library record and in the input 
file do not have to be identical in order for a match to 
be made.)  

Table 73. Non-Serial Match Methods

Field Description

Table 74. Comparison Between 035 (Other System Identifier and Unique OCLC Identifier Match 
Methods

Value in Library 
Record

Value in Input File Unique 
OCLC 
Identifier 
Match 
Method

035 (Other 
System 
Identifier) 
Match 
Method

035 $$a(OCoLC)2014031801 035 $$a2014031801 No match No match

035 $$a(OCoLC)2014031801 035 $$aocm2014031801 Match No match

035 $$a(OCoLC)2014031801 035 $$a(ocm)2014031801 No match No match

035 $$a(OCoLC)2014031801 035 $$a(OCoLC)2014031801 Match Match

035 $$a(apple)2014031801 035 $$a2014031801 No match No match

035 $$a(apple)2014031801 035 $$a(orange)2014031801 No match No match

035 $$a(apple)2014031801 035 $$a(apple)2014031801 No match Match
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Working with EOD Field Mapping
A user with the appropriate role can import EOD files to the Alma repository. 
The records are loaded into the Metadata Management System and the order-
related data is extracted from the record to create PO lines, POs, and inventory 
records. The relevant information for ordering is determined by the MARC 
fields/subfields provided by the vendors’ EOD records. Certain parameters may 
be fixed by the import profile.

Alma supports the configuration of EOD import profiles, which are customized 
according to the fields and codes used in the vendor-supplied EOD file.

The mapping described in the following table is for the generic 949 profile, but 
the set of Target fields in the Alma PO line may be mapped from your own 
source fields.

035 $$a2014031801 035 $$a(OCoLC)2014031801 No match No match

035 $$a2014031801 035 $$a2014031801 No match Match

Table 74. Comparison Between 035 (Other System Identifier and Unique OCLC Identifier Match 
Methods

Value in Library 
Record

Value in Input File Unique 
OCLC 
Identifier 
Match 
Method

035 (Other 
System 
Identifier) 
Match 
Method

Table 75. EOD Field Mapping

Source Field Target Field in PO Line Data Restriction
949‡1 Standard number type Currently ISBN, ISSN, or ISAN

949‡2 Standard number Free text

949‡3 Vendor title number Free text

949‡4 Vendor reference number type Valid type from code table 
vendor reference number type

949‡5 Vendor reference number Free text, optional

949‡a Volume/part number Free text, optional
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949‡b PO line reference For new orders, cannot be the 
same reference as an already 
existing PO line at the same 
organizational unit. For 
Update Inventory, this should 
match the PO line whose shelf-
ready inventory you want to 
update.

949‡c PO number Free text

949‡d Note Free text

949‡e Reporting code Value must be synchronized 
between vendor and institution

949‡f Needed by date Valid date

For example: 2010-09-30

949‡g Interested users Value must be synchronized 
between vendor and institution

949‡h PO line type Valid type taken from the PO 
Line Type table

For example, DVD

949‡i DVD format Free text

949‡j DVD region code Free text

949‡k Vendor invoice number Value must be synchronized 
between vendor and institution

949‡m Vendor account Valid vendor account code

949‡n Binding Free text

949‡o Quantity (repeatable) 
(required)

Number, quantity, and 
locations are repeated in 
couples.

949‡r Rush Yes or No Used to specify when it is a 
rush order. Yes means process 
the order on a rush basis. 

949‡s List price Number with decimal point

For example, 27.90

949‡t Physical shelving location 
(repeatable)

Valid location code

Table 75. EOD Field Mapping

Source Field Target Field in PO Line Data Restriction
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The load logic is based on the following:

 If a 949 field contains a ‡1, it must contain a ‡2, and vice versa.

 If a 949 field contains a ‡4, it must contain a subfield ‡5, and vice versa. 

 If a 949 field contains a sequence of ‡o‡t pairs, none of the pairs may be 
incomplete. If the EOD contains a ‡o, it must be immediately followed by a 
‡t. The only exception is that a ‡o containing a quantity can be alone in the 
record if it is the only ‡o in the field and there is not a ‡t.

 If a 949 field contains a sequence of ‡u‡w pairs, none of the pairs may be 
incomplete. If the EOD contains a ‡u, it must be immediately followed by a 
‡w. The only exception is that a ‡u containing a fund can be alone in the 
record if it is the only ‡u in the field and there is not a ‡w.

 All the quantities in the 949‡o subfields are numeric. 

 The ‡b and ‡c must contain unique values. 

 The ‡t is mandatory at this stage - meaning that in order to create a physical 
item out of the EOD record in the inventory, a physical shelving location 
code must be provided.

Managing Import Profiles
This section explains how to work with import profiles that already exist in the 
system. It covers:

 Editing and Viewing Import Profiles on page 555

 For quick creation of a profile similar to an existing profile, Copying Import 
Profiles on page 558 

 Deleting Import Profiles on page 559

949‡u Fund code Valid fund code

949‡v Vendor Valid vendor code

949‡w Percent Number 

949‡x Ownership 
(required)

Valid organizational unit code

949‡z PO line currency Valid currency ISO code that is 
supported by this 
organizational unit

Table 75. EOD Field Mapping

Source Field Target Field in PO Line Data Restriction
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VIDEO:
See Importing Bibliographic Records and Creating Inventory for a detailed 
training Webex session on importing records (49 mins). Note that you 
must be logged on to the Ex Libris Learning Center to access this session.

Editing and Viewing Import Profiles

PERMISSIONS:
To edit and view import profiles, you must have one of the following 
roles:

 Purchasing Operator

 Purchasing Manager

 Repository Administrator

 Catalog Administrator

 General System Administrator

The Import Profile Details page enables you to edit (see page 555) or view (see 
page 557) import profiles. The tabs on this page correspond to the respective 
steps in the Import Profile wizard (see Configuring New Import Profiles on 
page 512). The procedures in this section describe how to access the Import 
Profile Details page, which contains all of the information you entered in the 
steps of the profile creation wizard. Each step of the wizard has its own tab (see 
Figure 425).

To edit an import profile:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 
scroll to the import profile you want to edit in the list or locate it using the 
Find box at the top of the list, and then select Actions > Edit. 

The Import Profile Details page opens.

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1016
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Figure 218: 

Figure 425: Edit Import Profile Details Page

The Import Profile Details page has up to seven tabs, each corresponding to 
a wizard step described in Configuring New Import Profiles on page 512. 
The following table lists each of these tabs and the corresponding table in 
which the fields in the tab are described.

NOTE:
The Import Profile Details page includes the Mapping tab if you selected 
the Map Library Location or the Fund Distribution Field check boxes in 
wizard steps 6 or 7. This enables you to enter the location and fund 
mapping details. You can find a description of these check boxes in 
Table 69  on page 536 and Table 71 on page 543, respectively.

Table 76. Import Profile Details Tabs

Tab Name Reference to Field 
Descriptions 

Profile Details Import Profile Details Wizard - 
Page 2 Fields on page 518

Normalization and Validation Import Profile Details Wizard - 
Page 3 Fields on page 523

Match Profile Import Profile Details Wizard - 
Page 4 Fields on page 525
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2 Edit the fields as needed, referring to the field description tables listed in 
Table 76.

3 If you selected the Map Library Location (available for physical material 
only) or the Fund Distribution Field check boxes described in Table 69  on 
page 536 and Table 71  on page 543 respectively, add the fund and/or 
location mapping as follows:

a In the Fund Mapping section, enter the Source Value of the fund and 
add the destination fund by clicking the Find button and selecting the 
required value. 

b Click Add to add the line to Fund Mapping.

c In the Location Mapping section, enter the Source Value of the location 
and add the destination location by clicking the Find button and 
selecting the required value.

d Click Add to add the line to Location Mapping.

4 Click Save Draft or Save to save your changes.

To view an import profile:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 

Set Management Tags Import Profile Details Wizard - 
Page 5 Fields on page 528

Inventory Information Import Profile Details Wizard - 
Page 6 Electronic Fields E-Book 
Mapping Section on page 531

PO Line Information Import Profile Details Wizard - 
Page 7 Electronic/Physical Fields 
on page 543

Mapping If you selected the Map Library 
Location (available for physical 
material only) or the Fund 
Distribution Field check boxes in 
wizard steps 5 (physical) and 6 
respectively, you must enter the 
field mapping in this tab. See step 3 
below.

Table 76. Import Profile Details Tabs

Tab Name Reference to Field 
Descriptions 
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scroll to the import profile you want to view on the displayed list or locate it 
using the Find box at the top of the list, and then click Actions > View. 

The Import Profile Details page opens.
Figure 219: 

Figure 426: View Import Profile Details Page

The Import Profile Details page has up to seven tabs, each corresponding to 
a wizard step described in Configuring New Import Profiles on page 512. 
Table 76 on page 556 lists each of these tabs and the corresponding table in 
which the fields in the tab are described.

2 Click any of the tabs to view its contents.

3 Click Back to return to the Run Import page.

Copying Import Profiles

PERMISSIONS:
To copy and edit import profiles, you must have one of the following 
roles:

 Purchasing Operator

 Purchasing Manager

 Repository Administrator

 Catalog Administrator

 General System Administrator
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When creating a new import profile, you might save time and effort by copying 
an existing similar profile and modifying it (see Editing and Viewing Import 
Profiles on page 555). 

To copy an import profile:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 
scroll to the profile you want to copy and select Actions > Copy.

The Import Profile Details page opens (Copy of an Import Profile on 
page 559). Fields are populated with the values of the import profile you 
copied.

Figure 220: 

Figure 427: Copy of an Import Profile

2 In the Profile Name field, change the name.

3 Edit any information on the tabbed pages as described in Editing and 
Viewing Import Profiles on page 555.

4 Click Save or Save Draft to save the new profile and return to the Run 
Import page.

Deleting Import Profiles

PERMISSIONS:
To delete import profiles, you must have one of the following roles:

 Repository Administrator
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 Catalog Administrator

 General System Administrator

You can delete import profiles that are no longer required.

To do so, on the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 
scroll to the profile you want to delete and select Actions > Delete. When the 
Delete Confirmation Message dialog box opens, click Confirm. The import 
profile is deleted from the Run Import page and from the system.

NOTES:
 Only inactive import profiles can be deleted.

 Once you use an import profile, it cannot be deleted because its job 
history remains (and cannot be deleted).

Defining Import Profiles for Multiple Item 
Creation

You can create multiple items in multiple libraries and locations using an import 
profile that defines how Alma should handle files that contain information on 
multiple items, libraries, and locations. 

You can create multiple items in multiple libraries and locations using either 
one of the following types of input files, with corresponding import profiles:

 Option 1 – All subfields are part of a single data field, such as 949, which 
includes library and location information, and well as item information, 
such as barcode and item policy.

 Option 2 – Library and location subfields are part of one data field, such as 
949, and item subfields are part of another data field, such as 948.

NOTE:
If library and location fields are mapped to more than one field (for 
example, the number of items is mapped to 950 and the location is 
mapped to 949), or item fields are mapped to more than one field (for 
example, the barcode is mapped to 949 and the item policy is mapped to 
950), the import process cannot create multiple items.

Examples of Option 1
The following three examples delineate three different scenarios in which all 
library, location, and item subfields are part of a single data field.
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The import profile is defined as follows for all three examples:
Figure 221: 

Figure 428: Import Profile – All Data Subfields Mapped to the Same Field

Example 1: Each Data Field Tag Contains Data for a Single Item

The input file is as follows:

In this case, three items are created, each receiving its corresponding barcode 
and policy. The first item is created for the default library and location.

Figure 222: 

Figure 429: Items Created Upon Import – Example 1

Example 2: Locations and Related Items Are in the Same Data Field Tag

The input file is as follows:

In this case, the following is created:

 Three items with barcodes 1, 2, 3, and policy 1 are created at the TML/
Unassigned library/location.

 Three items with barcodes 4, 5, 6, and policy 2 are created at the default 
library and location.

=949 $bBARCODE-1$pPOLICY-1
=949 \\$mTML$tUNASSIGNED$bBARCODE-2$pPOLICY-2
=949 \\$mMAIN$tMUSIC$bBARCODE-3$pPOLICY-3

=949 \\$mTML$tUNASSIGNED$bBARCODE-1$bBARCODE-2$bBARCODE-
3$pPOLICY-1
=949 \\$bBARCODE-4$bBARCODE-5$bBARCODE-6$pPOLICY-2
=949 \\$bBARCODE-7$bBARCODE-8$pPOLICY-7
=949 \\$mONL$tONL ABC$o3$bBARCODE-9$bBARCODE-10
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 Two items with barcodes 7 and 8, and policy 7 are created at the default 
library and location.

 Three items are created at the ONL/ONL ABC library/location. Two items 
are created with barcodes 9 and 10, and one item is created with an 
automatically generated barcode.

Figure 430: Items Created Upon Import – Example 2

Example 3: No Barcodes Are Stipulated

The input file is as follows:

In this case, the following is created:

 Five items are created at the TML/Unassigned library/location.

 Four items are created at the ONL/ONL ABC library/location. (Since the 
number of items is not specified, the default number is used.)

 Three items are created at the default library and location.

=949 \\$mTML$tUNASSIGNED$o5
=949 \\$mONL$tONL ABC
=949 \\$o3
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Figure 431: Figure 64 – Items Created Upon Import – Example 3

Example of Option 2
The following example delineates a scenario in which library and location 
subfields are part of one data field, and item subfields are part of another data 
field.

The import profile is defined as follows:

Figure 432: Import Profile – Library/Location and Item Subfields Mapped to Different Fields

The input file could be as follows, with a list of libraries/locations followed by a 
list of barcodes:

=949  \\$mULINC$tMUSIC$o3
=949  \\$mONL$tONL ABC
=949  \\$mTML$tUNASSIGNED$o3
=948  $bBARCODE-1$pPOLICY-1
=948  $bBARCODE-2 =948  $bBARCODE-3 =948  $bBARCODE-4 =948  
$bBARCODE-5 =948  $bBARCODE-6 =948  $bBARCODE-7 =948  
$bBARCODE-8
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Alternatively, the input file could be as follows, with a combined list of libraries/
locations and barcodes:

After importing either one of the above input files, the following is created:

 Three items with barcodes 1, 2, 3 are created at the ULINC (Main Library)/
Music library/location.

 Four items with barcodes 4, 5, 6, 7 are created at the ONL/ONL ABC library/
location. (Since the number of items is not specified, the default number is 
used.)

 Three items are created at the TML/Unassigned library/location. One item is 
created with barcode 8, and two items are created with automatically 
generated barcodes.

Figure 433: Items Created Upon Import – Search Results and List

=949  \\$mULINC$tMUSIC$o3
=948  $bBARCODE-1$pPOLICY-1 =948  $bBARCODE-2 =948  
$bBARCODE-3
=949  \\$mONL$tONL ABC
=948  $bBARCODE-4 =948  $bBARCODE-5 =948  $bBARCODE-6 =948  
$bBARCODE-7
=949  \\$mTML$tUNASSIGNED$o3
=948  $bBARCODE-8
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 Running a New Import Job

PERMISSIONS:
To run an import process, you must have one of the following roles:

 Purchasing Operator

 Purchasing Manager

 Catalog Manager

 Catalog Administrator

You can import a new file (bibliographic, authority, or EOD) using a profile 
from the Run Import page. The workflow is the same whether you run the 
process from the Resource Management area or from Acquisitions (Figure 434):

Figure 223: 

Figure 434: Import Workflow Overview

When the job has been run, you can find it on the Monitor Imports page. (For 
details, see  on page 570, and for Acquisitions see Monitoring Imports on 
page 209.)

To resolve issues that arose during the job, see Resolving Import Issues on 
page 582.
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In addition to performing a batch import for multiple bibliographic records, you 
can import a single bibliographic record to synchronize bibliographic records 
with external catalogs. For more information on the single bibliographic record 
import, To import a single bibliographic record: on page 570.

VIDEO:
See Importing Bibliographic Records and Creating Inventory for a detailed 
training Webex session on importing records (49 mins). Note that you 
must be logged on to the Ex Libris Learning Center to access this session.

NOTES:
Before beginning the import job, check the following:

 If none of the existing profiles is suitable for your bibliographic, 
authority, or EOD file, create a new profile (see Configuring New Import 
Profiles on page 512) or copy an existing profile and modify it (see 
Managing Import Profiles on page 554).

 Ensure that you have the correct Submission Format option selected (see 
Import Profile Details Wizard - Page 2 Fields on page 518), and that 
your bibliographic, authority, or EOD import file is located in the correct 
place for this option. For example, if you select the Upload File option, 
your import file must be located on your computer. If you select Server 
Directory, the import file must be located on a server on your network.

To import a file with multiple records:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 
scroll to the import profile you want to use for the import or locate it using 
the Find box at the top of the list, and click Actions > Run Import.

NOTE:
If you do not have administrative privileges, you can also access the Run 
Import page from the Alma menu as follows: Resource Management > 
Import > Start New Import, then click Actions > Run Import. For 
Acquisitions users, see Creating Purchase Order (PO) Lines in the Alma 
Acquisitions Guide.

The Start New Import page opens.

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1016
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Figure 224: 

Figure 435: Start New Import Page

2 If you have Upload File/s selected as the File Upload Method in the Import 
Profile, use the browse feature of the File field to locate the bibliographic, 
authority, or EOD file you want to import. Select the file from the Windows 
File Upload box.

The selected file appears in the File field.

NOTES:
 For the files that you select to import in this manner, it is suggested that 

you limit your file size to a maximum of 10MB. For files imported using 
the FTP File Upload Method, this limitation does not apply (refer to the 
procedure To create the import profile: on page 518 for more 
information regarding the FTP option).

 The import process accepts ZIP files, MRC files, or XML files, but not 
tar.gz files.

3 To use a label for the file to help identify the contents, enter a label in the 
Label field.

4 Enter any notes for the import in the Notes field.

5 Click Add. 

The page reloads with the selected file listed in the Files List section at the 
bottom of the page (Figure 436).
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Figure 225: 

Figure 436: Start New Import - File Added

General information about the file (including a label, if you included one, 
the source of the file, and the size of the file) appears in this section. In 
addition, an Actions button provides options for editing the Notes field of 
the entry or deleting the entire entry. There is also a Submit button at the 
top and bottom of the Start New Import page.

6 Add any additional import files by repeating step 2 through step 5.

7 Click Submit. The Monitor and View Imports page opens, showing a 
message indicating the import job status. For details on monitoring import 
jobs, refer to Monitoring Imports on page 209 in the Alma Acquisitions 
Guide.
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Figure 226: 

Figure 437: Monitor and View Imports Page - EOD File Loaded Successfully

8 Click Refresh to update the page details.

If the import finished, the status changes, as shown in the Status change 
from Figure 437 to Figure 438.

NOTE:
Additional Status classifications are Pending, In Process, and Completed 
Successfully.
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Figure 227: 

Figure 438: Monitor and View Imports Page - EOD File Import Status Refreshed

 To view reports on the status of successful imports, click the Actions 
button and select one of the four types of information.

 If you receive a status of Manual Handling Required, click the Manual 
Handling Required text link to access the page where you can resolve 
issues with the file.

 Click Back to return to the Alma home page.

To import a single bibliographic record:

1 Configure a Repository import profile. 

2 In the Other Settings Configuration table (Resource Management > 
Resource Configuration > Configuration Menu > General > Other 
Settings) click Customize for the upload_single_record_from_file 
parameter key.

3 In the Parameter field, enter the name of the import profile that you want to 
use when importing a single bibliographic file.

4 Select Resource Management > Import > Upload single record from file. 
The following is displayed:
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Figure 439: Start New Import

5 Select the file with the bibliographic record that you want to import.

6 Click Submit and Edit to open the imported record in the MD Editor. For 
example:

Figure 440: Submit and Edit

7 Click Edit to display the record in the repository. For example:
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Figure 441: Submit

Viewing an Import Profile Job History

PERMISSIONS:
To view an import profile job history and related reports, you must have 
one of the following roles:

 Purchasing Operator

 Purchasing Manager

 Catalog Manager

 Catalog Administrator

The Job History page lists a history of the EOD jobs that have been processed 
with the profile whose history you are viewing. In some cases, you can use the 
Job History page as a starting point for identifying problems with files and 
records and resolving them.

The Job History page provides basic report information about each job: status, 
start and stop time, and files processed and rejected.

VIDEO:
See Importing Bibliographic Records and Creating Inventory for a detailed 
training Webex session on importing records (49 mins). Note that you 
must be logged on to the Ex Libris Learning Center to access this session.

To view an import profile job history:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import > Import Profiles), 
scroll to the job whose history you want to view or locate it using the Find 
box at the top of the list, and then click Actions > Job History. 

The Job History page opens (Figure 442).

http://learn.exlibrisgroup.com/mod/resource/view.php?id=1016
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Figure 228: 

Figure 442: Job History Page

The Job History page for the job you selected lists general information for each 
instance of the job having been run: ID, status, user, time started and ended. It 
also shows a green status bar with the percent of the job complete and a button 
with an ellipsis (...) beside it. To view counts of files processed, click the ellipsis 
button and the information opens in a pop-up box.

2 To view specific import job details, click the Actions button of the job’s row 
and select:

 View file details to view the file details for the selected import job (see 
Viewing File Details on page 574)

 Events to view the events report for the selected import job (see 
Viewing Events on page 576)
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 Imported records to view the imported records for the selected import 
job (see Viewing Imported Records on page 577)

 Imported PO Lines to view the PO lines associated with the selected 
import job (see Viewing PO Lines Associated With an Import Job on 
page 577)

 Report to view a report for the selected import job (see Viewing a Job 
Report on page 579)

To download a spreadsheet of all the import jobs on the Job History page, 
click the Tools button, then select Excel, and follow the Windows prompts.

3 Click Back to return to the Run Import page.

Viewing File Details
The Import Job Details page (Figure 443) opens when you click the Actions > 
View file details option from the Job History page. This page lists basic 
imported EOD file information such as Label, Size, Number of Records, and 
Problem.

If there is an option for downloading a file (for editing or otherwise), the 
Actions button is available in the file’s row. 

NOTE:
You can download records that were not imported due to matching errors 
(see Resolving Matching Issues on page 583).

To view file details and/or download unimported records:

1 On the Job History page, click Actions > View File Details. The Import Job 
Details page opens.

Figure 443: Import Job Details Page
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2 To download a specific file, click the Actions button and select Download 
unimported records.

The Opening Failed Records dialog box opens.

Figure 444: Opening Failed Records Dialog Box

Open the file that is created or save it in the default downloads folder on 
your local computer.

3 Click OK. 

The file is opened or downloaded to your local drive. 

See the following for a partial example of a file that contains an unimported 
record.

NOTE:
Use your PDF or browser zoom function to better view the example.
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4 Edit the file to correct the invalid records and then re-import the file, as 
described in Running a New Import Job on page 565. 

Viewing Events
You can view the events that were generated while the EOD file was being 
imported using a specific profile.

To do so, on the Job History page, click Actions > Events.
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Figure 445: Events Report Page

The Events Report page displays events such as a job starting and stopping. 
The page lists dates, type or severity of events, and which part of the system 
an event occurred in.

To return to the Job History page, click the Back link.

Viewing Imported Records
You can view the records that were imported using the profile from which you 
viewed the job history.

The imported records are viewed on the Repository Search page (see Using the 
Alma Repository Search on page 18). From the Job History page, you can view 
them by clicking Actions > Imported Records. Use the Back link to return to the 
Job History page.

Viewing PO Lines Associated With an Import Job
You can view the PO lines associated with an import job and create a set of PO 
lines upon importing an EOD. You create a PO line set to perform global 
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updates on the imported PO lines, such as changing status, updating PO line 
information, and so forth.

PO Lines can be changed globally via the relevant PO line process (see 
Configuring Processes on page 700).

To create a PO line set from an imported EOD:

1 On the Job History page (Acquisitions > Acquisitions 
Configuration > Configuration Menu > Purchase Orders > Import 
Profiles, filter the results by New Order profiles and select Actions > Job 
History for an entry), select Actions > Imported PO Lines. The Search for 
PO Line page opens and displays the PO lines associated with the job.

Figure 229: 

Figure 446: Search for PO Line Page

2 Click Save. The Set Details page opens.
Figure 230: 

Figure 447: Set Details Page
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3 In the Set name field, enter a name for the set.

4 Modify any other parameters, as necessary.

5 Click Save.

Viewing a Job Report
The Job Report page provides summary information for an import job listed on 
the Job History page. When you select Actions > Report in the row of an import 
job, the Job Report page displays counts for such items as

 records processed, imported, and deleted

 PO lines processed and imported

 physical items and electronic portfolios processed and imported

The report includes information organized into collapsible headings.
Figure 231: 

Figure 448: New Job Report Format and Content

In addition, you can view bibliographic records related to a result, create an 
itemized set for one row of results, or download sources as XML or binary files.
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To preview records, create a set from the results, or download the results as 
XML or binary files, find the row containing the records you want to work on 
and click the Actions button. (Then see the procedures below.)

To preview the records from a row of the results:

1 Select Actions > Preview records for the row containing the information you 
want to preview.

Alma returns a list of bibliographic records to which the row refers. (See 
figure below.)

Figure 232: 

Figure 449: Actions > Preview Merged Records on Repository Search Page

2 From the Repository Search page, perform any actions available to the item 
and to your role.
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To create a set of records from an import job report:

1 From the new report, find the line containing the items you want to include 
in the set. (For example, merged records in Figure 449.)

2 Select Actions > Create itemized title set.

The Set Details page opens. The default name for the set appends the date 
and time to the name of the job (see figure below).

Figure 233: 

Figure 450: Create Itemized Title Set From Report

3 Complete the fields as you would for any itemized set (see Adding Itemized 
Sets on page 84), then click the Submit button.
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4 Click through the confirmation box for the new set.

The confirmation box closes and Alma returns you to the Report page, 
where a message informs you that the job was submitted. The set is created 
in Alma and can be used immediately.

To download an XML or binary file:

From the report page, select Actions > Download sources (XML) or 
Actions > Download sources (binary) for the row containing the source file 
you want to view and/or edit. The source downloads as a compressed file. 
To view or edit, unzip the file and open it in an XML or plain text editor or 
the program you use to work with binary files.

Resolving Import Issues

PERMISSIONS:
To resolve issues related to an import job, you must have one of the 
following roles:

 Purchasing Operator

 Purchasing Manager

 Catalog Manager

 Catalog Administrator

The following types of import issues can arise during the import process:

 Matching – Indicates that the imported record matches an already existing 
record in the database. When this occurs, the issue is resolved according to 
the match profile configured during import profile creation (see Import 
Profile Details Wizard - Page 4 Fields on page 525).

For details on resolving matching records, see Resolving Matching Issues 
on page 583.

 Validation – During the import process, the imported records are checked 
according to the validation task chain selected during import profile 
creation (see Import Profile Details Wizard - Page 3 Fields on page 523). If 
the check determines that an issue exists as an Error and not as a Warning, 
the file is sent to the Validation subpage of the Resolve Import Issues page. 
Whether the issue is an Error or a Warning is determined according to the 
severity profile chosen during profile creation. For information on 
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configuring validation exception (severity) profiles, see Working with 
Validation Exception Profiles on page 652.

It is not possible to fix records that cannot be validated. You can either force 
the import of the record or discard it. You also can force the import of the 
entire file or abort the import.

For details on resolving validation issues, see Resolving Validation Issues 
on page 589.

 Errors – Indicates that something unexpected has happened which cannot 
be resolved. These errors include any problems with file data not related to 
matching or validation of records. The Errors subpage of the Resolve Import 
Issues page displays only the files with these issues.

For details on viewing error records, see Viewing Import Errors on 
page 595.

Resolving Matching Issues
A matching discrepancy occurs when the imported record matches an already 
existing record in the database. When this occurs, the issue is resolved according 
to the Match profile handling method configured when the import profile was 
created (see Import Profile Details Wizard - Page 4 Fields on page 525). The 
following handling options are available on the Import Profile Details page:

 Manual – The file is sent to the Matching subpage of the Resolve Import 
Issues page, where you resolve the problem by selecting the Job ID link, 
viewing the record, and choosing to import, merge, or overlay the record. 
For details, see Editing Matching Records on page 587.

 Automatic – The matching record is processed automatically, according to 
the Match Action options chosen when defining the import profile (see the 
Import Profile Details Wizard - Page 4 Fields on page 525).

If either Merge or Overlay was defined and there are multiple record 
matches, the process reverts to manual operation where you manually 
choose which matching record to merge/overlay.

To resolve matching issues:

1 On the Resolve Import Issues page (Acquisitions > Import > Resolve 
Import Issues or Resource Management > Import > Resolve Import 
Issues), select Matching from the left margin and scroll to the import job 
you want to view, or locate it using the Find box.

NOTE:
You can also access the Resolve Import Issues page by clicking the 
Manual Handling Required link in the Status column on the Monitor and 
View Imports page.
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Figure 451: Resolve Import Issues Page – Matching Errors

2 Click the Actions button for the relevant job and select:

 View records (Viewing Matching Import File Records on page 585)

 Edit (Editing Matching Records on page 587)

 Release assignment (Releasing Assignments on page 589)

 Do Not Import –  Discards the records with matching errors, while 
importing the valid records in the file.

 Reject File – Discards the file containing records with matching errors. 
The file is removed from the Handle Import Validation Errors page.

NOTES:
 The Actions options that are displayed depend on the user’s role.

 If the import file is unassigned, the Release assignment option is not 
displayed.

3 To perform multiple Do Not Import and Reject File actions on imported file 
records, select the issues on which you want to perform the Do Not Import 
and Reject File actions, and click the Reject Records or Reject Entire File 
buttons.
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Viewing Matching Import File Records
You can view the records within the import file that match existing Alma 
records. You can then determine whether you want to import these matching 
records.

On the Handle Matching page, you can filter the list of results by handling type 
using the Filter drop-down list. Choose from the following options:

 Manual – Indicates that manual handling for matches was configured 
during import profile configuration (see Configuring New Import Profiles 
on page 512)

 Multiple Matches Delete – Indicates that the delete failed due to matching 
records

 Multiple Matches EOD – Indicates that the EOD import failed due to 
matching records

 Multiple Matches Merge – Indicates that the merge failed due to matching 
records

 Multiple Matches Overlay – Indicates that the overlay failed due to 
matching records

The matching import profile records are displayed on the Handle Matching 
page (choose Import > Resolve Import Issues from the Acquisitions or 
Resource Management menu, select Matching from the left margin and 
Actions > View records or click the job ID link for the relevant import job).

The Handle Matching page displays the following columns in the Imported 
Records to Handle section:

 Row number

 Record ID

 Author

 Short Title

 Publisher

 Date

 Handling Type – Indicates the handling option for matches selected during 
import profile configuration (see Import Profile Details Wizard - Page 4 
Fields on page 525). The possible values are indicated in the Filter options 
described above.

 Action / View Matches

To view matching records:

On the Handle Matching page (select Actions > View records or click the job ID 
link for the relevant import job on the Resolve Import Issues page), click the 
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record ID link or View Matches for the record whose matches you want to 
handle.

 If there is only one record that matches, the Side-By-Side Matching page 
opens:

Figure 452: Side By Side Matching Page

The Side-By-Side Matching page displays the Imported Record Details on 
the left side of the page and the Matched Record on the right side of the 
page.

 If there is more than one record that matches, the Import Record Matches 
page opens.

Figure 453: Import Record Matches Page

The Import Record Matches page displays the Imported Record Details (on 
the left side of the page) and the Matched Records in your catalog (on the 
right side of the page).

In the Matched Records List section, select the record that you want to 
match with the new record.

To preview how the record would look following an import, select a record in 
the Matched Record List and click Merge Preview.
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Figure 454: Merged Preview Page

Editing Matching Records
You use the Edit option to view the record details and errors, and perform an 
import of the record as needed.

To edit matching records:

1 On the Handle Matching page (select Actions > Edit or click the job ID link 
for the relevant import file on the Resolve Import Issues page), click the 
record ID link or View Matches for the relevant import file.

 If there is only one record that matches, the Side-By-Side Matching page 
opens:

Figure 455: Side By Side Matching Page

The Side-By-Side Matching page displays the Imported Record Details 
on the left side of the page and the Matched Record on the right side of 
the page.

 If there is more than one record that matches, the Import Record 
Matches page opens.
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Figure 456: Import Record Matches Page

In the Matched Records List section, select the record that you want to 
match with the new record.

2 Click Merge Preview to view the matched record in a merged view.

Figure 457: Merged Preview Page

Click Back to return to the Side-By-Side Matching page or Import Record 
Matches page.

NOTE:
You can click Approve Import on the Handle Matching page to approve 
the import without viewing the records. The record is imported, but it 
may be a duplicate of an existing record. For information on monitoring 
imports, see Monitoring Imports on page 209.

3 Select an option from the drop-down list for the record and click Execute. 
The available options are: 

 Import – The record is imported, but may be a duplicate of an existing 
record

 Do Not Import – The new record is discarded

 Merge – Merges the records according to the options chosen in the 
profile configuration. For details on configuring import profiles, see 
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Configuring New Import Profiles on page 512. Note that if this option 
cannot be performed, as in the case of importing records marked for 
deletion, it is unavailable. 

 Overlay – Keeps the old record only, but changes its internal data 
according to the new record

NOTE:
The Overlay option enables the history of all the linking already 
performed for this record to be kept.

If the record is imported, details of the import can be viewed on the Monitor 
and View Imports page.

Releasing Assignments
Import jobs are initially assigned to the user who creates and runs the job. The 
Assigned To column on the Resolve Import Issues page lists the user assigned to 
each job. If no user is assigned to a particular job, the column is empty for the job 
and the Release assignment option under Actions is not displayed.

Assigning a job to a user avoids duplicate work on the same job. Only the user 
to whom the job is assigned can work on it. Therefore, if you are unable to work 
on a job assigned to you; and you want to release the job so that other users can 
work on it, you must select Actions > Release Assignment for that job (relevant 
import file) on the Resolve Import Issues page. The import job is unassigned, 
and a dash (–) displays in the Assigned To column for the selected job. Any user 
can work on an unassigned job, and Alma then automatically assigns it to that 
user.

Resolving Validation Issues
Imported records are validated according to the validation task chain defined in 
the import profile (see Configuring New Import Profiles on page 512).

For jobs/records with validation issues, you can:

 Force the import

 Choose not to import

 Reject the file

 Create an XML file of the failed records

To resolve validation issues:

1 On the Resolve Import Issues page (Acquisitions > Import > Resolve 
Import Issues or Resource Management > Import > Resolve Import 
Issues), select Validation from the left margin. The Resolve Import 
Validation Errors page opens.
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NOTE:
You can also access the Resolve Import Validation Errors page by clicking 
the Manual Handling Required link in the Status column on the Monitor 
and View Imports page.

Figure 234: 

Figure 458: Resolve Import Validation Errors Page

2 Locate the import job with which you want to work using Find or one of the 
following primary filters and selecting All or Assigned to Me from the 
secondary filter:

 Authority

 Initial Authority

 Remote Digital

 Repository

3 Select one of the following row actions (using the Actions button) or check 
box actions (for one or multiple rows):

 Row action options:

 View records (Viewing Import File Records With Validation Errors 
on page 591)

 Edit (Editing Records With Validation Errors on page 594)

 Release assignment (Releasing Assignments on page 589)



Chapter 6: Managing Profiles for Record Imports

591January 2015

Alma Resource Management

Ex Libris Confidential

NOTE:
The Release Assignment option is only available as a row action for 
import files/jobs that have an assigned user ID displayed in the Assigned 
To column.

 Do Not Import –  Discards the records with validation errors, while 
importing the valid records in the file.

 Reject File – Discards the file containing records with validation 
errors. The file is removed from the Handle Import Validation Errors 
page.

NOTE:
The Actions button is only available for import jobs assigned to you or 
unassigned import jobs. The View button displays for import jobs 
assigned to another user ID.

 Check box action options (to perform multiple Do Not Import and 
Reject File actions):

 Reject Records button

 Reject Entire File button

Viewing Import File Records With Validation Errors
You can view the records within the import file that match existing Alma 
records. You can then determine how you want to handle the records with 
validation errors.
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To view validation errors:

1 On the Resolve Import Validation Errors page, select Actions > View 
records for the relevant import file. The Handle Import Validation Errors 
page opens.

Figure 235: 

Figure 459: Handle Import Validation Errors Page

The Handle Import Validation Errors page includes the following sections:

 Job Details – Provides details of the import job file.

 Error List – Displays the following columns:

 Error Message – Describes the error that caused the validation to fail.

 Number of Records – The number of records that have an error.

 Records List – Describes the record details in the following columns:

 Record ID

 Author

 Short Title
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 Publisher

 Date

 Number of Errors

2 Click View Errors. The Imported Record Details page opens.
Figure 236: 

Figure 460: Imported Record Details Page

The left side of this page displays the record details in the following formats:

 Original record format

 MARC record format

Select the appropriate tab to display the view you prefer to see.

The right side of the page displays the error information. The Error List 
section on this page displays the same error information as displayed in the 
Error List section on the Handle Import Validation Errors page.

3 Using the Tools button, you can export the following information to an 
Excel file or click Back to return to the Handle Import Validation Errors 
page:

 Original record content

 MARC record content
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 Error List section content

The content that is generated for export to Excel is determined by which 
Tools button you click (on the left side of the display or the right side of the 
display) and, for the left side of the display, which tab is open.

With the exported record content, you can make corrections and, 
subsequently, use the corrected content to import to Alma.

Editing Records With Validation Errors
The Edit option enables you to view the record details and validation errors and 
provides several options for managing the records/files with these errors.

To edit a record:

1 On the Resolve Import Validation Errors page, select Actions > Edit or click 
the link in the Job ID column for the relevant import file. The Handle 
Import Validation Errors page opens.

Figure 461: Handle Import Validation Errors Page

2 Choose one of the following page or row actions:

 Page actions:

 Do Not Import – Discards the records with validation errors while 
importing the valid records in the file.

 Force Import – Imports all the records including those with errors.

 Reject File – Discards the file containing records with validation 
errors. The file is removed from the Handle Import Validation Errors 
page.

 Create File – Enables saving the record details to an external XML 
file in which you can edit the records. You can then re-import the file.

 Row action:
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 View Errors – Refer to step 2 and step 3 in the procedure To view 
validation errors: on page 592 for a description of the Imported 
Record Details page that displays.

Viewing Import Errors
The Resolve Import Errors page lists the import jobs with unexpected errors that  
occurred during the import process. These errors include any problems with file 
data not related to matching or the validation of records. Refer to the Monitor 
and View Imports page and Monitoring Imports on page 209 in the Alma 
Acquisitions Guide for more details.

To view import errors:

1 On the Resolve Import Issues page (Acquisitions > Import > Resolve 
Import Issues or Resource Management > Import > Resolve Import 
Issues), click Errors. The Resolve Import Errors page opens.

Figure 462: Resolve Import Errors Page

2 Click Download to download an XML or a binary file (depending on the 
format defined in the import profile) listing the records that did not import 
properly. For example:
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Figure 237: 

Figure 463: Error(s) in downloaded XML

3 Correct any errors you detect and run the import process again.

Job History Information and Solutions
In order to gather more detailed information about errors and how to correct 
them, you can view jobs and their errors through the Configuration Menu of the 
Acquisitions or Resource Management menu on Alma.

To handle errors and issues after running an import:

1 From the Run Import page (Acquisitions > Acquisitions Configuration > 
Configuration Menu > Purchase Orders section > Import Profiles or 
Resource Management > Resource Configuration > Configuration Menu > 
Record Import section > Import Profiles), find the job whose import 
performance you want to view. (Use the filter or Find search tool at the top 
of the page to help you find the job.)

2 Select Actions > Job History in the row of the job with which you want to 
view more detailed information. The Job History page for the selected 
profile opens.
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Figure 238: 

Figure 464: Job History Page

The Job History page lists the following information for each job that was run 
for the profile:

 Job ID

 Status

 User

 Time started

 Time ended

 Files processed (percentage complete)

The Actions button provides the following options for managing the jobs based 
on the job’s status:

 Report

 View file details

 Events

 Imported records

 Imported PO lines

For information on addressing problems related to import jobs, see  on page 570 
and Resolving Import Issues on page 582.
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Advanced Tools

Overlap Analysis

PERMISSIONS:
To work with overlap analysis, you must have one of the following roles:

 Purchasing Operator

 Purchasing Manager

 Repository Manager

 Electronic Inventory Operator

Alma provides the capability to perform overlap analysis for electronic 
resources. When making acquisitions decisions, this facility enables you to 
compare the content of electronic collections in order to determine where there 
may be a subscription overlap. Alma provides the following types of 
comparisons:

 Set Comparison (refer to the procedure To perform overlap analysis for a 
set: on page 600 for more information)

 Selected Titles (refer to the procedure To complete an overlap analysis for 
selected titles: on page 606 for more information)

VIDEO:
For more information about Overlap Analysis, refer to the Electronic 
Collection Overlap Analysis video (7:46 mins.). 

This section includes:

 Overlap Analysis on page 599

http://www.youtube.com/watch?v=pXXTHk98E1M&hd=1
http://www.youtube.com/watch?v=pXXTHk98E1M&hd=1
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To perform overlap analysis for a set:

1 Open the Overlap Analysis page (Resource Management > Advanced Tools 
> Overlap Analysis).

2 Click Submit New Report. The system defaults to the Set Comparison type 
of report.

3 Click Next. The Compare Electronic Collections page opens.

4 Click Definition of Source Set and complete the usual repository steps to 
identify your source set of records.

5 Select the Select All option or select individual records from the repository 
search results to identify the records in your source set and click Add 
Selected.

6 Click Done when you have completed identifying the records for your 
source set. The system displays your source set on the Compare Electronic 
Collections page. 

Figure 239: 

Figure 465: Source Set Defined

7 Click Definition of Target Set and complete the usual repository steps to 
identify your target set of records

8 Select the Select All option or select individual records from the repository 
search results to identify the records in your target set and click Add 
Selected.

9 Click Done when you have completed identifying the records for your 
target set. The system displays your target set on the Compare Electronic 
Collections page. 

You may repeat the Definition of Target Set steps again to define an 
additional target set for comparison.
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10 When you have completed defining your source and target sets, click Next. 
The Compare Electronic Collections page refreshes to display the following: 

Figure 240: 

Figure 466: Compare Electronic Collections Parameters

11 Enter the following to match your requirements:

 Report name

 Report description

 Match method (ISSN, ISBN, Title, LCCN, or 035)

 Use date coverage information in the comparison (select the check box if 
you want to use this information)

When you select this option, the following parameter becomes an active 
option.

 Reference year for calculating the embargo (make a selection from the 
drop-down list: Current Year, Current +1, Current +2, and so forth)

12 When you are finished setting the parameters, click Submit. The system 
displays a message confirming that your Overlap Analysis job has been 
successfully submitted.
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Figure 241: 

Figure 467: Successfully Submitted Overlap Analysis Job

13 Use Monitor Jobs (Administration > Manage Jobs) to track the progress of 
your Overlap Analysis report.

14 When your job has completed processing, select the History tab on the 
Monitor Jobs page and select Actions > Report to view your results. Use the 
Repository filter to more quickly locate your report. The report provides the 
following information:

 Process ID

 Name (of the job)

 Started on/Finished on dates and time

 Total run time 

 Created by (user ID)

 Status

 Status date

 Records processed (total number)

 Records with exceptions (number)

 Links to the reports created



Chapter 7: Advanced Tools

603January 2015

Alma Resource Management

Ex Libris Confidential

Figure 242: 

Figure 468: Overlap Comparison Report Links

15 Click the links in the results provided to view the following types of 
comparisons/reports (in Excel format):

 Complete Overlap Report – This report contains matching titles with 
identical coverage dates.

 Partial Overlap Report – This report contains matching titles with 
partially overlapping coverage dates.

 Title Overlap Report – This report contains matching titles with 
mutually exclusive coverage dates.

 Unique Titles Report – This report contains titles that are unique to the 
source set you created for the comparison. 

Each report link has a number in parentheses indicating the number of titles 
in the report. For example, Set Comparison - Title Overlap report (3) 
indicates that there are three titles in the Title Overlap Report as a result of 
the comparison that was done.

The Complete Overlap Report, the Partial Overlap Report, and the Title 
Overlap Report contain the following columns:

 Title

 Identifier

 MMS ID

 Collection – Source Set
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 Portfolio ID – Source Set

 Coverage – Source Set

 Collection – Target Set

 Portfolio ID – Target Set

 Coverage – Target Set

The Unique Titles Report contains the following columns:

 Title

 Identifier

 MMS ID

 Collection – Source Set

 Portfolio ID – Source Set

 Coverage – Source Set

In the Unique Titles Report, these titles are the ones that are unique to the 
source set that you created for the comparison.

Below is an example of a Partial Overlap Report that contains matching 
titles with partially overlapping coverage dates. This illustration is 
displayed in three sections showing rows 1 through 9 for columns A-C, D-G, 
and H-K of the report spreadsheet. Specifically, columns G and K show the 
source and target coverage overlap information. In row 2, for example, 
coverage years 2000 – 2011 overlap between the source and the target sets 
for "The South African archaeological bulletin" title. 

Figure 243: 

Figure 469: Partial Overlap Report Rows 1-9, Columns A-C
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Figure 244: 

Figure 470: Partial Overlap Report Rows 1-9, Columns D-G with Source Coverage

Figure 245: 

Figure 471: Partial Overlap Report Rows 1-9, Columns H-K with Target Coverage
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To complete an overlap analysis for selected titles:

1 Click Submit New Report on the Overlap Analysis page (Resource 
Management > Advanced Tools > Overlap Analysis).

Figure 246: 

Figure 472: Submit New Report

The Overlap Analysis wizard opens.

2 From the Choose Report Type section of step 1, select the Selected Titles 
option and click Next.

3 From the Select File section in step 2, browse to locate the Excel file 
containing the unique identifiers for the selected titles you want to compare 
and click Next.

The column heading in the Excel file should identify the contents in the 
column as one of the following to use for matching records that you want to 
compare: ISBN, ISSN, LCCN, or TITLE. This Excel file is a single-column file 
(refer to the example below).

Figure 247: 

Figure 473: Example Single-Column Excel File

4 Complete the following information on the Compare Electronic Collections 
page:

 Report name – Specify a unique name or use the default that is supplied

 Report description – Use this option to further identify the report that 
his generated by Alma
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Figure 248: 

Figure 474: Compare Electronic Collections Page

5 Click Submit.

The system displays a message confirming that your Overlap Analysis job 
has been successfully submitted and displays your report job in the Report 
History section of the Overlap Analysis page.

Figure 249: 

Figure 475: Overlap Analysis Job Details and Submitted Message

6 Use Monitor Jobs (Administration > Manage Jobs) to track the progress of 
your Overlap Analysis report.

7 When your job has completed processing, select the History tab on the 
Monitor Jobs page and select Actions > Report to view your results. Use the 
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Repository filter to more quickly locate your report. The report provides the 
following information:

 Process ID

 Name (of the job)

 Started on/Finished on dates and time

 Total run time 

 Created by (user ID)

 Status

 Status date

 Records processed (total number)

 Records with exceptions (number)

 Links to the reports created
Figure 250: 

Figure 476: Overlap Comparison Report Links

8 Click the links in the results provided to view the following types of 
comparisons/reports (in Excel format):

 Selected Titles – Title Overlap Report – This report contains titles from 
the Excel file that the Overlap Analysis tool found to exist more than 
once in the repository.
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 Selected Titles – Unique Titles Report – This report contains titles from 
the Excel file that the Overlap Analysis tool found to exist only once in 
the repository.

 Selected Titles – Not in DB Report – This report contains titles from the 
Excel file that the Overlap Analysis tool found did not have any matches 
in the repository.

Each report link has a number in parentheses indicating the number of titles 
in the report. For example, Selected Titles - Title Overlap report (1) indicates 
that there is one title in the Title Overlap Report as a result of the 
comparison that was done.

The Title Overlap Report and the Unique Titles Report contain the following 
columns:

 Title

 Identifier

 MMS ID

 Collection

 Interface

 Portfolio ID

 Coverage

The Not in DB Report contains the following column:

 Identifier

Below is an example of a Selected Titles – Overlap Report that contains 
matching titles with overlapping coverage dates. This illustration is 
displayed in four sections showing row 1 for columns A-C, D-E, F, and G of 
the report spreadsheet. Specifically, column G shows the coverage overlap 
information. 
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Figure 251: 

Figure 477: Row 1, Columns A-C

Figure 252: 

Figure 478: Row 1, Columns D-E

Figure 253: 

Figure 479: Row 1, Column F

Figure 254: 

Figure 480: Row 1, Column G
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Configuring Resource Management

Overview
Resource management comprises the administration of the library's many 
resources, processes, and search-related activities. 

The infrastructure for the resource management workflows involves 
configuration of search methods, metadata, and creating, editing, viewing, 
copying, deleting, and using import and publishing profiles. The workflows 
include configuring search indexes, cataloging, and managing duplicate 
records.

This section describes how to configure the various resource management 
functions. 

This section includes:

 Overview on page 611

 Configuring Resource Management Activities on page 612

 Search Configuration on page 614

 Cataloging on page 634

 Record Export on page 657

 Record Import on page 675

 General on page 694
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Configuring Resource Management Activities

PERMISSIONS:
To configure resource management activities, you must have one of the 
following roles:

 Cataloging Administrator

 General System Administrator

Administrators configure the various resource management activities from the 
Resource Management Configuration page (from the Alma menu, select 
Resource Management > Resource Configuration > Configuration Menu). 

NOTE:
During implementation, most of the Resource Management configuration 
can be performed only by Ex Libris Professional Services staff. Only the 
publishing profiles are available for customer configuration. Once your 
Alma system is “live” and your institution’s administrators have received 
their Alma certification, this area is open to them.

The Configuration page displays the following:

 A filter option, enabling you to display the configuration options for 
configuring the institution (Main Campus) or libraries within the institution

 The available configuration options (refer to Table 77 for a list))

NOTE:
All the configurations are available on both the institution and library 
levels.

The following table lists the available configuration options.

Table 77. Resource Management Configuration Options

Section Configuration Item Refer To:
Search Configuration Search Indexes Configuring Search Indexes on 

page 615

Customize Indexes Labels Configuring Index Labels on 
page 627

External Search Resources Configuring External Search 
Resources on page 632

External Search Profile Configuring External Search 
Profiles on page 633
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Cataloging Metadata Configuration Configuring Metadata on 
page 634

Controlled Vocabulary Registry Configuring Controlled 
Vocabulary Registry on 
page 654

Record Export Publishing Profiles Configuring Publishing 
Profiles on page 657

Exclude Process Type from 
Publishing

Configuring Exclude Process 
Types from Publishing on 
page 670

Map Holdings Field to Bib 
Records – OCLC

Publishing to OCLC in the 
Alma Integrations with External 
Systems Guide

Institution OCLC Symbol Publishing to OCLC in the 
Alma Integrations with External 
Systems Guide

Map Holdings fields to Bib 
Records – Libraries Australia

Publishing to Libraries 
Australia in the Alma 
Integrations with External 
Systems Guide

Institution NUC Symbol Publishing to Libraries 
Australia in the Alma 
Integrations with External 
Systems Guide

Export URLs Extracting Electronic Portfolio 
URLs on page 671

Record Import Import Profiles Configuring Import Profiles on 
page 675

Originating Systems for MD 
Records

Configuring Originating 
Systems for MD Records on 
page 676

Remote Digital Repositories Remote Digital Repositories on 
page 680

General Other Settings Configuring Other Settings on 
page 695

Processes Configuring Processes on 
page 700

Table 77. Resource Management Configuration Options

Section Configuration Item Refer To:
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Search Configuration
This section describes:

 Configuring Search Indexes on page 615

 Configuring Index Labels on page 627

 Configuring External Search Resources on page 632

 Configuring External Search Profiles on page 633

Provenance Code Configuring Provenance Codes 
on page 701

Accession Numbers Configuring Accession 
Numbers on page 706

E Task Statuses Configuring E-Task Statuses 
on page 710

Label Printing Tool Configuring the Label Printing 
Tool on page 712

Call Number Parsing Configuring Call Number 
Parsing on page 714

Barcode Generation Configuring the Barcode 
Generation Method on 
page 723

Description Templates Configuring Description 
Templates on page 725

Inventory Network Groups Configuring Inventory 
Available For Management 
Groups for Multicampus 
Environments on page 730

Physical Item Sort Routines Configuring Physical Item Sort 
Routines on page 734

Physical Material Type 
Descriptions

Configuring Physical Item 
Material Type Descriptions on 
page 740

Table 77. Resource Management Configuration Options

Section Configuration Item Refer To:
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Configuring Search Indexes

PERMISSIONS:
To configure search indexes, you must have one of the following roles:

 Cataloging Administrator

 General System Administrator

Alma lets you configure which indexes are searched when conducting Simple 
and Advanced searches. You can configure the order that the indexes are 
searched and whether an index should be included in simple searches, 
advanced searches, or both. The indexes are available to be selected when 
performing a search. For example, locally configured indexes for the Simple 
search display in the Where drop-down list (see Figure 481). 

Figure 481: Local Index Configured

To customize the search index label that displays in the drop-down list, refer to 
Configuring Index Labels on page 627.

Each MARC tag, such as the 984, is indexed as a separate searchable field and all 
of its subfields are indexed and searchable when the 984 is selected as the Where 
option.
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Administrators configure search indexes from the Mapping Table page, by 
selecting Search Indexes from the Search Configuration section on the 
Configuration page (Resource Management > Resource Configuration > 
Configuration Menu).

The Mapping Table displays:

 Details about the table that contains the search indexes

 A list of the search indexes that are defined for each type of search

 A group of input fields that enable you to modify the search index

Figure 482: Mapping Table Page Search Indexes

To edit a search index:

1 On the Mapping Table page, under Mapping Table Rows, locate the search 
index that you want to edit.

2 Click Customize. The Mapping Table page opens for editing.
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Figure 483: Mapping Table Page Edit Search Indexes

3 Edit the search index as follows:

 To display a search index in the Simple Search, enter true in the Simple 
Search column.

 To hide a search index in the Simple Search, enter false in the Simple 
Search column.

 To display a search index in the Advanced Search, enter true in the Adv. 
Search column.

 To hide a search index in the Advanced Search, enter false in the Adv. 
Search column.

4 Edit the Index Order as follows:

 Alma uses the numerical order of the codes when applying the search 
indexes that are enabled and marked as true.

 The lower the number in the Index Order column, the higher the search 
index priority.
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5 Click Save. The search indexes are stored in the Alma system.

NOTE:
You can, at any time, click Restore to restore the initial parameter value.

The following table maps the index codes as found in the Mapping Table page 
to the index labels as found in Alma:

Table 78. Index Codes to Search Index Labels Mapping

Index Codes Search Index Labels
accessionNumber  Accession Number

all  Keywords

all_authority  Keywords

alternate_complete_edition  Edition

ar_description  AR description

auth_corporate_name  Corporate Name

auth_meeting_name  Meeting Name

auth_mms_id  MMS ID

auth_mms_originatingSystem  Originating System

auth_mms_sip_id  MMS SIP ID

auth_name_title  Name Title

auth_names  Names

auth_personal_name  Personal Name

auth_subject  Subject

auth_uniform_title  Uniform Title

barcode  Barcode

callNumberSuffix  Call number suffix

copyrights_note  Copyright Note

creatorName  Creator Name

depositSetId  Deposit set ID

description  Description

dewey_decimal_class_number  Dewey decimal class number

file_label  File Label
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file_note  File Note

file_pid  File PID

fulfilment_note  Fulfillment Note

general_note  Public note

generalNote  Public note

government_document_number  Government Document Number

handleId  Handle ID

harvestDate  Harvest date

holding_Note  Holding note

holding_pid  Holding PID

iec_external_system  External System

iec_external_system_id  External System Id

iec_label  Collection Name

iec_pid  Collection PID

ied_pid  IE PID

iepa_authenticationNote  Authentication Note

iepa_Library  Library

iepa_pid  Electronic Collection PID

iepa_POLineID  Collection PO Line ID

iepa_tps_accessRights  Access Rights

interfaceName  Interface Name

internal_note_1  Internal note 1

internalDescription  Internal Description

inventoryNumber  Inventory number

isbn  ISBN

issn  ISSN

issueYear  Issue year

item_pid  Item PID

itemPOLineID  PO Line

Table 78. Index Codes to Search Index Labels Mapping

Index Codes Search Index Labels
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itemSequenceNumber  Item sequence number

lc_class_number  LC Call Number

lcsh  Subjects (LC)

local_notes  Local notes

mesh  Medical Subjects (MeSH)

mms_id  MMS ID

mms_sip_id  MMS SIP ID

name  Names

national_bibliography_number  National bibliography number

notes  Notes

originating_system_id  Originating System ID

other_class_number  Other Classification Number

other_system_number  Other System Number

package_license_id  License ID

packageName  Electronic collection Name

PermanentCallNumber  Permanent call number

portfolio_accessRights  Access Rights

portfolio_authenticationNote  Authentication note

portfolio_internalDescription  Internal description

portfolio_license_id  Portfolio License ID

portfolio_pdaId  Portfolio PDA ID

portfolio_pid  Portfolio PID

portfolio_POLineID  Portfolio PO Line ID

pps_authenticationNote  Service Authentication Note

public_note  Public Note

publicNote  Public note

publisher  Publisher

publisher_number  Publisher number

representation_label  Representation Label

Table 78. Index Codes to Search Index Labels Mapping

Index Codes Search Index Labels
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The following table maps the search index labels as found in Alma to the index 
codes as found in the Mapping Table page:

representation_pid  Representation PID

series  Series

standard_number  Standard number

subjects  Subjects

summaryHolding  Summary holding

title  Title

tps_pid  Title Service PID

universal_decimal_class_number  UDC

Table 79. Search Index Labels to Index Codes Mapping

Search Index Labels Index Codes
 Access Rights iepa_tps_accessRights

 Access Rights portfolio_accessRights

 Accession Number accessionNumber

 AR description ar_description

 Authentication Note iepa_authenticationNote

 Authentication note portfolio_authenticationNote

 Barcode barcode

 Call number suffix callNumberSuffix

 Collection Name iec_label

 Collection PID iec_pid

 Collection PO Line ID iepa_POLineID

 Copyright Note copyrights_note

 Corporate Name auth_corporate_name

 Creator Name creatorName

 Deposit set ID depositSetId

 Description description

Table 78. Index Codes to Search Index Labels Mapping

Index Codes Search Index Labels
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 Dewey decimal class number dewey_decimal_class_number

 Edition alternate_complete_edition

 Electronic collection Name packageName

 Electronic Collection PID iepa_pid

 External System iec_external_system

 External System Id iec_external_system_id

 File Label file_label

 File Note file_note

 File PID file_pid

 Fulfillment Note fulfilment_note

Government Document Number government_document_number

 Handle ID handleId

 Harvest date harvestDate

 Holding note holding_Note

 Holding PID holding_pid

 IE PID ied_pid

 Interface Name interfaceName

 Internal Description internalDescription

 Internal description portfolio_internalDescription

 Internal note 1 internal_note_1

 Inventory number inventoryNumber

 ISBN isbn

 ISSN issn

 Issue year issueYear

 Item PID item_pid

 Item sequence number itemSequenceNumber

 Keywords all

 Keywords all_authority

 LC Call Number lc_class_number

Table 79. Search Index Labels to Index Codes Mapping

Search Index Labels Index Codes
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 Library iepa_Library

 License ID package_license_id

 Local notes local_notes

 Medical Subjects (MeSH) mesh

 Meeting Name auth_meeting_name

 MMS ID auth_mms_id

 MMS ID mms_id

 MMS SIP ID auth_mms_sip_id

 MMS SIP ID mms_sip_id

 Name Title auth_name_title

 Names auth_names

 Names name

 National bibliography number national_bibliography_number

 Notes notes

 Originating System auth_mms_originatingSystem

 Originating System ID originating_system_id

 Other Classification Number other_class_number

 Other System Number other_system_number

 Permanent call number PermanentCallNumber

 Personal Name auth_personal_name

 PO Line itemPOLineID

 Portfolio License ID portfolio_license_id

 Portfolio PDA ID portfolio_pdaId

 Portfolio PID portfolio_pid

 Portfolio PO Line ID portfolio_POLineID

 Public note general_note

 Public note generalNote

 Public Note public_note

 Public note publicNote

Table 79. Search Index Labels to Index Codes Mapping

Search Index Labels Index Codes
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The following table maps the Object Type column as found in the Mapping 
Table page to the search index types as found in Alma:

 Publisher publisher

 Publisher number publisher_number

 Representation Label representation_label

 Representation PID representation_pid

 Series series

 Service Authentication Note pps_authenticationNote

 Standard number standard_number

 Subject auth_subject

 Subjects subjects

 Subjects (LC) lcsh

 Summary holding summaryHolding

 Title title

 Title Service PID tps_pid

 UDC universal_decimal_class_number

 Uniform Title auth_uniform_title

Table 79. Search Index Labels to Index Codes Mapping

Search Index Labels Index Codes
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Figure 255: 

Figure 484: Object Type to Search Index Types Mapping

Search Indexes Example
If the accession number is enabled, it is displayed as an option when performing 
an advanced search:

Figure 485: Accession Number Enabled
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Figure 486: Accession Number Displayed

If the accession number is disabled, it is not displayed as an option when 
performing an advanced search:

Figure 487: Accession Number Disabled
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Figure 488: Accession Number Not Displayed

NOTE:
In addition, when the Accession Number is disabled, it is not searched 
when performing a simple search.

Refer to the How To Presentations folder in the Resource Management section 
of the Documentation Center (Alma > Production Documentation > Resource 
Management) for additional examples, such as the How to Configure Indexing and 
Search for 9XX Fields.

Configuring Index Labels

PERMISSIONS:
To configure index labels, you must have one of the following roles:

 Cataloging Administrator

 General System Administrator

Alma lets you define the names of the index labels of local fields used in simple 
and advanced searches and the order in which they are displayed.



Alma Resource Management

January 2015628

Chapter 8: Configuring Resource Management

Ex Libris Confidential

Administrators configure index labels from the Code Table page (select 
Customize Indexes Labels from the Search Configuration section of the 
Resource Management > Resource Configuration > Configuration Menu).

Figure 489: Code Table Page Index Labels

This page describes:

 Navigating and Filtering the List of Index Labels on page 629

 Editing (and Enabling/Disabling) Index Label Details on page 630
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Navigating and Filtering the List of Index Labels
The Code Table page displays:

 Details about the table that contains the index labels for the institution.

Most of the details are system-generated and cannot be edited.

 A list of the index labels that are defined for the institution

 A group of input fields that enable you to define and create a new index 
label

Figure 490: Code Table Page Index Labels



Alma Resource Management

January 2015630

Chapter 8: Configuring Resource Management

Ex Libris Confidential

Editing (and Enabling/Disabling) Index Label Details
You can edit the details of any index label.

To edit the details of an index label:

1 On the Code Table page, under Labels of local fields for searching, locate 
the index label that you want to edit.

Figure 491: Code Table Page List of Index Labels

2 Use the Display or Order up and down arrows to set the order of the index 
labels. The index labels display in the defined order in all Labels of local 
fields for searching drop-down lists such as the Where drop-down list in 
the Simple Search (see Figure 481). 

3 Modify the index label code and description as required.

4 Select Default Value if the new index label is to be the default index label 
whenever a Labels of local fields for searching drop-down list is displayed.

5 Click Customize to store the modified index label in the system.

Configuring Index Label Example
If the local field 900 is named Additional Information, the Additional 
Information field is displayed when performing a search:

Figure 492: Local Field 900 – Additional Information
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Figure 493: Advanced Search – Additional Information

If you change the name of the local 900 field to More Information, the More 
Information field is displayed when performing a search:

Figure 494: Local Field 900 – More Information



Alma Resource Management

January 2015632

Chapter 8: Configuring Resource Management

Ex Libris Confidential

Figure 495: Advanced Search – More Information

Refer to the How To Presentations folder in the Resource Management section 
of the Documentation Center (Alma > Production Documentation > Resource 
Management) for additional examples such as the How to Configure Indexing and 
Search for 9XX Fields.

Configuring External Search Resources
You configure external resources from the Search External Resource Setup page, 
which you access by selecting Resource Configuration > Configuration Menu 
from the Resource Management menu, and then selecting External Search 
Resources from the Search Configuration section on the Configuration page.
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Figure 496: Search External Resource Setup Page

For information on configuring external search resources, see External System 
Search in the Alma Integrations with External Systems Guide.

Configuring External Search Profiles

PERMISSIONS:
To configure external search profiles, you must have one of the following 
roles:

 Cataloging Administrator

 General System Administrator

Once you configure external search resources, you create a search profile that 
defines the order in which the external resources are searched, as well as the 
search conditions. For information on configuring external search profiles, see 
External System Search in the Alma Integrations with External System Guide.

You configure external profiles from the External Search Profile List page, 
which you access by selecting Resource Configuration > Configuration Menu 
from the Resource Management menu, and then selecting External Search 
Profile from the Search Configuration section on the Configuration page.
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Figure 497: External Search Profile List

Cataloging
This section describes:

 Configuring Metadata on page 634

 Configuring Controlled Vocabulary Registry on page 654

Configuring Metadata

PERMISSIONS:
To configure metadata, you must have one the following roles:

 Cataloging Administrator

 General System Administrator

In this section you can configure the following characteristics of the MD Editor:

 which metadata fields and subfields display in the metadata editor and if 
they are repeatable 

 if the subfields use a controlled vocabulary

 normalization processes

 validation processes 

You configure the metadata fields from the Metadata Configuration List page 
(Resource Management > Resource Configuration > Configuration Menu > 
Cataloging > Metadata Configuration).
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Figure 498: Metadata Configuration List Page

Refer to Working with Authority Records on page 184 for additional 
information related to global and local authority records in Alma.

This section describes:

 Viewing a List of Metadata Profiles on page 635

 Viewing Metadata Profile Details on page 636

 Editing Profile Details on page 637

 Editing Fields on page 638

 Adding a Field to the Qualified Dublin Core Metadata Configuration 
Profile on page 642

 Restoring Profile Field Details on page 643

 Working with Normalization Processes on page 643

 Editing Validation Routines on page 649

 Working with Validation Exception Profiles on page 652

Viewing a List of Metadata Profiles
The Metadata Configuration List page (Resource Management > Resource 
Configuration > Configuration Menu > Cataloging > Metadata Configuration) 
displays a list of metadata profiles that are defined for the institution, a link to 
each profile, and the following information (when available) for each profile:

 Vocabulary

 Family

 Type

 Usage

 Updated on (date)
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Figure 499: Metadata Configuration List Page

Viewing Metadata Profile Details
The Profile Details page displays a list of metadata profile details.

To view metadata profile details:

1 On the Metadata Configuration List page (Resource Management > 
Resource Configuration > Configuration Menu > Cataloging > Metadata 
Configuration), click the name of the profile you want to view. The Profile 
Details page opens. 

Figure 500: Profile Details Page



Chapter 8: Configuring Resource Management

637January 2015

Alma Resource Management

Ex Libris Confidential

2 Select Actions > View for the profile details you want to view. The Field 
Details page opens.

Figure 501: Field Details Page

3 Click Back to return to the Profile Details page.

Editing Profile Details
You can modify the details of a metadata profile using the options provided in 
the following tabs that display on the Profile Details page:

 Fields – see Editing Fields on page 638

 Normalization Processes – see Working with Normalization Processes on 
page 643

 Validation – see Editing Validation Routines on page 649

 Validation Exception Profile List – see Working with Validation Exception 
Profiles on page 652
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Figure 502: Profile Details Page

Editing Fields
From the Fields tab on the Profile Details page for a specific metadata 
configuration profile, you can edit (Actions > Customize) the fields of a 
metadata profile as described in the To edit fields: procedure below. 

The fields that are available to edit is determined by profile link/type 
(bibliographic, holdings, authority, or Qualified Dublin Core) that you select on 
the Metadata Configuration List page (Resource Management > Resource 
Configuration > Configuration Menu > Cataloging > Metadata 
Configuration). When you click the profile link, the Profile Details page opens 
to the Fields tab that displays all the fields that you are able to customize. Using 
the Filter and Find options enable you to easily locate the field that you want to 
customize.

Specific to the Qualified Dublin Core metadata configuration profile, you can 
also add fields in addition to editing fields (refer to Adding a Field to the 
Qualified Dublin Core Metadata Configuration Profile on page 642 for more 
information).

To edit fields: 

NOTE:
This procedure describes the process for editing bibliographic fields. The 
process is similar for holdings, authority, and Qualified Dublin Core.

1 On the Metadata Configuration List page (Resource Management > 
Resource Configuration > Configuration Menu > Cataloging > Metadata 
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Configuration), click the name of the profile you want to edit. The Profile 
Details page opens.

Figure 503: Profile Details Page

2 Locate the field you want to edit using the Filter drop-down list or the Find 
search option to locate a specific Field or Description.

3 Select Actions > Customize for the field you want to edit. The Field Details 
page opens.

Figure 504: Field Details Page
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4 Edit the following field options (which may vary) to match your 
requirements:

 Mandatory - Specify Yes or No.

 Description - Optionally edit to provide details for your reference.

 Help URL - Enter a URL that can be used for help.

The help information that this URL points to displays on the Info tab in 
the MD Editor.

Figure 256: 

Figure 505: MD Editor Info Tab Related to the Help URL Option

 Subfields - Click the plus sign to expand this section, and click Assign 
for the subfield you want to edit.
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Figure 506: Subfields Section Expanded

Figure 507: Assign Controlled Vocabulary

 Select a controlled vocabulary (CV) from the drop-down list and 
click Assign. The options displayed in this list are configured in 
Configuring Controlled Vocabulary Registry on page 654.

 For your convenience, you may use the Create New CV Value 
section to add controlled vocabulary terms. The terms that you add 
here will only apply to the field that you are editing. If you want to 
use these terms with another/different field, use the Controlled 
Vocabulary Registry (refer to Configuring Controlled Vocabulary 
Registry on page 654) to create a CV that may be used for more than 
one field. 
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To add a new controlled vocabulary value in the Create New CV 
Value section, enter a code and description and click Add. When you 
are finished adding terms, click Assign.

 First Indicator - Make any required changes. 

 Second Indicator - Make any required changes. 

5 Click Save. The field changes are saved in the metadata profile.

6 Click Deploy.

Adding a Field to the Qualified Dublin Core Metadata Configuration 
Profile

The Fields tab on the Profile Details page for the Qualified Dublin Core 
metadata configuration profile contains a list of each of the metadata fields 
contained in the profile. You can add a field to the metadata profile using the 
steps below. To edit the fields on the Fields tab, see Editing Fields on page 638.

To add a field:

1 In the Fields tab, click the Add Field button (available for some of the 
profiles). The page for adding a field opens. 

Figure 508: Adding a Field

2 In the Field field, select a field from the metadata list of fields.

3 In the Description field, enter a description for the new field.

4 In the Encoding Schema field, select a schema for the new field.

5 In the Language Occurrence drop-down list, select Disallowed, Mandatory, 
or Optional.

6 If the field you are adding is required, select the Yes radio button for 
Mandatory.

7 If the field you are adding is a repeatable field, select the Yes radio button 
for Repeatable.

8 Click Save. The field is saved in the metadata profile.
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Restoring Profile Field Details
You can restore the profile details to the default values.

To restore the default profile field details:

1 On the Metadata Configuration List page, click the link in the Profile 
column for the profile that contains the field you want to restore. The Profile 
Details page opens on the Fields tab.

Figure 509: Profile Details Page

2 Select Actions > Restore for the profile details that you want to restore. The 
profile change that was locally customized is restored to the field’s default 
value. 

3 Click Deploy.

Working with Normalization Processes
Normalization processes are used to correct or update metadata records such as 
sorting a record’s fields, removing empty fields, or stripping out fields 
containing order information. 

You can perform the following actions in the Normalization Processes tab on 
the Profile Details page (Resource Management > Resource Configuration > 
Configuration Menu > Cataloging > Metadata Configuration > click Profile 
Link):

 Create a customized normalization process – Shared normalization rules 
can be defined through the MD Editor, then added to processes and used in 
profiles. See the To add a process: procedure below.
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NOTE:
Normalization processes can be identified from the Administration > 
Manage Jobs > Run a Job by filtering on their type MARC 21 Bib 
normalization. Refer to the section Running Jobs on Defined Sets on 
page 305 for more information.

 Edit a normalization process – Select Actions > Edit.

 Disable a normalization process – If the normalization process is not 
currently required but may be required in the future, you can disable it by 
clicking the process’ yellow check mark. The check mark turns gray to 
indicate that the rule is disabled. (To re-enable it, click the gray check mark.)

Figure 257: 

Figure 510: Profile Details Page, Normalization Processes Tab

To add a process:

1 In the Normalization Processes tab on the Profile Details page (Resource 
Management > Resource Configuration > Configuration Menu > 
Cataloging > Metadata Configuration > click Profile Link), click Add 
Process. The first page of the wizard opens. 
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Figure 258: 

Figure 511: Process Details Page

NOTE:
If you want to create a copy of an existing process, select Actions > Copy. 
Once you have copied the process, you can edit it as needed.

2 In the General Information section:

 Enter the name and description for the process. These values will be 
visible to users on the Process List page.

 In the Status field, select whether the process is available (Active) or not. 
A process that is inactive can be stored and edited in the system without 
being run. It can be made active at any time. 

3 Click Next. The next page of the wizard opens.
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Figure 259: 

Figure 512: Process Details Page, Processes Selected

4 In the Process List Pool area, select one or more processes and click Add to 
Selection. The following table describes the available processes:

Table 80. Normalization Processes

Process Name Description
MarcDroolNormalization Runs the normalization rules that are 

selected as parameters in the Task 
Parameters tab

Marc21BibResequenceTask Runs a task that resequences the 
bibliographic fields according to their 
proper order—for example, 001, 100, 200, 
and so forth

Marc21BibClearEmptyFieldsTask Runs a task that deletes the bibliographic 
fields that are empty
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MmsTagSuppressed Runs a task that suppresses/unsuppresses 
the bibliographic records from discovery 
according to the selected value (True/False) 
in the Task Parameters tab

MmsTagSyncExternal Runs a task that sets the synchronization 
policy for the bibliographic records with 
the external catalog according to the 
selected value in the Task Parameters tab

MmsIdentifyingBriefRecords Runs a task that checks whether the 
bibliographic records should be set as brief 
records

Marc21createControlNumber Runs a task that creates a new control 
number from the bibliographic records’ 001 
and 003 fields and places it in the 035 field

MmsTagSyncNationalCatalog Runs a task that sets the synchronization 
policy for the bibliographic records with 
the national catalog according to the 
selected value in the Task Parameters tab

Marc21HoldingClearEmptyFieldsTask Runs a task that deletes the holdings fields 
that are empty

Marc21HoldingResequenceTask Runs a task that resequences the holdings 
fields according to their proper order 

852 field normalization Runs a task that takes the control number 
from the bibliographic record and places it 
in the correct subfield in the holdings 
record

Marc21ExpandHoldingBy86XTask Runs a task that adds a description to the 
holdings record (in another 86X field)

Marc21AuthClearEmptyFieldsTask Runs a task that deletes the authority fields 
that are empty

Marc21AuthResequenceTask Runs a task that resequences the authority 
record fields according to their proper 
order

DcBibClearEmptyFieldsTask Runs a task that deletes the Dublin Core 
fields that are empty

DcBibResequenceTask Runs a task that resequences the Dublin 
Core fields according to their proper order

Table 80. Normalization Processes

Process Name Description
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5 Use the up and down arrows to arrange the order in which the tasks will be 
performed as part of the routine. 

6 Click Next. The next page of the wizard opens.
Figure 260: 

Figure 513: Task Parameters Tab for Normalization Process

NOTE:
Depending on the processes you selected on page 2 of the wizard, you 
may see none or all of the selections that you see here.

7 For Marc Drool Normalization, select a normalization rule from the drop-
down menu. For more information regarding working with and creating 
normalization rules, refer to Working with Normalization Rules on 
page 220 and Normalization Rules – Syntax and Examples on page 224.

NOTE:
Only normalization rules that are created as shared rules in the MD Editor 
are displayed in the drop-down list to be selected. 

8 For the Suppression from Discovery field, select True for records to be 
suppressed from publishing to Primo, False to allow records to be published 
to Primo.

9 For the Synchronize with External Catalog field, select one of the following:

 Publish bibliographic records: marks bibliographic records to be 
included in exports to OCLC

 Publish holdings only: marks holdings records to be included in 
exports to OCLC

 Don’t publish: marks records to be excluded from exports to OCLC

10 Click Save. The process is added to the profile in the Alma system.
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Editing Validation Routines
There are two out-of-the-box validation routines:

 MARC21 Bib match validation – defines the way in which validation is 
handled when a bibliographic record match is performed during the import 
process or in the MD Editor

 MARC21 Bib validation on save – defines the way in which validation is 
handled when importing MARC records using an import profile, copy 
cataloging via an external resource (such as WorldCat or LoC), and saving a 
bibliographic record in the MD Editor.

You can edit these routines, but you cannot create new validation routines.

If the routine is not currently required but may be required in the future, you 
can disable it by clicking the yellow check mark to the left of the routine. The 
check mark becomes gray to indicate that the routine is disabled. (To re-enable a 
routine, click the gray check mark.) 

To edit a validation routine:

1 In the Profile Details page’s Validation Processes tab (Resource 
Management > Resource Configuration > Configuration Menu > 
Cataloging > Metadata Configuration > [profile name]) > Validation), 
select Edit for the routine that you want to edit. 

Figure 261: 

Figure 514: Validation Processes Tab

The Process Details page opens to the General Information tab.
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Figure 262: 

Figure 515: Process Details Page, General Information Tab

2 Edit the validation details as required, selecting the tabs to access the 
information you want to modify. 
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Figure 263: 

Figure 516: Task List Tab for a Validation Routine

3 Click Save. The validation routine is saved in the Alma system.
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Working with Validation Exception Profiles
The Validation Exception Profile List tab (Resource Management > Resource 
Configuration > Configuration Menu > Cataloging > Metadata 
Configuration > [profile name]) > Validation Exception Profile List) displays 
the validation exception profiles that are used to determine the severity of the 
validation issues that are identified using the validation profiles (see Editing 
Validation Routines).

There are two out-of-the-box validation exception profiles:

 MARC XML Bib Import 

 MARC XML Bib Metadata Editing on Save 

The MARC XML Bib Metadata Editing on Save exception profile is used when 
copy cataloging via an external resource (such as WorldCat or LoC) and when 
saving a bibliographic record in the MD Editor. When defining an import 
profile, you define the validation exception profile to be used during the import. 
It is recommended that you select the MARC XML Bib Import exception profile 
to handle invalid data as it is being imported.

Unlike validation profiles, you can define additional exception (severity) 
profiles. You can also edit the existing profiles or delete them (Actions > 
Delete).

NOTE:
For information on configuring an error message to be displayed when 
adding 9XX fields to Network Zone records, see Configuring an Error 
Message to Be Displayed When Manually Adding 9XX Fields to 
Network Zone Records in the Working with Collaborative Networks 
(Consortia) in Alma Guide.

To add a severity validation profile:

1 On the Profile Details page (Resource Management > Resource 
Configuration > Configuration Menu > Cataloging > Metadata 
Configuration > [profile name]), click the Validation Exception Profile List 
tab.

NOTE:
If you want to create a copy of an existing Validation Exception Profile 
List, select Actions > Copy. Once you have copied the Validation 
Exception Profile List, you can modify it as needed.
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Figure 517: Add Severity Validation Profile Area

2 In the Add Severity Validation Profile area, do the following:

 Enter a name (required) and description for the severity validation 
profile you want to add.

 In the Default Severity field, select the type of severity, an error or a 
warning.

3 Click Add Severity Validation Profile. The profile is added to the list of 
Validation Exception Profiles.

To edit a severity validation profile:

1 On the Profile Details Page, in the Validation Exception Profile List tab, 
select Actions > Edit for the validation exception that you want to update.

Figure 518: Validation Severity Profile Exceptions Page Edit

2 In the General Information area, make changes to name, description, or 
default severity as required. The default severity determines whether 
violations of the field-level parameters defined in the Fields tab (for 
example, mandatory, non-repeatable) are treated as warnings (which can be 
overridden) or as errors (which must be resolved).
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3 In the Message area, select a message to be deleted, as required, and click 
Delete. 

4 The Add Validation Severity Exception area allows configuration of new 
validation exceptions. In the Message drop-down list, select a validation 
exception message. The syntax of the message is not configurable. 

5 Click Save. The validation exception profile is saved in the Alma system.

Configuring Controlled Vocabulary Registry

PERMISSIONS:
To configure the controlled vocabulary registry, you must have one of the 
following roles:

 Cataloging Administrator

 General System Administrator

Alma supports validation of subfield values based on a controlled vocabulary (a 
list of acceptable values for that subfield). To implement a controlled vocabulary 
(CV), you need to:

1 Create a controlled vocabulary  

2 Assign the controlled vocabulary to a specific MARC 21 subfield

Refer to the procedure in Editing Fields on page 638 and the steps that 
describe editing field options.

You configure controlled vocabularies (CVs) from the Metadata Configuration 
List page, which you access by selecting Resource Configuration > 
Configuration Menu from the Resource Management menu, and then selecting 
Controlled Vocabulary Registry from the Cataloging section on the 
Configuration page.
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Figure 519: Controlled Vocabulary Registry Page

You can perform the following actions on this page:

 View the controlled vocabulary details (Actions > View)

 Add a controlled vocabulary (see Adding a Controlled Vocabulary on 
page 655)

 Delete a controlled vocabulary (Actions > Customize, then click Delete on 
the Controlled Vocabulary Details page)

Adding a Controlled Vocabulary 
You can add a new controlled vocabulary.

To add a controlled vocabulary:

1 On the Controlled Vocabulary Registry page (Resource Configuration > 
Configuration Menu > Cataloging section > Controlled Vocabulary 
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Registry), click the Add CV button. The Controlled Vocabulary Details page 
opens.

Figure 520: Controlled Vocabulary Details Page

2 Specify a name and enter a description.

This name and description displays on the Controlled Vocabulary Registry 
page and in the drop-down list of options for Choose Controlled 
Vocabulary when you assign a CV to a MARC 21 subfield.

3 In the Add new value area, specify a code and enter a description. 

The code that you enter is the term that is validated or provided as an option 
when entering a record in the Metadata Editor.

Figure 521: 245 $h CV Example

In the 245 $h example above, the codes that you enter display first in each 
row, and the description displays to the right of each code in parentheses.

The description for the code that you enter in the CV registry can provide 
additional information regarding the term that you entered.
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4 Click Add. The controlled vocabulary name is added to the list of controlled 
vocabulary registries.

5 Repeat steps 3 and 4 to add any additional codes (terms).

6 Click Cancel to return to the Controlled Vocabulary Registry page. The 
controlled vocabulary registry records are saved in the Alma system.

Record Export
This section describes:

 Configuring Publishing Profiles on page 657

 Configuring RSS in Alma on page 658

 Configuring Exclude Process Types from Publishing on page 670

 Extracting Electronic Portfolio URLs on page 671

Configuring Publishing Profiles

PERMISSIONS:
To configure publishing profiles, you must have one of the following 
roles:

 Cataloging Administrator

 General System Administrator

Alma lets you configure publishing profiles for RSS feeds, Primo, Primo Central, 
Google Scholar, OCLC, COPAC, Libraries Australia, and PubMed. 

You can configure publishing profiles from the Publishing Profiles page 
(Resource Management > Resource Configuration > Configuration Menu, 
then select Publishing Profiles from the Configuration page, Record Export 
section).
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Figure 264: 

Figure 522: Publishing Profiles Page

NOTE:
Publishing profiles are now available for configuration during the Alma 
implementation process.

For information on configuring an RSS profile, refer to Configuring RSS in 
Alma on page 658.

For information on configuring the other types of publishing profiles, refer to 
Resource Management in the Alma Integrations with External Systems Guide.

Configuring RSS in Alma

PERMISSIONS:
To set up an RSS feed, you must have one of the following roles:

 General System Administrator

 Repository Administrator

 Catalog Administrator

The RSS (Rich Site Summary, www.whatisrss.com) feature in Alma provides a 
feed to the discovery interface (Primo), identifying new items published or 
added to the inventory. This feature enables you to create a new book list (refer 
to the New Book List Workflow on page 659).
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The library items to be included in the RSS are determined by set management 
selections and by the relative date spans set up in the RSS publishing profile.

Alma uses ItemToRSSNormalizer to normalize records for RSS files. 

IMPORTANT:IMPORTANT:
Internet Explorer fully supports RSS. Firefox offers some support, and 
Chrome does not support RSS at all. To use RSS with a browser other than 
IE, consult the help for that browser to find an add-on or work-around.

VIDEO:
See Configuring RSS Feeds for New Book Lists for an “Ask the Expert” 
session on this functionality (40 mins).

New Book List Workflow
Creating a new book list, by utilizing the Alma RSS feature, involves the 
following key workflow steps:

 Create a physical items set (refer to Saving Queries on page 32)

Use this step to identify the set of records within which you expect to locate 
your list of new books. You will need to specify the name of this set in the 
RSS publishing profile that you create in a later part of the workflow.

 Create the RSS discovery URL (refer to Creating the RSS Discovery URL on 
page 663)

After you have identified all the parts and created the RSS discovery URL 
that you need to use for your new book list process, you need to enter the 
URL in the rss_discovery_url parameter that is located on the Mapping 
Table page of Other Settings (Administration > General Configuration > 
Configuration Menu > General Configuration section).

 Create an RSS publishing profile (refer to Configuring an RSS Publishing 
Profile on page 660)

 Create the RSS feed URL (refer to Creating the RSS Feed URL on page 667)

 Optionally, confirm that new books have been added/received to your 
database (within the set that you previously saved above)

 Confirm that the RSS publishing profile has successfully completed 
processing by using Monitor Jobs (Administration > Manage Jobs) and 
checking the Completed tab (filter on Publishing)

For more information refer to Monitoring Jobs on page 286 in the Alma 
Administration Guide.

 Use the RSS feed URL (created above) to view the new book list by entering 
the URL into a browser and viewing the results in Primo. Refer to RSS Feed 
Job Processing on page 668.


https://exlibris.webex.com/exlibris/ldr.php?RCID=92a3888e7a922050ca0f003833b3174d
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Configuring an RSS Publishing Profile
To implement RSS, an authorized user must:

 Configure a publishing profile that includes a definition of new that is 
between 90 and 2 days ago (refer to the Max number of days ago and Min 
number of days ago settings described in the procedure below related to the 
definition of new)

 Create and/or select a physical item set to be used with the RSS publishing 
profile

 Define a new customer parameter, rss_discovery_url 
(Administration > General Configuration > Configuration 
Menu > General Configuration > Other Settings), that links to Primo at the 
institution level. Refer to Creating the RSS Discovery URL on page 663.

The RSS feed can then be run (see RSS Feed Job Processing on page 668).

NOTE:
Alma’s RSS feed pertains to physical items only. 

To configure the RSS feed:

1 From the Configuration page of the Resource Management component 
(Resource Management > Resource Configuration > Configuration Menu), 
click Publishing Profiles in the Record Export section. The Publishing 
Profiles page opens, listing all preconfigured publishing profiles.

2 Click the Add Profile button, and select the RSS option. The Publishing 
Profile Details page opens to a blank RSS profile.
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Figure 265: 

Figure 523: Publishing Profile Details for RSS

3 Configure the RSS publishing profile using the table below that describes 
your options.

Table 81. RSS Publishing Profile

Field Description
Profile Details

Profile name The unique name of this RSS feed publishing profile. 
Used to identify the profile on the list of Publishing 
Profiles page.

Profile description Provides more information about the profile and 
displays it on the Publishing Profiles page as well.

Status Determines whether the status is:

 Active (yellow check mark), meaning it is in use or 
can be used, or 

 Inactive (clear check mark), meaning it is unable to 
be used at present.
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4 Click the Save. The Publishing Profile list page opens with the new RSS feed 
publishing profile listed.

Scheduling Select a time or interval from the drop-down menu to 
identify when you want publishing to be run that uses 
this profile. 

Email Notifications Opens the Email Notifications for Scheduled Jobs page, 
which allows you to specify which users and email 
addresses will receive email notifications when the 
publishing profile has completed. You will have the 
option to choose whether to send the notifications for 
successful jobs and/or jobs that contain errors.

RSS Feed Parameters

RSS feed name The name used to generate the link to the feed. Avoid 
spaces in the name.

RSS feed title Displays as the name of the profile in the Publishing 
Profiles list.

This also displays in the RSS feed results.

RSS feed description A description of the profile that displays in the 
Publishing Profiles list.

This also displays in the RSS feed results.

Language A drop-down list from the languages code table. 
Default is empty. Once a value has been selected, it 
becomes the default on subsequent uses of the profile.

Select Population

Set name The set of physical items that the RSS action will be 
applied to. Click the arrow to open a list of physical 
item sets to browse or search, then select one.

Max number of days ago The maximum number of days past to look for new 
items for the feed. New is determined by the item’s 
Receiving date identified on the Physical Item Editor 
page. 

The default number of days is 60. This number cannot 
exceed 90.

Min number of days ago The minimum number of days past to look for new 
items. The default is 2, and two days is the minimum to 
ensure synchronization with the Primo. This number 
cannot exceed the Max number of days ago.

Table 81. RSS Publishing Profile

Field Description
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Creating the RSS Discovery URL
The RSS discovery URL has several component parts. Use the following 
template to define your RSS discovery URL:

http://<primo domain>/primo_library/libweb/action/
dlSearch.do?institution=<institution>&vid=<view>&tab=<tab 
code>&indx=1&bulkSize=10&query=any,contains,<value>

An example of a functional RSS discovery URL may look something like:
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

This template can be divided into the following components some of which you 
need to locate and other parts that are provided:

1 Primo domain
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

This can be obtained from the Primo URL.

2 RSS discovery URL string provided (1)
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

3 Institution code
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

This is the Primo institution code not the Alma institution code. This can be 
located in the Primo back office by editing the Primo institution (Primo 
Home > Ongoing Configuration Wizards > Institution Wizard). For more 
information, refer to the Primo Back Office Guide.

4 vid (view ID)
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

Use the vid value that you find in the Primo URL.
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5 View tab
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

This is the tab code name (case sensitive) for the desired view in the Primo 
back office at Primo Home > Ongoing Configuration Wizards > Views 
Wizard as shown below. For more information, refer to the Primo Back Office 
Guide.

Figure 266: 

Figure 524: Primo Tab Code

6 Scope name within the selected tab
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

You identify the scope name to be used from the ones defined in the Primo 
back office for the view tab you identified in the previous component. For 
more information, refer to the Primo Back Office Guide. 
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Figure 267: 

Figure 525: Scope Name (Primo Back Office)

7 RSS discovery URL string provided (2)
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

8 sourceid
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

The sourceid can be found in the Primo back office Data Sources 
Configuration (Primo Home > Ongoing Configuration Wizards > Pipe 
Configuration Wizard >Data Sources Configuration) or by viewing the 
<sourceid> in a Primo PNX record. For more information, refer to the 
Primo Back Office Guide.
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Figure 268: 

Figure 526: Primo sourceid

Figure 269: 

Figure 527: Primo sourceid from a PNX Record
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9 RSS discovery URL string provided (3)
http://demo.alma.exlibrisgroup.com:1701/primo_library/ 
libweb/action/dlSearch.do?institution=EXLDEV1_INST&vid= 
Alma&tab=default_tab&search_scope=Alma&indx=1&bulkSize= 
10&query=any,contains,primo_alma@@ALMA_IND@@

Once you have defined your RSS discovery URL, you can enter it in the 
rss_discovery_url parameter that is located on the Mapping Table page of 
Other Settings (Administration > General Configuration > Configuration 
Menu > General Configuration section).

Creating the RSS Feed URL
The RSS feed URL is used to retrieve the records in the RSS feed. After each time 
that the RSS publishing job is run, the RSS feed includes records in the results 
with items that have a receiving date that meets the criteria for minimum/
maximum number of days ago that you set in the RSS publishing profile. These 
records make up the list of new books for your new book list. Patrons may sign 
up for the RSS feed or a link to the RSS feed URL may be placed in Primo or on 
another library web page.

The following is an example of an RSS feed URL:
http://demo.alma.exlibrisgroup.com:1801/rep/
getFile?institution_code=EXLDEV1_INST&file= 
library_science_RSS_name&type=RSS

The RSS feed URL is made up of the following component parts (using the 
example above):

1 Alma URL
http://demo.alma.exlibrisgroup.com:1801

2 RSS feed URL string provided (1)
/rep/getFile?institution_code=

3 Alma institution code
EXLDEV1_INST

4 RSS feed URL string provided (2)
&file=
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5 RSS feed name as defined in the RSS publishing profile
library_science_RSS_name

Figure 270: 

Figure 528: RSS Feed Name from the RSS Publishing Profile

6 RSS feed URL string provided (3)
&type=RSS

RSS Feed Job Processing
After you have completed the RSS feed publishing profile, the RSS feed job is 
run per the schedule you defined in the profile. To view the progress of the job, 
find it using the Publishing filter on the Monitor Jobs page in the Running or 
Completed tab (Administration > Manage Jobs > Monitor Jobs) or select 
Actions > History for the RSS profile on the Publishing Profile page to display 
the results on the Monitor Jobs page. 

For completed jobs, selection Actions > Report to open the Job Report page. In 
addition to the files created as a result of the RSS feed job being run, Alma 
generates a summary link (displayed on the Job Report page) for each RSS job in 
the following format:
http://[Alma URL]/rep/getFile?institution_code=[Alma Institution 
Code]&file=[RSS feed name]&type=RSS

This is the same URL format as described in Creating the RSS Feed URL on 
page 667. To display the results of the RSS feed publishing profile, that is, the 
new book list, you can click the link provided on the Job Report page; or you can 
copy/paste the RSS feed URL that you created in the section Creating the RSS 
Feed URL on page 667 into a browser (refer to the figure below). 

Figure 271: 

Figure 529: RSS Feed URL Entered into a Browser
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Either method opens a page similar in format to the figure below that contains a 
list of items matching the date span criteria that you provided in the publishing 
profile. This is your new books list.

Figure 272: 

Figure 530: RSS Feed Results/New Books List
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When you click the link for one of the records in the RSS feed results list (the 
new books list), the item opens in your discovery tool/Primo as shown in the 
figure below. 

Figure 273: 

Figure 531: New Item Displayed in Primo

Configuring Exclude Process Types from Publishing
You configure exclude process types from publishing from the Mapping Table 
page, which you access by selecting Resource Configuration > Configuration 
Menu from the Resource Management menu, and then selecting Exclude 
Process Types from Publishing from the Record Export section on the 
Configuration page.
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Figure 532: Exclude Process Types from Publishing

NOTE:
It is not possible to create new process types.

For information on configuring exclude process types from publishing, see 
Excluding Process Types from Publishing in the Alma-Primo Integration Guide. 

Extracting Electronic Portfolio URLs

PERMISSIONS:
To extract electronic portfolio URLs, you must have one of the following 
roles:

 Inventory Operator

 General System Administrator

The Export URLs option provides a method for extracting electronic portfolio 
URLs from Alma for synchronizing with a proxy server. With this utility, you 
can run a job to extract all electronic portfolio URLs or a logical set of URLs. The 
utility extracts the portion of the URL up to the query string, as in the bolded 
portion of the example below:
http://www.yahoo.com/articles?artid=1234
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To extract electronic portfolio URLs:

1 On the Resource Management Configuration page (Resource 
Management > Resource Configuration > Configuration Menu), click 
Export URLs in the Record Export section. The Export Electronic Resource 
URLs page opens.

Figure 274: 

Figure 533: Export Electronic Resource URLs Page

2 Specify one of the following options from the Input URLs drop-down list:

a All and skip to step 5.

b Logical Set and continue with the next step.
Figure 275: 

Figure 534: Logical Set Option

3 Browse to locate the set that you previously saved (using Repository Search 
and Save Query).

Figure 276: 

Figure 535: List of Available Sets

4 Click the appropriate radio button for the set you want to use and click 
Select.
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Figure 277: 

Figure 536: Set Selected

5 Click Save. A confirmation message displays with the ID number of the job 
that is being run to extract the URLs.

Figure 278: 

Figure 537: Confirmation Message with Job ID Number

6 View the job results.

a From the Completed tab on the Monitor Jobs page (Administration > 
Manage Jobs > Monitor Jobs), click Actions > Report for the Export 
Electronic Resource URLs job that you just ran.

Figure 279: 

Figure 538: Completed Tab on the Monitor Jobs Page

b On the Job Report page, click the Link to exported records link.
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Figure 280: 

Figure 539: Job Report Page

c Select Actions > Download.

d Open the .csv file created that contains the extracted URLs.
Figure 281: 

Figure 540: Open the .csv File
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Figure 282: 

Figure 541: .csv File

Record Import
This section describes:

 Configuring Import Profiles on page 675

 Configuring Originating Systems for MD Records on page 676

 Remote Digital Repositories on page 680

Configuring Import Profiles

PERMISSIONS:
To configure import profiles, you must have one of the following roles:

 Cataloging Administrator

 General System Administrator

Import profiles enable you to define how to import metadata and order 
information into the Alma repository. The definitions include source format, 
mapping definitions, and normalization routines to be executed during the 
import process. Profiles are created for each vendor with specific configurations 
for the purchases that are being processed from that vendor. There could be 
multiple import profiles for a vendor with specific configurations for a 
particular purchase type. For example, you would have different import profiles 
for purchases of material being funded through different funds, or for purchases 
for different libraries in the institution. 

For more information on import profiles see Managing Profiles for Record 
Imports on page 511.
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Configuring Originating Systems for MD Records

PERMISSIONS:
To configure originating systems for MD records, you must have one of 
the following roles:

 Cataloging Administrator

 General System Administrator

You can configure the originating system to be used when creating import 
profiles (such as WorldCat or Library of Congress). The originating systems that 
you configure in this section are available in the Originating System drop-down 
list when creating import profiles. For more information on import profiles, see 
About Import Profiles on page 511.

Figure 542: Configuration Files Page - Originating Systems for MD Records

You configure the Originating Systems for MD Records from the Configuration 
Files page, which you access by selecting Resource Configuration > 
Configuration Menu from the Resource Management menu, and then selecting 
Originating Systems for MD Records from the Record Import section on the 
Configuration page.

This section describes:

 Viewing Originating Systems for MD Records on page 677

 Adding an Originating System for MD Records Code on page 677

 Editing Originating System for MD Records Codes Details on page 678

 Deleting and Disabling an Originating System for MD Records Code on 
page 679



Chapter 8: Configuring Resource Management

677January 2015

Alma Resource Management

Ex Libris Confidential

Viewing Originating Systems for MD Records
The Code Table page displays:

 details about the table that contains the Originating Systems for MD 
Records codes for the institution. Most of the details are system-generated 
and cannot be edited.

 a list of the Originating Systems for MD Records codes that are defined for 
the institution.

 a group of input fields that enable you to define and create a new 
Originating System for MD Records code.

Figure 543: Code Table Page Originating Systems for MD Records Code

Adding an Originating System for MD Records Code
You can add new originating systems for MD records codes to the institution. 
The originating systems for MD records codes that you add apply to all libraries 
within the institution.

If you prefer to use the Import option to populate the code table, see Importing 
Information to Code Tables on page 283 in the Alma Administration Guide for 
more information.

To add a new originating systems for MD records code to the institution:

1 On the Code Table page, under Create New Code Table Row, enter a code 
for the new originating system for MD records code.

Figure 544: Create New Reporting Code Row Section of the Code Table Page
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2 Enter a code and description for the new originating system for MD records 
code. 

3 From the Default value drop-down list, select Yes if the new originating 
system for MD records code will be the default reporting originating system 
for MD records whenever an Originating Systems for MD Records drop-
down list is displayed.

4 Click the Add Row button. The new originating system for MD records 
code is displayed at the bottom of the list of defined originating systems for 
MD records. Note that by default, each new originating systems for MD 
records code is enabled. To disable a reporting code, click the yellow check 
mark to the left of the originating system for MD records code.

5 Click Save to store the new originating system for MD records code details 
in the system.

Figure 545: Code Table Page Originating System for MD Records Code

The originating system is displayed in the Originating System drop-down list 
when creating import profiles. 

Figure 546: Originating System Drop-Down List

Editing Originating System for MD Records Codes Details
You can edit the details of any originating system for MD records code.
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To edit the details of an originating system for MD records code:

1 On the Code Table page, under Code, locate the originating system for MD 
records code that you want to edit.

Figure 547: Code Table Page List of Originating Systems for MD Records Codes

2 To disable an enabled originating system for MD records code, click the 

yellow check mark  to the left of the originating system for MD records 
code.

3 To enable a disabled originating system for MD records code, click the gray 

check mark  to the left of the originating system for MD records code.

4 Use the Display or Order up and down arrows to set the order of the 
originating system for MD records codes. The originating system for MD 
records codes will appear in the defined order in all Originating System for 
MD Records drop-down lists. 

5 Modify the group code and description as required.

6 Select Default Value if the new originating system for MD records code will 
be the default originating system for MD records code whenever an 
Originating System for MD Records drop-down list is displayed.

7 Click Save to store the modified Originating System for MD Records code in 
the system.

Deleting and Disabling an Originating System for MD Records Code
You can delete an originating system for MD records code if the originating 
system for MD records code is no longer required. Alternatively, if the 
originating system for MD records code is not currently required but may be 
required in the future, you can disable it.

To delete an originating system for MD records code: 

1 Click the Delete button to the right of the originating system for MD records 
code that you want to delete. 

2 In the Confirmation Message dialog box, click Confirm.

3 Click Save to store the list of originating system for MD records codes 
without the deleted originating system for MD records code.
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To disable an originating system for MD records code: 

Click the yellow check mark  to the left of the originating system for MD 

records code. The check mark becomes gray  to indicate that the originating 
system for MD records code is disabled. To enable an originating system for MD 
records code, click the gray check mark to the left of the originating system for 
MD records code. The check mark becomes yellow to indicate that the 
originating system for MD records code is enabled.

Remote Digital Repositories

PERMISSIONS:
To configure remote digital repositories, you must have one of the 
following roles:

 Remote Digital Operator

This functionality allows institutions to integrate their local Digital Asset 
Management System (such as Rosetta or DSpace) with Alma. This entails the 
remote digital system providing a bibliographic metadata record (full or partial) 
with the digital-specific record ID and any additional digital-oriented inventory 
information embedded as bibliographic field information. This feed ensures that 
the digital inventory from the remote system is reflected in Alma for new, 
updated, and deleted digital inventory–ensuring that inventories of all types 
(physical, electronic, and digital) can be catalogued in one place and managed 
by one staff.

NOTES:
 At this stage, the synchronization is one-way only: metadata is sent from 

the local Digital Asset Management (DAM) System to Alma. 

 Alma currently supports imports in OAI formats only (either directly 
online through the http OAI-PMH protocol or using downloaded files in 
the following OAI formats): oai_dc (simple or qualified) , oai_marc21 or 
DSpace's simple archive format. If you are working with a different 
format (such as non-OAI Dublin Core, non-OAI Marc21, or delimited 
text), convert it to one of the supported OAI formats before attempting to 
import.

Related Areas of the System
The repositories configured in this section are available in the Remote digital 
repository instance drop-down field during the creation of a new digital import 
profile. 
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Figure 283: 

Figure 548: Remote Digital Import Profile Page

For further information, see Profile Types on page 512 and Creating the Profile 
Using the Wizard on page 517. For the broader workflow and links to related 
information, see Integrating Remote Digital Asset Management Systems on 
page 31 of the Integrations with External Systems Guide.

Configuring Remote Digital Repositories
To access configuration for remote digital repositories, select Resource 
Management > Resource Configuration > Configuration Menu > Record 
Import > Remote Digital Repositories.

The Remote Digital Repositories page opens (Figure 549).
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Figure 284: 

Figure 549: Remote Digital Repositories Page

NOTE:
Out of the box, Alma provides a set of remote digital repositories for D-
Space, Rosetta, Digitool, Fedora, Equella, Omeka, and Bepress/
DigitalCommons with selected OAI formats. If your format differs, you 
may choose one of the other system's formats, while ensuring your local 
format adheres to one of the supported OAI-PMH standards. If none of 
the supported standard OAI formats can be supplied, new repository 
types and formats may be considered for enhancement and added by Ex 
Libris in the future.

From this page, you can add a new instance of a remote repository or you can 
edit some values of the existing Alma-supplied repository types/formats. When 
you add a new instance, use the Add Remote Repository Instance button. This 
will start the three-step wizard that allows you to add a remote repository 
instance. The three steps correspond to the three tabs of a digital repository 
definition.

General Information Tab (Wizard Step 1)
The General Information Tab opens first when you edit or view an existing 
remote repository configuration. The tab contains the same fields as Step 1 of the 
wizard, when you are adding a repository instance.
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Figure 285: 

Figure 550: General Information Tab for Remote Digital Repository

The remote repository is defined by the following parameters on this page:

 Remote Repository Code — a unique code that is set when the repository or 
repository instance is first created. If you are adding a repository instance, 
the field is blank and you can create a code that indicates the remote system 
type and format (such as ROSETTA_OAI_QDC for a remote system using 
Rosetta from a source with the format of OAI QDC). 

 Remote Repository Name — the name of the remote digital repository. This 
name displays as one option in the import profile drop-down list for remote 
repositories.

 Remote System Type — indicates the external digital system (such as 
Rosetta or Fedora). 

 Format — the format of the records to be imported. Alma supports OAI-DC, 
Simple-DC, oai_marc21, and DSpace simple archive. More formats will 
be added based on customer needs.

Transformer Rules (Wizard Step 2)
The remote digital repository definitions include a set of rules that determine 
how the metadata and bibliographic records of digital remote representation 
resources should be created based on the imported bibliographic records.
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Figure 286: 

Figure 551: Transformer Rules Tab for Remote Digital Repositories

Transformer rules are logically split into two types:

 General rules — The record identifier, which is used internally in Alma to 
import the digital resource, does not have a target section and cannot be 
deleted.

 Representation rules — Rules that define a mapping between the import 
record values and the remote representation. These rules may be edited, 
deleted, and added.

NOTE:
The remote digital system integration allows you to build base URL 
templates to the remote system for digital delivery. Ex Libris recommends 
that the remote system metadata feed pass only the record ID of the 
remote digital record rather than a full URL to its delivery. This allows 
greater flexibility should the digital system base URL change in the future.

Setting Transformer Rules
Representation rules define how information is mapped from the source record 
to the representation’s definition in Alma. In addition, you can create multiple 
representations in Alma for a single import record when your remote digital 
system maintains more than one version of a digital inventory record (for 
instance, high resolution master versus a low resolution copy). 

You can configure representation rules per representation instance by selecting 
Actions > Edit in the row of the rule you want to edit or by clicking Add Rule in 
the Transformer Rules tab.
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Figure 287: 

Figure 552: Representation Rules

Representation rules contain the following settings:

Table 82. Representation Rule Settings

Field Description
Representation section:

Representation number The representation instance to which this rule applies. 
This allows you to specify rules for multiple 
representations. If you do not want to create multiple 
representations for an import record, specify 1 for all 
rules. 

NOTE:
Because general rules apply to all 
representations for the import record, they are 
not assigned a representation number.
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Source Field section: This section is required only if you need information from the 
source record to create a representation.

Field name The name of the field from which to extract its 
value in the harvested record. A source field value 
can be retrieved by using one of the following 
methods: field order or regular expression.

Extract value by order Allows you to select which occurrence of the field 
to use. 

This method requires you to specify the Field order 
field.

Field order If using the field order method, specify the occurrence 
of the field. 

For example, specify 1 in the Field order field to 
select the first occurrence of the field in the import 
record

Extract value by regular 
expression

Allows you to match the first value of the field 
that matches a given regular expression. This 
method requires you to specify the Regular 
expression value extraction field.

Regular expression value 
extraction

If using the regular expression method, specify a 
regular expression to find the field in the import 
record.

Source Field Normalization and Validation section: This section is required only if 
you want to change or validate information retrieved from the import record.

Add source field 
normalization

Select this field if you want to normalize information 
retrieved from the import record. 

Refer to the following fields for more information.

Table 82. Representation Rule Settings

Field Description
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Normalization type Select one of the normalization methods:

 Code table – Uses the DigitalNormalizerValue code 
table to retrieve the corresponding codeValue for 
the source field value.

 Constant – Replaces the value retrieved from the 
source record with the constant value specified in 
the Normalization Pattern field. 

 Regular expression – Specify a regular expression 
that groups information in the source field’s value 
so that you can extract information for a particular 
group. For more information, refer to the 
Normalization pattern and Normalization group 
fields.

Normalization Pattern For the regular expression method, specify a regular 
expression that separates the source field’s value into 
groups of information so that you can extract 
information from a particular group, which is specified 
in the Normalization group field.

For the constant normalization method, specify a value 
that will replace the source field’s value in the 
representation.

Normalization group For the regular expression method only, specify which 
group of information (as determined by the 
Normalization pattern field) to extract from the source 
field’s value.

Add source field 
validation

Select this field if the source field’s value is required to 
create the representation. Otherwise, no validation is 
performed on the source field’s value.

Refer to the Validation type field, for more 
information. 

Validation type Set this field to Mandatory if a value is needed to create 
the representation. Otherwise, the representation will 
created even if the field’s value does not exist in the 
import record.

Table 82. Representation Rule Settings

Field Description
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Target Field section: 

Target field Specify one of the following fields, which will be 
populated on the Digital Representation Resource 
Editor page for the representation:

 Entity Type – can be used for storing values such as 
Web site, E-book, Digitized photo and more.  

 Linking Parameter 1 - 5 – a value that is needed to 
create View It and Thumbnail links. This can be the 
ID of the object in the remote system that should be 
used as part of the delivery URL (for example, 
http://some-system.com?view={Linking 
Parameter})

 Representation Type – can be used to tell if a 
representation is an Access Copy or a Master

Table 82. Representation Rule Settings

Field Description
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Transformer example:

This example shows how the linking ID, which is stored in the <identifier> 
element of an OAI-DC import record, is normalized, stored in the 
LinkingParameter1 target field, and used to build the URL that allows users to 
view the item in the remote digital respository.

Figure 288: 

Figure 553: Example OAI-DC Import Record - Linking ID

To extract the linking ID and build the delivery URL:

1 On the Resource Configuration page (Resource Management > Resource 
Configuration > Configuration Menu), click Remote Digital Repositories 
under Record Import to open the Remote Digital Repositories page.

2 Select Actions > Edit for your remote digital repository.

3 The General Information tab opens on the Remote Digital Repository Details 
page.

4 Select the Transformer Rules tab to display the list of defined transformation 
rules.
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Figure 289: 

Figure 554: Transformer Rules Tab 

5 Select Actions > Edit for the LinkingParameter1 target field. 

The transformation details for the linking parameter opens in the editor 
page.

Figure 290: 

Figure 555: Transformer Rules Editor 

NOTE:
If additional information from the input record was needed to build the 
URL, you would have to create additional rules to pass that information to 
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additional linking parameter fields (LinkingParameter2 - 
LinkingParameter5), as needed.

6 Specify the following fields:

Table 83. Representation Rule Settings

Field Description
Representation section:

Representation number Because you are only creating one representation per 
import record, specify 1.

Source Field section: 

Field name Specify header:identifier, which is the field that 
contains the object’s ID in the import record (see 
Figure 553). 

For this example, the following value is extracted from 
the import record:

oai:digitool-demo.exlibrisgroup.com:343143

Extract value by order Select this method to extract the value.

Field order Specify 1 to extract the entire value from the first and 
only header:identifier field for this record. 

Source Field Normalization and Validation section: 

Add source field 
normalization

Select this field because information is needed from the 
import record.

Normalization type Select Regular Expression.

Normalization Pattern Specify the following regular expression to separate the 
value of the identifier into three groups, where each 
group is separated by a colon in the value:

(.*):(.*):(.*)

Normalization group Specify group 3, which holds the ID number for the 
object.

For this example, the following value is extracted: 
343143

Add source field 
validation

Select this field to make sure that an ID exists for the 
object.

Validation type Set this field to Mandatory.
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7 Select the Delivery tab to configure the template that Alma uses to build the 
URL that displays the object in the remote digital repository.

Figure 291: 

Figure 556: Delivery Tab 

In the Object template field, add the LinkingParameter1 field to the URL. 
In this example, the object template was set to the following URL, which was 
dependent upon the Digital Asset Management system that was used:

http://dc03vg0053eu.hosted.exlibrisgroup.com:1801/
webclient/DeliveryManager?pid=$$LinkingParameter1&amp; 
custom_att_2=simple-viewer 

This link appears as follows in the Primo View It tab:
Figure 292: 

Figure 557: Delivery Link in Primo View It Tab 

Target Field section: 

Target field Select the LinkingParameter1 field.

For this example, the following value is stored in the 
LinkingParameter1 field: 343143

Table 83. Representation Rule Settings

Field Description
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Delivery (Wizard Step 3)
The remote digital repository includes a set of configurations that support the 
viewing of loaded remote digital resources.

To edit conditions for a remote digital repository, or to create a new 
configuration based on one of the existing, out-of-the-box configurations, access 
the Wizard Step 3 through the Add... process, or select the Delivery tab of the 
Remote Digital Repository Details page. 

Figure 293: 

Figure 558: Delivery Tab for Remote Digital Repository 

The following configuration is available:

 Repository Name – The repository name to be displayed both in the View It 
and Search Results screens.
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 Object Template – the URL template to view remote digital resources. 

This URL contains general attribute parameters such as linkingParameter1, 
linkingParameter2 …, linkingParameter5 (note that these parameters are 
extracted using the representation rules configuration).

Enter the information in the syntax as follows: 

For DigiTool:
<DigiTool base URL>/webclient/
DeliveryManager?pid=$$LinkingParameter1&amp;custom_att_2=simp
le_viewer

Example:
http://www.digi-tool.com/webclient/
DeliveryManager?pid=$$LinkingParameter1&amp;custom_att_2=simp
le_viewer

For Rosetta:
<Rosetta base URL> delivery/
DeliveryManagerServlet?dps_pid=<$$LinkingParameter1>

Example: 
http://rosetta.com/delivery/
DeliveryManagerServlet?dps_pid=IE4536647

For Dspace:
<DSpace base URL>/xmlui/<$$LinkingParameter1>

Example: 
http://open.ut.edu/xmlui/430494

 Thumbnail Template – URL template for generating an object’s thumbnail 
resource link (to be used only when the remote repository supports 
thumbnail generation).

General
This section describes:

 Configuring Other Settings on page 695

 Configuring Processes on page 700

 Configuring Provenance Codes on page 701

 Configuring Accession Numbers on page 706

 Configuring E-Task Statuses on page 710

 Configuring the Label Printing Tool on page 712
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 Configuring Call Number Parsing on page 714

 Configuring the Barcode Generation Method on page 723

 Configuring Description Templates on page 725

 Configuring Inventory Available For Management Groups for 
Multicampus Environments on page 730

 Configuring Physical Item Sort Routines on page 734

 Configuring Physical Item Material Type Descriptions on page 740

Configuring Other Settings

PERMISSIONS:
To configure other settings, you must have one of the following roles:

 Cataloging Administrator

 General System Administrator

This option enables you to customize other settings that are not specific to any 
other resource management action.

You configure other settings from the Mapping Table page, which you access by 
selecting Resource Configuration > Configuration Menu from the Resource 
Management menu, and then selecting Other Settings from the General section 
on the Configuration page.

Figure 559: Mapping Table Page - Other Settings
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The following table describes the Other Settings options:
Table 84. Other Settings

Parameter Key Description
access_right_default_policy Define the access rights that are applied to all digital 

inventory that are not attached to access rights. Possible 
values are:

 Restrict – Indicates that all users are restricted from 
accessing the specified digital object

 Allow – Indicates that all users are allowed to access the 
specified digital object

activation_due Define a default e-activation task due date. The due date is 
added to all e-activation tasks. When the due date passes, a 
notification is sent to the user that is assigned the e-resource 
activation task and an alert is displayed in the user’s list of 
tasks.  For more information, see Managing Electronic 
Resource Activation on page 395 and the Manually 
Creating a PO Line section of the Alma Acquisitions Guide.

asrs_socket_timeout Not functional (for future use)

call_number_type If the call number type of a given holdings record has not 
been specified (MARC 852 first indicator) and no default call 
number type has been configured for the location of the 
holdings record, the value selected here is used by default. 
The following values for the call number type are supported: 

0 - Library of Congress classification 

1 - Dewey Decimal classification 

2 - National Library of Medicine classification 

3 - Superintendent of Documents classification 

4 - Shelving control number 

5 - Title 

6 - Shelved separately 

7 - Source specified in subfield $2 

8 - Other scheme

course_restricted_bib_data_ 
will_be_deleted

Indicate True to delete a bibliographic record that is created 
as course restricted when the course is deactivated. If the 
value of this field is False, the record is suppressed from 
publication.
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course_restricted_field The field in the bibliographic MARC record that indicates 
whether a bibliographic record is restricted for use by a 
course. Note that it is possible in Alma to use defined 
subfield separators, such as dollar dollar $$ or double 
dagger ‡. The type that is defined as the subfield separator 
must also be stipulated in this field. 

disable_preferred_term_ 
correction_job

If set to False, the Authorities - Preferred Term Correction 
job performs preferred term correction on all bibliographic 
records that are linked to authority records via the 
Authorities - Link bibliographic headings job. By default, 
this parameter is set to True. For more information on this 
parameter and the Authorities - Preferred Term Correction 
job, see Working with Authority Records on page 184.

ignore_cz_records Various processes in Alma (such as the following) use record 
matching before adding records to the institution's catalog:

 Metadata import 

 OCLC Connexion matching 

 Linking IZ (Institution Zone) records to NZ (Network 
Zone) records

To fine tune the matching process, Alma allows you to 
indicate at the institution level whether to consider matching 
records that are linked to the CZ (Community Zone). 

The valid values are true and false. If this parameter is set to 
true, Alma will match incoming records with any record 
that exists in the catalog and ignore bibliographic records 
that link to CZ bibliographic records. 

index_notes_activated Not in use.

marc_holding_in_use Indicate True to display holdings records in MARC format.

merge_method The drool file that defines the default merge profile to be 
used in the metadata editor when importing a record from 
an external source or when importing files of records to be 
merged with existing records.

networkSearchInstitution The code of the Network Zone institution.

networkSearchInstitutionId The ID of the Network Zone institution.

networkSearchPassword The password of the Network Zone institution.

networkSearchServer The name of the server of the Network Zone institution.

Table 84. Other Settings

Parameter Key Description
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non_serial_match_profile The default match profile for non-serial items in the MD 
Editor and Search External Resources (the match profiles for 
import profiles are defined elsewhere). Enter one of the 
following file keys in the Parameter Value column:

 com.exlibris.repository.mms.match.CDLMatchi
ngProfile – The Fuzzy Non-Serial match method uses 
an internal algorithm based on a combination of the 245, 
260, 020, 035, and 010 fields. The record with the highest 
score is considered to be the matching record.

 com.exlibris.repository.mms.match.IDsMatchP
rofile – The ISBN 024/035 match method matches 
based on any one of the following fields: 020, 024, or 035. 
If a field contains several values, any one of the values is 
used to match. The 020 and 035 fields are checked first.

 com.exlibris.repository.mms.match.ISBNMatch
Profile – The ISBN match method matches based on 
the 020 field only.

 com.exlibris.repository.mms.match.LCCNMatch
Profile – The LCCN match method matches based on 
the 010a field only.

 com.exlibris.repository.mms.match.OCLCMatch
Profile – The 035 (Other System Identifier) match 
method matches based on the system control number 
that uses any 035 field. If the 035 field contains several 
values, any one of these values is used to match.

For NZ institutions, refer to the procedure To configure the 
MD Editor Share With Network function to find matches 
based upon the 035 field: on page 7 in the Working with 
Collaborative Networks in Alma Guide for more 
information.

publishing_test_mode For Ex Libris staff use only.

search_limit Deprecated.

Table 84. Other Settings

Parameter Key Description
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serial_match_profile The default match profile for serial items in the MD Editor 
and Search External Resources (the match profiles for import 
profiles are defined elsewhere). Enter one of the following 
file keys in the Parameter Value column:

 com.exlibris.repository.mms.match.CDLSeMatc
hingProfile – The Fuzzy Serial match method uses an 
internal algorithm based on a combination of the 245, 
260, 022, 035, and 010 fields. The record with the highest 
score is considered to be the matching record

 com.exlibris.repository.mms.match.IDsSerial
MatchProfile – The ISSN 024/035 match method 
matches based on any one of the following fields: 022, 
024, or 035. If a field contains several values, any one of 
the values is used to match. The 022 and 035 fields are 
checked first.

 com.exlibris.repository.mms.match.ISSNMatch
Profile – The ISSN match method matches based on 
the 022 field only.

 com.exlibris.repository.mms.match.LCCNSeria
lMatchProfile – The LCCN Serial match method 
matches based on the 010a field only.

 com.exlibris.repository.mms.match.OCLCSeria
lMatchProfile – The 035 (Other System Identifier) 
match method matches based on the system control 
number that uses any 035 field. If the 035 field contains 
several values, any one of these values is used to match.

For NZ institutions, refer to the procedure To configure the 
MD Editor Share With Network function to find matches 
based upon the 035 field: on page 7 in the Working with 
Collaborative Networks in Alma Guide for more 
information.

suppressBibWithDeletedHol Indicate True to suppress the bibliographic record when the 
holdings record is deleted.

suppressBibWithSuppressed 
Hol

Indicate True to suppress the bibliographic record when the 
holdings record is suppressed.

system_date_format The system date format, for example: dd/MM/yyyy

upload_single_record_from_file The import profile used when importing a single 
bibliographic record. For more information, see Running a 
New Import Job on page 565. 

use_holdings_form Indicate True to use the Form format to display the holdings 
record in the MD Editor. If False, MARC format is used.

Table 84. Other Settings

Parameter Key Description
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To edit other settings:

1 On the Mapping Table page, change the Table Description as required.

2 Under Mapping Table Rows, locate the setting that you want to edit, and 
click Customize.

3 Modify the parameter value as required.

NOTE:
You can, at any time, click Restore to restore the initial parameter value.

4 Click Save. The modified customer parameters are saved in the Alma 
system.

Configuring Processes

PERMISSIONS:
To configure processes, you must have one of the following roles:

 Cataloging Administrator

 General System Administrator

Batch jobs or processes can be run from a standard list of available processes 
(defined by Alma) and monitored from the Alma menu (see Monitoring Jobs 
on page 286 in the Alma Administration Guide). The list of available processes is 
updated as and when new processes are defined.

Each process requires different sets of parameters that may be changed from 
time to time. 

For more information on configuring/running processes see Running Jobs on 
Defined Sets in the Alma Administration Guide.

working_copy_lock 
timeout 

Enter the number of hours in the Parameter Value cell that 
you want the bibliographic record to be locked. The amount 
you specify can be up to 9999 and excludes 0.

Refer to Edit on page 42 in Table 6, Search Results List 
Actions for additional information.

Table 84. Other Settings

Parameter Key Description
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Figure 560: Configuring Processes

NOTE:
The Active column is not functional. All columns listed are active.

Configuring Provenance Codes

PERMISSIONS:
To configure provenance codes, you must have one of the following roles:

 Cataloging Administrator

 General System Administrator

The provenance code is an arbitrary code that an institution can assign to a 
group of items for tracking purposes. It is not required. For example, it may be 
used if a library receives a donation of materials that are not shelved together 
but need to be tracked as one group. 

To configure provenance code, navigate to the Configuration page (Resource 
Management > Resource Configuration > Configuration Menu) and select 
Provenance Code from the General section.
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Figure 561: Code Table Page – Provenance Codes

This section describes:

 Viewing the List of Provenance Codes on page 702

 Adding a Provenance Code on page 703

 Editing Provenance Code Details on page 704

 Deleting and Disabling a Provenance Code on page 704

Viewing the List of Provenance Codes
The Code Table page displays:

 details about the provenance codes for the institution. Most of the details are 
system-generated and cannot be edited.

 a list of the provenance codes that are defined for the institution.

 a group of input fields that enable you to define and create a new 
provenance code.

Figure 562: Code Table Page - Provenance Codes
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Adding a Provenance Code 
You can add a new provenance code to the institution. The provenance code 
that you add applies to all libraries within the institution.

To add a provenance code:

1 On the Code Table page, under Create New Code Table Row, enter a code 
for the new provenance code.

Figure 563: Create New Provenance Row Section of the Code Table Page

2 Enter a code and description for the new provenance code. 

3 From the Default value drop-down list, select Yes if the new provenance 
code will be the default override policy whenever a Provenance Code drop-
down list is displayed.

4 Click the Add Row button. The new provenance code is displayed at the 
bottom of the list of defined provenance codes. 

5 Click Save to store the new provenance code details in the system.

Figure 564: Code Table Page – Provenance Codes
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Editing Provenance Code Details
You can edit the details of a provenance code.

To edit the details of a provenance code:

1 On the Code Table page, in the Item Provenance Codes area, locate the code 
that you want to edit.

Figure 565: Code Table Page – List of Provenance Codes

2 Use the Display or Order up and down arrows to set the order of the 
provenance code. The provenance codes will appear in the defined order in 
all Provenance Code drop-down lists. 

3 Modify the provenance code and description as required.

4 Select Default Value if the new provenance code will be the default 
provenance code whenever a Provenance Code drop-down list is displayed.

5 Click Save. The provenance code is stored in the Alma system.

Deleting and Disabling a Provenance Code
You can delete a provenance code if the provenance code is no longer required. 
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To delete a provenance code: 

1 Click the Delete button to the right of the provenance code that you want to 
delete. 

2 Click Confirm in the Confirmation Message dialog box.

3 Click Save to store the list of provenance codes without the deleted policy.

Provenance Code Example
If you define two provenance codes, for example, Winter Display and Summer 
Display:

Figure 566: Provenance Code Example

These options are displayed when editing physical item records. Since Winter 
Display is defined as the default value, it is displayed first:

Figure 567: Provenance Code Example in Physical Item Editor
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Configuring Accession Numbers

PERMISSIONS:
To configure accession numbers, you must have one of the following 
roles:

 Cataloging Administrator

 General System Administrator

You can automatically generate accession numbers in holdings records to 
identify a resource and configure how these numbers are generated. For 
example, you can use a prefix that includes the year the resource is acquired, 
and the resource number (if duplicate resources have been acquired), or you can 
identify by location. 

NOTE:
For more information on Alma accession numbers, refer to the Alma 
Record Numbering System document under Alma > Product 
Documentation > Resource Management > How To Documents and 
Presentations in the Documentation Center.

The accession number begins by default at 1 and is incremented by 1 each time 
an accession number is generated. It is possible to set an initial value different 
than 1. It is also possible to skip some numbers and set a new next sequence 
value, which must be higher than the last one in use. (For more information, see 
Editing an Accession Number on page 709.)

After you configure the accession number, it is generated in the MD Editor for a 
holdings record by selecting Tools > MARC 21 Holdings > Generate Accession 
Number.
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Figure 568: Generate Accession Number

You configure accession number from the Accession Configuration page, which 
you access by selecting Resource Configuration > Configuration Menu from 
the Resource Management menu, and then selecting Accession Number from 
the General section on the Configuration page.

Figure 569: Accession Number Page

This section describes:

 Viewing the Accession Number List on page 708

 Adding a New Accession Number Sequence on page 708

 Editing an Accession Number on page 709 

 Deleting an Accession Number on page 709
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Viewing the Accession Number List
The Accession Configuration page displays the following:

 a list of the library locations

 the method assigned to generate the accession number

Figure 570: Accession Configuration Page 

Adding a New Accession Number Sequence 
You can add a new sequence to the list of accession numbers.

To add a new sequence:

1 On the Accession Configuration page, under Create a New Sequence, select 
a library from the Library drop-down list code for the new sequence.

Figure 571: Code Table Page Create New Provenance Row

2 In the Location drop-down list, select a location for the new sequence. 

3 In the Sequence Name field, enter a name for the new sequence.

4 In the Method drop-down list, select a method to generate the new 
sequence.

5 Click Add Row. The new sequence is added to the Accession Configuration 
list.
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Editing an Accession Number
The accession number begins by default at 1 and is incremented by 1 each time 
an accession number is generated. It is possible to set an initial value different 
than 1. It is also possible to skip some numbers and set a new next sequence 
value, which must be higher than the last one in use.

To edit the accession number:

1 On the Accession Configuration page, select Actions > Set Next Sequence 
Value for the library whose sequence value you want to change. The Set next 
number value dialog box opens.

Figure 572: Set Next Number Value Dialog Box

2 Enter the next value.

3 Click Save. The new sequence value displays on the Accession 
Configuration page.

Deleting an Accession Number
You can delete a library’s accession number.

To delete an accession number:

1 On the Accession Configuration page, select Actions > Delete for the library 
whose accession number you want to delete. 

2 Click Confirm in the Confirmation Message dialog box.

3 The accession number is removed from the Accession Configuration list.

Assigning Accession Number Placement
In order to have the automatically generated accession number indexed and 
thereby searchable in the repository, you must assign the accession number to a 
MARC field. For more information, the Editing Physical Location section in the 
Alma Fulfillment Guide.
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Configuring E-Task Statuses

PERMISSIONS:
To configure e-task statuses, you must have one of the following roles:

 Repository Administrator

When you manage electronic resource activation from Manage Inventory > 
Manage Electronic Resource Activations or Manage Inventory > Manage 
Electronic Resource Activations > Actions > Edit, you assign a status to the 
electronic resource from a drop-down list. This section describes how you 
configure the statuses available to be assigned. For more information, see 
Managing Electronic Resource Activation on page 395.

You configure the e-task statuses from the Code Table page, which you access 
by selecting Resource Configuration > Configuration Menu from the Resource 
Management menu, and then selecting E Task Statuses from the General 
section on the Configuration page.

Figure 573: E Task Statuses

This section describes:

Viewing the E-Task Statuses on page 711

Adding an E-Task Status on page 711

Editing E-Task Details on page 711

Deleting an E-Task on page 712
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Viewing the E-Task Statuses
The Code Table page displays:

 details about the table that contains the e-task statuses

 a list of the e-task statuses that are defined for the institution

 a group of input fields that enable you to define and create a new e-task

Adding an E-Task Status
You can add new e-tasks to the institution. The tasks that you add are available 
to all libraries within the institution.

If you prefer to use the Import option to populate the code table, see Importing 
Information to Code Tables in the Alma Administration Guide for more 
information.

To add a new e-task:

1 On the Code Table page, under Create New Code Table Row, enter a code 
for the new e-task.

2 Enter a code and description for the new e-task. 

3 Select the Default value check box if the new e-task will be the default e-
task whenever an e-task drop-down list is displayed.

4 Click the Add Row button. The new e-task is displayed at the bottom of the 
list of defined e-tasks. Use the Move Up and Move Down arrows to set the 
order of the e-task.

5 Click Save to store the new e-task details in the system.

Editing E-Task Details
You can edit the details of any e-task.

To edit the details of an e-task:

1 On the Code Table page, under E-Task Status, locate the e-task that you 
want to edit.

2 Use the Display or Order up and down arrows to set the order of the e-
tasks. The groups will appear in the defined order in all e-task drop-down 
lists. 

3 Modify the code and description as required.

4 Select Default value if the new e-task will be the default e-task whenever an 
e-task drop-down list is displayed.

5 Click Save to store the modified e-task in the system.
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Deleting an E-Task
You can delete an e-task if it is no longer required. 

To delete an e-task: 

1 Click the Delete button to the right of the e-task that you want to delete. 

2 Click Save to store the list of e-tasks without the deleted group.

Configuring the Label Printing Tool

PERMISSIONS:
To configure the label printing tool, you must have one of the following 
roles:

 API Label Printing Read

 General System Administrator

You can use the Alma Label Printing tool to print book labels. To do this, 
configure the label printing tool from the Download Label Printer page (follow 
the Alma menu path Resource Management > Resource Configuration > 
Configuration Menu, then, from the Configuration page, select Label Printing 
Tool from the General section).

Figure 574: Download Label Printing

NOTE:
Before downloading the Alma printing tool you must confirm that you 
have Java 1.7.0_04 or later and a third-party, XML-based PC print 
solution, such as BIAF in stalled on your computer. If you want to use the 
Ex Libris provided BIAF spine label application, contact Ex Libris 
Support. For detailed information regarding this tool, see How to Configure 
and Use Alma with BIAF to Print Labels. (Note that you must be logged in to 
the Documentation Center in order to view this document.)

http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Configure%20and%20Use%20Alma%20with%20BIAF%20to%20Print%20Labels.pdf
http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Configure%20and%20Use%20Alma%20with%20BIAF%20to%20Print%20Labels.pdf
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To download the label printing tool:

1 Click Download. 

Your browser’s download box opens with the file urm_label_printer.zip.

2 Open or save the urm_label_printer.zip file, then extract the files using 
your computer’s extraction tool or wizard.

3 Complete the wizard steps to store the label-printing files and folders on 
your computer.

To install and configure the label printing tool:

1 Run the run.bat file from the bin directory from the location in which you 
saved the files. After the software is successfully installed, the Label Printer 
application opens to the default tab, Item Details.

Figure 294: 

Figure 575: Item Details

2 Click the Configuration tab to enter user and location information.

3 Fill in the User, Password, Alma URL, and Institution fields. For the user 
name and password, enter the Alma logon information of the staff operator 
that uses the application.

4 The Program Location and Program Parameters fields are intended for your 
third-party, XML-based PC print program. For the Program Location for 
BIAF, put the location of AddToQueue.exe using the full path:
C:\BIAF\BIAFLABEL\AddToQueue.exe   

5 In the Program Parameters field, enter preview to preview the file before 
printing.
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To print labels:

1 Open your label printing tool from an icon or an executable in the label 
printing tool’s folder.

The Label Printer opens.

Figure 576: Item Details

2 Wand or enter either an item barcode or an item ID (PID).

3 Click Send.

After sending the barcode or item ID, the client application triggers an Alma 
Web service. The Web service returns the item information in XML format. Then 
the client application does one of the following:

 Activates a configurable third-party, PC XML-based print solution (such as 
BIAF) and sends the XML as input to that third-party solution

 Places the XML on a client-side directory

Configuring Call Number Parsing

PERMISSIONS:
To configure call number parsing, you must have one of the following 
roles:

 Cataloging Administrator

 General System Administrator

Alma Resource Management provides options for call number parsing when 
libraries need to create labels for physical items. 

Configure call number parsing from the Call Number Parsing mapping table 
(Resource Management > Resource Configuration > Configuration Menu then 
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then select Call Number Parsing from the General section on the Configuration 
page).

Figure 577: Call Number Parsing Configuration

This section describes:

 Viewing Call Number Parsing on page 715

 Adding, Editing, and Deleting Call Number Parsing on page 717

 Call Number Parsing Options on page 717 

Viewing Call Number Parsing
To view call number parsing, navigate to the Configuration page (Resource 
Management > Resource Configuration > Configuration Menu) and select Call 
Number Parsing from the General section.

The Call Number parsing link opens the mapping table for call number parsing 
options.
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Figure 578: Mapping Table Page – Call Number Parsing

The mapping table page displays the following information for each row.

Table 85. Call Number Parsing Fields

Name Description
Enabled A yellow check mark indicates that the row is in use, a 

clear check mark indicates that the row has been 
disabled. Click the check mark to toggle.

Call Number Type The type/format of the call number being assigned the 
parsing method.

Call Number Parsing 
Type

The way the call number is split or parsed when 
printed for a label. Nine methods are available.

Updated By The user who last updated the mapping row.
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Adding, Editing, and Deleting Call Number Parsing
Call number parsing routines can be added to call number types, edited from 
their current assigned call number types, or deleted from their assigned call 
number types.

To add a call number parse routine:

1 From the Mapping Table page for call number parse options (Resource 
Management > Resource Configuration > Configuration Menu > Call 
Number Parsing), in the Create a New Mapping Row section, select a call 
number type that you want to associate with a parse routine, and then select 
the parse routine you want to associate with that call number type.

2 Click the Add Row button below your selections.

The new row is added to the existing mapping rows in the table.

3 To save the mapping, click the Customize button.

The system creates the association you specified.

To edit or delete an existing call number parse routine:

1 From the Mapping Table page for call number parse options (Resource 
Management > Resource Configuration > Configuration Menu > Call 
Number Parsing), locate the row you want to edit or delete in the Mapping 
Table Rows section.

2 To edit a parsing association, use the drop-down selections for Call Number 
Type or Call Number Parsing Type to make the changes you want.  
 
To delete a mapping, click the Delete button of the row of the mapping you 
want to delete.

3 Click the Customize button to save your changes.

Call Number Parsing Options
Call number parsing routines are system-defined and cannot be edited by users. 
Users select one of the following parsing routines.

Last Updated The date and time of the last update to the mapping 
row.

Table 85. Call Number Parsing Fields

Name Description
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Table 86. Parsing Routines

 # Description
1 Logic:

 5 lines maximum; if there are more than 5 lines, do not split the last part

 8 characters per line maximum

 Split the call number at spaces

 Split the call number at the opening parenthesis (

 Split the call number on a period if the line is longer than 5 characters 
(except parenthesis)

Examples:

 Call number = QC 300 G662(9.03) F749(.03) +2

 Label printed:

QC 

300 

G662

(9.03) 

F749

(.03) +2

 Call number = CQ 9101 T39.994

 Label printed:

CQ

9101

T39

.994

 Call number=CM 1000 E61 -3,3,2+2

 Label printed:

CM 

1000 

E61 

-3,3,2+2
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2 Logic:

 3 lines maximum; if there are more than 3 lines, do not split the last part

 Split the call number at spaces

Examples:

 Call number = 9.6 RUMÄ Roma

 Label printed:

9.6 

RUMÄ 

Roma

 Call number = 9.2.23.5 FORT

 Label printed:

9.2.23.5

FORT

3 Split by a space:

 Splits the call number at spaces and subfield i.

 If the character ^ is present in the call number, it is converted to a space but 
does not break at that point.

Example:

 Call number = $$hG635.H4$$iA3 1989^a

 Label printed:

G635.H4

A3

1989 a

Table 86. Parsing Routines

 # Description
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4 Split by a space and a period:

 Splits the call number at spaces, periods, and subfield i.

 If the character ^ is present in the call number, it is converted to a space but 
does not break at that point.

Example:

 Call number = $$hG635.H4$$iA3 1989^a

 Label printed:

G635

.H4

A3

1989 a

5 Split by a space and classification:

 In addition to parse routine 4, breaks between the letter and number 
components of the classification part of the call number (even if there is no 
space) and breaks on a decimal preceding a letter (even if it is not preceded 
by a space).

Example:

 Call number = $$h KJV444.21804 A7 $$i L63 1805

 Label Printed:

KJV

444.21804

A7

L63

1805

Table 86. Parsing Routines

 # Description
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6 Split by a space, classification, and limit length:

 Adds to parse routine 5 (split by a space and classification). When a line 
ends up longer than eight characters, it splits on a "."

Example:

 Call number = $$h KJV444.21804 A7 $$i L63 1805

 Label Printed:

KJV

444

.21804

A7

L63

1805 

7 Split into the first 3 letters, then the rest; letters and numbers are split at the 
beginning of the call number, even if there is only one letter; a 2nd period 
causes a split regardless of whether there is a character after it or of the length 
of the line (if not broken).

Example:

 Call number = HS RA44050B .5.T46.7.8.9.10.11.12.13.14.15 E47 2013

 Label printed:

HS

RA

44050B

.5

.T46.7.8.9.10.11.12.13.14.15

E47

2013

Table 86. Parsing Routines

 # Description
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8  Splits the call number at spaces, periods, and subfield i.

 If the character ^ is present in the call number, it is converted to a space but 
does not break at that point.

 If the number of digits after the period is more than 4, break as follows:

 5 = 3, 2 

 6 = 3, 3 

 7 = 4, 3 

Example:

 Call number = 363.7387403 E564

 Label printed:

363

.7387

403

E564

9  For the Superintendent of Documentation (SuDoc) classification system

 Used primarily for portrait-oriented spine labels and does the following:

 Inserts a line break after the first colon.

 Replaces each slash following the colon (not before the colon) with a 
line break.

Examples:

 Call number = HE 20.6520/2: AC9/2

 Label printed:

HE 20.6520/2:

AC9

2

 Call number = HE 20.6520/2: 17

 Label printed:

HE 20.6520/2:

Table 86. Parsing Routines

 # Description
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Configuring the Barcode Generation Method

PERMISSIONS:
To configure the barcode generation method, you must have one of the 
following roles:

 Repository Administrator

 General System Administrator

The barcode is a unique identifier (at the institution level) given to each item. 
The institution can use the Barcode Generation Configuration page (see 
Figure 579) to define which of the following barcode generation routines is used 
to automatically generate barcodes when a barcode value is empty:

 None – No barcode is generated automatically.

10  For the Superintendent of Documentation (SuDoc) classification system

 Used primarily for landscape-oriented spine labels and inserts a line break 
after the first colon.

Examples:

 Call number = HE 20.6520/2: AC9/2

 Label printed:

HE 20.6520/2:

AC9/2

 Call number = HE 20.6520/2: 17

 Label printed:

HE 20.6520/2:

17

11  Splits the call number at space, comma, semi-colon, and plus sign

Example:

 Call number = M780.92,P175 1;F

 Label Printed:

M780.92

P175

1

F

Table 86. Parsing Routines

 # Description
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 Prefix + sequence – This validates that the barcode starts with the value 
specified in the Prefix field (see instructions below) followed by a number.

Each barcode is validated for uniqueness, as follows:

 Valid value – If the barcode has a value and it is unique, the barcode format 
is validated as described below.

 Not valid value – If the barcode format is not valid, a warning message is 
generated; and the item’s record is not saved. However, if the user confirms 
saving the item in the Metadata Editor, it is saved.

 Validation at import – When an item is imported, it is created/saved and 
any resulting validation warning messages are stored in the import report.

The list of all the barcode format validation routines supported by Alma are 
saved in a mapping table and maintained by Ex Libris for institutions. The 
validation routines can be enabled or disabled. The list of enabled validation 
routines are scanned until the barcode is found valid, or there are no more 
entries in the list.

NOTE:
If barcodes without values are allowed, an empty value is not validated 
for format or uniqueness.

To configure the barcode generation method:

1 On the Resource Management Configuration page (Resource 
Management > Resource Configuration > Configuration Menu), click 
Barcode Generation in the General section.

The Barcode Generation Configuration page opens.
Figure 295: 

Figure 579: Barcode Generation Configuration Page

2 Specify the following fields:

 Barcode generation method – Initially, this field is configured by Ex 
Libris Professional Services during the implementation phase. 
Optionally, you can change the method over time. 
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 Prefix – Use this field to define the prefix used (any string) when the 
barcode generation method selected is Prefix + sequence.

 Last sequence value – This is a view-only field. It displays the last 
assigned barcode value. This value can be changed by using the Set next 
sequence value option.

 Set next sequence value – Click this link to open the Set Next Number 
Value dialog box and enter a sequence value. This value must be unique 
within the sequence and higher than the last sequence value.

Figure 296: 

Figure 580: Set Next Sequence Value Dialog Box

3 Click Save.

Configuring Description Templates

PERMISSIONS:
To configure the description templates, you must have one of the 
following roles:

 Repository Administrator

 Catalog Administrator

 General Administrator

This section describes how to configure a template to be used when generating 
an item description based on information that you enter in the ENUM/CHRON 
Information tab of the Physical Item Editor page. For more information, see   
Using the Repository Search Results List on page 35 and the Receiving 
Physical Material section of the Alma Acquisitions Guide.

You configure description templates from the Description Template Setup Rules 
page, which you access by selecting Resource Configuration > Configuration 
Menu from the Resource Management menu, and then selecting Description 
Templates from the General section on the Configuration page.
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Figure 581: Description Templates

The following actions can be performed on this page:

 Adding a description template rule (see Adding Description Template 
Rules)

 Editing a description template rule (see Editing a Description Template 
Rule on page 728)

 Duplicating a description template rule (Actions > Duplicate and edit the 
relevant fields)

 Deleting a description template rule (Actions > Delete)

Adding Description Template Rules
You can add a description template rule. The rules that you define apply to all 
the libraries within the institution.

To add a description template rule:

1 On the Description Template Setup Rules page, click the Add Rule button. 
The Description Template Setup page opens.

NOTE:
If you want to create a copy of an existing description template rule, select 
Actions > Duplicate. Once you have copied the description template, you 
can modify it as needed.
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Figure 582: Description Template Setup Page

2 Under Description Template Setup Editor, enter a name and description of 
the description template.

3 Under Input Parameters, specify the components of the input parameter 
(Name, Operator, and Value). A set of input parameters may look like this: 
Library=Art Library, EnumA=Vol. 1, ChronI=2012. For an explanation of the 
Enum (Enumeration) and Chron (Chronology) parameters, see Table 6 in 
the Alma Acquisitions Guide.

4 Click Add Parameter. The set of input parameters is added to the list of 
parameters for the description template rule.
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5 Repeat the previous two steps to add all of the required parameters for the 
rule.

NOTE:
All the input parameters must be fulfilled in order for the rule to be 
applied. For multiple description templates to work, every rule must have 
input parameters.

6 Under Output Parameters, enter the following:

a The prefix that you want to appear before the field.

b The field for which you want to have a prefix and suffix displayed.

c The suffix that you want to appear after the field.

NOTE:
If you want to have a space before or after a prefix, leave a space before or 
after the prefix that you enter in the prefix field.

7 Click Save to store the new rule.

8 If you have defined more than one rule, use the Move Up and Move Down 
arrows to set the order of the rules. The order of the rules is important since 
the system applies the first (and only the first) appropriate rule. If no 
appropriate rule is found, the system uses the default rule.

NOTE:
The Enabled column is not functional. All columns listed are enabled.

Editing a Description Template Rule
You can edit description template rules.
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To edit a description template rule:

1 On the Description Template Setup Rules page, select Actions > Edit for the 
specific rule you want to edit. The Loan Limit page opens.

Figure 583: Edit Description Templates Page

2 Modify the rule name and description as required.

NOTE:
You cannot edit an existing set of input parameters. To modify an existing 
set of input parameters, first delete the existing set, and then add a new 
set.
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3 Click Delete for the specific set of input parameters record you want to 
delete. 

4 Add a new set of input parameters as described in Adding Description 
Template Rules on page 726.

5 Under Output Parameters, enter the following:

a The prefix that you want to appear before the field.

b The field for which you want to have a prefix and suffix displayed.

c The suffix that you want to appear after the field.

6 Click Save to store your changes to the description template rule.

NOTE:
For information on how to display an enumeration level b value as text in 
the item description, see the document How to Display an Enumeration Level 
b Value as Text in the Item Description.

Configuring Inventory Available For Management Groups 
for Multicampus Environments

PERMISSIONS:
The following roles can configure campus/library inventory management 
network groups:

 Repository Administrator

 General System Administrator

The following role can define availability for electronic collections and/or 
portfolios:

 Electronic Inventory Operator

Often, access to electronic resources is restricted to certain campuses and/or 
libraries within an institution and is not available to all the patrons across the 
institution. In order to address this requirement to manage the availability of 
electronic resources per campus and/or library, Alma provides configurable 
inventory (Available For) management group settings.

NOTE:
If resources are available for all patrons across the institution, there is no 
need to set up management groups or Available For definitions since, by 
default, active resources are available for all patrons.

http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Display%20the%20Enumeration%20Level%20b%20Numeric%20Value%20as%20Text%20in%20the%20Item%20Description.pdf
http://customercenter.exlibrisgroup.com/DocumentationCenter/Ex%20Libris%20Documentation/Alma/Product%20Documentation/Resource%20Management/How%20To%20Documents%20and%20Presentations/How%20to%20Display%20the%20Enumeration%20Level%20b%20Numeric%20Value%20as%20Text%20in%20the%20Item%20Description.pdf
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A group represents a set of campuses and/or libraries for which you want to 
manage electronic resources as a group. Group setting characteristics or 
considerations include the following:

 One or more campuses and/or libraries may be defined in a single group

 One campus and/or library can be a part of multiple groups

 Settings should be defined in a manner that eases the management and 
activation of electronic resources

Example:

An institution may have the following campuses that purchase and manage 
electronic resources independently:

 North Campus

 South Campus

 Main Campus

 City Campus

Each of these campuses is defined as a separate group. 

In addition, there are certain electronic resources that the North Campus 
and the Main campus purchase and manage together. For this scenario, you 
may want to configure the North and Main Campus as a single group if this 
configuration makes it easier for you to manage/limit access to electronic 
resources. Otherwise, you can separately specify the North Campus group 
and the Main Campus group to an electronic resource and achieve/provide 
the same level of access to the patrons.

These groups are assigned to electronic resources using Add Settings for 
Group (refer to Adding Group Settings to Electronic Resources on 
page 280). Also, refer to Adding/Editing IP Definitions for a Library on 
page 196 in the Alma Administration Guide that is related to associating/
providing access to library resources.

With the Inventory Network Groups configuration options, you can define 
groups that you can use to manage access to electronic resources. You can define 
campuses and/or libraries within a specific group for sharing electronic 
resources. Refer to the steps below for configuring management groups.

NOTE:
In order for Inventory Network Groups to display as a configuration 
option in the Resource Management configuration menu, someone with 
the General System Administrator role needs to set the parameter value to 
true for the multi_campus_inventory_management parameter in the 
mapping table located in Administration > General Configuration > 
Configuration Menu > General Configuration section > Other Settings.
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Adding Available For Inventory Management Groups
Use the following procedure to add inventory (Available For) management 
groups.

To add an inventory (Available For) management group:

1 On the Inventory Available For Management Groups page (Resource 
Management > Resource Configuration > Configuration Menu > 
General > Inventory Network Groups), click Add Group. The Add Group 
dialog box opens.

2 Assign a name to the group, optionally enter a description, and click Add 
and Close.

Figure 584: Add Group

The Inventory Available For Management Groups page displays the list of 
groups.

Figure 585: Group Added to the List

3 Select Actions > Edit for the group you are adding. The Inventory 
Management Group Details page is displayed.
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Figure 586: Inventory Management Group Details Page

4 Select one of the previously defined campuses and/or libraries and click 
Add Campus and/or Add Library. The campuses/libraries are added to the 
list of group members.

Figure 587: Group List

5 Continue adding campus/library members until the group is complete. 
When you are finished, click Back to return to the Inventory Available For 
Management Group Details page.
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Deleting Available For Management Groups
Use the following procedure to delete inventory Available For management 
groups.

To delete an inventory Available For management group:

1 Access the Inventory Available For Management Groups page (Resource 
Management > Resource Configuration > Configuration 
Menu > General >Inventory Network Groups).

Figure 588: Inventory Available For Management Groups Page

2 Select Actions > Delete for the group your want to delete.

IMPORTANT:IMPORTANT:
It is strongly recommended that you do not delete Available For groups 
after they are set and associated with inventory. If you delete an Available 
For group that is connected to inventory, the relevant Available For 
setting in the inventory is also deleted. Available For group association 
with inventory is done via an internal ID; and once it changes (such as 
when groups are deleted), the association will not be kept. Refer to 
Adding Group Settings to Electronic Resources on page 280 for more 
information regarding associating Available For groups with inventory. 

Configuring Physical Item Sort Routines

PERMISSIONS:
The following role can configure physical item sort routines:

 General System Administrator

The Physical Item Sort Routines configuration options provide greater flexibility 
for determining the sort order display of physical items in the Receive Items List 
(Acquisitions > Receiving and Invoicing > Receive > Continuous tab, select 
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Actions > Manage Items), the staff search physical items list, and/or the Get It 
tab.

These configuration options enable you to create your own custom sort routines 
in addition to the default sort routines provided with Alma. 

The sort routines display in a drop-down list that allows you to dynamically 
switch from one sorted view to another. See below for examples of sort routines.

Figure 297: 

Figure 589: Sort Routines for the Staff Search Physical Items List

To the right of the drop-down list are up/down arrows that allow you to 
dynamically switch between ascending and descending order for the sort 
routine that you have selected.
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Figure 298: 

Figure 590: Sort Routines for Received Items List
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Figure 299: 

Figure 591: List of Items on Get It Tab (Displayed on the Alma Electronic Services Page)

VIDEO:
For more information on item sort routines, see the Item Sort Routines 
video (7:34 mins).

To configure item sort routines:

1 On the Sort Routine List page (Resource Management > Resource 
Configuration > Configuration Menu > General > Physical Item Sort 
Routines), click Add Sort Routine. The first step of the sort routine wizard 
opens.

2 Enter the name and description for the sort routine and click Next. Step 2 of 
the sort routine wizard opens.

3 Select the sort order (ascending or descending) for this routine.

4 Select the fields by which you want this routine to sort.

http://www.youtube.com/watch?v=V4kzKP8Ly94&hd=1
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Figure 300: 

Figure 592: Select Fields on Which to Sort

5 Click Add to Selection.
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Figure 301: 

Figure 593: Sort Fields Selected

6 Use the up/down arrows to the left of the selected fields to identify the order 
in which you want this fields sorted and click Next. Step 3 of the sort routine 
wizard opens.

7 Select the item list in which you want this sort routine to be available and 
select whether it should be the default sort routine to be used.
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Figure 302: 

Figure 594: Sort Routine Available For Selection

8 Click Save. The new sort routine is added to the list of routines on the Sort 
Routine List page.

To edit an existing sort routine, select Actions > Edit for the routine on the Sort 
Routine List page. To delete a sort routine, select Actions > Delete.

Configuring Physical Item Material Type Descriptions

PERMISSIONS:
The following roles can configure item material type descriptions:

 Cataloging Administrator 

 General System Administrator

You can configure the descriptions of the material types that are displayed from 
the Material type drop-down list. This drop-down list appears in many pages in 
Alma—for example, in the Physical Item Editor when editing a physical item. In 
addition, the change to the material type description appears in the Primo View 
It and Get It tabs.

To customize the physical item material type descriptions:

1 On the Resource Management Configuration page (Resource 
Management > Resource Configuration > Configuration Menu), click 
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Physical Material Type Descriptions under General. The code table of the 
Physical Material Type opens.

Figure 595: Physical Material Type Descriptions

2 Edit the descriptions of the material types in the Description field.

3 Use the up and down arrows to change the order in which the material type 
will be displayed in the Material type drop-down list.

4 Click Save.

All Material type drop-down lists in Alma (for example, in PO lines or the 
Physical Item Editor) will now display the customized values.
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